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About this Manual
This manual describes how to model business processes using the Interstage Business Process
Manager Studio.

Intended Audience
This manual is intended for process designers who define their business process models using the
Interstage Business Process Manager Studio. It assumes that the reader has experience on working
with graphical user interfaces.
When using advanced process modeling features, the manual assumes that the reader has basic
programming skills and is familiar with JavaScript, XML technologies, and Web Services concepts.

This Manual Contains

DescriptionTitleChapter

Introduction to Interstage BPM,
and to process definitions and
their components.

Introduction1

Explains how to start and exit
Interstage BPM Studio, and how
to model your first process.

Getting Started2

Introduces the user interface
components and explains how
to customize the user interface.

Understanding and Customizing the User
Interface

3

Describes how to create and
work with Workflow Application
and server projects.

Managing Projects4

Describes how to create and
work with process definitions.

Managing Process Definitions5

Explains how to add nodes,
swimlanes, groups, and arrows
and how to define their
properties.

Modeling Processes6

Explains how to create
Interstage BPM Forms and
QuickForms that are presented
to end-users during process
execution.

Using Forms7

Describes how to model
processes that need to be split
in multiple process definitions.

Modeling Subprocesses, Remote
Subprocesses and Chained-Processes

8

Explains how to work with Java
Actions, Triggers, and
JavaScript Expressions.

Advanced Process Modeling9
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DescriptionTitleChapter

Describes how to create and use
simulation scenarios for
simulating the execution of a
process.

Simulating Processes10

Describes the JavaScript
functions supported by
Interstage BPM.

Supported JavaScript FunctionsAppendix A

Explains all components that are
part of a project

Project ComponentsAppendix B

Glossary of terms.Glossary

Typographical Conventions
The following conventions are used throughout this manual:

MeaningExample

Text you are required to type at a command line is identified by
Courier font.

command

Text that is visible in the user interface is bold.screen text

Reference material is in italics.Reference

A command parameter is identified by Courier font.Parameter

Other References
The following references for Interstage Business Process Manager are also available:
• Interstage Business Process Manager Form Editor User's Guide

Describes how to create Interstage BPM Forms using the Interstage BPM Form editor available
in the Interstage BPM Studio. This guide is available in HTML format and can be accessed by
calling the following URL:
<Studio install dir>share\docs\FormEditorUsersGuide\docs\overview.htm

where <Studio install dir> is the directory to which you have installed the Interstage BPM
Studio, for example:
C:\fujitsu\InterstageBPM_studio

• Release Notes
Contains an overview of Interstage Business Process Manager, installation tips, and late-breaking
information that could not make it into the manuals.

• Interstage Business Process Manager Server and Console Installation Guide
Describes software and hardware requirements, installation procedure for Interstage Business
Process Manager Server and Console

• Interstage Business Process Manager Server Administration Guide
Explains how to configure and administrate Interstage Business Process Manager Server. This
guide also describes the configuration parameters of the Interstage BPM Server.
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• Interstage Business Process Manager Developer's Guide
Describes how to use the Interstage Business Process Manager API to customize and extend
Interstage BPM to fit the unique needs of your organization.

• Interstage Business Process Manager Tenant Management Console Online Help
Explains how to use the Interstage Business Process Manager Tenant Management Console
user interface.

• Interstage Business Process Manager Console Online Help
Explains how to use the Interstage Business Process Manager Console user interface.

• Interstage Business Process Manager ARIS Process Performance Manager Integration Guide
Describes how to install and configure the PPM adapter and the PPM autoConfig tool. With these
two programs, process data can be transferred from Interstage Business Process Manager to
ARIS Process Performance Manager.

• API Javadoc
This HTML documentation provides the API and syntax of the packages, interfaces and classes
for developing custom applications or embedding Interstage Business Process Manager into
other products.

Abbreviations
The products described in this manual are abbreviated as follows:
• "Interstage Business Process Manager" is abbreviated as "Interstage BPM".
• "Interstage Business Process Manager Studio" is abbreviated as "Interstage BPM Studio".
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1 Introduction
This chapter gives an overview of Interstage Business Process Manager and Interstage Business
Process Manager Studio. It also explains basic concepts you need to know before getting started.

1.1 About Interstage Business Process Manager
Interstage Business Process Manager empowers business groups to collaboratively plan, automate,
track, and improve business processes. It allows to design automated processes that comprise the
sequence of activities, human and IT resources as well as the data to be handled.
Interstage BPM has an open, flexible, scalable architecture that integrates seamlessly into existing
environments. Its Application Programming Interfaces (APIs) empower developers or system engineers
to tailor Interstage BPM to an organizations' specific needs. Interstage BPM is made up of several
components.
The Interstage BPM Studio is an easy-to-use business process modeling tool. It enables process
designers and system integrators to graphically model the business processes of an enterprise.
Entire workflow applications including all artefacts required to run the application can be created
using the Interstage BPM Studio. Such an application can be developed offline and later be deployed
on an Interstage BPM Server that can be accessed by end-users. To facilitate developing and
deploying an application, Interstage BPM Studio provides a wide range of upload and download
functions, as well as import and export functions.
Interstage BPM Studio is also available as an Eclipse-plugin. When integrating BPM Studio into the
Eclipse software framework, you can use Eclipse as a development environment for Java technology.
Eclipse has many features that make for quick and painless Java programming and debugging. For
more information, refer to section Using Interstage BPM Studio as Eclipse Plug-In on page 17.
Interstage BPM Server is a Web-enabled workflow engine. It provides the run-time environment
for process instances created from process definitions.
The Browser-based Interstage BPM Console enables users to start processes, respond to work
items and administer the Interstage BPM Server.
The following figure shows the Interstage BPM components.

Figure 1: Interstage BPM Components

For details on the Interstage BPM architecture, refer to the Interstage Business Process Manager
Server Administration Guide.
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1.2 Interstage BPM Studio Features
Interstage BPM Studio is an intuitive and easy to use process modeling tool and web application
development tool. It is based on the latest user interface technologies and provides the following
features:
• Offline Editing

Interstage BPM Studio is a standalone tool that can be used independently of an Interstage BPM
Server. Individual process definitions can be exported from Interstage BPM Studio and imported
to an Interstage BPM Server.
In addition, Interstage BPM Studio allows you to design entire workflow applications offline.
Later you can deploy such an application on an Interstage BPM server that can be accessed by
Interstage BPM clients. A Workflow Application project contains everything necessary for the
running of a process solution, for example process definitions, forms, simulation scenarios,
attachments, etc. When creating a Workflow Application project, you are working locally and are
thus independent of an Interstage BPM Server. You can easily upload entire applications to a
remote server and download applications from a server. You can also package applications to a
file and thus export a project to a file, as well as import a project from the local file system.
Interstage BPM Studio supports accessing multiple tenants on Interstage BPM Server.
In SaaS mode:
• A default tenant as well as some other tenants exist.
• Each tenant can have multiple applications.
• Each tenant has a BaseURL. When you upload or download the application, you access this

BaseURL.
In non-SaaS mode:
• Only the default tenant exists.
• The default tenant can have multiple applications.
• The default tenant has a BaseURL. When you upload or download the application, you access

this BaseURL.

• Online Editing: Server Projects
In addition to working offline in the Interstage BPM Studio, using it as a standalone tool, you can
work directly on a connected Interstage BPM Server. Process definitions that you create with
Interstage BPM Studio are stored directly in the database located on the Interstage BPM Server.
Using a Server Project, you can access only the System application in the default tenant .

• Process Simulation
Interstage BPM Studio allows for simulating the execution of business processes. Simulation
scenarios can be defined, and, based on the scenarios, cost and time can be calculated and
reports can be generated for analysis and optimization purposes.

• Swimlanes and Groups
Interstage BPM Studio supports swimlanes and groups for organizing activities into visual
categories. Swimlanes are used to group activities by the same Role to illustrate different functional
capabilities or responsibilities. Groups are used to group activites by a specific category.
Both, swimlanes and groups do not affect the sequence flow of the activities within.

• Flexible Arrows
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Flexible multi-point arrows are shown with editable names. The user interface allows easy source
and target node selection for drawing arrows. To draw arrows, you have to drag from the source
node to the target node.

• Alignment
Rulers, grids and toolbar buttons allow for easy horizontal and vertical alignment of nodes,
swimlanes, and groups.

• Selection of Multiple Elements
Multiple nodes, swimlanes, and groups can be selected for moving and alignment.

• Zoom Support and Navigation
You can zoom in or out on process definitions. An Outline view and an Overview view facilitate
navigating large process definitions.

1.3 Using Interstage BPM Studio as Eclipse Plug-In
Interstage BPM Studio can be used as a standalone application or as a plug-in to the Eclipse software
development environment.
• Using BPM Studio as application: This is the default use of Interstage BPM Studio.
• Using BPM Studio as Eclipse plug-in: The Eclipse software development kit provides a Java

development environment. BPM Studio can be easily used as an Eclipse-based application. It
seamlessly integrates with the Eclipse platform.

Using Interstage BPM Studio as an Eclipse plug-in requires the following:
• A complete Interstage BPM Studio installation: The Eclipse plug-in module automatically comes

with the Interstage BPM Studio installation. Note that even when you use Interstage BPM Studio
as Eclipse plug-in, you need an installation directory of Interstage BPM Studio.

• The Eclipse Integrated Development Environment (IDE) and the Graphical Editing Framework
(GEF): The Eclipse IDE is the default form of the Eclipse software framework. The GEF provides
a foundation for building rich, interactive user interfaces.

Interstage BPM supports Eclipse IDE 3.4.1 and Eclipse GEF 3.4.1.Note:

For more information on developing and using Eclipse plug-ins, refer to the Eclipse documentation.

To use Interstage BPM Studio as Eclipse plug-in:
1. Download the Eclipse IDE and the GEF from the Eclipse website.
2. Copy the <Interstage BPM Studio install directory>\share\EclipsePlugin\features

directory to the <Eclipse directory>\features directory.
3. Copy the <Interstage BPM Studio install directory>\share\EclipsePlugin\plugins

directory to the <Eclipse directory>\plugins directory.
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The following figure shows the Interstage BPM Studio installation directory, including the features
and plugins directories.

Figure 2: Interstage BPM Studio installation directory

If the workspace is created with the V10.1 or earlier versions of Studio, reset the perspective
by clicking Reset Perspective in the Window menu. This ensures that views and menus
related to Interstage BPM Studio display correctly.

Note:

When you want to uninstall the Eclipse plug-in, remove the files and directories copied in
steps 2 and 3 from the <Eclipse directory> directory again.

Note:

1.4 Process Definitions
Process definitions represent a business process in a form that supports automated manipulation.
They define the behavior and properties of the process instances created from them including the
flow of control within the process, based on the preceding activity.
A process definition consists of activities and their relationships, criteria to indicate the start and end
of the process, and information about the individual activities, such as participants and the data to
be handled.
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The following figure shows a sample process definition. It describes the basic activities that are
accomplished with a bank loan approval:

Figure 3: Sample Process Definition

1.5 Nodes
Nodes represent the steps in a process. A step could be an activity where process participants are
assigned specific tasks to be completed. A step could also be a place where a decision on the process
flow is made. In this case, no user action is required.
Interstage BPM supports different node types. Each node type is represented by its own graphical
symbol.
The Process Definition editor, which is the main window for process modeling, offers a palette
containing all the nodes that can be used while modeling a process definition. These nodes are
grouped based on their purpose:
• Start Node
• Activity Nodes
• Routes
• Event Nodes
• Customized Nodes
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Start Node
The Start Node identifies the beginning of a process. Every process definition has one and only one
Start Node, which is created automatically whenever you create a new process definition. Depending
on whether a trigger has been defined for the process definition, the Start Node is displayed as
follows:

DescriptionSymbolNode Type

Start Node of a process definition for which no trigger has
been defined so far. This is the default notation when starting
to create a process definition.

Start Node

Start Node of a process definition for which one or more
triggers have been defined.Start Node

Activity Nodes
These are nodes that usually involve human activity in order to complete them:

DescriptionSymbolNode Type

Activity Nodes are the main building elements of a process
definition. They model tasks that require user actions or
decision-making.
They define the tasks, the forms associated with the task and
the users assigned to perform the task.

Activity
Node

A Voting Activity Node allows users to work on an activity in
collaboration with one another.
All users can make their own choice (or vote). All of their
votes are polled. The winning vote, represented by one of
the outgoing arrows, is determined by voting rules.

Voting
Activity Node

When you want to refer to the process state in terms that are
larger in scope than its individual activities, a Compound
Activity Node is used. A Compound Activity Node is a
container that contains various nodes and arrows.

Compound
Activity Node
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DescriptionSymbolNode Type

A Subprocess Node represents a complex task. The details
of that task are defined in another process definition.
When a Subprocess Node is reached, control is passed to
the subprocess. The parent process waits for the subprocess
to complete and the results to come back.
Subprocesses are used to break tasks into a hierarchy of
easier-to-handle units.
Note: If you click the + sign on the node, an image of the
subprocess definition will be displayed. If you double-click
the + sign, the subprocess definition will be opened in a
separate editor.

Subprocess
Node

Like a Subprocess Node, a Chained-Process Node represents
a complex task. However, this task can be accomplished
independently from the tasks defined in the parent process
definition.
Once a chained process is started, the parent process
continues with its own process flow without waiting for the
chained-process to complete.
Note: If you click the + sign on the node, an image of the
chained process definition will be displayed. If you double-click
the + sign, the chained process definition will be opened in
a separate editor.

Chained-Process
Node

A Remote Subprocess Node represents a subprocess that
runs on a remote workflow server. A remote workflow server
might be, for example, another Interstage BPM Server.
When a Remote Subprocess Node is reached, control is
passed to the remote subprocess. The parent process waits
for the remote subprocess to complete and the results to
come back.

Remote
Subprocess
Node

Routes
This area contains nodes that involve branching and process flow control. They are also called
"Gateways". They are all automatic nodes that do not involve human interaction.

DescriptionSymbolNode Type

An AND Node synchronizes multiple branches in a process.
When an AND Node is reached, the process does not
continue until all activities that lead to this node are completed.

AND Node
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DescriptionSymbolNode Type

An OR Node splits process flow into multiple parallel
branches.
When an OR Node is reached, it activates all subsequent
nodes connected to it simultaneously.

OR Node

A Conditional Node directs process flow along one of several
branches, depending on a specified criteria.
Conditional Nodes allow for automated decision-making.
When a Conditional Node is reached, the process continues
along the arrow that satisfies the criteria specified.

Conditional
Node

A Complex Conditional Node is similar to a Conditional Node.
The only difference is the type of criteria that is specified to
direct process flow. For a Conditional Node, a value is
compared to another value. For a Complex Conditional Node,
advanced criteria can be specified using a JavaScript
expression.

Complex
Conditional
Node

Event Nodes
This area includes nodes that involve some kind of event related to the process flow. They are all
automatic nodes that do not involve human interaction.

DescriptionSymbolNode Type

A Delay Node suspends process execution for a certain
amount of time. The amount of time is specified with one or
more timers.
When a Delay Node is reached, the process pauses until the
first timer attached to the Delay Node fires. Then the Delay
Node activates all subsequent nodes connected to it
simultaneously.

Delay Node

A Trigger Node represents a step in the process which is
driven by an external event.
Each Trigger Node has a defined trigger that is supposed to
fire when data, typically XML files, comes in from an external
system. Once the data arrives, the trigger moves the data
into User Defined Attributes (UDAs) according to the trigger's
definition. The trigger then makes a choice and process
execution moves to the next node.

Trigger
Node

An Exit Node identifies the end of a process branch. Every
process definition has at least one Exit Node.Exit Node
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Customized Nodes
This area includes nodes that are customized to perform certain tasks. They are all automatic nodes
that do not involve human interaction.

DescriptionSymbolNode Type

An Email Node sends out predefined emails. After that, it
activates all subsequent nodes connected to it simultaneously.
No user action is required with this node.

Email Node

A DB Node (Database Node) accesses an external database
using JDBC. The SQL statements to be executed are
specified with the DB Node.
After accessing the external database, the DB Node activates
all subsequent nodes connected to it simultaneously. No user
action is required with this node.

DB Node

A Web Service Node retrieves data from a Web Service and
makes it available for further processing.
After retrieving data, the Web Service Node activates all
subsequent nodes connected to it simultaneously. No user
action is required with this node.

Web
Service Node

1.6 Property Symbols
You can assign specific properties to process definitions, nodes and arrows. These properties are
represented by symbols. The property symbols help you to easily identify the properties that have
been assigned to a process definition, node or arrow. Interstage BPM Studio displays these properties
in the Process Definition editor (for more information, refer to section Displaying Properties on page
64).
You can turn off or on the display of the properties in the Process Definition editor by selecting Show
Details from the View menu.
Depending on the specified properties, the following symbols are used:

DescriptionSymbolProperty
Type

Triggers move data from external systems into process instances.
The trigger symbol is displayed when one or more triggers have been
defined for a process definition or node. For more information on
triggers, refer to section Using Triggers on page 321.
Triggers can be used with process definitions, Activity Nodes and
Trigger Nodes.

Trigger
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DescriptionSymbolProperty
Type

Timers trigger Java Actions when they expire.
The timer symbol is displayed when a due date or one or more timers
have been defined. For more information on timers, refer to section
Using Due Dates and Timers on page 152.
Timers can be used with process definitions, Activity Nodes, Voting
Activity Nodes, Compound Activity Nodes and Trigger Nodes.

Timer

Java Actions are executed when a process definition or node starts
or completes. The Java Action symbol is displayed when one or more
Java Actions have been defined. For more information on Java Actions,
refer to section Using Java Actions on page 233.
Java Action properties can be used with process definitions and the
following nodes: Activity, Voting Activity, Compound Activity,
Subprocess, Chained-Process, Remote Subprocess, Conditional,
Complex Conditional, Delay, AND, OR Nodes, and Trigger Nodes.

Action

Error Actions are executed when a regular Java Action throws an
exception. The Error Action symbol is displayed when Error Actions
have been defined. For more information on Error Actions, refer to
section Defining Exception Handling on page 316.
Error Actions can be used with process definitions and all nodes,
except Start Nodes and Exit Nodes.

Error

Forms can take data from a process and present it to the user. The
Form symbol is displayed when forms have been defined. For more
information on forms, refer to chapter Using Forms on page 174.
Forms can be used with Activity, Voting Activity, Compound Activity,
and Start Nodes. They cannot be used with process definitions.

Form

Java Agents are Java programs that perform well-defined tasks in the
background. For more information on Java Agents, refer to section
Defining Java Agents on page 330.
Java Agents can only be used with Activity Nodes. The Java Agent
symbol is only displayed when an Activity Node is defined as an Agent.

Agent

Refer to section Arrows on page 24 for a description of the symbols used with arrows.

1.7 Arrows
Arrows define the flow of events. They are the connectors between nodes that guide the process
flow from one node to another.
When an arrow originates from an Activity Node, it represents a choice that the activity assignee can
make in response to the activity.
Depending on where an arrow originates and where it goes to, it can have different properties. Again,
one symbol is associated with each property:
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DescriptionSymbolProperty
Type

The arrow originates from an Activity Node, Voting Activity Node,
Compound Activity Node, or Remote Subprocess Node. This
expression means that only one arrow is executed at runtime.

"Normal"
outgoing
arrow

The arrow originates from a node except Activity, Voting Activity,
Compound Activity, or Remote Subprocess Node. This expression
means that all arrows are executed at runtime.

Outgoing
arrow from a
node except
Activity,
Voting
Activity,
Compound
Activity, or
Remote
Subprocess
Node.

The arrow originates from an Activity Node, Voting Activity Node, or
Compound Activity Node for which a timer is defined. The timer must
have at least one Make Choice Java Action defined for its timer.

Timer

The arrow originates from an Activity Node for which one or several
triggers are defined.

Trigger

The arrow originates from an Activity Node for which one or several
triggers and timers are defined.

Multiple
events

1.8 Forms
Most business processes involve decisions and actions that are based on information. In Interstage
BPM, "form" is used as an abstract concept. A form can be any technology that can take data from
a process and present it to the user so that information can be provided and accessed.
Forms can be associated with Start Nodes, Activity Nodes, Compound Activity Nodes, and Voting
Activity Nodes. Refer to chapter Using Forms on page 174 for details.

1.9 Roles
In a typical business process, several people are performing tasks. With Interstage BPM, these
people are called Roles.
A Role is a name given to a single person or to a group of users. Roles are defined according to the
needs of the organization. Most commonly, users are grouped according to the kind of work they
perform. They can also be grouped according to their authority, responsibility, skill, or profession.
For example, a Manager Role might contain the first-line managers in an organization.
With Interstage BPM, you assign activities (Activity Nodes, Compound Activity Nodes, or Voting
Activity Nodes) to Roles according to who is responsible for completing the activity. The advantage
of using Roles rather than individual users is that if personnel changes occur, only the Role definition
needs to be updated and not all the process definitions that use the Role.
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1.10 Swimlanes and Groups
Many process modeling methods use swimlanes or groups for organizing activities into visual
categories. These visual categories illustrate different functional capabilities or responsibilities. With
Interstage BPM Studio, you can use swimlanes to visually group activities performed by the same
Role. Groups are irrespective of Roles.
The grouping is purely visual; nodes placed on swimlanes or in groups are not processed in a special
way.
Refer to section Process Definitions on page 18 for an example of a process definition that uses
swimlanes.

1.11 Annotations
Interstage BPM Studio allows you to add annotations to your process definition. Using annotations,
you can make comments and explain important aspects of your process design.
In addition to user-defined annotations, Interstage BPM Studio shows the list of Java Actions (if
defined for a node) in the same way. This list of Java Actions is called "Action Annotations".
An Action Annotation is available for and contains information of the following Java Actions:
• SendEmail
• Web Service Call
• Delete SQL Java Action
• Insert SQL Java Action
• Select SQL Java Action
• Update SQL Java Action
• Decision Tables
• Fair Isaac Blaze Advisor
• ILOG JRules
Action Annotations are attached to the following types of nodes:
• Activity Node
• Voting Activity Node
• Compound Activity Node
• Subprocess Node
• Chained-Process Node
• Remote Subprocess Node

1.12 Workflow Application Projects
A Workflow Application project is a project for managing all files (process definitions, forms, icons,
simulation scenarios, etc.) that are required for performing any task with your application. Interstage
BPM Studio allows you to design Workflow application projects offline. Later you can deploy such
an application on an Interstage BPM Server that can be accessed by Interstage BPM clients.
Workflow Application projects help you to develop and deploy rich internet and composite applications
very rapidly by providing a design and runtime environment that does not require skills in JavaScript,
HTML and CSS. If you have larger projects and consequently have a high number of layouts and
adapter classes, you might want to structure your development activities in a better way. For this
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reason, Interstage BPM allows you to separate your project's resources in Workflow Application
projects.
A Workflow Application project is represented in the file system by a single directory. It groups all
the process definitions, forms, attachments, etc. which are specific to a business process. The default
project directory contains all components that are required for running a process solution (refer to
section Project Components on page 379 for a complete overview), for example:
• XML layout definitions of Interstage BPM Forms
• HTML files that are generated from the layout definitions
• Required images or required HTML files
• Blaze files
• ILOG rules files
• Java Script files
• Simulation scenarios and simulation result files
• Calendar files
• Configuration file for Java Agents used by the application
• Configuration files for new data sources used by Interstage BPM Studio
• FTP Agent files
• HTTP Agent files
• Custom Config files
• File Listener files
• Adapter classes
• Rule files
• Document files
• Help files
Also, refer Menu Bar on page 48 for more information about these components.
Each Workflow Application project is represented by a subdirectory of the web application's directory
inside the Interstage BPM Studio installation.
Using Workflow Application projects with a predefined structure has the following advantages:
• You can use the available tools for accessing and creating layouts based on a Workflow Application

project. Thus you can easily access and generate a structured overview of all Interstage BPM
Forms.

• You make use of the hard dependency between Interstage BPM Forms and the process definition
of an application.

1.13 Offline Editing and Transfer to Server
Interstage BPM Studio is a standalone tool. It allows you to model your Workflow Application projects
together with process definitions offline, that is without connection to an Interstage BPM Server. All
artefacts that you create with Interstage BPM Studio are stored in a file system folder of your choice.
You can export individual process definitions or entire Workflow Application projects from the Interstage
BPM Studio and import or deploy them on an Interstage BPM Server.
Transferring Individual Process Definitions
On the Interstage BPM Server, you can publish process definitions and start process instances from
it. Vice versa, you can export process definitions from an Interstage BPM Server and import them
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into the Interstage BPM Studio. After completing your modifications, you transfer the modified process
definition again to the Interstage BPM Server.
XPDL is used to exchange data between Interstage BPM Studio and Interstage BPM Server. XPDL
stands for XML Process Definition Language and is a standard file format for process definitions.
The following figure shows how process definitions are transferred between Interstage BPM Studio
and Interstage BPM Server.

Figure 4: Transferring Process Definitions

Transferring Workflow Application Projects
The Interstage BPM Studio allows you to transfer entire Workflow Application projects between your
workspace, the local file system, and the Interstage BPM Server. To facilitate the transfer, projects
are packaged into .bar files. These files contain everything that is required to run your application.
You can transfer projects as a whole, or you can select specific components to be transferred. You
can then use the Interstage BPM Console for deploying the application on the Interstage BPM Server
and thus make the application available for public use.
The name of a Workflow Application project must clearly identify the application.
When transferring Workflow Application projects, you have the following options:
• Download projects from an Interstage BPM Server: This function allows you to download

Workflow Application projects from a remote server to your workspace. You can select entire
projects or specific components to be downloaded. For more information, refer to section
Downloading Workflow Application Projects From a Server on page 97.

• Upload projects to an Interstage BPM Server: This function allows you to upload a local
Workflow Application project from your workspace to a remote server. Similarly to the Download
function, you can upload entire projects or selected components. For more information, refer to
section Uploading Workflow Application Projects to a Server on page 103.
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• Import projects from the local file system: This function allows you to import a project or
selected components from a .bar file that is stored on your local file system. For more information,
refer to section Importing Workflow Application Projects on page 91.

• Export projects to a file: This function allows you to export a local Workflow Application project
from your workspace to the local file system. You can select specific components to be exported,
too. The exported .bar file can then be deployed on the Interstage BPM Server. For more
information, refer to section Exporting Workflow Application Projects on page 94.

The following figure shows how Workflow Application projects can be transferred between Interstage
BPM Studio and Interstage BPM Server.

Figure 5: Transferring Workflow Application Projects

1.14 Online Editing: Server Projects
In addition to the possibility of working offline in the Interstage BPM Studio as a standalone tool, you
can work directly on a connected Interstage BPM Server. Process definitions that you create with
Interstage BPM Studio are stored directly in the database located on the Interstage BPM Server.
You can also transfer process definitions created locally directly to the server.
You can either directly connect to an Interstage BPM Server through default tenant in non-SaaS
mode or connect to a tenant on that server in SaaS (Software as a Service) mode. Refer Interstage
BPM Studio Features on page 16 for more information about SaaS and non-SaaS modes.
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Tenants can have multiple applications. You can access the applications for a particular tenant using
the specific Base URLs. Refer Creating Server Projects on page 110 to know more about server
connection and setting for multiple tenants.

1.15 Simulation Scenarios and Results
A simulation scenario defines criteria for simulating the execution of a business process as defined
in a process definition. The scenario defines the behavior and properties of the process instances
created from the process definition including the flow of control within the process, for example, the
probability with which a specific activity will be performed.
A simulation scenario consists of a process definition, criteria to indicate the start and end of the
simulation run, and information about the individual activities, such as participants, the data to be
handled, the estimated cost of an activity or resource. A simulation scenario file includes the details
of a process simulation as well as - after running a simulation - the simulation results. You find more
information on the simulation process in section Defining a Simulation Scenario on page 346.
You can simulate process definitions that you are currently using, as well as process definitions that
you created some time ago and transferred to the server. This process of simulating old data from
a server is called "historical simulation". Refer to section Using Simulation Values From History on
page 348 for more details.
The simulation of a process can help you in calculating cost and time for specific activities, and thus
optimize your business processes.
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2 Getting Started
This chapter explains how to start Interstage BPM Studio, model your first process and exit Interstage
BPM Studio.

2.1 Starting Interstage BPM Studio
Starting the Interstage BPM Studio involves two steps:
1. Starting the Interstage BPM Forms server so that you can create, design and work with Interstage

BPM Forms.
2. Starting the Interstage BPM Studio.
Proceed as follows:
1. Click Start on the Windows Task Bar.
2. SelectPrograms orAll Programs > Interstage Business ProcessManager Studio > Interstage

BPM Forms > Start Interstage BPM Forms. Minimize the opened window to the Windows Task
Bar.

3. Again, click Start on the Windows Task Bar.
4. Select Programs or All Programs > Interstage Business Process Manager Studio > Studio.
5. In the Workspace Launcher dialog, select a location for your workspace.

The workspace is a file system folder where your work will be stored.

6. Click OK.

The Workspace Launcher dialog has an option to turn off the prompting for a workspace (Use this
as the default and do not ask again check box). To turn it back on, select Window > Preferences
and then Interstage BPM Studio > Startup and Shutdown. Select Prompt for workspace on
startup.

Only one instance of Interstage BPM Studio can run at any one time. You cannot start
multiple instances.

Note:

If you have upgraded from a previous version of Interstage BPM Studio and have installed
this version in the same directory as the previous version, you might find that, for example,
the online help provided with the Interstage BPM Studio is outdated. Proceed as follows to
update all data used by Interstage BPM Studio:

Note:

1. Exit Interstage BPM Studio.
2. Click Start on the Windows Task Bar and open Programs orAll Programs > Interstage

Business Process Manager Studio > Studio.
3. Right click the Studio menu option and select Properties.
4. In the Studio Properties dialog, add the -clean option at the end of the entry in the

Target field, for example:
C:\fujitsu\InterstageBPM_studio\bin\IBPMStudio.exe -clean.

5. Click OK.
6. Start the Interstage BPM Studio as described in this section.
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To configure Studio to access HTTPS secured console, set up the Java Virtual Machine
(JVM) used by Studio as follows:

Note:

1. Verify the file <Interstage_Studio_Installation_Directory>\bin\IBPMStudio.inito
find JVM.

2. Add certificates needed to connect web server to the key store of the JVM . E.g.
keytool-import-trustcacerts-fileC:\Temp\ServerCertificate.cer keystore
C:\PRG\Java\jre1.5.0_11\lib\security\cacerts.This will ensure that the web
server certificate gets added to the JVM's key store.

2.2 Modeling Your First Process
This section provides a quick walk-through of how to model a simple process. As an example, you
will be modeling the basics of a bank loan approval. In this process, an agent gets a loan request
and passes this on to an underwriter for verification. Once the underwriter approves the request, an
accountant issues the check and notifies the agent to contact the customer.
To model your first process:
1. Make sure that you have started the Interstage BPM Forms server and the Interstage BPM Studio.

First, you create a project where your work will be stored.

2. To create a project:
a) Select File > New > Project > Application.
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b) In the Project name field, type MyBankLoanProject as the name.

Figure 6: Creating a Project

c) Click Next.
d) In the Project dialog, type in a description for the new project and the name of the project

owner.
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The following figure shows the Project dialog with the specified information:

Figure 7: Providing project information

e) Click Finish.
Next, you create a process definition.

3. To create a process definition:
a) Select File > New > Process Definition.
b) In the New Process Definition dialog, click Browse. Select the project that you created, and

click OK.
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c) Type BankLoan as the name for your process definition in the Name field and enter a brief
description in the Description field.

Figure 8: Creating a Process Definition

d) Click Finish.
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Your process definition is now listed in the Navigator view. A Process Definition editor is opened
and a Start Node is automatically added. You can now change the name that identifies the process
definition and provide a new description.

Figure 9: Getting Started

4. To change the process definition's name and provide a description:
a) In the Navigator view, double-click the process definition.
b) In the General tab of the Properties view, type BankLoanApproval as the name and Sample

bank loan processing as a description.

Figure 10: Defining Name and Description

Next, you add a first Activity Node.
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5. To add an Activity Node:
a) Open the palette by clicking the Show Palette button on the palette.
b) Click the Activity button.
c) In the Process Definition editor, point to the area where you want to place the Activity Node.

Click to add it.

Figure 11: Adding an Activity Node

You can now specify the name of the activity and the users that will be performing it.
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6. Click the node's name, type Submit Loan Request as the new name, and click Enter to confirm
the name.

Figure 12: Defining the Activity's Name

7. In the General tab of the Properties view, type Agent in the Role field in the Assignee area.

Figure 13: Defining the Role
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The Activity Node should now look like this:

Figure 14: Your First Activity Node

8. Add three more Activity Nodes for the following activities:
• Activity name: Verify Loan Request, Role: Underwriter
• Activity name: Issue Cheque, Role: Accountant
• Activity name: Contact Customer, Role: Agent

9. Add an Exit Node.
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This is how your process definition should look now:

Figure 15: Added all Nodes

As a next step, you add swimlanes to visually group activities performed by the same Role.

10. To add a swimlane:
a) Click the swimlane button in the palette.
b) Drag to draw the swimlane.
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c) In the Properties view, type the Role performing the activities as the name.

Figure 16: Adding Swimlanes

11. As you added all nodes and swimlanes, you no longer need the palette. Collapse the palette by
clicking the Hide Palette button on the palette.

Next, you connect all the nodes with arrows. To do this, use the Arrow button in the toolbar.

12. To add an arrow:
a) Click the Arrow button in the toolbar.
b) Drag the cursor from the source node to the target node.
c) Point to the place where you want the arrow to end. Release the cursor.

Figure 17: Adding an Arrow
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The arrow cursor is still active, so you can draw further arrows.

13. Disable the arrow cursor by clicking the Select button in the toolbar. Then connect the nodes
as shown in the following figure. When you are done, press the <Esc> key to disable the Arrow
cursor.

Figure 18: Connecting Nodes

14. Click the arrow's name and type a name for the action associated with the arrow. Perform this
step for all the arrows in your process definition.
If you want to rearrange elements, select them and drag them to a new location. When you move
nodes, the arrows connected to them move automatically. You can easily align nodes and
swimlanes by selecting them and using the Align buttons in the toolbar.
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The sample process definition is now completely defined. A process definition is complete when
it has a Start Node, at least one Exit Node, and all nodes are connected with arrows.

Figure 19: Completing your Process Definition

15. Select File > Save to save the process definition.

2.3 Using Business User Perspective
You can create new Application projects and Process Definitions in Business User Perspective. You
can also edit the existing Application projects and Process Definitions.
Refer Application View on page 69 and Process Outline Editor on page 71 for more information
about various controls in Business User Perspective.
Refer Creating Workflow Application Projects on page 80 to know how you can create a new
Application project.
You need to create Process Definitions in Process Outline view of Business User Perspective.
To create Process Definitions in an Application project in Business User Perspective:
1. Enter a name for the Process Definition in the Name field. This is a mandatory field.
2. Create parallel tasks per the requirement:

a) Select the task (say, A) which you want to define as parallel task of another task.
b) Click the Create Parallel Task button.

A flag of a particular color is displayed in the Parallel Task field of task A.
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c) Create another task (say, B) using the Add Task button.
d) Right-click in the Parallel Task field of task B and select the flag of the same color as that of

the previous task to make this task as a parallel task of the previous task.

To create parallel tasks, the color of the group flag that you select for the parallel tasks,
needs to be the same and the tasks need to be at the same level and in a continuous
sequence.

Note:

You can select a parallel task and click theDelete Parallel Task button to remove its parallel
task property.

Note:

3. Optional: Enter a description of the Process Definition in the Description field.
4. Click Add Task to add tasks to the Tasks Table.

The task is added in the Tasks Table.

Task Name is an editable field. By default, task0 is added when you click the Add Task
button. The default task names are incremented by 1 (for example, task1, task2 and so on).

Note:

5. Use the various buttons above the Task Table to move or delete your tasks.
• Select a task and click the Level Down button to make the selected task the sub-task of the

previous task. This button is disabled for the very first task. You can also create sub-tasks to
the existing sub-tasks.

• Select a sub-task and click the Level Up button to make the selected sub-task the task.
• Select a task or a sub-task and click Move Up or Move Down to move the selected task or

sub-task accordingly.
• Select a task or a sub-task and click Remove Task to delete the selected task or sub-task.

6. Enter the assignee name for the task in Assignee column.
7. Enter the date when the task is due to be completed (absolute or relative) in the Due Date field.
8. Optional: Enter additional information about the task in Description field.
9. Enter the duration (in days) for the completion of the task for an assignee in Duration field.
10. Save the Process Definition.

2.4 Exiting Interstage BPM Studio
Each time Interstage BPM Studio is exited, your working environment is saved including all settings
and windows. The next time Interstage BPM Studio is started, it will appear exactly as it was when
it was last exited, except: any process definition located on a server will not be automatically reopened.
To exit Interstage BPM Studio:
1. Select File > Exit.
2. If there are unsaved changes, a dialog appears where you can select the process definitions,

simulation scenarios, and/or Interstage BPM forms to save. Select the files and click OK.
3. If a process definition or scenario is not valid, a message is displayed telling you so. You can

display detailed information on the errors that have been found. You have the following options:
• You can save and exit anyway by clicking YES.
• You can cancel saving. You can then fix the errors and try exiting again.
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4. Finally shut down the Interstage BPM Forms server:
a) Click Start on the Windows Task Bar.
b) Select Programs or All Programs > Interstage Business Process Manager Studio >

Interstage BPM Forms > Shutdown Interstage BPM Forms.

You can also exit Interstage BPM Studio by clicking the window close button (x). A message is
displayed asking you to confirm the exiting (Always exit without prompt check box). The message
box has an option to turn off the prompting. To turn it back on, select Window > Preferences and
then Interstage BPM Studio > Startup and shutdown. Select Confirm exit when closing last
window.
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3 Understanding and Customizing the User Interface
This chapter introduces the user interface of Interstage BPM Studio. You will learn how to work with
user interface components and how to customize the user interface to your needs.

3.1 User Perspectives
Depending on the user requirements, Interstage BPM Studio provides two perspectives for users.
These perspectives are:
• Power User Perspective
• Business User Perspective

3.2 Workbench Window of Power User Perspective
By default, Interstage BPM Studio opens in Power User Perspective for the power users of the
Interstage BPM Studio. Power users have deep technical knowledge of Interstage BPM Studio and
its features. Power users are required to use all the features of the Interstage BPM Studio in order
to create detailed Process Definitions and Projects. Using Power User Perspective, users can:
• Create complete Application Projects or Server Projects
• Create complete Process Definitions involving several Nodes, Arrows, Forms, Swimlanes, Activities

and so on
To start Power User Perspective:
1. Click Window and select Open Perspective > Power User.

When you click Power User, you can switch to any perspective using the Business User
and Power User buttons displayed in the right upper corner of the Interstage BPM Studio.

Note:

Interstage Business Process Manager Studio User's Guide 46

3: Understanding and Customizing the User Interface



The user interface of Power User Perspective comprises a menu bar, a toolbar, various views, the
Process Definition editor, the Scenario editor, and the Form editor. These components are also
referred to as Workbench window. The following figure shows the Workbench window:

Figure 20: Workbench Window of Power User Perspective

Key:
• 1 Menu bar
• 2 Toolbar
• 3 Navigator view
• 4 Process Definition editor, Scenario editor, Form editor, Resource editor, Decision Table Editor
• 5 Properties view or Style Sheet Editor (also used for displaying search results)
• 6 Overview view
• 7 Outline view
The following sections explain these components.
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3.2.1 Menu Bar
The menu bar contains menus and menu options with which you access the Interstage BPM Studio
functions.

File Menu
The functions available from the File menu differ depending on what is selected in the Navigator
view:
• Project: Workflow Application project, local project, server project, or Simulation Scenarios project
• Process definition: located on the local machine (local process definition) or located on a server
• Simulation scenario
• Folder of a Workflow Application project
• Interstage BPM Form

DescriptionMenu Option

Creates a new project.New > Project

Creates a new process definition.New > Process Definition

Creates a new simulation scenario.New > Scenario

Creates a new Interstage BPM form. Available only for Workflow
Application projects.

New > Interstage BPM Form

Creates an agentsConfig.xml file where you can define agents
for Workflow Application projects.

New > Agents

Creates an FTP Agent file where you can define FTP agents for
Workflow Application projects.

New > FTP Agent

Creates an HTTP Agent file where you can define HTTP agents
for Workflow Application projects.

New > HTTP Agent

Creates a Configuration file for customer's JavaAction or Agent.New > Custom Config

Creates an fileListenerConf.xml (fixed name) file for Workflow
Application projects.

New > File Listener

Creates ProcessSceduler.xml file for Workflow Application
projects.

New > Process Scheduler

Creates a DataSourceDefinition.xml file where you can define
data sources for Workflow Application projects.

New > Java Actions > Data
Source

Creates a new calendar .cal file where you can define new
business calendars.

New > Calendar

Creates Rules Set for creating Decision TablesNew > Rules > Rules Set

Creates Decision TablesNew > Rules > Decision Table

Creates a new subfolder beneath the selected folder. Available
only for Workflow Application projects.

New > Folder
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DescriptionMenu Option

Creates a new file beneath the selected file. Available only for
Workflow Application projects.

New > File

Creates Process Fragments to define Process Fragment ProjectNew > Process Fragment

Closes the process definition that is displayed in the Process
Definition editor, the scenario that is displayed in the Scenario
editor, the resource file that is opened in a text editor, or the
Interstage BPM Form that is displayed in the Form editor.

Close

Closes all process definitions, scenarios, text editors, and
Interstage BPM Forms.

Close All

Saves the process definition of the active Process Definition
editor, the scenario of the active Scenario editor, resource files
opened in a text editor, or the Interstage BPM Form of the active
Form editor.

Save

Saves a process definition to another location and/or to another
file name, a resource file that has been changed using a text
editor, or a scenario or Interstage BPM Form to another file name.

Save As

Saves all open process definitions, resource files, scenarios and
Interstage BPM Forms that have been changed.

Save All

Removes a project, process definition, scenario, Interstage BPM
Form, resource files, and other files and folders in the Workflow
Application project structure. Process definitions of a server
project and theSimulation Scenario andAnalytics folder cannot
be deleted.

Delete

Refreshes the Navigator view.Refresh

Prints the process definition displayed in the Process Definition
editor.

Print

Switches to a different workspace. This options restarts Interstage
BPM Studio.

Switch Workspace

Transfers a local process definition to a server project.Send to Server

Uploads a Workflow Application project from your workspace to
a remote server

Upload Application

Downloads a Workflow Application project from a remote server
to your workspace

Download Application from
Server

Imports a Workflow Application project from the local file system
to your workspace.

Import Bar File

Imports resources of a Workflow Application project from the local
file system to your workspace.

Import
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DescriptionMenu Option

Exports resources of a Workflow Application project from your
workspace to the local file system. When you export the process
definition, you can select the following formats using the Export
Process Definition dialog:
• XPDL1.0
• XPDL2.0
• XPDL2.1

Export

Generates the report of the Process Definition displayed in an
active Process Definition Editor.

Generate Process
Documentation

Simulates a scenario and generates simulation result that can be
used to replay the simulation.

Run Simulation

Displays properties of projects, local process definitions,
simulation scenarios, Interstage BPM Forms, resource files, and
other project-related properties.

Properties

Closes Interstage BPM Studio.Exit

Edit Menu
The Edit menu opens only if a process definition or a simulation scenario is open.

DescriptionMenu Option

Undoes the last change to a process definition or scenario.Undo

Redoes the change that has been previously undone.Redo

Cuts selected process definition nodes, swimlanes or groups, or
text strings defined in a scenario.

Cut

Copies selected process definition nodes, swimlanes or groups,
or text strings defined in a scenario.

Copy

Pastes cut or copied process definition nodes, swimlanes or
groups, or text strings defined in a scenario.

Paste

Removes selected nodes, swimlanes, groups, and arrows from
the process definition, or selected text strings from a scenario.

Delete

Selects all elements of the process definition or text strings defined
in the scenario currently displayed.

Select All

Contains menu options for aligning nodes, swimlanes, and groups.Align (Submenu)

Contains menu options for adjusting the height and width of
swimlanes to the same size.

Same Size (Submenu)

Contains menu options for switching between the alignment of the
swimlane title (at the top or to the left).

Swimlane Style (Submenu)
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View Menu
The View menu opens only if a process definition is open.

DescriptionMenu Option

Increases the magnification of the Process Definition editor.Zoom In

Decreases the magnification of the Process Definition editor.Zoom Out

Contains menu options for switching between Enhanced View and
Classic BPMN View.

Display Mode (Submenu)

Turns the display of property symbols (node icons) and Action
Annotations on or off.

Show Details

Turns the display of Roles on Activity, Compound Activity, and
Voting Activity nodes on or off.

Show Role

Turns the grid on or off.Show Grid

Turns rulers on or off.Show Ruler

Turns feedback lines on or off. Feedback lines help to align
elements when dragging.

Snap to Geometry

Opens a dialog for customizing the palette.Palette Settings

Window Menu

DescriptionMenu Option

Opens the process definition, simulation scenario, resource file,
or Interstage BPM Form that is currently displayed in a new editor.

New Editor

Allows you to switch between the normal BPM Studio and
Interstage Analytics perspectives. The Analytics perspective is
only visible if you have installed Interstage Analytics before.

Open Perspective

Contains menu options to open a view that is not included in the
current perspective.

Show View (Submenu)

Resets the Workbench window to its default settings.Reset Perspective

Contains menu options for navigating between views, Process
Definition editors, Scenario editors, Resource editors, and Form
editors. Also use this submenu for maximizing views, Process
Definition editors, Scenario editors, and Form editors, and for
displaying or hiding the system menu and view menus.

Navigation (Submenu)

Opens a dialog where you can set your preferences for working
with Interstage BPM Studio. The preferences include appearance
of graphical display settings, editor, navigator, startup and
shutdown, and server connection settings

Preferences
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Help Menu

DescriptionMenu Option

Opens the help browser and displays the table of contents for the
online Studio User's Guide.

Help Contents

Opens a Help view where you can type the terms you are searching
for.

Search

Opens a Help view where you can browse for help topics.Dynamic Help

Opens a dialog where you can access version information and
technical information about Interstage BPM Studio components.

About Interstage Business
Process Manager Studio

Interstage BPM Form Menu
The Interstage BPM Form menu opens only if an Interstage BPM Form is open in the Form editor.

DescriptionMenu Option

Generates the Interstage BPM Form and displays it in the Preview
Area of the Form editor.

Preview

Compiles newly developed adapter classes and generates the
Interstage BPM Form using these classes and displays it in the
Preview Area of the Form editor.

Preview with latest classes

Generates the required HTML file for preview.Publish

Contains menu options for opening log files, resource files, etc.
making up your Interstage BPM Form.

View (Submenu)

3.2.2 Toolbar
The toolbar contains buttons for frequently used functions.

DescriptionButton

Opens a wizard that allows you to create a new project, process definition,
scenario, Interstage BPM Form, Java Agent, data source, Calendar file, FTP
Agent, HTTP Agent, Custom Config, File Listener, Process Scheduler, Decision
Table, Process Fragment and a new folder or file.

Validates the process definition, scenario or decision table displayed in the
Process Definition editor, Scenario editor or Decision Table editor respectively,
and displays the errors in them in the BPM Problems view.

Saves the process definition of the active Process Definition editor, the
scenario of the active Scenario editor, the Interstage BPM form of the active
Form editor or any other active editor.

Prints the process definition displayed in the Process Definition editor, or the
resource file displayed in the Text editor.
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DescriptionButton

Undoes the last change to a process definition, scenario, or resource file.

Redoes the change that has been previously undone.

Aligns selected nodes and swimlanes or groups to the left edge, to their center,
or to the right edge in the Process Definition editor.

Aligns selected nodes and swimlanes or groups to the top edge, to their middle,
or to the bottom edge in the Process Definition editor.

Adjusts the height and width of swimlanes or groups to the same size in the
Process Definition editor.

Increases the magnification of the Process Definition editor.

Decreases the magnification of the Process Definition editor.

Sets the magnification of the Process Definition editor to the specified zooming
level.

Allows you to connect nodes with arrows in the Process Definition editor.

Allows you to select elements in the Process Definition editor. You can select
multiple elements by holding down the <Ctrl> key.

Opens the online Studio User's Guide.

Allows you to search for folders and files within your workspace, in selected
resources, or in enclosing projects.

Generates the Interstage BPM Form and displays it in the Preview Area of
the Form editor.

Compiles newly developed adapter classes and generates the Interstage
BPM Form using these classes and displays it in the Preview Area of the Form
editor.

Generates the required HTML file for preview.

If you use Interstage BPM Studio as an Eclipse plugin, some additional toolbar buttons are
displayed. These buttons allow you to switch between the different perspectives, for example
the Java and BPM Studio perspective.

Note:
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3.2.3 Navigator View
The Navigator view shows your Workflow Application and server projects, as well as the Simulation
Scenarios project, the file names or names of the process definitions, scenarios, Interstage BPM
Forms, and folders contained in these projects, and Process Fragments.
Use this view to manage your projects, process definitions, and scenarios. For example, you can
open process definitions for editing or select them for copying, renaming, exporting, and so on.

Figure 21: Navigator View

Navigator View Toolbar
The toolbar of the Navigator view contains buttons for frequently used functions.

DescriptionButton

Go back one level in the hierarchy of projects, folders, etc.

Go forward one level in the hierarchy of projects, folders, etc.

Go up one level in the hierarchy of projects, folders, etc.

Collapse all projects.
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DescriptionButton

Link the selected item with the editor.

Opens a menu for selecting the Filters menu option. See below for details.

Filtering Projects
You can filter the projects displayed in the Navigator view by selecting Filters from the Menu icon
in the Navigator toolbar. The following dialog is opened:

Figure 22: Filtering Projects in the Navigator View

Select the filters to apply to the Navigator view. For example, if you select the Simulation Scenario
Project checkbox, all projects except the Simulation Scenarios project will be listed in the Navigator
view.

The Local Project check box refers to projects that were created with a release of the
Interstage BPM Studio prior to 8.2.

Note:

3.2.4 Process Definition Editor
The Process Definition editor is the main window for process modeling. Use the editor to add and
edit all elements that belong to your process definition.
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When you open a process definition, the Process Definition editor is automatically opened. You can
open several process definitions in parallel. Each process definition is displayed in a tab. Depending
on your preferences settings for the Navigator view, the tab shows the file name or name of the
process definition; an asterisk (*) to the left of the file name or name indicates that there are unsaved
changes.

Figure 23: Process Definition Editor

The Process Definition has a palette with buttons for adding nodes, swimlanes or groups, and
annotations.
• To temporarily open the palette, hover the cursor over the collapsed palette. The palette quickly

expands.
• To open the palette and keep it open, click the Show Palette button (<) on the palette.
• To collapse the palette, click the Hide Palette button (>) on the palette.
• You can place the palette on the left-hand side or right-hand side of the Process Definition editor.

Click the palette header and drag it to the desired location.
• To resize the palette, click the border that faces the editing area. Drag the border.
By default, the palette is collapsed on the right side of the Process Definition editor. You can change
the default settings using Window > Preferences. Refer Setting Your Preferences on page 76 for
more information.
When you open a process definition that is read-only, the palette is not displayed. The status bar
indicates that the file is read-only.

3.2.5 Form Editor
The Form editor is the main window for Interstage BPM Form creation. Use the editor to design your
Interstage BPM Forms.
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When you open an Interstage BPM Form, the Form editor is automatically opened. You can open
several Interstage BPM Forms in parallel. Each Interstage BPM Form is displayed in a tab. The tab
shows the file name of the Interstage BPM Form; an asterisk (*) to the left of the file name or name
indicates that there are unsaved changes.

Figure 24: Form Editor

Refer to the Interstage Business Process Manager Form Editor User's Guide for details on how to
use the Form editor.

3.2.6 Scenario Editor
The Scenario editor is the main window for defining a simulation scenario and storing simulation
results. Use the Scenario editor for defining simulation properties and display and report simulation
results.
Every scenario must import a process definition from either a Workflow Application or a server project.
The process definition used by a scenario can, in turn, be exported to a local or server project. In
addition, for every activity defined in the process definition, simulation properties can be specified.
Use the Scenario editor to add and edit all elements that belong to your process definition.
When you open a simulation scenario, the Scenario editor is automatically opened. You can open
several scenarios in parallel. Each scenario is displayed in a tab on top of the Scenario editor.
Depending on your preferences settings for the Navigator view, the tab shows the file name or name
of the scenario; an asterisk (*) to the left of the file name or name indicates that there are unsaved
changes.
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Depending on whether an opened scenario already imports an existing process definition, the process
definition is also opened in a separate tab that you can access at the bottom of the Scenario editor.

Figure 25: Scenario Editor

The process definition imported by the scenario in the Scenario editor is opened on a separate tab
(if it exists), and you can change it, if required: Click the tab labeled with the name of the process
definition at the bottom of the Scenario editor to do so. In the sample above, this is the
BankLoanApproval tab.
The Gather Default Values From History link indicates that you can fetch "historical" process
definitions from a remote server and use them for simulation.
Scenario results are also displayed in the Scenario editor. In this case, the Simulation Controller is
displayed below the Scenario editor.

Simulation Controller
The Simulation Controller is used for starting, stopping and pausing a simulation run, and for controlling
the speed with which activities are processed and animated during the simulation. In addition, the
Simulation Controller also provides a tab for generating simulation reports.
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When you have executed the Run Simulation command on a selected simulation scenario, the
Simulation Controller is displayed just below the Scenario editor.

Figure 26: Displaying the Simulation Controller

3.2.7 Decision Table Editor
Decision Tables allow you to design advanced rules for decision making without programming.
Decision Tables use a simple yet powerful table based approach for managing rules dynamically.
Desision Table editor is used to define Decision Table.

3.2.8 Properties View
The Properties view displays all the properties for a process definition or for a selected node and
allows you to edit them.
When you select a project, process definition, scenario, folder, or Interstage BPM Form in the
Navigator view, the Properties view usually displays folder or file properties (File name setting).
Depending on your setting of the preferences for the Navigator view, the name of the process
definition, scenario or decision table and its description (Name setting) may be displayed.
When you click the empty space in the Process Definition editor, the Properties view displays the
properties of the process definition like its name and description, and information about the UDAs,
forms, due dates, timers, triggers, Action Set, Exception Handling, Voting Rules, Data Mapping and
Decisions associated with it. When you select an element of a process definition, the properties of
that element are displayed. As an example, the following figure shows the Properties view for an
Activity Node.

Figure 27: Properties View for an Activity Node

3.2.9 Search Results View
The Search Results View displays search results and provides several functions for analyzing the
search results. This view is displayed only after searching for specific items.
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The toolbar provides, among others, symbols for displaying selected matches and showing the
search history. The following figure shows the Search Results View after searching for the word
"simulation":

Figure 28: Search Results View

3.2.10 Style Sheet Editor View
The Style Sheet Editor view allows you to use the integrated Style Sheet editor which simplifies the
creation of your own style sheets for Interstage BPM Forms.

Figure 29: Style Sheet Editor View

3.2.11 BPM Problems View
The BPM Problems view displays the errors for a particular process definition, scenario or decision
table.
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When you open a process definition and click Validate on the toolbar or right click the empty space
in the Process Definition editor and select Validate from the pop-up menu, the BPM Problems view
displays all the errors relevant to that process definition. Similarly errors in a scenario or a decision
table can also be displayed in the BPM Problems view.
In Navigator view, the error icon is added to the resource file that has the error.
If the BPM Problems view is closed, select Window > Show View > BPM Problems, to display it.
It displays the following information for each error:

DescriptionField

Describes the nature of the error.Description

Displays the name of the resource where the error occurred.Resource

Displays the precise element in the resource where the error occurred.Location

Displays the name of the project to which the resource belongs.Project

When you double click on a particular row, the precise element in the process definition, where the
error occurred gets selected in the Process Definition editor so that the error can be corrected.
Similarly, the precise element in a scenario or Decision Table gets selected in the Scenario editor
or Decision Table editor respectively. Refer to Validating Decision Tables for Errors and Warnings
on page 227 for more information about validating Decision Tables for errors and warnings.

In Navigator view, when you copy the resource file having the error icon and create a new
resource file, the error icon is not added to the new resource file.

Note:

Interstage Business Process Manager Studio User's Guide 61

3: Understanding and Customizing the User Interface



If a process definition, scenario or Decision Table is deleted then the errors associated with them
are also deleted.

Figure 30: BPM Problems View for a process definition

The BPM Problems view displays the results of only the last validation performed for the
process definition, scenario or decision table.

Note:

3.2.12 Overview View
The Overview view is useful with large process definitions. It gives an overview of the whole process
definition and allows you to quickly navigate to the area you want to work on.
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If a process definition is too large to be displayed as a whole in the Process Definition editor, the
Overview view highlights the area that is currently visible. To navigate to another part, move the
highlighted area.

Figure 31: Overview View

3.2.13 Outline View
The Outline view displays an outline of the active process definition or process fragment. It displays
all nodes the process definition or fragment is made of.
Using the Outline view, you can quickly navigate to particular nodes in large process definitions or
fragments. You can also use this view for node operations like cutting, copying, and pasting, and for
defining node properties.
Nodes are represented by an icon and the node name. Refer to sectionNodes on page 19 for an
explanation of the icons. Note that any annotations to Actions or Nodes are not visible in Outline
view.

Figure 32: Outline View

If a simulation scenario is active, the Outline view only displays the scenario name.
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3.2.14 Pop-Up Menu
Most elements have a pop-up menu associated with them that contains frequently used functions.
The contents and availability of the pop-up menu depends on the type of element. To display the
pop-up menu, select an element in a view, in the Process Definition editor, in the Scenario editor,
or in the Form editor, and right click.

3.2.15 Displaying Properties
Properties help you specify process definitions, nodes and arrows (for more information on properties
and their symbols, refer to section Property Symbols on page 23).
By default, properties are automatically displayed in the Process Definition editor. When you modify
the properties of a process definition or node through the Properties view, Interstage BPM Studio
automatically checks if there are any properties assigned. If there are, the property symbols are
displayed.
Property symbols are put in different places, depending on whether they are assigned to a process
definition, a node or an arrow:
• Process Definition Symbols: Process-related symbols are displayed on the top-left of the

Process Definition editor. The name of the process definition will be underlined. The following
example shows a process definition for which Java Actions, a timer, Error Actions, and a trigger
have been defined:

Figure 33: Displaying property symbols for process definitions

In the example, the property symbols are displayed in the following order (from left to right):
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MeaningSymbolNo.

A Java Action has been defined. If you see two Java Action symbols, one Owner
or Init Java Action and one Commit Java Action have been defined.

1

A timer has been defined for the process definition.2

One or more Java Actions have been defined for dealing with errors during process
execution.

3

A trigger has been defined for the process definition.4

• Node symbols: Node-related symbols are placed within a node. The following example shows
an Activity Node to which a Java Agent has been assigned. All available properties have been
set for the Activity Node (triggers, timers, Error Actions, and BPM Forms):

Figure 34: Displaying property symbols for an Activity Node

In the example, the property symbols are displayed in the following order (from top left to bottom
right):

MeaningSymbolNo.

This symbol indicates that you have assigned a Java Agent to the Activity Node.1

This symbol indicates that at least one Role or Prologue Action has been defined
for the Activity Node. This Java Action is executed when the Activity Node is
initialized.

2

This symbol indicates that a due date or timer has been defined for the Activity
Node.

3

This symbol indicates that one or more Forms have been defined for the Activity
Node.

4

This symbol indicates that an Error Action has been defined for the Activity Node.5

This symbol indicates that one or more triggers have been defined for the Activity
Node.

6

This symbol indicates that at least one Epilogue Action has been defined for the
Activity Node. This Java Action is executed when the Activity Node is completed.

7

Java Action symbols for nodes are displayed only if you have defined Prologue or Role
Actions (for initializing an activity), and Epilogue Actions (for completing an activity).

Note:
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3.2.16 Displaying or Hiding Rulers
Rulers help you align elements in the Process Definition editor. They use pixels as measurement
unit.
By default, rulers are displayed. You can change this setting for any open Process Definition editor.
You can also set your preference for all Process Definition editors that you open in the future.
To display or hide rulers for an open Process Definition editor:
1. Click the Process Definition editor to make it active.
2. Do one of the following:

• To hide rulers, select View and uncheck Show Ruler.
• To display rulers, select View and check Show Ruler.

To set your ruler preference, select Window > Preferences and then Interstage BPM Studio >
Editor.

3.2.17 Displaying or Hiding the Grid
The grid helps you align elements in the Process Definition editor.
By default, the grid is displayed. You can change this setting for any open Process Definition editor.
You can also set your preference for all Process Definition editors that you open in the future.
To display or hide the grid for an open Process Definition editor:
1. Click the Process Definition editor to make it active.
2. Do one of the following:

• To hide the grid, select View and uncheck Show Grid.
• To display the grid, select View and check Show Grid.

Refer to section Setting Your Preferences on page 76 for information on how to set your grid
preference.

3.2.18 Displaying or Hiding Roles
By default, the Role that is supposed to complete an activity is displayed on the Activity or Compound
Activity or Voting Activity Node. You can hide Roles so that they are not displayed on the nodes.
You can change this setting for any open Process Definition editor. You can also set your preference
for all Process Definition editors that you open in the future.
To change role settings for an open Process Definition editor:
1. Click the Process Definition editor to make it active.
2. Do one of the following:

• To hide Roles, select View and uncheck Show Role.
• To display Roles, select View and check Show Role.

To set your preference for the display of Roles in Activity Nodes, select Window > Preferences and
then Interstage BPM Studio.

3.2.19 Changing Display Mode
Interstage BPM Studio supports two display modes for the Process Definition editor:
• Classic BPMN View
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Elements in the Process Definition editor are shown in black and white only.

• Enhanced View
Elements in the Process Definition editor have different colors.

By default, the Enhanced View is set. You can change this setting for any open Process Definition
editor. You can also set your preference for all Process Definition editors that you open in the future.
To change display mode for an open Process Definition editor:
1. Click the Process Definition editor to make it active.
2. Select View > Display Mode. Select the display mode you want to use.

To set your preferred display mode, selectWindow > Preferences and then Interstage BPMStudio.

3.2.20 Changing Palette Settings
You can change the appearance of the palette for each Process Definition editor individually. You
can also set preferences for all Process Definition editors that you open in the future.
To change palette settings, right click the palette and select Settings from the pop-up menu. The
Palette Settings dialog is displayed:

Figure 35: Palette Settings

1. To change the Font settings for the icon texts:
a) Click Change.
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b) Change font properties like font family or font size.
c) Close the dialog by clicking OK.

2. To change the palette Layout, select the desired layout, for example Icons only. For every layout,
you can choose between large and small icons be checking or unchecking the Use large icons
check box.

3. The buttons in the palette are grouped in drawers. To change Drawer options, choose between
always closing a drawer when opening another one, automatically closing drawers when there
is not enough room, or never closing drawers.

4. Save your settings by clicking OK.
5. Depending on your settings, drawers may be closed automatically. To permanently display a

drawer, click its Pin Open button.

Figure 36: Pin Open Button

You can set palette preferences for Process Definition editors that you open in the future. Select
Window > Preferences and then Interstage BPM Studio > Editor.

3.3 Workbench Window of Business User Perspective
Business User Perspective of Interstage BPM Studio provides a simple way of creating process to
the business users who do not possess deep technical knowledge of Interstage BPM Studio. The
user interface of Business User Perspective comprises a menu bar, a toolbar, Application View and
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Process Outline Editor. These components are also referred to as Workbench Window. The following
figure shows the Business User Workbench Window:

Figure 37: Workbench of Business User Perspective

Key:
• 1 Menu bar: It is a subset of the menu of Power User Perspective.
• 2 Toolbar: It is a subset of the toolbar of Power User Perspective.
• 3 Application view
• 4 Process Outline editor

When you save an Application project in Business User Perspective, you can also view and
edit it in Power User Perspective.

Note:

To start Business User Perspective:
1. Click Window and select Open Perspective > Business User.

When you click Business Perspective, you can switch to any perspective using the
Business User and Power User buttons displayed in the right upper corner of the Interstage
BPM Studio.

Note:

3.3.1 Application View
The Application view displays the following:
• Application project: Application projects are displayed in the Application view under which

Process Definitions, Simulation files, Calendar files, Rules files and Document files are displayed.
Refer Modeling Your First Process on page 32 and Managing Workflow Application Projects on
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page 80 to know more about creating Applications. You can perform the following operations on
an Application project:
1. Create, delete, and rename an Application project
2. Import, and export an Application project

When you import or export an Application Project, all the resources (web folder and Form
folder and so on) in that particular Applicaiton Project are imported or exported respectively.

Note:

• Process Definitions: Process Definitions under an Application project are displayed. Refer
Managing Process Definitions on page 115 to know more about Process Definitions and operations
to be performed on them. You can perform the following operations on Process Definitions:
1. Create, delete, rename, and open Process Definitions
2. Import, and export Process Definitions to or from Application projects

• Simulation files: Simulation files under an Application project are displayed. Refer Simulating
Processes on page 344 to know more about Simulation. You can perfrom the following operations
on Simulation files:
1. Create, delete, rename, and open Simulation files
2. Import and export Simulation files to or from Application projects

• Calendar files: Calendar files under an Application project are displayed. Refer Creating Your
Own Business Calendars on page 161 to know more about Calendars. You can perform the
following operations on Calendar files:
1. Create, delete, rename, and open Calendar files
2. Import and export Calendar files to or from Application projects

• Rules files: Rules files under an Application project are displayed. Refer Workflow Application
Projects on page 26 and Using Rules Actions on page 283 to know more about Rules. You can
perform the following operations on Rules files:
1. Create, delete, and rename Rules Set
2. Create, delete, rename, and open Rules files
3. Import and export Rules files to or from Application projects

• Document files: Document files under an Application project are displayed. You can perform
the following operations on Documents files:
1. Create, delete, rename, and open Documents files
2. Import and export Documents files to or from Application projects
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The following figure shows the Application view:

Figure 38: Application View

Business User Perspective does not support Server Projects.Note:

3.3.2 Process Outline Editor
The Process Outline editor contains the list of tasks, which are Activities defined in the Process
Definition. The Process Outline editor displays the following:
General Information
• Name: Name of the Process Definition
• Description: Description of the Process Definition
Tasks Table
The Tasks Table has the following columns:

DescriptionColumn Name

Name of the task or subtaskTask Name

Flag to identify a parallel taskParallel Task

Assignee of the taskAssignee

Date when the task is due to be completedDue Date

Additional information about the taskDescription

Duration for the completion of the task for an assigneeDuration

Gantt Chart based on the duration is displayed in this column.
This is a view-only column.

Timeline
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The Tasks Table has the following function buttons:

DescriptionFunction Name

To add tasks to the Tasks TableAdd Task

To remove the selected task from the Tasks TableRemove Task

To create parallel task in the Tasks TableCreate Parallel Task

To delete selected parallel tasks from the Tasks TableDelete Parallel Task

To make the selected task a sub-taskLevel Down

To make the selected sub-task a taskLevel Up

To move the selected task downMove Down

To move the selected task upMove Up

When you click in the Due Date field, a calendar icon is displayed. You can select the due
date using the calendar. The date you select using the calendar is absolute date.
To set a relative due date for a task, you need to again click in the Due Date field (after the
calendar icon is displayed) without selecting a date in the calendar (you do not need to click
the calendar icon). Then you can enter a relative date which is entered as a number of days
after a certain task is completed in the editable Due Date field.

Note:

You can define a parallel flag at up to five places.Note:

The following figure shows the Process Outline editor:

Figure 39: Process Outline Editor

If you right-click the task row in Task Name column, the following options are displayed:
• Add Task: Adds a task
• Add Sub-task: Adds a sub-task to the selected task
• Remove Task: Removes the selected task
• Level Up: Makes a selected sub-task a task
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• Level Down: Makes a selected task a sub-task
• Move Up: Moves up the selected task
• Move Down: Moves down the selected task
• Columns: Selects or hides columns per your requirements
If you right-click the task row in Parallel Task column, the options are displayed that can be used
to group parallel tasks. For example, tasks A and B can be grouped as parallel tasks using Task
Group 1 option.

To create parallel tasks, the color of the group flag that you select for the parallel tasks,
needs to be the same and the tasks need to be at the same level and in a continuous
sequence.

Note:

Relation between Tasks and Nodes
The type of node can be related with tasks in the following ways:
• Through task level
• Through color of parallel task flag

Through Task Level
Consider tasks that have been defined as in the figure below:

Figure 40: Task Level
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This process definition is displayed in the process editor as follows:

Figure 41: Related Process Definition for Task Level

Figure 42: Child Task

• 1st Level Tasks (In this case, task0 and task1):
• If a task does not have a child task, the node is defined as an Activity.
• If a task has a child task, the node is defined as a Compound Activity.

• 2nd Level Tasks (In this case, task11):
• This task is included in a Compound Activity
• If this task does not have a child task, the node is defined as an Activity.
• If this task has a child task, the node is defined as a Subprocess Node.
• A Subprocess definition of the same name as this Subprocess Node is created.

• 3rd Level Tasks (In this case, task12):
• This task is included in a Subprocess Definition.
• If this task does not have a child task, the node is defined as an Activity.
• If this task has a child task, the node is defined as a Subprocess Node.
• A Subprocess definition of the same name as this Subprocess Node is created.
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Through Color of Parallel Task Flag
Consider tasks defined as follows:

Figure 43: Parallel Tasks

This process definition is displayed in the process definition editor as follows:

Figure 44: Process Definition for Parallel Tasks

Tasks with the same color of Parallel Task flag are defined to be processed parallely.

Notes on Business User Perspective

When you define a new process definition, and you save this process definition with the
subprocess node, the subprocess definition file is created at the same time with the following
file name:
<ProcessDefinitionName>_<SubprocessNodeName>.xpdl

Note:

When you open a process definition, change the task name that corresponds to the
subprocess node and you save this process definition, it is saved in the same subprocess
definition file. The file of the subprocess definition of a new name is not created.

Note:

Ensure you do not open the subprocess definition file; instead, open the process definition.Note:

Ensure you do not change the subprocess definition file name when you are editing a
process definition.

Note:
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If you save a process definition with parallel tasks, close the editor, and re-open the process
definition, the color of the Parallel Task flag may be different.

Note:

3.4 Setting Your Preferences
You can set your preferences for the Process Definition editor and for the display of process definition
elements. These settings become effective for all Process Definition editors that you open in the
future. Process Definition editors that are currently open are not affected. You can change some
settings for currently open Process Definition editors using the View menu and the pop-up menu of
the Palette.
You can set your preferences for the Navigator view, too: You can choose whether the names or file
names of local process definitions or scenarios are displayed. In addition, you can define which editor
is to be used for opening a process definition, simulation file, or resource file.
You can also set preferences for messages that appear when starting and exiting Interstage BPM
Studio.
To set your preferences:
1. Select Window > Preferences.
2. To set your preferred Display Mode for elements in the Process Definition editor:

a) Click Interstage BPM Studio.
b) Choose between Enhanced View (elements have different colors) and Classic BPMN View

(elements are black and white only).

3. To set your preference for the display of property symbols in nodes, and to define how many of
the defined Java Actions are displayed in a Java Action annotation.
a) Make sure that the Interstage BPM Studio page is open.
b) Check or uncheck the Show Details check box.
c) Enter the desired number of Java Actions to be displayed in the annotation for Java Actions.

4. To set your preference for the display of Roles on Activity nodes:
a) Make sure that the Interstage BPM Studio page is open.
b) Check or uncheck the Show Role check box.

5. To set your preferred position of swimlane titles:
a) Expand Interstage BPM Studio and click Appearance.
b) To place the title on the left-hand side, select Left. To place the title on the upper side, select

Top.

6. To set your preferences for the palette:
a) Expand Interstage BPM Studio and click Editors.
b) Specify your preferences for the width and position of the palette. Choose whether the palette

is collapsed or open (Lock Palette).
c) Click Palette Settings and specify your preferences for the layout and drawers.

7. To set your preferences for the grid:
a) Make sure that the Editor page is open.
b) Choose whether to display or hide the grid (Show Grid).
c) In the Grid horizontal spacing and Grid vertical spacing fields, type the distance in pixels

between grid points.
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The lower the value, the more grid points you see in the Process Definition editor.

8. To set your preferences for the rulers:
a) Make sure that the Editor page is open.
b) Choose whether to display or hide the rulers (Show Ruler).

9. To set your preferences for alignment support:
a) Make sure that the Editor page is open.
b) Choose whether to turn feedback lines on or off (Snap to Geometry).

Feedback lines help to align elements when dragging.

10. To set your preferences for the Navigator view:
a) Click Navigator.
b) Choose whether to display the names or the file names of process definitions that are stored

in local projects, or the names or the file names of simulation scenarios.

11. To set your preferences for the editor that you want to use for opening a file in the Navigator view:
a) Expand Editors and click File Associations.

The File Associations page displays all available file types.

b) Select a file type and assign it to an editor from the Associated editors list.

12. To set your preferences for messages that appear when starting and exiting Interstage BPM
Studio:
a) Click Startup and Shutdown.
b) Change the settings as required.

13. To set your preferences for the server connections that are used by Interstage BPM Studio:
a) Click Server connection settings.
b) In the Server connections field, select a server, and clickApply. If you want to edit an existing

server or add a new server to the list:
c) Click New or Edit.
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d) Type in the configuration parameters for the new or updated server connection.

Figure 45: Server Connection Setting

Type in the following parameters:
• Connection Name: Name of the specified server connection
• Base URL: The Base URL is the URL used to create a connection to the server. The

sample URL is:

http://<hostname>:<port>/<content>/_wfxml/<tenant>/

In the following URL, console is the context root for server connection, ibpmserver is the
hostname and 49950 is the port.

http://ibpmserver:49950/console/_wfxml/default/

Base URL is the URL that connects to the tenant if you are working in SaaS mode.Note:

In SaaS mode, the <tenant> in the URL connects you to the specific tenant on the Interstage
BPM Server. Refer Interstage BPM Studio Features on page 16 to know more about SaaS
mode.

Note:

If you want to connect to Interstage BPM Server in non-SaaS mode, enter default in
<tenant> in the URL. This will, through the default tenant, directly connect you to the server
specified in <hostname> in the URL.

Note:

• User name: User name to authenticate with Interstage BPM
• Password: Password associated with the user name

e) Optional: Check the Save Password check box if you want to save the specified password
so that you do not need to provide it again when you log in to the Interstage BPM Server.

f) Click OK.

14. To set your preferences for the Process Outnile Editor:
a) Click Process Outline editor.
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b) In the Hide/Show Colums, set the displayed column and the column's order when you open
Process Outline Editor.

This setting is applied to all the Process Outline Editors that are currently open.Note:
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4 Managing Projects
Projects are containers that help you organize your process definitions, resource files, forms,
simulation scenarios, attachments, etc. On file system level, a project corresponds to a folder. As a
default, projects are stored in your workspace, but you can store them in any location that is accessible
from your computer.
Interstage BPM differentiates the following types of project:
• Workflow Application project: Interstage BPM Studio allows you to design entire workflow

applications offline. Process definitions, for example, are created and designed on your local
machine. You can store just one or several related process definitions in a Workflow Application
project. Later you can deploy such an application on an Interstage BPM Server that can be
accessed by clients. A Workflow Application project is represented in the file system by a single
directory. It is used to structure the components that make up an application: process definitions,
resources, forms, attachments, icons, simulation scenarios, etc.
By default, Interstage BPM Studio shows a project named "BankLoan" in the Navigator view after
installation. This is a Workflow Application project consisting of a process definition, several JSP
pages, xml configuration files, etc. Take a look at the project structure to get a first impression
on where to store which application artefacts.
If you are upgrading from a previous version of Interstage BPM Studio and are using your previous
workspace, Interstage BPM Studio shows a project named "Local" in the Navigator view. You
can use existing process definitions and copy them to new Workflow Application projects or
transfer them individually to the Interstage BPM Server.

• Scenario project: Project containing scenarios for locally simulating the execution of a process
definition. A scenario is stored locally on your machine and can import either a local process
definition or a process definition located on an Interstage BPM server. By default, Interstage BPM
Studio shows a project named "Simulation Scenarios" in the Navigator view after installation. You
can add your local scenarios in this project, or directly in a Workflow Application project, which
contains a default folder named "Simulation". In addition, you can also use previously created
process definitions ("historical values") for simulation. Refer to section Simulating Processes on
page 344 for details.

• Server project: Project displaying the process definitions stored on an Interstage BPM server.
Before you can work with these process definitions, you need to log in to the Interstage BPM
server as an Interstage BPM user. You can transfer any local process definition to the server or
export one from the server to your local machine.
In SaaS mode, you can connect to a tenant on an Interstage BPM Server. Each tenant has its
own applications. Refer Interstage BPM Studio Features on page 16 and Online Editing: Server
Projects on page 29 to know more about SaaS and non-SaaS modes.

This chapter explains how to create projects and work with them.

4.1 Managing Workflow Application Projects
This section explains the functions available for managing Workflow Application projects.

4.1.1 Creating Workflow Application Projects
To create a Workflow Application project on your local machine:
1. Select File > New > Application.
2. In the Project name field, type a name for your project. This is usually the name of your application.
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The project that you create corresponds to a folder in the file system. As a default, the project is
created in your workspace.

Figure 46: Creating a Workflow Application Project

3. If you want to change the location of your project:
a) Clear the Use default location check box.
b) Click Browse. Select an existing folder, or create a new one. Click OK.

4. Click Next.
Type in the required information:
• Description: Provide a brief description of your project.
• Owner: Type in the person who is responsible for the project. The project owner is allowed

to change or delete the project.

5. Finish.
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The new Workflow Application project is listed in the Navigator view. The folders are still empty.

Figure 47: Creating a new Workflow Application project

4.1.2 Components of a Workflow Application Project
By default, the following folder structure is created for a Workflow Application project:

Figure 48: Workflow Application Project Folder Structure

The default folder structure contains everything necessary for managing your Workflow Application
project.
Your Workflow Application project folder contains the following components:
• Process Definitions: This is where you store the process definition(s) of your application.
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• Forms: This is where you store any Interstage BPM Forms.
• Web: This is where you store all material that is to be made available to Interstage BPM clients

through the web. The files placed in this folder are exposed to the Internet. For example, all your
QuickForms associated with the process definitions of your Workflow Application project, any
help pages, etc. should be stored in this folder. You can create additional folders beneath the
web folder that will also be exposed to the web, such as subfolders for images and styles.

• dms: This is where you store, for example, any attachment that is part of your Workflow Application
project. For this purpose, there is a predefinedAttachments folder where you can create additional
folders, if required.
• In Attachments folder, Blaze files too are stored. Refer Integrating Blaze Rules on page 284

to know more about Blaze files.
• New ILOG rules files will be placed in this folder, too. Refer Integrating ILOG JRules on page

287 to know more about ILOG rules.
The dms folder will, together with any subfolders, be copied to the corresponding folder on the
Interstage BPM Server when your application is installed. You can create additional folders
beneath the dms folder.

• Application Classes: This is where you store class files and jar files used by your application.
These files are stored in the engine subfolder. Java Script files are stored in js folder. js folder
too is a subfolder of the engine folder.

• Simulation: This is where you store the simulation scenarios for your application. This folder
includes scenario files (provide information about process simulation parameters) and simulation
result files (provide information about simulation results). Both scenario and simulation result files
use the .ssr file extension. For more information on simulating processes, refer to section
Executing a Simulation Scenario on page 358.

• Calendar: This is where you store the calendar (.cal) files of your application. For more
information on business calendars, refer to section Creating Your Own Business Calendars on
page 161.

• Resources: This is where you store resource files as listed below. For more information on these
resource files, refer to section Working With Resources on page 88. The Resources folder
contains and supports creating:
• Configuration files for Java Action Agents (refer Defining Java Agents on page 330)
• Configuration files for new data sources used by Interstage BPM Studio (refer Configuring

Interstage BPM for Database Actions on page 292)
• FTP Agent files (refer Defining FTP Agents on page 331
• HTTP Agent files (refer Defining HTTP Agents on page 335)
• Custom Config files
• File Listener files (refer Defining File Listener on page 338)
• Process Scheduler File (refer Interstage Business Process Manager Developer's Guide for

more information)

• Rules: Rules folder contains Rules Set folder and Rules Set folder further contains Decision
Tables. Refer Creating a New Rule Set on page 217 for more information about Rules Set.

• Documents: The Process Definition reports are stored in this folder. ReferUsing Process Definition
Reports on page 119 for more information about reports and Documents folder.

• Analytics: This is the convenient access point for the Analytics application. If Interstage Analytics
is installed, this folder allows you to create and edit the Analytics settings.
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You have to install the Interstage Analytics plugin before you can use the Analytics function
with Interstage BPM Studio.

Note:

MyApplication in the sample above is the application root folder. All components of the application
are contained in this folder. The contents of this folder can be zipped into one file which is used for
transferring the application from one machine to another.
For a complete overview of all components of a Workflow Application project, refer to section Project
Components on page 379.

4.1.3 Using Folders
In any Workflow Application project, you can create additional folders or structure the existing folders
to your needs in order to reflect the hierarchy of your application.

You can create new folders beneath the default dms, web, and classes folders.Note:
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To create a folder:
1. Right click the Workflow Application project folder beneath which you want to create a subfolder

in the Navigator view. Select New > Folder from the pop-up menu.

Figure 49: Creating a new folder

2. Enter a name for the new folder, and click Finish.
You can proceed with importing existing folders and files from your file system into the folder you
have just created. Refer to section Importing Folders and Files on page 86 for details.
In addition, you can use the default functions for folders that are also available for standard file system
folders, such as copy and paste, rename, and delete. Note that these functions are only available
for folders that you created, not for the predefined ones.
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4.1.4 Importing Folders and Files
Prerequisite: You have created a Workflow Application project where you can import folders and
files.

Existing folders and files can only be imported into the default web folder or the dms folder
and their subfolders.

Note:

To import folders or files from a file system:
1. In the Navigator view, right click the Workflow Application project folder where you want to import

the files. Select Import from the popup menu. In the following example, two QuickForms are to
be imported to your workspace:

Figure 50: Importing Folders and Files

2. Click Browse and navigate to the directory where the folders and files are stored that you want
to import in your Workflow Application project. Select an existing folder and click OK.

3. Select the folders and files to be imported.
4. The Into folder field shows the path of the folder you selected when starting the import function.

You can change this path if you want to import the folders and files into a different project or folder
of your Workflow Application project.
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5. Decide whether you want to overwrite existing folders and files without warning, and whether
your Workflow Application project is to contain the complete folder structure or the selected folder
or file only.

6. Click Finish.

The selected files (QuickForms, in the example above) contained in the local directory will be imported
into your Workflow Application project.

In addition to importing folders and files from the local file system, you can also import entire
Workflow Application projects to your workspace. For more information, refer to section
Importing Workflow Application Projects on page 91.

Note:

4.1.5 Searching for Folders and Files
You have created a Workflow Application project where you can search for specific folders and files.

Interstage BPM allows you to search for folders and files in your workspace or in a specific Workflow
Application project. Search is based on the text search method. This method specifies that the files
you are searching for contain certain text strings in the title, contents, or properties. You can also
specify where to look for folders and files and thus limit the range of your search.
To search for specific folders and files:
1.

Select Search from the Toolbar ( ).
The Search dialog is displayed.

Figure 51: Searching for files

2. Type in a search string or select a string from the drop-down list.
The Search dialog shows the string you have selected. You can search by the following criteria:
• All or part of a folder´s or file´s name
• A word or phrase in the name
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3. If you want Interstage BPM Studio to distinguish between uppercase and lowercase letters, select
the Case sensitive check box.

4. Select one of the Scope check boxes to narrow the scope of search.
You have the following options:
• Workspace: Sets the search range to the file system folder where your work is stored.
• Selected resources: Sets the search range to the Workflow Application project you have

selected in the Navigator view.
• Enclosing projects: Sets the search range to the selected project, including the resources

that are opened in the Resource editor.

5. Click Search to start searching for the specified folders or files.
The search results are displayed in the Search view. The following example shows the search
results for the term "simulation" in your workspace:

Figure 52: Displaying search results

From the results list, you can take further actions on the files you find, such as viewing or editing
the files. To do this, double-click the files to open them in the editor window above the Search
view.

4.1.6 Working With Resources
Prerequisite: You have created a Workflow Application project that contains all components that
are required for managing your project.

Interstage BPM Studio allows you to add new resources to Workflow Application projects. The term
"Resources" refers to the following:
• FTP Agent files
• HTTP Agent files
• Custom Config files
• Configuration file for Java Agents used by the application (agentsConfig.xml)
• Configuration files for new data sources used by Interstage BPM Studio

(DataSourceDefinition.xml)
• File Listener file (fileListenerConf.xml)
• Process Scheduler file (ProcessScheduler.xml)
After creating a new project, the project folder structure contains, among other folders, an empty
Resources folder. This folder is intended for the resource files listed above.

You can add only one Java Agent, one data source configuration file, one File Listener file
and one Process Scheduler file to your project.

Note:

Interstage Business Process Manager Studio User's Guide 88

4: Managing Projects



To add new resources to a project:
1. Right-click your project in the Navigator view and select New from the pop-up menu.
2. Select the resource that you want to add to your project.

You have the following options:
• FTP Agent: Use this option to create a new FTP Agent.
• HTTP Agent: Use this option to create a new HTTP Agent.
• Custom Config: Use this option to create new Custom Configuration files.
• Agents: Use this option to create a new Java Agent.
• Java Actions > Data Source: Use this option to add a new data source.
• File Listener: Use this option to create new File Listener file.
• Process Scheduler File: Use this option to create a new Process Scheduler file.

3. If you want to edit existing resources:
a) Open any of the following files in the Resource editor.

• FTP Agent file
• HTTP Agent file
• Custom Config file
• agentsConfig.xml

• DataSourceDefinition.xml

• fileListenerConf.xml

• ProcessScheduler.xml

b) Please refer Interstage Business Process Manager Developer's Guide to know about the tags
of each of these files.

For more information, refer to sections:Note:
• Defining FTP Agents on page 331 (FTP Agents)
• Defining HTTP Agents on page 335 (HTTP Agents)
• Defining Java Agents on page 330 (Java Agents)
• Configuring Interstage BPM for Database Actions on page 292 (Data Source)
• Defining File Listener on page 338 (File Listener)
• Defining Process Scheduler in Interstage Business Process Manager Developer's Guide

c) Click the Save button in the toolbar to save your changes.

4. If you want to copy and paste existing resource files:
a) In the Navigator view, right-click a resource file and select Copy from the pop-up menu.
b) Navigate to the Resources folder of another project, right-click this folder, and select Paste

from the pop-up menu.
The resource file is pasted to the new location. If the same file already exists at the new location,
Interstage BPM Studio will ask you to overwrite the file. Click Yes to complete the paste procedure.

You can only copy and paste the contents of one Resources folder to another. You cannot
copy the Resources folder itself.

Note:

Interstage Business Process Manager Studio User's Guide 89

4: Managing Projects



4.1.7 Copying Workflow Application Projects
You can copy Workflow Application projects with all of their contents from one location to another.

You can copy Workflow Application projects only. Server projects and scenario projects
cannot be copied.

Note:

To copy a project:
1. Right click the project in the Navigator view. Select Copy from the pop-up menu.
2. Right click again and select Paste from the pop-up menu.
3. In the Copy Project dialog, type a name for the copy.

Figure 53: Copying a Project

4. As a default, the project is stored in your workspace. If you want to change the location:
a) Clear the Use default location check box.
b) Click Browse. Select an existing folder or create a new one.

5. Click OK.

The copy is listed in the Navigator view.
You can copy several projects at once. Hold down the <Shift> or <Ctrl> key to select all projects to
be copied.

4.1.8 Renaming Workflow Application Projects
You can rename Workflow Application projects only. Server projects and the scenario project
cannot be renamed.

Note:

To rename a local project:
1. Right click the project in the Navigator view. Select Rename from the pop-up menu.
2. Type the new name for the project.
3. Press the <Enter> key.
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4.1.9 Closing Workflow Application Projects
When you close a project, it is still displayed in the Navigator view, but you cannot change it any
more. Its content, for example process definitions, is no longer visible.
To close a Workflow Application project:
• Right click the project in the Navigator view. Select Close Project from the pop-up menu.

The icon left to the project name indicates that it is closed.
You can close several projects at once. Hold down the <Shift> key or <Ctrl> key to select all projects
to be closed.

The closing procedure applies to server projects, too. For more information on server
projects, refer to section Managing Server Projects on page 110.

Note:

4.1.10 Opening Workflow Application Projects
You can reopen a project that is currently closed. The icon left to the project name indicates whether

it is closed ( ) or open ( ).

You can reopen server projects, too. For general information on server projects, refer to
section Managing Server Projects on page 110.

Note:

To open a project:
• Right click the project in the Navigator view. Select Open Project from the pop-up menu.

4.1.11 Removing Workflow Application Projects
You can remove projects with all of their contents from Interstage BPM Studio.

You cannot remove the projects named "Simulation Scenarios". When you remove a
Workflow Application project, all files in the project are also removed and no longer
accessible.

Note:

To remove a Workflow Application project:
1. Right click the project in the Navigator view. Select Delete from the pop-up menu.
2. Confirm the removal of the project by clicking Yes.

4.1.12 Importing Workflow Application Projects
You can download Workflow Application projects packaged into .bar files from the local file system
to your workspace.
To import a Workflow Application project from your local file system:
1. In the Navigator view, right-click the project name. Select Import Bar File from the pop-up menu.
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The Import Bar File dialog is displayed.

Figure 54: Displaying the Import Bar File dialog

2. Specify the project to be imported. To do so:
a) Select a .bar file from the From archive file drop-down list, or click Browse. From your local

file system or a file server, select the .bar file that you want to import, and click OK. The
selected file is added to the From archive file field. The file path is displayed, for example
C:\Fujitsu\InterstageBPM_studio\workspace\MyBankLoanProject.bar.
If the project that you are importing has the same name as another project in your workspace,
you will encounter an error message.

b) Use the check boxes to select or deselect components to be imported. You can select or
deselect all project components at once, using the Select All or Deselect All tabs.

c) From the Import as drop-down list, select a name for the project to be imported. If you are
trying to import a project that has the same name as a project in your workspace, an error
message is displayed. Change the project name to avoid any conflicts.
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After specifying all import settings, the Import Bar File dialog looks as follows:

Figure 55: Specifying import settings

3. You can provide additional information about your project. To do so:
a) Click Next.
b) In the Project dialog, type in additional information about your project.
Providing additional project information is optional. You can type in a brief description of the
project as well as the name of the project owner. For more than one project owners, use a
comma-separated list of names.
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The following figure shows an example specifying two project owners:

Figure 56: Providing additional information

4. Click Finish to import the selected project components to your workspace.
While the application is being imported, a temporary project is listed in the Navigator view. You
can identify this temporary project by its name starting with two tildes and the name you entered
for the application project, e.g. ~~MyApp. As soon as the import is finished, the temporary
application project is deleted and the imported project is listed in the Navigator view.

4.1.13 Exporting Workflow Application Projects
You can export Workflow Application projects from your workspace to the local file system and
package all files that make up your application into a .bar file. This .bar file can later be deployed
on an Interstage BPM Server using the deployment mechanisms provided by Interstage BPM.
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To export a Workflow Application project to the local file system:
1. In the Navigator view, right-click the project name. Select Export from the pop-up menu. As an

alternative,you can also select this option from the File menu.
The Export Workflow Application Project dialog is displayed. It shows your local file system
and the name of the .bar file you have selected in the workspace.

Figure 57: Displaying the Export Workflow Application Project dialog

2. Specify the project components to be exported. To do so:
a) Select an application to be exported from theApplication drop-down list. The default application

is the name of the project you have selected in the Navigator view.
All files that make up your application are displayed.

b) Use the checkboxes to select or deselect specific files to be exported. You can select or
deselect all files at once, using the Select All or Deselect All buttons.
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c) Use the To archive file drop-down list to specify a file to archive the exported project. You
can also browse for an archive file using the Browse tab. The default archive file takes the
name of the project you are exporting (in the example, BankLoan.bar file).
The To archive file drop-down list contains file paths (for example
C:\Fujitsu\InterstageBPM_studio\workspace\Archive).
The following figure shows how to select specific project components and specify the default
archive file:

Figure 58: Specifying project components and archive file

3. Select the project components to be exported, specify an archive file, and click Finish to export
your project.
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Your Workflow Application project is now stored as MyBankLoanProject.bar file in the specified
directory in the local file system.

Figure 59: Location of the exported project

4.1.14 Downloading Workflow Application Projects From a Server
You can download Workflow Application projects packaged into .bar files from an Interstage BPM
Server to your local workspace. A wizard walks you through the downloading procedure.
To download a Workflow Application project from a server:
1. In the Navigator view, right-click the project name. Select Download Application from Server

from the pop-up menu.
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The Downloading Application dialog is displayed. It automatically shows the last active server
connection:

Figure 60: Displaying the Downloading application dialog

2. If you want to use an available server connection, select a server from the Server Connection
drop-down list and proceed with Step 5.

3. If you want to edit one of the server connections or specify a new server:
a) In the Downloading Application dialog, click Browse Connection.

The Select Server Connection dialog is displayed. The available server connections are
listed in alphabetical order. By default, the first server on the list is always highlighted. If you
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have not yet specified any server connection, the server connection field is empty. In the
following example, only one server connection is available.

Figure 61: Displaying server connections

b) In the Select Server Connection dialog, click New.
The Server Connection Setting dialog is displayed.

c) In this dialog:
1. Specify the parameters for the new server connection. Refer to section Setting Your

Preferences on page 76 for details on the required server parameters.

In SaaS mode, the <tenant> in the URL connects you to the specific tenant on the Interstage
BPM Server. Refer Interstage BPM Studio Features on page 16 to know more about SaaS
mode.

Note:

If you want to connect to Interstage BPM Server in non-SaaS mode, enter default in
<tenant> in the URL. This will, through the default tenant, directly connect you to the server
specified in <hostname> in the URL.

Note:

2. Optional: Select the Save Password checkbox if you do not want to enter it again the next
time.

d) Click OK to confirm the server settings.
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The new server connection is added to the server connections list. In the following example,
the Interstage BPM Server has been specified:

Figure 62: Displaying new server connection

e) In the Select Server Connection dialog, click OK to confirm your server choice.
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The Downloading Application dialog displays the selected server connection (Interstage
BPM Server, in the example):

Figure 63: Displaying the new server connection

4. In the Downloading Application dialog, click the Get List tab.
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All projects using the specified server connection are displayed in the empty space beneath the
tab. In the example, three projects are displayed.

Figure 64: Displaying Workflow Application projects

5. Select the project you want to download from the server, and click Next.
The Downloading Application dialog is displayed. It shows all components of the selected
project.
You can use the check boxes to select or deselect components to be downloaded. You can also
select or deselect all project components at once, using the Select All and Deselect All tabs.
Use the Import as drop-down list to select a name for the project that you want to download. The
default name is the name of the project in your workspace. Change this name to avoid any name
conflicts. The following example shows how to select project components to be downloaded:
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The Download as list contains the names of all available projects. However, it does not
contain any file paths.

Note:

6. Select project components to be downloaded, and click Next.
The Project dialog is displayed. Here you can enter additional information about the project.

7. Type in a project description and the name of the project owner.

Providing additional projet information is optional. You can leave out this step and immediately
finish the download process.

Note:

8. Click Finish to download the project from the specified server.
While the application is being downloaded, a temporary project is listed in the Navigator view.
You can identify this temporary project by its name starting with two tildes and the name you
entered for the application project, e.g. ~~MyApp. As soon as the download is finished, the
temporary application project is deleted and the downloaded project is listed in the Navigator
view.

If the logged-in user, who is not an Interstage BPM Administrator (whether application owner
or not), downloads an application from a server using the Interstage BPM Studio, Draft
Process Definitions that are part of the application belonging to other users are not exported.

Note:

4.1.15 Uploading Workflow Application Projects to a Server
Pre-requisite:
An application space is created with the same name as that of the application in Interstage BPM
Console before the application can be uploaded. This application is in offline state before the upload.

You can upload Workflow Application projects from Interstage BPM Studio to the Interstage BPM
Server and package all files that make up your application into a .bar file. This .bar file can later
be deployed on an Interstage BPM Server using the deployment mechanisms provided by the
Interstage BPM Console. An uploading wizard walks you through the procedure of uploading a project
from your workspace to a remote server.

You need to have Administrator rights on the remote server to be able to perform this task.Note:

To upload a Workflow Application project to a remote server:
1. In the Navigator view, right-click the project name. Select Upload application from the pop-up

menu.
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The Uploading application dialog is displayed. As long as no server connection is specified,
the dialog shows an error message.

Figure 65: Displaying the Uploading application dialog

2. To specify the project to be uploaded:
a) Select a project from the Application drop-down list.

The default application is the name of the project you have selected in the Navigator view.

b) Use the check boxes to select or deselect components to be uploaded. You can upload an
entire project or single components of a project. To do this, expand the project folder, clicking
the + sign in front of the project name. The possibility to select project components prevents
you from uploading identical projects. Besides, you do not have to deploy files that you don´t
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want to deploy. In addition, you can select or deselect all components at once, using the Select
All or Deselect All tabs. By default, all project components are selected.

3. Select a remote server.
You can select a server from a drop-down list or by browsing available server connections.
• Select a remote server from the Server Connection drop-down list. This list automatically

displays the last server you have selected. If you have not yet selected any server, the list is
empty. In that case, or if you want to select a different server:
1. In the Uploading Application dialog, click the Browse Connection tab, and select a

server. This dialog displays all available server connections.
2. Click OK to confirm your selection.
3. If no server is available, in the Select Server Connection dialog, click New to specify a

new server connection. Server Connection Setting dialog is displayed.
4. To create a new server connection, enter all the parameters in Server Connection Setting

dialog that is displayed after clicking the New button. Refer Setting Your Preferences on
page 76 to know more about various parameters.

In SaaS mode, the <tenant> in the URL connects you to the specific tenant on the Interstage
BPM Server. Refer Interstage BPM Studio Features on page 16 for more information about
SaaS mode. Also, refer Creating Server Projects on page 110 for more information about
the parameters.

Note:

If you want to connect to Interstage BPM Server in non-SaaS mode, enter default in
<tenant> in the URL. This will, through the default tenant, directly connect you to the server
specified in <hostname> in the URL.

Note:
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• In the example, you have specified an Interstage BPM Server. The Uploading Application
dialog now looks as follows:

Figure 66: Selecting project components and server

4. In the Uploading Application dialog, click Next.
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You can choose to update a project that already exists on the server, or create a new project:

Figure 67: Choosing to update or create an application

• Select theUpdate the existing application checkbox to upload your project to another project
that already exists on the server. You can choose to completely or partially update an existing
project. Select theComplete check box to completely replace the project on the server. Select
the Partial check box to add or update selected project components.

When you choose Complete, the uploaded process definitions are added as the latest
version. This means that any existing process definitions are not removed, but remain as
previous versions. All other resources are replaced.

Note:

• Select the Create new application checkbox to upload a new project onto the server. If your
new project has the same name as another project on the server, Interstage BPM Studio will
ask you to overwrite it.

5. Click Finish to upload the new project.
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4.1.16 Application Variables
Application Variables are the variables that you can define at application project level. By defining
the Application Variables, you can share these variables across all the processes within a specific
application project. This will save your effort for creating separate variables for each process.
Application Variables are dynamic in nature and you can use them for various Java Actions. For
example, you can use Application Variables for the Web Service Java Action as a Web Service
location. This will allow you to change the Web Service location dynamically without changing the
Process Definition Java Action.
You can define Application Variables when you create new application projects.
Along with the process-level variables, Application Variables too are available in the Expression
Builder. Refer Defining JavaScript Expressions on page 339 for more information about Expression
Builder.
Application Variables are displayed as %ApplicationVariable1% to distinguish them from the
process-level variables.
For example, if Variable1 is an Application Variable then its expression will be
sec.getApplicationVariable("Variable1").
Application Variables are stored in an xml file in the Application folder. The xml file is located at
Workspace >> Application Name >> Appvariable.xml.

4.1.17 Defining Application Variables
To define Application Variables:
1. Right-click the application project in the Navigator view.
2. Click Properties.

Properties dialog for the application project is displayed.

3. Click Application Variables in the left pane.
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Application Variables area is displayed in the right pane.

Figure 68: Defining Application Variables

4. Click the Add button to add Application Variables.

By default, the Application Variables are added as ApplicationVariable1, ApplicationVariable2
and so on. You can change the names and values.

Note:

When Application Variable is defined, and it is set with a certain JavaAction, you can delete
this Application Variable.

Note:

When you delete an Application Variable, it is necessary to check whether this Application
Variable is used.

Note:

5. Edit the name and the initial value of the Application Variable in the Name and Initial Value
columns respectively.

The maximum allowable length of the variable name is 256 characters and the maximum
allowable length of the value is 2000 characters.

Note:

6. Click Apply and then click OK to save the Application Variables.
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4.2 Managing Server Projects
This section explains the functions available for managing server projects.

Make sure that you do not edit any process definition that is part of a Workflow Application
project of a server project.

Note:

4.2.1 Creating Server Projects
To create a project that accesses an Interstage BPM server:
1. Select File > New > Project >Server.

New Server Project dialog is displayed.

2. In New Server Project, in the Project name field, type in a name for your project.
The project that you create corresponds to a folder in the file system. As a default, the project is
created in your workspace.

Figure 69: Creating a Server Project

3. To change the location of your project:
a) Clear the Use default location check box.
b) Click Browse. Select an existing folder, or create a new one. Click OK.

Interstage Business Process Manager Studio User's Guide 110

4: Managing Projects



4. Click Next. The dialog box for typing in information on the location of the Interstage BPM server
is opened.
The New Server Project dialog for server information, is displayed. Use this dialog to type in the
required server information.

Figure 70: Providing server information

5. Enter the Wf-XML Registry URL. This URL is composed of the host name, port number. The
sample URL is as given below:

http://<hostname>:<port>/<context>/_wfxml/default/service/registry/

In the following URL, console is the context root for server connection, ibpmserver is the
hostname and 49950 is the port.

http://ibpmserver:49950/console/_wfxml/default/service/registry/

Through a Server Project, you can access only the System application in the default tenant.Note:

6. Enter the user ID used to authenticate with Interstage BPM in the User ID field, and enter the
associated password in the Password field.

7. Optional: Check the Save Password check box if you want to save the specified password so
that you do not need to provide it again when you log in to the Interstage BPM Server.
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8. Click Finish.
The new server project is listed in the Navigator view (MyFirstServerProject, in the example):

Figure 71: Displaying the new server project

The default server project contains an empty Analytics folder that can be used as an access
point for the Analytics application.

You have to install the Interstage Analytics plugin before you can use the Analytics function
for the new server project.

Note:

9. To actually list the process definitions on the server in the Navigator view, you need to login to
the server: Right-click the new server project in theNavigator view and select Login. If you saved
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your password when you created the server project, you are instantly logged in and the process
definitions are listed. Otherwise, a dialog is opened in which you must enter the password.

Figure 72: Entering a Server Password

To log off from the server again, right-click the server project and select Logoff.

If your process definitions reference external files like forms, business calendars, cascading
style sheets, Java classes, or rules files, make sure that these files are available on the
computer on which the Interstage BPM Studio is installed and that any file paths are adjusted.
For more information, refer to the following sections:

Note:

• Using Forms on page 174
• Creating Your Own Business Calendars on page 161
• Integrating ILOG JRules on page 287
• Integrating Blaze Rules on page 284
• Using Generic Java Actions on page 312
• Integrating Decision Tables

If logging in to the Interstage BPM server fails, the following error message may be displayed:
@@Login failed. [Details]: Connection refused:connect

or
@@Login failed. [Details]: Connection timed out:connect

In this case:

Note:

• Make sure that the connection information required to access the Interstage BPM server
is correct (Host Name, Port and Base URL).
The connection information is displayed on the Server Info page in the Properties for
server dialog. To open this dialog, right-click the server project in the Navigator view
and select Properties from the pop-up menu.

• Check whether the server is started.

4.2.2 Closing Server Projects
You can close server projects in the same manner described for Workflow Application projects.
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To close a server project:
• Right click the project in the Navigator view. Select Close Project from the pop-up menu.

The icon left to the project name indicates that it is closed.
You can close several projects at once. Hold down the <Shift> key or <Ctrl> key to select all projects
to be closed.

4.2.3 Opening Server Projects
You can reopen a server project that is currently closed. The icon left to the project name indicates

whether it is closed ( ) or open ( ).
To open a server project:
• Right click the project in the Navigator view. Select Open Project from the pop-up menu.

4.2.4 Removing Server Projects
You can remove server projects with all of their contents from Interstage BPM Studio.

When you remove a server project, this means that the registered Interstage BPM Server
is also removed and the process definitions located on the server are no longer accessible.

Note:

To remove a server project:
1. Right click the project in the Navigator view. Select Delete from the pop-up menu.
2. Confirm the removal of the project by clicking Yes.
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5 Managing Process Definitions
This chapter explains how to create new process definitions and work with them.

5.1 Creating Process Definitions
Prerequisite: You have created a project where the process definitions can be stored.

To create a process definition:
1. Select File > New > Process Definition.
2. In the New Process Definition dialog, click Browse. Select the project where the process

definition is to be stored, and click OK.
The project name is displayed in the Project field.

3. Type a name for your process definition in the Name field.
If a file with this name already exists, a dialog is displayed asking you for a file name. Type a new
file name and click OK.

4. Enter a description for the process definition in the Description field.

Figure 73: Creating a Process Definition

5. Click Finish.

The new process definition is listed in the Navigator view. A Process Definition editor is opened and
a Start Node is automatically added.

You can now define a new name and change the description for the process definition and start
modeling your process.

When creating a process definition in a server project, its application ID is set to 'System'.Note:
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5.2 Validating Process Definitions
Prerequisite: You have created a project where the process definitions can be stored.

Validating a process definition helps identify errors in the process definition, and the arrows, nodes
and timers comprising it.

Java actions and triggers are not validated by this process.Note:

Process definitions that are part of a server project cannot be validated.Note:

To validate a process definition:
1. Do one of the following:

• Click the Process Definition editor to make it active and click Validate on the toolbar.
• Right click the empty space in the Process Definition editor and select Validate from the

pop-up menu.
Any errors in the process definition will be displayed in the BPM Problems view. For more
information about BPM Problems view refer to section BPM Problems View on page 60.

5.3 Saving Process Definitions
You can save process definitions that have been modified. If there are no changes, the save functions
are not active.
To save process definitions:
1. Do one of the following:

• To save the process definition that is currently displayed in the Process Definition editor, select
File > Save.

• To save all process definitions that have been modified, select File > Save All.

2. If a process definition is not valid, a message is displayed telling you so. You can display detailed
information on the errors that have been found. You have the following options:
• You can save the process definition anyway by clicking Yes.
• You can cancel saving by clicking No. You can then fix the errors and try saving the process

definition again.

5.4 Saving a Process Definition to a Different Name or Project
To save a process definition to a different name or project:
1. Click the Process Definition editor that displays the process definition to be saved.
2. Select File > Save As.
3. If the process definition is not valid, a message is displayed telling you so. You can display detailed

information on the errors that have been found. You have the following options:
• You can save the process definition anyway by clicking Yes.
• You can cancel saving by clicking No. You can then fix the errors and try saving the process

definition again.

4. In the Save As Process Definition dialog, select the project where you want to save the process
definition. You can save it to any Workflow Application or other local project, or to a server project

Interstage Business Process Manager Studio User's Guide 116

5: Managing Process Definitions



to which you are currently logged in. You cannot save the process definition to the "Simulation
Scenarios" project.

When saving a process definition to a server project, its application ID is set to 'System'.Note:

5. If you want to save the process definition to a different name, type the new name in the Name
field.

Figure 74: Saving a Process Definition to a Different Name or Project

6. Click OK.
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5.5 Defining the Process Definition Name and Description
The name of a process definition is used to identify it. You can use a description to provide additional
information on the process.

The name of process definitions contained in a server project cannot be changed.Note:

To define a name and description for a process definition:
1. In the Navigator view, double click the process definition.
2. In the General tab of the Properties view, type the process definition's name.
3. If you want to provide more information about the process, type a description in the General tab

of the Properties view.

5.6 Setting the Process Definition Priority
You can set priority for a process definition. By default, a process definition is given a medium priority
of 8. However, its priority can be changed to an integer greater than or equal to 0.
To set the process definition priority:
1. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
2. Select the General tab in the Properties view.
3. Enter the priority value in the Priority field. This will set the priority for the process definition.

5.7 Using Same Versions of Subprocess Definitions
For a parent process with subprocesses associated with it, there could be several versions of the
parent process definition and the subprocess definitions. Depending on your design requirements,
you may need to use specific versions of the subprocess definitions. In Interstage BPM Studio, while
designing the processes, you can choose to use the versions of subprocesses same as that of the
parent process definition.
If you do not update any of the process definitions and still choose to use the same versions of the
subprocess definitions then the parent process definition will search for the subprocess definitions
of the same version as its own. If they are available then the process instance will start or an error
will be thrown.
For example, consider a parent process definition A of version V1 with two subprocess definitions
namely B of version V3 and C of version V2 in a certain application APP01.
If you choose to use the same versions of the subprocess definitions and then update APP01, then
versions of A, B, and C will become V4. This version is calculated as: New Version = Maximum
version number of the process definitions that will be updated together + 1. In this scenario,
the parent process definition A (having version V4) will search for the subprocess definitions having
version V4. B and C will also have version V4 and the process instance will start.
While updating an application, if you want to use the same versions of the subprocess definitions,
you need to update the parent process definition as well as the child process definitions.

Ensure that for a version of a parent process definition, subprocess definitions having that
same version exist. If the parent process instance tries to call a subprocess definition with
a version number that does not exist, an error is thrown.

Note:

You can choose to use the same versions of only subprocesses and chained-processes.Note:
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This function is effective when you select the parent process definition and the subprocess
definition and execute the Upload Application command.

Note:

To use the same versions of subprocesses:
1. Click the General tab in the Properties view of the parent process definition.
2. Select the Use the same subprocess definition version checkbox.

5.8 Using Process Definition Reports
You can create reports of the Process Definitions in HTML, PDF and MS-PowerPoint formats. This
feature is useful for the users who need an overview of their systems. They do not need to know the
technical details of the Interstage BPM. Their need is to know the business-specific details about
the systems that have been designed using Interstage BPM. For example, a manager of a bank will
be interested in understanding the details about the bank's credit card and loan systems. S/he may
not be interested in knowing the Interstage BPM-specific details pertaining to his/her systems.
You can create reports for the following:
• Process Definition reports can be generated from Process Definition Editor as well as Process

Outline Editor.
The report for any of the above contains the following details:
• Process Definition Name
• Process Definition Description
• Process Definition Creation Date
• Snapshot of the Process Definition (only in Process Definition Editor)
• Description of the following nodes in the Process Definition: Activity, Voting Activity, Compound

Activity, Subprocess
Details of a node that are included in the report are:
• Node Name
• Node Description
• User who has been assigned the activity
• Due Date of the activity
An activity in Interstage BPM Studio is referred as a task in the report.
The PDF and HTML reports contain the details in tabular form. Details of each activity and compound
activity are listed in separate tables.
The MS-PowerPoint report generates separate slides for each major activity (node) and compound
activity in the process.
Details about the child nodes of a compound activity are included in one slide of the MS-PowerPoint.

The reports also contain Appendix which includes the day and timer codes for the due
dates of the tasks. Refer Time and Day Codes for Advanced Due Dates and Timers on
page 160 to know about day and timer codes.

Note:

The reports do not contain information about triggers, timers, Java Actions, agents, and
UDAs of the process.

Note:

The reports contain details about only those tasks which need human intervention. These
are Activity Nodes and Voting Activity Nodes.

Note:
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The reports that are generated are saved in the documents folder of the application. By default,
report is saved with the name that you enter in the Title field of the Generate Report dialog. You
can rename the reports later.
You can perform the following operations on this folder:
• Copy
• Paste
• Rename
• Delete
• Import
You can access all the reports in Interstage BPM Studio. PDF and HTML reports open in their
respective formats. MS-PowerPoint reports open in Studio.
Refer Creating Process Definition Reports on page 120 to know how to create reports.

5.8.1 Creating Process Definition Reports
Pre-requisites
• Generate Process Documentation option in File menu is enabled when the Process Definition

Editor or the Process Outline Editor is active.
• The Process Definition has been saved.

To create a report of a Process Definition:
1. Open the Process Definition for which you want to create a report, from the Navigator view.
2. Click File menu and select Generate Process Documentation command.

Generate Report dialog is displayed.

3. Enter the name of the report in the Title field.
4. Select the appropriate checkbox to select the format of the report. The format options are HTML,

PDF and MS-PowerPoint.

You can select more than one options to generate reports in multiple formats.Note:

5. Click Save.
The report is generated and saved in the documents folder in the Navigator view. A message
is displayed stating that the report has successfully been saved in the documents folder. If saving
the report fails, an error message is displayed.

If the Process Definition contains compound activity then the snapshot of the child process
will not be generated in the report.

Note:

When the Process Definition of Server Project is opened, the Generate Process
Documentation command cannot be used.

Note:

When you use the Interstage BPM Studio as Eclipse Plug-In, the Generate Process
Documentation command cannot be used.

Note:

When the Generate Process Documentation command is executed by the Process
Definition Editor and HTML report is created, a snapshot of the Process Definition is included
in the report of the process definition. The file name of this snapshot is generated by adding
.jpg as a file extension at the end of the name of the report file.

Note:
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When the HTML report is created by the Generate Process Documentation command,
the _IBPM_STUDIO_Stype.css file is created. This file is the style sheet file of HTML report.
You must not rename this file. If you decide to move the HTML report file to another folder,
ensure you move this style sheet file as well.

Note:

5.9 Opening Process Definitions
To open a process definition, do one of the following:
• In the Navigator view, double click the process definition.
• In the Navigator view, right click the process definition and select Open from the pop-up menu.

For process definitions stored in a project located on an Interstage BPM Server, you have the
additional option of opening a specific version of it:
1. In the Navigator view, right click the process definition and select Open With Version from the

pop-up menu.
2. Select the desired version in the dialog and click OK.

5.10 Importing Process Definitions
Prerequisite: You have created a project where the process definition can be imported.

You can import process definitions in XPDL format into Interstage BPM Studio.

When importing a process definition into a server project, its application ID is set to 'System'.Note:

To import a process definition:
1. In the Navigator view, right-click the Process Definitions folder of the Workflow Application

project where you want to import the process definition. Select Import from the pop-up menu.
2. Navigate to the location where the process definition is stored.
3. Select the process definition and click Open.
4. If a process definition with the same file name already exists in the project, a dialog is displayed

asking you for a file name. Type a new file name and click OK.

If the process definition references external files like forms, cascading style sheets, Java
classes, or rules files, make sure that these files are available on the machine where you
import it. For more information, refer to the following sections:

Note:

• Using Forms on page 174
• Creating Your Own Business Calendars on page 161
• Integrating ILOG JRules on page 287
• Integrating Blaze Rules on page 284
• Using Generic Java Actions on page 312
• Integrating Decision Tables

5.11 Exporting Process Definitions
You can export process definitions from Interstage BPM Studio to the file system. You can use the
exported files, for example, to import them into other systems. For the export format, you can choose
between XPDL 1.0, XPDL 2.0, and XPDL 2.1.
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You can export entire Workflow Application projects including all process definitions, forms,
attachments, etc. in one step, and later deploy the application on an Interstage BPM server.
Refer to section Exporting Workflow Application Projects on page 94 for details.

Note:

To export a process definition:
1. In the Navigator view, right click the process definition. Select Export and then the desired XPDL

format.
2. Navigate to the location where the exported process definition is to be stored.
3. Click Save.

You can import process definitions into an Interstage BPM Server by creating a server project (refer
Creating Server Projects on page 110 to know how you can create server projects) and transferring
them to the server project, or by using the Interstage BPM Console. Refer to the Interstage Business
Process Manager User's Guide for instructions.

If the process definition references external files like forms, business calendars, cascading
style sheets, Java classes, or rules files, make sure that these files are available on the
machine to which you export it. For more information, refer to the following sections:

Note:

• Using Forms on page 174
• Creating Your Own Business Calendars on page 161
• Integrating ILOG JRules on page 287
• Integrating Blaze Rules on page 284
• Using Generic Java Actions on page 312
• Integrating Decision Tables

5.12 Sending Process Definitions to a Server
Prerequisite: You have locally created one or more process definitions in Workflow Application
projects. One or more Interstage BPM Servers are connected, i.e. you have defined one or more
server projects and are logged in to the respective server(s).

When sending a process definition to a server project, its application ID is set to 'System'.Note:

To send a local process definition to the server:
1. In the Navigator view, right-click the process definition that is to be uploaded to an Interstage

BPM Server, and select Send to Server.
You can select multiple process definitions in the same project using the <Shift> or <Ctrl> keys.
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2. Select the server project from the drop-down list that shows all defined server projects.

Figure 75: Sending Process Definitions to the Server

If you have created a server project in SaaS mode, the server project is created on the
specified tenant which is on the Interstage BPM Server. The selected process definition is
sent to the server project created on the tenant. Refer Interstage BPM Studio Features on
page 16 for more information about SaaS mode.

Note:

If you have created a server project in non-SaaS mode, the server project is created on the
default tenant.

Note:

3. If you are currently not logged in to the selected server project, the Password Required dialog
is displayed. Enter the required password and click OK.
The display of the Password Required dialog depends upon whether you selected the Save
Password checkbox when creating the server project. Refer to section Creating Server Projects
on page 110 for details.

The local process definition is uploaded to the server and listed in the selected server project. If the
process definition already exists on the server, a new version is created. You can access a specific
version of the process definition using the Open With Version function.
If the uploading to the server fails, a red icon is displayed aside the process definition name in the
Navigator view. The process definition is saved to the specified server project, but not yet available.
You need to retry sending this process definition to the server by selecting Send to Server again.
If successful, the process definition is instantly transferred to the server you specified when you first
tried to send it.

If your local process definition references external files like forms, business calendars,
cascading style sheets, Java classes, or rules files, make sure that these files are available
on the Interstage BPM Server. For more information, refer to the following sections:

Note:

• Using Forms on page 174
• Creating Your Own Business Calendars on page 161
• Integrating ILOG JRules on page 287
• Integrating Blaze Rules on page 284
• Using Generic Java Actions on page 312
• Integrating Decision Tables
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5.13 Copying Process Definitions
You can copy process definitions easily in the Navigator view.

You can use this function for local process definitions contained in Workflow Application
projects only. Process definitions contained in a server project cannot be copied.

Note:

To copy a process definition:
1. In the Navigator view, right click the process definition that you want to copy and select Copy

from the pop-up menu.
2. Right click the project where you want to paste the process definition and select Paste from the

pop-up menu.
3. If you copy within a project and a process definition using the same file name already exists, a

dialog is displayed asking you for a file name. Type a new file name and click OK.
4. If you copy between projects and a process definition using the same file name already exists, a

dialog is displayed telling you so. Do one of the following:
• To overwrite the existing process definition, click Yes.
• To keep the existing process definition, click No.

In this case, the process definition is not pasted.

You can copy several process definitions at once. Hold down the <Shift> key or <Ctrl> key while
selecting all process definitions to be copied.

5.14 Renaming Process Definitions
You can specify a new file name for a process definition.

You can use this function for local process definitions contained in Workflow Application
projects only, and only if you set your preferences for the Navigator view to File name.
Process definitions contained in a server project cannot be renamed.

Note:

To rename a process definition:
1. Right click the process definition in the Navigator view. Select Rename from the pop-up menu.
2. Type the new name for the process definition.
3. Press the <Enter> key.
4. If a process definition using the same file name already exists in that project, a dialog is displayed

telling you so. Do one of the following:
• To overwrite the existing process definition, click Yes.
• To keep the existing process definition, click No.

In this case, the process definition is not renamed.

5.15 Closing Process Definitions
To close process definitions:
1. Do one of the following:

• To close a particular process definition, click the Close button of the Process Definition editor.
• To close all process definitions, select File > Close All.
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2. If there are unsaved changes, a message is displayed telling you so. Do one of the following:
• To close the process definition and save your changes, click Yes.
• To close the process definition without saving your changes, click No.

5.16 Removing Process Definitions
When you remove a process definition, it is removed from the Interstage BPM Studio and from the
file system as well.

You can use this function for local process definitions contained in Workflow Application
projects only. Process definitions contained in a server project cannot be removed.

Note:

To remove a process definition:
1. Right click the process definition in the Navigator view. Select Delete from the pop-up menu.
2. Click Yes to confirm the removal.
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6 Modeling Processes
A process definition is complete, when it has a Start Node, at least one Exit Node and all nodes are
connected through arrows.
Once you have created a process definition, you are recommended to model your process with the
following sequence of steps.
1. Add all nodes that you need in your process definition.

For details, refer to section Adding and Editing Nodes on page 127.

2. Add the arrows to connect your nodes.
For details, refer to section Adding and Editing Arrows on page 131.

3. Optional: Add swimlanes to visually group activities performed by the same Role.
For details, refer to section Adding and Editing Swimlanes on page 134.

4. Optional: Add groups to visually group activities of the same category.
For details, refer to section Adding and Editing Groups on page 137.

5. Optional: If you want to make comments on your process definition, add annotations.
For details, refer to section Adding Annotations on page 140.

6. Optional: Define the owner of the process instances created from the process definition.
For details, refer to section Assigning Process Instance Owners on page 142.

7. Assign all activities to Roles.
For details, refer to section Assigning Activities to Roles on page 142.

8. Define the information that process participants need to access, modify, or add.
For details, refer to section Specifying User Defined Attributes on page 143.

9. Create forms and associate them with activities.
For details, refer to chapter Using Forms on page 174.

10. If you have added Voting Activity Nodes, define the voting rules.
For details, refer to section Defining Voting Rules on page 165.

11. If activities are due to be completed at a particular time, define a due date or timer for these
activities.
For details, refer to section Using Due Dates and Timers on page 152.

12. If the process is to start at a particular date, define a timer for the process definition.
For details, refer to section Defining Timers on page 154.

13. If you have added Delay Nodes, define a timer for them.
For details, refer to section Defining Timers on page 154.

14. If you have added Conditional Nodes or Complex Conditional Nodes, define the required conditions.
For details, refer to sections Defining Conditions on page 168 and Defining Complex Conditions
on page 171.

You can also use pre-defined process fragments to add pallette elements to your Process
Definition. Refer to Using Process Fragments on page 172 for more information.

Note:
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6.1 General Procedures
The following sections explain how to zoom, how to undo and redo changes, and how to print.

6.1.1 Using Undo and Redo
You can easily undo and redo changes to nodes, arrows, swimlanes, and groups.
To undo and redo a change:
• To undo the most recent change, right click the empty space in the Process Definition editor and

select Undo.
• If you decide you didn't want to undo the change, right click the empty space in the Process

Definition editor and select Redo.

6.1.2 Zooming
With zooming, you can increase or decrease the magnification of the Process Definition editor.
To zoom, do one of the following:
• To increase magnification, click the Zoom In button in the toolbar.
• To decrease magnification, click the Zoom Out button in the toolbar.
• Select a predefined zooming level in the toolbar.
• Type a zooming level in the toolbar's zooming text field. Press the <Enter> key to apply the

change.

Figure 76: Zooming Tools in the Toolbar

6.1.3 Printing Process Definitions
To print a process definition:
1. Open the process definition.
2. Select File > Print.
3. Check the printer settings and change them according to your needs.
4. Click OK.

6.2 Adding and Editing Nodes
The palette contains buttons for all types of nodes that you can add to your process definition. You
can move nodes and align them easily.
The following sections tell you how to add and remove nodes, how to define their basic properties
and how to align them.

You can also use pre-defined process fragments to add pallette elements to your Process
Definition. Refer to Using Process Fragments on page 172 for more information.

Note:
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6.2.1 Adding Nodes
For each node that you want to add to your process definition, select the type of node you want to
add from the palette. Make sure to add at least one Exit Node.
To add a node:
1. Display the process definition in the Process Definition editor.
2. Display the palette.

Figure 77: Using the Palette to Select the Type of Node

3. Click the type of node you want to add.
4. In the Process Definition editor, point to the area where you want to place the node. Click to add

the node.

6.2.2 Defining the Node Name and Description
You can change the default name of a node and provide a description.
To define the name and description for a node:
• To define the node name, select the node in the Process Definition editor. Click its name and

type the new name.
The node name cannot be longer than 64 characters.
For some nodes, e.g. for AND nodes, the node name is not displayed on the node symbol, but
you can type a name in the Properties view.

• To provide a description, select the node and type the description in the Properties view.
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6.2.3 Setting Activity Level Priority
You can set priority at the activity level for Activity Nodes, Voting Activity Nodes, and Compound
Activity Nodes. By default, an activity is given a priority of -1. However, its priority can be changed
to an integer greater than or equal to 0.
You can set priority at the activity level either through the General tab in the Properties view or by
using a Java Action. For more information on setting activity level priority using Java Action, refer to
section Setting Priority for an Activity on page 257.
To set activity priority through the General tab:
1. Select the node to display the Properties view for the nodes.
2. Select the General tab in the Properties view.
3. Enter the priority value in the Priority field. This will set the priority for the activity.

6.2.4 Aligning Nodes
You can align two or more nodes.
To align nodes:
1. In the Process Definition editor, select the nodes to be aligned. Keep the <Shift> or <Ctrl> key

pressed while selecting nodes.
2. Depending how you want to align the nodes, click one of the following buttons in the toolbar:

DescriptionButton

Aligns elements to the left edge of the element that you selected last (Align Left).

Aligns elements vertically through the middle of the elements (Align Center).

Aligns elements to the right edge of the element that you selected last (Align
Right).

Aligns elements to the top edge of the element that you selected last (Align
Top).

Aligns elements horizontally through the center of the elements (Align Middle).

Aligns elements to the bottom edge of the element that you selected last (Align
Bottom).
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Example
The following example shows how to align two nodes to the left edge.

Figure 78: Aligning Nodes to the Left Edge

You can also align nodes with swimlanes or groups. Select the nodes and swimlanes/groups to be
aligned and click the appropriate Align button in the toolbar. For information on how to work with
swimlanes, refer to section Adding and Editing Swimlanes on page 134; for information on how to
work with groups, refer to section Adding and Editing Groups on page 137.

6.2.5 Cutting, Copying and Pasting Nodes
You can cut, copy and paste some nodes at a time. As the Start Node is mandatory and there is
only one of it, you cannot cut the Start Node.
• To cut a node:

Select the node. Right click and select Cut from the pop-up menu.
The node is removed from the process definition along with its associated arrows.

• To copy a node:
Select the node. Right click and select Copy from the pop-up menu.

• To paste a node:
Select Edit > Paste.
The node is inserted near the original node.

When you paste a node that you copied or cut from another process definition, you need
to add all User Defined Attributes that the pasted node is using in the source process
definition.

Note:

6.2.6 Moving Nodes
You can move nodes from one location to another.
To move a node:
1. Select the node to be moved.
2. Drag the node to the desired location.

Interstage BPM Studio automatically adjusts all connected arrows.
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You can also move several nodes at once. Hold down the <Shift> key or <Ctrl> key to select all
nodes to be moved.

6.2.7 Removing Nodes
You can remove all nodes from your process definition except the Start Node.
To remove a node:
• Right click the node to be removed. Select Delete from the popup-menu.

The node is removed along with its associated arrows.

6.3 Adding and Editing Arrows
Arrows connect the nodes in your process definitions. With arrows, you define the flow of events.

You can also use pre-defined process fragments to add pallette elements to your Process
Definition. Refer to Using Process Fragments on page 172 for more information.

Note:

The following sections tell you how to add and remove arrows, how to define their basic properties
and how to change their shape.

6.3.1 Adding Arrows

Using the arrow button in the toolbar, you can draw arrows to connect nodes. Your process
definition must have at least two nodes before you can draw any connecting arrows. You cannot
draw an arrow that does not connect two nodes.
To add an arrow:
1. Click the Arrow button in the toolbar.
2. Move the cursor to the arrow’s source node. From the cursor's shape you can recognize where

you can start drawing the arrow.
3. Drag the cursor from the source node to the target node.
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Every node has several connection points for the arrow to snap in. You can see the connection
points when you point to the edges of the node.

Figure 79: Adding an Arrow

The arrow cursor is still active and you can draw as many arrows as you wish. To disable it, press
the <Esc> key or click the Select button in the toolbar.

6.3.2 Defining the Arrow Name
When you add an arrow, a default name for the action associated with the arrow is automatically
added. You can change the default name.

Note: • The outgoing arrows of the following nodes must have different names:
• Activity Node
• Voting Activity Node
• Compound Activity Node
• Conditional Node
• Complex Conditional Node
• Remote Subprocess Node.

• Naming arrows is especially important for Voting Activity Nodes, Conditional Nodes, and
Complex Conditional Nodes. These nodes use arrow names to route the process flow
according to criteria that you set.

To define the arrow name:
1. Select the arrow.
2. Click the arrow's name and type the new name.

Alternatively, you can type the new name in the Properties view.
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6.3.3 Changing the Arrow Shape
You can change the shape of an arrow dragging its bend points. Interstage BPM Studio automatically
adds additional bend points or removes bend points while you are dragging the arrow.
To change the arrow shape:
1. Select the arrow so that its bend points become visible.
2. To reshape the arrow, drag the bend points to the desired location.

Figure 80: Reshaping an Arrow

6.3.4 Reconnecting Arrows
You can change the source and the target of an arrow. For example, you might want an arrow to
snap to another connection point of a node.
To move an arrow:
1. If you want the arrow to start from another location, drag the starting point of the arrow to the

desired target.
2. If you want the arrow to point to another location, drag the arrow head to the desired target.

The outgoing arrows of the following nodes must have different names:Note:
• Activity Node
• Voting Activity Node
• Conditional Node
• Complex Conditional Node
• Remote Subprocess Node.
Therefore, you might need to change the arrow name before reconnecting the arrow.

6.3.5 Removing Arrows
To remove an arrow:
1. Select the arrow to be removed.
2. Right click and select Delete.
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6.4 Adding and Editing Swimlanes
With Interstage BPM Studio, you can use swimlanes to visually group activities performed by the
same Role.

You can also use pre-defined process fragments to add pallette elements to your Process
Definition. Refer to Using Process Fragments on page 172 for more information.

Note:

The following sections explain how to add and remove swimlanes, and how to change their
appearance.

6.4.1 Adding Swimlanes
To add a swimlane:
1. Display the process definition in the Process Definition editor.
2. Click the swimlane button in the palette.
3. In the Process Definition editor, drag to draw the swimlane.

Figure 81: Adding Swimlanes

6.4.2 Defining the Swimlane Title
The swimlane title typically indicates who performs the activities placed on the swimlane. You can
change the default title that is automatically generated when you add a swimlane.
To define a swimlane title:
1. Select the swimlane.
2. Click the swimlane's title and type the new title.

Figure 82: Defining the Swimlane Title

Alternatively, you can type the new title in the Properties view.

6.4.3 Aligning Swimlanes
You can align two or more swimlanes.
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To align swimlanes:
1. Select the swimlanes to be aligned. Keep the <Shift> or <Ctrl> key pressed while you click the

swimlanes.
2. Click one of the following buttons in the toolbar:

DescriptionButton

Aligns elements to the left edge of the element that you selected last (Align
Left).

Aligns elements vertically through the middle of the elements (Align Center).

Aligns elements to the right edge of the element that you selected last (Align
Right).

Aligns elements to the top edge of the element that you selected last (Align
Top).

Aligns elements horizontally through the center of the elements (AlignMiddle).

Aligns elements to the bottom edge of the element that you selected last
(Align Bottom).

You can also align nodes with swimlanes. Select the nodes and swimlanes to be aligned and click
the appropriate Align button in the toolbar.

6.4.4 Adjusting Swimlane Size
You can manually adjust the height and width of swimlanes. Also, you can scale swimlanes to the
same width or height.
To adjust swimlane size, do one of the following:
• To adjust the height and width manually:

a) Select the swimlane.
b) Point to one of the sizing handles and drag the swimlane to the new size.

• To scale swimlanes to the same width or height:
a) Select the swimlanes to be scaled. Keep the <Shift> or <Ctrl> key pressed while selecting the

swimlanes.
b) Click one of the following buttons in the toolbar:

DescriptionButton

Adjusts the height to the height of the swimlane that you selected last.

Adjusts the width to the width of the swimlane that you selected last.
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6.4.5 Changing Swimlane Color
To change the color of a swimlane:
1. Select the swimlane.
2. In the Properties view, select color.
3. Click the button that appears in the Value column to open the color palette.

Figure 83: Picking a Color from the Palette

4. Pick a color from the palette.
5. Click OK.

6.4.6 Changing Swimlane Style
You can place the swimlane title on the left-hand side or on the upper side of a swimlane.
You can change this setting for all swimlanes of a process definition.
To change swimlane style for swimlanes of a process definition:
1. Click the Process Definition editor to make it active.
2. Do one of the following:

• To place the title on the left-hand side, select Edit > Swimlane Style > Left.
• To place the title on the upper side, select Edit > Swimlane Style > Top.

You can set your preferred style for Process Definition editors that you open in the future. Select
Window > Preferences and then Interstage BPM Studio > Appearance.
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6.4.7 Cutting, Copying and Pasting Swimlanes
You can cut, copy, and paste a single swimlane at a time.
• To cut a swimlane:

Select the swimlane. Right click and select Cut from the pop-up menu.

• To copy a swimlane:
Select the swimlane. Right click and select Copy from the pop-up menu.

• To paste a swimlane:
Select Edit > Paste.
The swimlane is inserted near the original swimlane.

6.4.8 Moving Swimlanes
You can move swimlanes from one location to another.
To move a swimlane:
1. Click the swimlane to be moved.
2. Drag the swimlane to the desired location.

You can also move several swimlanes at once. Hold down the <Shift> key or <Ctrl> key to select all
swimlanes to be moved.

6.4.9 Removing Swimlanes
To remove a swimlane:
1. Select the swimlane.
2. Right click and select Delete from the pop-up menu.

6.5 Adding and Editing Groups
With Interstage BPM Studio, you can use groups to visually group activities according to custom
categories.
The following sections explain how to add and remove groups, and how to change their appearance.

6.5.1 Adding Groups
To add a group:
1. Display the process definition in the Process Definition editor.
2. Click the group button in the palette.
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3. In the Process Definition editor, drag to draw the group.

Figure 84: Adding Groups

6.5.2 Defining the Group Title
The group title typically indicates the category of activities that are grouped. You can change the
default title that is automatically generated when you add a group.
To define a group title:
1. Select the group.
2. In the Properties view, enter a new title in the name field.

6.5.3 Aligning Groups
You can align two or more groups.
To align groups:
1. Select the groups to be aligned. Keep the <Shift> or <Ctrl> key pressed while you click the groups.
2. Click one of the following buttons in the toolbar:

DescriptionButton

Aligns elements to the left edge of the element that you selected last (Align
Left).

Aligns elements vertically through the middle of the elements (Align Center).

Aligns elements to the right edge of the element that you selected last (Align
Right).

Aligns elements to the top edge of the element that you selected last (Align
Top).

Aligns elements horizontally through the center of the elements (AlignMiddle).

Aligns elements to the bottom edge of the element that you selected last
(Align Bottom).

You can also align nodes with groups. Select the nodes and groups to be aligned and click the
appropriate Align button in the toolbar.
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6.5.4 Adjusting Group Size
You can manually adjust the height and width of groups. Also, you can scale groups to the same
width or height.
To adjust group size, do one of the following:
• To adjust the height and width manually:

a) Select the group.
b) Point to one of the sizing handles and drag the group to the new size.

• To scale groups to the same width or height:
a) Select the groups to be scaled. Keep the <Shift> or <Ctrl> key pressed while selecting the

groups.
b) Click one of the following buttons in the toolbar:

DescriptionButton

Adjusts the height to the height of the group that you selected last.

Adjusts the width to the width of the group that you selected last.

6.5.5 Cutting, Copying and Pasting Groups
You can cut, copy, and paste a single group at a time.
• To cut a group:

Select the group. Right click and select Cut from the pop-up menu.

• To copy a group:
Select the group. Right click and select Copy from the pop-up menu.

• To paste a group:
Select Edit > Paste.
The group is inserted near the original group.

6.5.6 Moving Groups
You can move groups from one location to another.
To move a group:
1. Click the group to be moved.
2. Drag the group to the desired location.

You can also move several groups at once. Hold down the <Shift> key or <Ctrl> key to select all
groups to be moved.

6.5.7 Removing Groups
To remove a group:
1. Select the group.
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2. Right click and select Delete from the pop-up menu.

6.6 Adding Annotations
You can add annotations to make comments on your process definition and explain important aspects
of your process design.
To add an annotation:
1. Display the process definition in the Process Definition editor.
2. Click the annotation button in the palette.
3. In the Process Definition editor, drag to draw the annotation.
4. Click the annotation and type your comments.
5. If the annotation refers to a particular node, you can connect them to visually represent their

relation. To do so:
a) Click the Arrow button in the toolbar.
b) Drag the cursor from the annotation to the node it refers to.
The following example shows an annotation that has been connected to a node.

Figure 85: Adding Annotations and Connecting them to Nodes

You can connect only one annotation to a node.Note:

6. You can resize the annotation as follows:
a) Select the annotation.
b) Point to one of the sizing handles and drag the annotation to the new size.

6.7 Enabling Recall for Nodes
The recall functionality provides you with the option to enable or disable recall for completed work
items. By default recall is enabled. This feature is available only for Activity, Voting, Delay and Trigger
Nodes.
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Note: • Only completed work items can be recalled.
• Only single level recall of work item is possible. Multiple level recall of work items cannot

be done.

To enable recall for an activity:
1. Select the Activity, Voting, Delay or Trigger Node to display the Properties view for the node.
2. In the General tab, select or clear the Enable Recall? check box to enable or disable recall

respectively.

6.8 Enabling Future Work Items on Activity Node
Future Work Items are the work items that the users may be assigned in future. As a user, Future
Work Items help you to be aware of work items that may be assigned to you later so you can plan
your tasks in advance.
Future Work Items generated for a user may not be accurate since task assignment can vary during
the process execution.
Future Work Items are displayed as a list for a particular user. User cannot actually accept them or
reject them or perform any kind of actions on them since these are displayed as a read-only list.

Future Work Items are generated only on activity nodes.Note:

To enable Future Work Items on an activity node:
1. Open the process definition.
2. Select the activity node on which you want to enable Future Work Items.
3. In the General tab of Properties view of the activity, select the checkbox Enable Future

Workitem.

Future Work Items cannot be set for the activity nodes that have Agents defined on them.Note:

Future Work Items cannot be set for the activity nodes configured as Iterator Nodes.Note:

4. Save the process.
The following figure shows how Future Work Items can be enabled on an activity node:

Figure 86: Enabling Future Work Items
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6.9 Assigning Process Instance Owners
Process instance owners can edit the process instances that they own while the process instances
are running.
By default, the owner of the process definition is the owner of the process instances that are created
from the process definition. However, you can assign process instance ownership to another Role.
To assign process instance owners:
1. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
2. Select the General tab in the Properties view.
3. Type the name of the Role in the Owner field in the Process Instance Owner area. This will

assign the process instance to the owner.

Figure 87: Assigning Process Instance Owners

6.10 Assigning Activities to Roles
When modeling an activity, you assign it to a Role according to who is responsible for completing
the activity. Each activity (that is each Activity Node, Voting Activity Node, and Compound Activity)
must be assigned to a Role. If an activity is not assigned, the process instances created from the
process definition will go into error state.
You can assign an activity
• To a Role
• To particular users in a Role
This section explains how to assign activities to Roles. Refer to section Assigning an Activity to a
User on page 251 for instructions on how to assign an activity to particular users.
To assign activities to roles:
1. Select the Activity Node, Voting Activity Node, or Compound Activity .
2. In the General tab of the Properties view type the name of the role, in the Role field in the

Assignee area.
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6.11 Configuring Work Item Generation
At run time, when an Activity Node or Compound Activity becomes active, work items are generated
and assigned to the users having the Role to which the Activity Node has been assigned. The number
of generated work items depends on how the Activity Node has been configured. These are the
options:
• Individual Work Items

By default, one work item is generated for every user having the Role to which the Activity Node
has been assigned. As soon as a user accepts the work item, the other work items associated
with the activity are set inactive. This way, Interstage BPM prevents users from duplicating each
other's work.

• Group Work Item
As an alternative, one work item is generated for the entire group of users having the Role. Any
user of the group can work on the activity by accepting the group work item.
Group work items are especially useful in case of frequent changes to the users having a Role
and when many users are having one and the same Role (for performance reasons).

To configure work item generation for an Activity Node:
1. Select the Activity Node or Compound Activity to display the Properties view for the node.
2. In the Assignee area, check the setting of Expand Groups:

• If you want individual work items to be generated, make sure that the check box is selected.
• If you want a group work item to be generated, clear the check box.

6.12 Specifying User Defined Attributes
User Defined Attributes (UDAs) contain the data that process participants need to access, modify
or add. UDAs are global variables that are defined on process definition level so that all nodes within
a process instance can access all UDAs. Using UDAs, you can specify the behavior of nodes and
store data for process execution. UDAs are unique across a process definition so that two different
process definitions can have the same identifier.
UDAs hold values in a running process. Process participants provide the values through forms,
JavaScripts or Java Actions. UDAs consist of a name and an identifier (ID). Both values are stored
in the database. By default, UDA identifiers are automatically set by the system. However, you can
also specify your own identifiers. For every user interaction, the UDA name is used. Whenever
necessary, the name is automatically mapped to the UDA identifier. The identifier is used for all
purposes that do not allow special characters, for example when creating QuickForms or using
JavaScript.
For example, a purchase requisition process might have UDAs for the article to be purchased, the
quantity and cost. You can set the values by filling in a form.
To specify User Defined Attributes:
1. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
2. Select the User Defined Attributes tab.
3. Click Add. Specify the following parameters:
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DescriptionField

Name of the UDA
The UDA name is descriptive and user-defined. It can contain up
to 64 characters, including special characters. The name must not
start with two underscores (__) because two underscores are used
as a prefix of UDAs created and maintained by the system.

Name

Identifies a UDA by providing a unique name.
By default, UDA Identifiers are system-generated. However, you
can also specify your own IDs. UDA Identifiers can contain up to
32 characters. Identifiers must not contain any special characters
(all characters except 'a' - 'z', 'A' - 'Z', '0' - '9').
If you do not specify a value for the ID, it is formed automatically
by taking the name and removing all of the characters except for
ASCII letters. This process is called "UDA sanitization". If the
"sanitized name" (ID) is longer than 32 characters, empty or not
unique, the ID will be composed of the prefix 'uda<number>', for
example 'uda1'. The number is incremented by one each time a
new ID is created. Refer to the Interstage Business Process
Management Server Administration Guide for more details.
Note: The Identifier field is only displayed if you select the Show
Identifier check box in the Properties view.

Identifier

UDA data types
You can distinguish the following data types: BIGDECIMAL,
BOOLEAN, DATE, FLOAT, INTEGER, LONG, STRING, XML

Type

Initial value of the UDA
Process participants can change this value. If you select a UDA
of type XML, two additional buttons are displayed. You can use
these buttons to configure the XML data type. For more information,
refer to section Specifying User Defined Attributes of Type XML
on page 147.
You can set an initial value within the following ranges:
• INTEGER Type:

• Max Value: 2147483647
• Min Value: - 2147483648

• LONG Type:
• Max Value: 9223372036854775807
• Min Value: - 9223372036854775808

• Float Type: The number of significant figures is 8.
• BIGDECIMAL Type: The number of significant figures is 17.

Initial Value
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DescriptionField

This column is only used with ARIS Process Performance Manager
(PPM). It indicates whether the UDA will be exported to ARIS PPM
and how it is used by ARIS PPM.
If you want the UDA to be exported, specify whether the UDA is
to be interpreted as a dimension or as a measure. For more
information, refer to the ARIS Process Performance Manager
Integration Guide.
If you don't want the UDA to be exported, use the default value
NONE.
If you are not using ARIS PPM, you can ignore this column.

Attributes

Indicates if the UDA is a Worklist UDA. Worklist UDAs allow
process participants to filter and sort the worklist and to retrieve
worklist items faster. If you select a UDA of type XML, this column
will be disabled.
Note: Worklist UDAs of type STRING cannot have values that are
longer than 256 characters.

Worklist

Enables or disables UDA tracking.
If you enable UDA tracking, changes made to any UDA value
during process execution will be recorded.
Note: When designing the process definition, you define the initial
setting for all process instances created from that process definition.

Trackable

4. Repeat the last step for each UDA that you want to specify.
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The following screen shows the Properties view for an Activity Node, in which three UDAs have
been specified for the node:

Figure 88: Specifying UDAs

5. If you want to display the UDA identifiers, select the Show Identifier checkbox.
A new Identifier field is added to the User Defined Attributes tab. You can specify new IDs or
change the IDs of existing UDAs.
• Specify a new ID: Select an empty row in the Identifier field, and type in a new ID.
• Change an existing ID: Select an existing ID in the Identifier field, and type in another ID.

If you change an ID, make sure that you also update the IDs that are referenced in Javascript
expressions, QuickForms, or data mappings.

Note:

If you do not display the UDA identifiers, or leave the identifier fields empty, Interstage BPM
automatically generates default identifiers (for example, 'Variable1', 'Variable2',
'Variable3').

6. If you want to rename a UDA, double-click its name and change it as required.
7. If you want to remove a UDA, select it and click Remove.

You can select multiple UDAs using the <Shift> or <Ctrl> keys.

You cannot rename or remove UDAs that are referenced in the process definition. If a UDA
cannot be renamed or removed, a message is displayed telling you so. The message also
displays the locations where the UDA is being used.

Note:
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6.12.1 Specifying User Defined Attributes of Type XML
In Interstage BPM Studio, you can create User Defined Attributes (UDAs) of type XML to enhance
the flexibility of the system.
XML data types allow you to invent as many different elements and attributes as you need. In addition,
UDAs of type XML are easy to use, unlimited and self-defining.
To specify a UDA of type XML:
1. Click the empty space in the Process Definition editor or select a node, to display the Properties

view for the process definition or the selected node respectively.
2. Select the User Defined Attributes tab.
3. Click Add, and select XML as type for the UDA.

In the Properties view, the Initial Value column displays the XML and XML Schema buttons. If
you select a non-XML UDA type, these buttons are not available.

Figure 89: Displaying UDAs

UDAs of type XML cannot be Worklist UDAs. Hence, if you select a UDA of type XML, the
Worklist column will be disabled.

Note:

4. In the Name and Identifier fields, specify the general parameters for the UDA of type XML.
Refer to section Specifying User Defined Attributes on page 143 for a detailed description of these
parameters.

5. In the Initial Value column, select the XML button.
The UDA Value Editor dialog is displayed.

6. Type in a value for the UDA, or browse for an XML file.
• Type in a UDA value: In the UDA Value field, type in a value for the UDA.
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• Browse for a file: Click the Browse button to select a file from the local file system. The UDA
Value Editor dialog displays the content of the file. Select a value from the content of this file,
and click OK.
The following example shows how to specify an XML value in the UDA Value Editor dialog:

Figure 90: Specifying a UDA value

7. Optional: In the Initial Value column, select the XML Schema button.
The XML Schema Editor dialog is displayed. You can use this dialog to type in an XML Schema
for the UDA, or browse for a schema file (.xsd) in the local file system.

8. Type in an XML Schema for the UDA, or browse for an XML file.
• Type in an XML Schema: In the XML Schema field, type in the XML Schema for the UDA.
• Browse for a file: Click the Browse button to select a file from the local file system. The XML

Schema Editor dialog displays the content of the file. Select a value from the content of this
file, and click OK.
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The following example shows how to specify an XML Schema in the XML Schema Editor dialog:

Figure 91: Specifying an XML Schema

9. Repeat the last step for all UDAs of type XML that you want to specify.
Similarly to all other UDA types, you can do the following:
• Display the UDA identifier: If you want to display or change the UDA identifier, select the

Show Identifier check box. The identifiers are then displayed in a separate Identifier column.
• Rename the UDA: If you want to rename the UDA, double-click its name and type in a new

name.
• Remove a UDA: If you want to remove a UDA, select it and click Remove.

6.13 Configuring Node as Iterator Node
In Process Definitions, a node may need to generate multiple node instances to eliminate the need
of creating individual nodes. Multiple node instances can also be assigned to multiple users by
defining only a single node.
For example, in a Process Definition for Order Management, it is required that the same activity (say
Approval) be repeated for all items that are part of an Order. Configuring the ‘Approval’ activity node
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as an Iterator Node will help avoid the need to add a new activity node for each Order item in the
Process Definition.
A node that generates multiple node instances is called an Iterator Node. While designing the Process
Definition, you can specify the number of node instances to be generated for a node by selecting a
UDA of type Integer.

If a specified UDA for an iterator node does not exist, process validation will fail and no
process instance can be started from the process definition until the UDA is added.

Note:

The number of node instances the selected node generates is equal to the number value returned
by the selected UDA. The maximum value that can be set for this UDA is 200.

You can configure a node as an Iterator Node only on Activity Node, Subprocess Node and
Chained-Process Node.

Note:

To configure a node as an Iterator Node
1. Select the node that you want to configure as an Iterator Node.
2. In General tab of Properties view, select the Integer type UDA for the value of count in Count

drop-down list under Iterator Setting.
The integer value returned by the selected UDA is considered as the count value for generating
the node instances.

If you do not select any UDA in the Count drop-down list, the selected node will not be
configured as an Iterator Node.

Note:

The Iterator Node is graphically represented as three vertical parallel lines in the node. The Activity
Iterator Node, Subprocess Iterator Node and Chained-Process Iterator Node are represented as
shown in the figures below.

Figure 92: Activity Iterator Node

Figure 93: Subprocess Iterator Node

Figure 94: Chained-Process Iterator Node

Interstage Business Process Manager Studio User's Guide 150

6: Modeling Processes



6.14 Using Compound Activity Node
When you want to refer to the process state in terms that are larger in scope than its individual
activities, a Compound Activity Node is used. A Compound Activity Node is a container that contains
various nodes and arrows.
A Compound Activity Node contains child nodes. A Compound Activity Node must have a child Start
Node and at least one child Exit Node. Also, no arrow transition is allowed from child nodes inside
the Compound Activity Node to the nodes outside the compound activity.
A compound activity is just like any other process definition. A Compound Activity Node can have
any node except another compound node.
Following are the features of a Compound Activity Node:
• You can resize a Compound Activity Node by selecting it and dragging its boundaries.
• You must define the arrow of the same name as that of the Exit node defined in Compound

Activity as the outgoing arrow of the Compound Activity.
• A Compound Activity Node can have only one Start node.
• Default name of a Compound Activity Node is Compound Activity 1. Suffix digit is incremented

according to the creation of compound nodes in a process definition.
• Compound Activity Node does not support Iterator Node, Recall, Voting, Triggers.
• You can add the following to a Compound Activity Node:

1. UDAs: Refer Specifying User Defined Attributes on page 143 for more details.
2. Action Set: Refer Using Java Actions on page 233 for more details.
3. Timers: Refer Using Due Dates and Timers on page 152 for more details.
4. Due Date: Refer Using Due Dates and Timers on page 152 for more details.
5. Forms: Refer Using Forms on page 174 for more details.
6. Priority: Refer Setting Activity Level Priority on page 129 for more details.

Refer Creating Compound Activity Node on page 151 to know how you can create a Compound
Activity Node.

6.14.1 Creating Compound Activity Node
To create a compound activity:
1. Open a process definition.
2. Click Compound Activity in the Palette and then click in the editor.

A Compound Activity Node area is displayed in the editor with a child Start node in it.

3. Do any one of the following while creating a new process definition or editing an existing process
definition:
• Create child nodes within the Compound Activity Node as you normally create the nodes using

the Palette and connect them using arrows.
• Drag the boundaries of the Compound Activity Node so that its area covers any required

existing nodes of the process definition. The nodes covered by the boundaries of the Compound
Activity Node are treated as its child nodes.

If all the four corners of a node are moved into the Compound Activity Node area then that
node is treated as a child node. You can select a child node and drag it outside the
Compound Activity Node area to exclude it from the Compound Activity Node.

Note:
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There should be at least one child Exit node inside the Compound Activity Node.Note:

The number of Exit nodes inside the Compound Activity Node and the number of outgoing
arrows from the Compound Activity Node should be the same.

Note:

When you move the Compound Activity Node, nodes and arrows inside the Compound
Activity Node also move together. But Swimlanes, Annotation and Groups do not move
together. Delete operation is similar.

Note:

4. Connect the Compound Activity Node to the node outside the compound activity.

The name of the child Exit node should be same as that of the arrow connecting the
compound activity and the node outside the Compound Activity Node.

Note:

5. Click Save to save the process.
The following figure shows the Compound Activity Node:

Figure 95: Compound Activity Node

6.15 Using Due Dates and Timers
Due dates specify when an activity is due to be completed once it has become active. They also
specify what will happen when the due date is reached and the activity has not been completed. For
example, the activity could be escalated to other users or an email could be sent. Due dates can be
defined for Process Definitions, Activity Nodes, Voting Activity Nodes, and Compound Nodes.
Timers trigger certain actions when they expire. They can be used, for example, with Delay Nodes
to suspend process execution for a certain amount of time. Timers may operate only once or
repeatedly. They can be defined for the process definition as a whole, for individual activities (Activity
Nodes, Voting Activity Nodes, and Compound Nodes), for Delay Nodes, and for Trigger Nodes.
When defining due dates and timers, you specify an absolute or relative time. A relative time can be
based on the regular calendar or on a business calendar that counts only business hours.
The following sections explain how to define due dates and timers. They also provide instructions
on using your own business calendars.

6.15.1 Defining Due Dates
When defining a due date, you can choose between the following due date types:
• Absolute: Sets the due date to an absolute time, for example to January 1, 2007, 00:00:00.
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• Calendar: Sets a relative due date based on the regular calendar. The due date is calculated
relative to the time the activity becomes active. The time is counted using all seven days of the
week and 24 hours of the day. As such, they can expire outside the normal business hours.

• Business: Sets a relative due date based on a business calendar. The time is counted using
only business days and hours. This ensures that activities are due only during normal business
hours.
Interstage BPM determines business days and hours using a business calendar. Refer to section
Creating Your Own Business Calendars on page 161 for more information on business calendars.

• Advanced: Sets the due date according to an expression that you specify. The expression defines
an absolute or relative due date. The time can be counted using the regular calendar or a business
calendar.

To define a due date:
1. Do any of the following:

• Select the Activity Node, Voting Activity Node, or Compound Activity Node to display the
Properties view for the nodes.

• Click in the blank space of the editor of the Process Definition to display the Properties view
for the Process Definition.

2. Select the Due Date tab.
3. Specify one of the following due date types:

• An absolute date based on the regular calendar.
Select Absolute and type the date and time.

While setting the Absolute time (Year, Month, Day, Time), if the value of time is larger than
that 24:00:00, it is converted as a day, and added to the Day field.

Note:

To define expiration time as an expression, you can enter the Java Script expression in the
Expression field. Refer Defining Timers on page 154 for details.

Note:

• A relative date based on the regular calendar.
Select Calendar and specify after how many days and at what time the activity is due to be
completed once it has become active.

While setting the Calendar timer (Day, Time), if the value of time is larger than that 24:00:00,
it is converted as a day, and added to the Day field.

Note:

To define expiration time as an expression, you can enter the Java Script expression in the
Expression field. Refer Defining Timers on page 154 for details.
The maximum value of the Calendar timer (Day, Time) is the following : Calendar timer
(Day, Time) is converted into the millisecond. This value is not to exceed the
Long.MAX_VALUE.

Note:

• A relative date based on the business calendar. Select Business and specify after how many
business days and at what business time the activity is due to be completed once it has become
active.
For the business time, you have different options. You can specify an absolute time, a time
relative to the current time, a time relative to opening time, or a time relative to closing time.
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• An absolute or relative date specified with an expression. Select Advanced and type the
expression.

If you set the expression in Advanced timer and if this expression is expressible as Business
timer then this expression is displayed as the Business timer.

Note:

For details on date codes that you can use in the expression, refer to section Time and Day
Codes for Advanced Due Dates and Timers on page 160.

4. Click Add and select the Java Actions to be executed when the due date is reached and the
activity has not been completed.
By default, an empty Timer Actions folder is displayed. You can add regular Java Actions, Error
Actions, and Compensation Actions to the Action list. For information on Java Actions, refer to
section Using Java Actions on page 233.
The following dialog shows an example of a due date. If the activity is not completed after three
business days, an email is sent.

Figure 96: Defining a Due Date

6.15.2 Defining Timers
Timers trigger certain actions when they expire. They may execute only once or repeatedly. You can
use timers with the following elements:
• Process Definitions

These timers start running whenever a new process instance is created from the process definition
containing the timer.

• Activity Nodes, Voting Activity Nodes, Compound Activity Nodes, and Trigger Nodes
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These timers start running when the node becomes active.

• Delay Nodes
Timers are used with Delay Nodes to suspend process execution for a certain amount of time.
These timers start running when the Delay Node becomes active.

Before a timer starts, it calculates an expiration time based on its settings. The timer is
supposed to execute at its expiration time, and it usually does. If, however, the calculated
expiration time is in the past relative to the timer start time, timers that execute only once
will execute upon starting, and a periodic timer will fail to execute. A timer having an expiration
time before its start time is considered an error, so the timer’s process instance will go into
error state. Periodic Timers must have expiration times that are in the future because they
represent a repeating loop that could become an infinite loop in such a case.

Note:

When defining a timer, you can choose between the following timer types:
• Absolute: Sets the absolute time when the timer will expire, for example, January 1, 2007,

00:00:00. Absolute time can either be set in the UDAs (Year, Month, Day, Time format) or to the
value defined in the Java Script expression. If you set absolute time in both (Year, Month, Day,
Time format and Java Script expression) and for example, the Java Script expression returns the
value of 4 hours then the Absolute timer will expire after 4 hours from the node activation time.
Java Script expression will automatically take the node activation date and time after the node is
activated. If you do not define the Java Script expression or the Java Script expression returns
an invalid value, Absolute timer will expire at the absolute time defined in the Year, Month, Day,
Time format (UDAs).

• Calendar: Sets the duration after which the timer will expire based on the regular calendar. The
time is counted using all seven days of the week and 24 hours of the day. As such, they can
expire outside the normal business hours. These timers start when the time set in the UDAs (days
and hours) is elapsed after the node or process instance to which they are assigned becomes
active. The time for Calendar timer can also be set relative to the value defined in the Java Script
expression. Java Script expression can be defined to return a value (for example, date) which
will be taken as the reference for the time set in the days and hours fields (UDAs). If both the
values (UDAs and Java Script expression) are set then the value returned by the Java Script
expression will be taken as the reference and the value from the UDAs will be taken as the relative
time. The timer will expire after the time set in the UDAs is elapsed starting from the date and
time set in the Java Script expression. If Java Script expression is not set, timer will expire after
the time set in the UDAs is elapsed from the time when the node to which it is assigned becomes
active.

• Business: Sets the duration after which the timer will expire based on a business calendar. These
timers start when the node or process instance to which they are assigned becomes active. The
time is counted using only business days and hours. These timers can expire only during normal
business hours.
Interstage BPM determines business days and hours using a business calendar. Refer to section
Creating Your Own Business Calendars on page 161 for more information on business calendars.

• Advanced: Sets the timer according to an expression that you specify. The expression defines
an absolute or relative timer. The time can be counted using the regular calendar or a business
calendar.
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To define a timer:
1. Do one of the following:

• To define a timer for a process definition, click the empty space in the Process Definition editor
to display the Properties view for the process definition.

• To define a timer for a node, select the node in the Process Definition editor to display the
Properties view for the node.

You can also select the Delay Node from the Palette and drag and drop it on the relevant
Activity Node or Voting Activity Node. Then you need to enter a name for the timer and
define its properties later on using the Properties view for the node.

Note:

2. Select the Timers tab.
3. Click Add in the All Timers area, to add a new timer.

This displays the Timer Details area where you can customise the settings for the timer.

4. By default, the new timer is named as Timer1, you can modify the name in the Name field.
5. To modify details for the timer, make sure that the timer is selected in the All Timers list.
6. Optional: Describe the purpose of the timer in the Description field.
7. To set the timers, do any of the following per requirements:

• If you want to set the Absolute timer based on the regular calendar:
1. Select Absolute timer in the Type drop-down list of the Timer Details area.
2. Enter year, month, day and time in Year, Month, Day and Time fields respectively. These

are the UDA values for the timer.
3. To define expiration time as an expression, enter the Java Script expression in the

Expression field. Click the A+B... button to define the Java Script Expression. You can
either directly enter the Java Script expression in the Expression field or clickA+B... button
to build it. Upon clicking the A+B... button, Interstage BPM Expression Builder dialog is
displayed. Build the Java Script expression using the operands and operators in this dialog.
For example, DateAdd(Packages.java.util.Date(), 4, \"hh\")will expire the Absolute
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timer after 4 hours from the node activation time. The following figure shows Expression
and A+B... fields for Absolute timer.

Figure 97: Defining an Absolute Timer

The following figure shows the Interstage BPM Expression Builder.

Figure 98: Building Java Script Expression
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While setting the Absolute time (Year, Month, Day, Time), if the value of time is larger than
that 24:00:00, it is converted as a day, and added to the Day field.

Note:

• If you want to set the Calendar (relative) timer based on the regular calendar:
1. Select Calendar timer in the Type drop-down list of the Timer Details area.
2. Specify after how many days and hours the timer needs to expire. For example, if you want

the timer to expire after 2 days and 3 hours from the time when the node is activated or
from the time defined by the reference value returned by the Java Script expression, enter
2 days and 03.00.00 in the respective fields. These are the UDA values for the Calendar
timer.

3. To set the Calendar timer to execute repeatedly, select the Periodic checkbox. Specify
the interval at which you want the timer to expire. Periodic Calendar timer is a periodic
timer based on the regular calendar. If the Periodic checkbox is not selected, the Calendar
timer executes only once.

4. If you want to set a reference value for the relative UDA values using the Java Script
expression, define the expiration time as an expression as explained in the third step of
the Absolute timer. Calendar timer will take the value returned by the expression as the
reference value and add the UDA value to it to calculate the expiration time. For example,
if you set 2 days in the Days field then uda.get("RequestDate") expires the Calendar
timer after 2 days from the date returned by the UDA ("RequestDate"). The value of
RequestDate is the long value shown in Date class.

While setting the Calendar timer (Day, Time), if the value of time is larger than that 24:00:00,
it is converted as a day, and added to the Day field.

Note:

The maximum value of the Calendar timer (Day, Time) is the following: Calendar timer (Day,
Time) is converted into the millisecond. This value is not to exceed the Long.MAX_VALUE.

Note:

• If you want to set a relative timer based on the business calendar:
1. Select Business timer in the Type drop-down list of the Timer Details area and specify

after how many business days and at what business time the timer is to expire. For the
business time, you have different options. You can specify an absolute time, a time relative
to the current time, a time relative to opening time, or a time relative to closing time.

2. To set the Business timer to execute repeatedly, select the Periodic checkbox. Specify
the interval at which you want the timer to expire. Business timer is a periodic timer based
on the business calendar. If the Periodic checkbox is not selected, the Business timer
executes only once.

• If you want to set an absolute or relative timer specified with an expression:
1. Select Advanced timer in the Type drop-down list of the Timer Details area and type the

expression in the Set Expression field. For details on date codes that you can use in the
expression, refer to section Time and Day Codes for Advanced Due Dates and Timers on
page 160.

2. To set the Advanced timer to execute repeatedly, selectAdvanced and select the Periodic
checkbox. Specify the interval at which you want the timer to expire. If thePeriodic checkbox
is not selected, the Advanced timer executes only once.

If you set the expression in Advanced timer and if this expression is expressible as Business
timer then this expression is displayed as the Business timer.

Note:
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Periodic timers are always relative to a given event. The first operation of a periodic timer
is relative to the time when the process instance or the node becomes active. Subsequent
operations are relative to the last operation.

Note:

8. Click Add and select the Java Actions to be executed when the timer is expired.
You can add regular Java Actions, Error Actions, and Compensation Actions to the Action list.
For more information on Java Actions, refer to section Using Java Actions on page 233.
The following figure shows a timer that expires after one business day. When the timer expires,
the activity is escalated.

Figure 99: Defining a Timer

For each timer that you define, one or multiple User Defined Attributes (UDAs) are created. The UDA
names identify the timer and the timer action.
For example, a typical UDA name might be __atmr_publication_time. The prefix __atmr identifies
this as a timer, the middle term publication contains the name of the timer, and the suffix time
identifies the function of the UDA.
These UDAs can be modified on a form, through a Java Action, or through a JavaScript.
You can check which UDAs belong to a timer by clicking Advanced on the Timers tab.
When a Make Choice Java Action has been defined for a timer and an arrow name has been defined
as the choice item for this Java Action, the following symbol is added to this arrow connecting the

Activity Node or Voting Activity Node or Compound Activity Node with another node: .

Interstage Business Process Manager Studio User's Guide 159

6: Modeling Processes



6.15.3 Time and Day Codes for Advanced Due Dates and Timers
Advanced due dates and timers are defined using expressions. In these expressions, you can use
codes to specify the time and/or day. This section describes the time and day codes.

Time Codes

ExampleMeaningCode

AT(16:30:00): 4:30pm on that day.Sets the absolute time of the day.AT

CT(00): Closing time.
CT(-02:00:00): 2 hrs before the closing
time.

Sets the business time relative to the
closing time of the day.
Allowed values: 00 or negative hours.
Typically you will use negative hours with
closing time in order to calculate a
relative time before closing time.

CT

OT(00): At the opening time.
OT(02:00:00): 2 hrs after the opening time.

Sets the business time relative to the
opening time of the day.
Allowed values: 00 or positive hours.

OT

BT(04:30:00): After 4 & 1/2 business hours
from the current time.
BT(-02:00): 2 business hours earlier.
BT(00): Use this to search forward to the
next business time, without changing the
time if the current time is not a business
time. You may need this if different
business days have different hours.
BT(-00): Use this to search backward to
the last previous business time. Has no
effect if the current time is already during
business time.

Sets the business time relative to the
current time of the day.

BT

Day Codes

ExampleMeaningCode

BD(4): Four business days from today.
BD(0): Same day if it is a business day,
else the next day.
BD(-0): Same day if it is a business day,
else the previous day.

Sets a business day.BD

RD(7): After one week.
RD(-1): One day earlier.

Sets a relative day from the current day.RD
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ExampleMeaningCode

WD(1): Sunday of that week.
WD(7): Saturday of that week.

Sets a day of the week.
Allowed values: 1 to 7.

WD

WN(1): The next Sunday after today.
WN(7): The next Saturday after today.

Sets the next weekday after today.
Allowed values: 1 to 7.

WN

RM(3): After 3 months.Sets a relative month in the future. If the
month does not have enough days to be
the same day, the day will be the last day
of the month.

RM

DM(1): The first day of the month.
DM(-1): The last day of the month.

Sets an exact day of the month.
Allowed values: Any number except 0.

DM

BM(1): The first business day of the month.
BM(-1): The last business day of the
month.

Sets an exact business day of the month.
Allowed values: Any number except 0.

BM

DY(1): The first day of the year.
DY(-1): The last day of the year.

Sets a day of the year.
Allowed values: Any number except 0.

DY

BY(1): The first business day of the year.
BY(-1): The last business day of the year.

Sets a business day of the year.
Allowed values: Any number except 0.

BY

6.15.4 Creating Your Own Business Calendars
When defining due dates and timers, you can use a business calendar instead of a regular calendar.
A business calendar defines the business hours and days of an organization. Using a business
calendar ensures that timers expire during business hours only. The same applies for due dates;
business calendars ensure that activities are due during business hours only.
Interstage BPM Studio provides a fully functional default business calendar. You can modify the
default business calendar or you can create your own business calendars. You may create as many
business calendars as necessary to meet the needs of your organization. For example, if your
organization has divisions in multiple states that have different business hours and public holidays,
you create a business calendar for each state.
To create a business calendar:
1. In your Workflow Application project, right click the Calendar folder and select New > Calendar.
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The New Calendar dialog is displayed. The Project field automatically shows the name of the
Workflow Application project for which you want to create the business calendar.

Figure 100: Displaying the New Calendar dialog

2. If you want to select a different project, click Browse.
The Folder Selection dialog is displayed. Select a project directory for the new calendar file. The
default name of your calendar file is <your name>.cal. The .cal extension indicates that this
is a business calendar. Calendars are like properties or .ini files that specify business days and
hours.

3. Select the project where the new calendar file is to be saved, and click OK.
If the file name already exists, type in a new name to avoid a file name conflict.

4. In the Name field, type in a name for the new calendar file, and click Finish.
The new calendar (.cal) file is automatically stored in theCalendar folder of the selected project.
The following figure shows the location of the new myNewBusinessCalendar.cal file:

Figure 101: Location of a new calendar file
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The new file automatically opens in the text editor you have specified for opening .cal files. The
default calendar file is stored in the C:\fujitsu\InterstageBPM_studio\ibpm\Data\calendar
directory. The file looks as follows:

EVERYDAY=8:00,18:00;
SAT=;
SUN=;
2003/01/01=;
2004/01/01=;
2005/01/01=;
2006/01/01=;
2007/01/01=;
2008/01/01=;
2009/01/01=;
2010/01/01=;
CALENDAR_END=2010/12/31;
CALENDAR_BEGIN=2003/01/01;
TIMEZONE=-8:00;

5. Define your business calendar.
You can use the default calendar file as an example. For a detailed explanation of the business
calendar format, refer to the Interstage Business Process Manager Server Administration Guide.

You can only save your changes using the Save option from the file menu. You cannot
select the Save As option for saving new resource files.

Note:

Once you have created a business calendar, you can assign it to process definitions or to particular
timers.

6.15.5 Assigning Business Calendars to Process Definitions
Prerequisite: You have created your own business calendar.

You can assign different business calendars for every process definition.
To assign a business calendar to a process definition:
1. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
2. Select the User Defined Attributes tab.
3. Add the User Defined Attribute (UDA) __businessCalendar of type STRING to the process

definition. Specify the name of your business calendar without the .cal extension as its value.

Interstage Business Process Manager Studio User's Guide 163

6: Modeling Processes



In the following example, a business calendar called German.cal is assigned to the process
definition:

Figure 102: Assigning a Business Calendar

6.15.6 Assigning Business Calendars to Due Dates or Timers
Prerequisite: You have created your own business calendar.

You can assign a business calendar to a particular due date or to a particular timer. The due date
or timer is then calculated based on this business calendar.
To assign a business calendar to a timer or due date:
1. Define an advanced timer or an advanced due date.

Refer to sections Defining Due Dates on page 152 or Defining Timers on page 154 for instructions.

2. In the Set Expression field, enter the following expression:
UC(<business calendar>.cal);

For <business calendar>, specify the name of your business calendar with the .cal extension.
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In the following example, a business calendar called german.cal is assigned to a timer:

Figure 103: Assigning a Business Calendar to a Timer

6.16 Defining Voting Rules
Prerequisites:
• You have added a Voting Activity Node to your process definition.
• The Voting Activity Node has outgoing arrows.

A Voting Activity Node allows users to work on an activity in collaboration with one another. All users
can make their own choice (or vote). All of their votes are polled. The winning vote, represented by
one of the outgoing arrows, is determined by voting rules.
The following figure shows an example, where Managers can give their vote on a change request.

Figure 104: Voting on a Change Request
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You define a voting rule for every outgoing arrow. The following rule types are available:
• Majority Rule

If this rule is assigned to a choice, a majority of votes for that choice make it the winning choice.
For example, if the majority rule were assigned to a choice called “Approve”, a majority of votes
for the “Approve” choice would make that the winning choice. The process instance would proceed
along the “Approve” arrow to the next activity.

• Percentage Rule
If this rule is assigned to a choice, the specified percentage of votes for that choice makes it the
winning choice.
For example, if a 50% rule is assigned to a choice called “Approve”, 50% of the total number of
votes for the “Approve” choice would make that the winning choice.

• "Number of" Rule
If this rule is assigned to a choice, the specified number of votes for that choice make it the winning
choice.
For example, if a "1" is assigned to a choice called “Reject”, one vote for “Reject” would make
that the winning choice.

When defining voting rules, you also choose a default rule. The default rule is chosen if none of the
rules apply.
To define voting rules:
1. Select the Voting Activity Node to display the Properties view for it.
2. Select the Voting Rules tab.

The All Voting Rules area displays all of the Voting Activity Node's outgoing arrows.

3. For each arrow, define a voting rule.
4. Do one of the following:

• If you want to complete the activity as soon as a voting rule is satisfied, select Evaluate voting
rules on every vote.

• If you want to make sure that everyone gets a chance to vote, select Evaluate voting rules
when all votes are cast.

5. If you want to define a default voting rule, select the voting rule and click Default. If it has already
been selected as the default, then the Default button is disabled.

6. You can rearrange the order in which the voting rules are evaluated by highlighting a rule and
clicking Up or Down.
All outgoing arrows are checked in the sequence in which they appear in this view. The first
matching rule is chosen. If no valid rule is found, the arrow defined as default is chosen – even
if the rule does not apply.
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Examples
The following figure shows an example for percentage rules. A decision is approved if at least 75 %
of the managers vote for it. The setting Evaluate voting rules when all votes are cast makes sure
that all managers give their vote.

Figure 105: Percentage Rules

The next example shows the usage of majority rules. A decision is approved or rejected, if the majority
of users vote for or against the decision. If an equal number of users vote for and against the decision,
the default voting rule is used. In this case, the default is to reject the decision.

Figure 106: Majority Rules
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In the following example, a decision is only approved if all users vote for it. As soon as one user
votes against it, the decision is rejected, and the process proceeds to the next activity.

Figure 107: Number of Rule

6.17 Defining Conditions
Prerequisites:
• You have added a Conditional Node to your process definition.
• The Conditional Node has outgoing arrows.
• You have specified User Defined Attributes (UDAs) that you want to evaluate.

A Conditional Node represents a step where the process proceeds in one of many possible directions.
The outgoing arrows of the node represent the directions in which the process can proceed. The
decision which direction to take depends on the value of a UDA.
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The following figure shows parts of a purchasing process. Team members can order goods directly
if the price is below a certain limit. Otherwise, the approval of the project manager is required.

Figure 108: Using Conditional Nodes

When defining conditions, you can also define a default arrow. The default arrow is chosen if none
of the conditions apply. It is also chosen, if you do not enter values for the Conditional Node to
evaluate.
To define conditions:
1. Select the Conditional Node to display the Properties view for it.
2. Select the Decision tab.
3. In the UDA to Evaluate area, select the UDA data type from the UDA namedrop-down list.

If you select a UDA data type as XML, the Properties view displays an addtional XPath field.

If you select a non-XML UDA type, the XPath field will be disabled.Note:

4. If you select a UDA data type as XML, click in the field in the XPath field. A drop-down list is
displayed. Select from the drop-down list, the XPath expression that specifies where the data will
be stored in the XML string of the target UDA. XPath field is active only if you have selected a
UDA of type XML in UDA name field.

5. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the Edit button that is displayed next to the XPath of target UDA drop-down list. XPath
Editor dialog is displayed with the selected XPath expression in its editor area. You can edit this
XPath expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:
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The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

6. Select the UDA from the UDA name drop-down list. The names listed in this list are based on
the UDA data type chosen by you.

7. For each arrow that originates from the Conditional Node, specify the criteria to compare with the
value of the UDA.

Figure 109: Defining Conditions

8. If you want to define a default conditon, select the condition in the All Conditons area and click
Default. If it has already been set as the default condition, the Default button is disabled.

9. You can rearrange the order in which the conditions are evaluated by highlighting the condition
and clicking Up or Down.
All outgoing arrows are checked in the sequence in which they appear in this view. The first
matching arrow is chosen. If no valid arrow is found, the arrow defined as default is chosen –
even if the condition does not apply.

If you want to specify advanced conditions, use a Complex Conditional Node instead of a Conditional
Node.
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6.18 Defining Complex Conditions
Prerequisites:
• You have added a Complex Conditional Node to your process definition.
• The Complex Conditional Node has outgoing arrows.
• You have specified User Defined Attributes (UDAs) that you want to evaluate.

When using Conditional Nodes, you can only specify simple conditions; that is, you can only specify
if a UDA is equal, less or greater than a given value. Complex Conditional Nodes give you more
flexibility as they allow you to specify conditions using JavaScript expressions.
To define complex conditions:
1. Select the Complex Conditional Node to display the Properties view for it.
2. Select the Decisions tab.

Figure 110: Defining Complex Conditions

3. For each arrow that originates from the Complex Conditional Node, specify a JavaScript expression.
You can type the JavaScript expression directly or build it using the Expression Builder. For
details, refer to section Defining JavaScript Expressions on page 339.
If the JavaScript expression for an arrow evaluates to true, the arrow is chosen.

4. If you want to define a default conditon, select the condition in the All Conditons area and click
Default. If it has already been set as the default condition, the Default button is disabled.

5. You can rearrange the order in which the conditions are evaluated by highlighting the condition
and clicking the Up or Down button.
All outgoing arrows are checked in the sequence in which they appear in this view. The first
matching arrow is chosen. If no valid arrow is found, the arrow defined as default is chosen –
even if the condition does not apply.
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7 Using Process Fragments
Process fragments are pre-defined, reusable fragments of a process definition that can be added to
process definitions. You can use process fragments to quickly define processes.
Process fragments are displayed as part of the Navigator view. When a new process fragment is
created it appears as a Business Process Fragment (.bpf) file in the Process Fragments project
folder in the Navigator view. When you open a process fragment it is displayed in the Process
Definition editor. You can add/remove nodes and arrows in this editor.

Figure 111: Process Fragments Navigator View

Workflow Patterns folder is a default folder within the Process Fragments project folder. This folder
contains 6 pre-built patterns to use in process definitions. You can define other folders within the
Process Fragments project folder to contain the process fragments added by you.
Refer to the following sections for more information on process fragments
• Creating Process Fragments on page 172
• Adding Process Fragments to Process Definitions on page 173

7.1 Creating Process Fragments
To add new process fragments:
1. On an active Process Definition Editor, select the node and/or arrows that you want to save as

reusable process fragments.

If you have not selected any nodes or arrows, the nodes and the arrows copied by the
previous operation are used.

Note:

To copy arrows, the source and target nodes of the arrow must also be selected.Note:

Interstage Business Process Manager Studio User's Guide 172

7: Using Process Fragments



2. Right-click the Process Fragments folder and select New > Process Fragment from the menu
or select New > Process Fragment from the File menu.
The New Process Fragment dialog box is displayed.

3. Enter the folder name where you want to save the process fragment. You can also click Browse
and navigate to the location where you want to save the process fragment.

4. Enter a name for the process fragment in the Name field.
5. Enter a description in the Description field.
6. Click Finish.

The process fragments is displayed in the Process Definition Editor with the elements that you
selected in step 1 . You can edit the process fragment in this editor and save it.

Unlike Process Definitions, process fragments need not have a Start node.Note:

The Business Process Fragment (.bpf) file is displayed in the Navigator view in the Process
Fragments project folder.

7.2 Adding Process Fragments to Process Definitions
Pre-requisites: Make sure that the process fragment that you want to add is available in the Process
Fragments folder.

To add process fragments to Process Definitions:
1. Open the Process Definition that you want to add the process fragments to, in the Process

Definition Editor.
2. Click the appropriate process fragment in the Navigator view.
3. Drag and drop the process fragment to the Process Definition editor.

The nodes and arrows that are present in the process fragment are added to the Process Definition.
The upper left point of the process fragment as defined while creating the process fragment is
placed in the editor at the location dropped.

The following points should be remembered while adding a process fragment to a Process Definition.
• If the process fragment has a Start Node, a confirmation dialog is displayed when you add it to

the Process Definition. The confirmation dialog confirms that you want to replace the Start Node
with the one defined in the process fragment. If you replace the Start Node with the one in the
process fragment, outgoing arrows defined in the target process definition re-attach the Start
Node from the process fragment.

• A swimlane has the style to place the swimlane title on the left-hand side or on the top of a
swimlane. If the process definition to which you want to add a process fragment has selected the
style different from the process fragment for the swimlane title, the style of swimlane defined in
the process fragment is changed to the same style as that process definition.

• When you add a process fragment to a Process Definition, UDAs used for nodes defined by
process fragment are copied and pasted to the process definition, except those UDAs which have
the same name as UDAs in the target Process Definition. System-generated UDAs with same
name as defined in the target Process Definition are renamed and pasted to the target Process
Definition.
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8 Using Forms
Most business processes involve decisions and actions that are based on information. Users can
provide and access information through forms.
Forms are structured, field-based HTML files. They serve as an interface for data exchange between
Interstage BPM and structured data repositories.
Forms can be used:
• For displaying or reporting data stored in User Defined Attributes (UDAs)
• For enabling users to add or modify data stored in UDAs.
Forms can be associated with Start Nodes, Activity Nodes, Voting Activity Nodes, and Compound
Activity Nodes. Depending on your needs, you may associate a single form with multiple nodes. Vice
versa, you may associate one or multiple forms with a node. If you associate multiple forms with a
node, the Interstage BPM Console displays them as a list of links at run time. Users can click the
links to open the referenced forms.
Interstage BPM differentiates between the following types of forms:
• Interstage BPM Form:

An Interstage BPM Form always consists of an XML layout describing the form and of a Java
adapter class representing the layout definition. The Java adapter class implements how controls
defined in a form work (buttons, text, etc.) , for example, what happens when a Button is clicked.
Interstage BPM Studio provides this adapter class. When you insert a control provided by Interstage
BPM, this adapter class is used. Refer so section Form Controls for Interstage BPM Forms on
page 180 for details.
The actual HTML file presented to users is generated from the layout definitions. An Interstage
BPM Form is created and designed using the Interstage BPM Form editor. You can modify the
layout using the Form editor, or by modifying the XML code directly.
For more information on how to use Interstage BPM Forms, refer to the Interstage Business
Process Manager Form Editor User´s Guide. This guide is available in HTML format and can be
accessed by calling the following URL:
<Studio install dir>/docs/FormEditorUsersGuide/docs/overview.htm

where <Studio install dir> is the directory to which you have installed the BPM Studio, for
example: C:/fujitsu/InterstageBPM_studio.

• QuickForm:
QuickForms are structured, field-based HTML files. You create QuickForms using the Interstage
BPM Studio as follows: Based on a few settings, Interstage BPM Studio generates an HTML file
that contains fields for all UDAs that are to appear on the form. The QuickForm is generated with
attributes that make it work with Java Server Pages (JSPs).
Once you have generated the form, you can customize it to your own particular needs as long
as you do not edit the HTML components needed by Interstage BPM for data and process
information display. You can modify the layout using any HTML editor or by modifying the HTML
code directly.

Both Interstage BPM Forms and QuickForms enable users to add or modify data stored in UDAs.

8.1 Creating Interstage BPM Forms
You create Interstage BPM Forms using the Interstage BPM Form editor.

Interstage Business Process Manager Studio User's Guide 174

8: Using Forms



Before you can create and work with Interstage BPM Forms, you need to start the Interstage
BPM Forms server (Programs orAll Programs > Interstage Business ProcessManager
Studio > Interstage BPM Forms > Start Interstage BPM Forms).

Note:

While working with the Form editor, you can always preview a generated version (for example an
HTML file) of the form. This feature allows you to continuously check the form layout and functionality.

Before you can preview an Interstage BPM Form, you need to execute the Interstage BPM
Form > Publish menu function.

Note:

To create an Interstage BPM Form:
1. There are two ways to open the Form editor:

a) In the Navigator view, select the Workflow Application project for which you want to create an
Interstage BPM Form, and select New > Interstage BPM Form from the File menu.

b) Open the process definition of your Workflow Application project for which you want to create
an Interstage BPM Form in the Process Definition editor, click the relevant Start Node, Activity
Node, Voting Activity Node, or Compound Activity Node, and select Interstage BPM Form >
New from the popup menu.

The following window will be opened:

Figure 112: Creating an Interstage BPM Form
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2. The Container field shows the folder of the selected Workflow Application project where the new
form will be stored. In the Navigator view, this folder is indicated by the Interstage BPM Forms
directory. Click Browse if you want to select a different Workflow Application project.

3. In the File name field, replace the default file name of the form with a file name that describes
the form and is easily recognized.
If you change the file name, make sure to specify .xml as the extension.

4. Select the template that you want to use. Interstage BPM Studio provides several predefined
HTML Page templates as well as a WSDL Page template. The Java adapter class for using
Interstage BPM controls is defined by Interstage BPM Form. Use this template if you do not want
to or need to create your own custom adapter classes. The other HTML Page templates are
general examples; WSDL Page templates are used to build a page on the basis of a Web Service.
If you want to use a template other than Interstage BPM Form, refer to the Interstage Business
Process Manager Form Editor User's Guide for a description of the available HTML Page and
WSDL Page templates.

5. Click Finish.
The Form editor will be opened. Proceed with designing the layout of the form. Refer to section
Using the Form Editor on page 176 for details.

Once you have created an Interstage BPM Form, you can customize it to your own particular needs.
You can modify the layout using the Form editor or by modifying the XML code directly: You can
simply drag and drop the respective XML layout file from the Navigator view to your favorite XML
editor.
Interstage BPM Forms are stored within your Workflow Application project and thus you do not need
to bother about file locations. When you deploy your application, the forms will always be available
in the correct locations on the Interstage BPM server and can be accessed by end-users without the
need for further customizations.

8.2 Using the Form Editor
You design the layout of your form using the Form editor. The result is kept in an XML layout
description file. The Form editor comes with a code generator that you can use to generate an HTML
page from the XML layout description.
The layout definition contains controls used on a form page and keeps information on how these
controls are bound to server-side Java objects. The generated HTML page contains HTML and
JavaScript statements and is executed in a web Browser at runtime.
While working with the Form editor, you can always preview the generated HTML version of the
form. This feature allows for permanent checking of the form layout.
The following default components are included in an Interstage BPM Form based on the Interstage
BPM Form HTML Page template: the title bar, header, pagebody and status bar:
Use the title bar to provide a form title.
Use the header to include all controls that should be available on top of the form.
Use the pagebody for designing the layout of your form including, e.g. work item operations, etc.
Use the status bar if you design a form that is to show, for example, a progress status.

After you have designed and saved the layout of a form using the Form Editor, you need
to refresh the Navigator view.

Note:
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8.2.1 Interstage BPM Form Tutorial
This section teaches you how to create an Interstage BPM Form which allows a user to start a
process instance. The following figure shows the corresponding section in the process definition:

Figure 113: Process Definition for Creating an Interstage BPM Form

Step 1: Create the Interstage BPM Form
Open the process definition of your Workflow Application project in the Process Definition editor,
click the relevant Activity Node, and select Interstage BPM Form > New from the popup menu.
Enter a File Name and select Interstage BPM Form as template. Refer to section Creating Interstage
BPM Forms on page 174 for details.
The Interstage BPM Form (BPM Form.xml) is created in your Workflow Application project.
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Step 2: Define the Controls
Proceed with defining the controls for displaying the value of a User Defined Attribute (UDA), and
the button for starting a process instance.
1. Define the control for displaying a UDA value:

Figure 114: Defining a Form Control for Displaying a UDA Value

a. From the Form editor Controls palette option Controls, click the Label control, and drag and
drop it to the Preview area of the Form editor. Label controls are used to distinguish UDAs.

b. Click the Field control, and drag and drop it to the right of the Label control. Field controls are
used to display the value of a UDA.

c. Repeat step 1 and 2 to insert another Label and Field control.
d. Select the first Label in the Form editor. In the Properties area name field, enter Variable01.
e. Select the second Label in the Form editor. In the Properties area name field, enter Variable02.
f. Select the first Field control in the Form editor. In the Properties area valueprop field, enter

uda_Variable01.
g. Select the second Field control in the Form editor. In the Properties area valueprop field,

enter uda_Variable02.
Refer to section Integrating UDAs in Interstage BPM Forms on page 189 for further information.
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2. Define the Button control for starting a process instance:
a. From the Form editor Controls palette option Controls, click the Label control, and drag and

drop it below the Variable02 Label control.
b. Delete the entry in the Properties area name field to define an empty String.
c. From the Form editor Controls palette option Interstage BPM, click the Start New Process

control, and drag and drop it to the right of the last Label control.

Figure 115: Defining a Form Control for Starting a Process Instance

The Controls palette option Interstage BPM offers various other controls, for example to display
the properties of a process instance (Process Instance Name), the status of a work item (WorkItem
Status), and to operate a process instance (Make Choice, Save WorkItem, etc.). Refer to section
Form Controls for Interstage BPM Forms on page 180 for a complete list.

Step 3: Save the Interstage BPM Form
By saving the Interstage BPM Form, an XML file is created in your Workflow Application project.
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Step 4: Associate the Interstage BPM Form with a Process Definition
As a last step, you need to associate the newly created Interstage BPM Form with a process definition.
You can associate the form to any process definition:
1. Open the process definition in the Process Definition editor.
2. In the Navigator view, select the newly created Interstage BPM Form.
3. Drag it and drop it on the Start Node of the process definition.
Refer to section Managing Interstage BPM Forms on page 192 for details.

8.2.2 Form Controls for Interstage BPM Forms
Interstage BPM comes with a set of predefined Java classes (controls) that handle all properties and
methods available for operations on a work item and a process instance, for display of information
on work items, process instances or process definitions, and for adding and deleting attachments to
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/ from a work item. The controls are accessible from the Form editor Controls palette option Interstage
BPM:

Figure 116: Interstage BPM Form Controls

You drag and drop one of the Interstage BPM Controls from the Controls Palette to the respective
section (pagebody) in the Layout Area of the Form editor.
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There are the following Interstage BPM Form Controls:
• MakeChoice (Combo)

Figure 117: MakeChoice (Combo)

Lists all the available choices in a dropdown list box for a given work item. Users can pick a work
item and make a choice. You can set the following properties:

DescriptionProperty name

name of the row area (default: Available Choices)name

text id for the nametextid

caption for the Choices drop down list boxlabel

text id for the labellabeltextid

width of the label (default: 150)labelwidth

height of the labellabelheight

text alignment in the labeltextalign

label alignmentlabelalign

label vertical alignmentlabelvalign

label stylelabelstyle

width of the button (default: 150)btnwidth

height of the buttonbtnheight

button alignmentbtnalign

button vertical alignmentbtnvalign

button stylebuttonstyle

button text stylebtntextstyle

caption for the button (default: Make Choice)buttonname

text id for the button namebuttontextid

• MakeChoice (FlexLine Buttons)

Figure 118: MakeChoice (FlexLine Buttons)
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Lists all the available choices for a given work item as row of buttons. You can set the following
properties:

DescriptionProperty name

name of the row area (default: Available Choices)name

text id for the nametextid

• Instance Info

Figure 119: Instance Info

Displays the details such as name, state, description, process instance name, process definition
name, responsible, assignees, created time, due date and priority of the given work item. You
can set the following properties:

DescriptionProperty name

name of the row area (default: Process Instance Information )name

text id for the nametextid

label to display the work item name (default: Workitem)label1

label to display the state of the work item (default: State)label2

label to display the description (default: Description)label3

label to display the process instance name (default: Process Instance)label4

label to display the process definition name (default: Process Definition)label5

label to display from who the work item originates (default: From)label6

label to display to who work item was sent (default: To)label7

label to display who created the work item (default: Created)label8

label to display when the work item is due (default: Due Date)label9

label to display the priority (default: Priority)label10

label to display the text id for each labellabel1textid, label2textid,
...

distance between the label and the value field where text is output
(default: 25)

hdistwidth

width of the value field (text out box that displays the value)toutwidth
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DescriptionProperty name

height of the value fieldtoutheight

text size in the value fieldtouttextsize

text color in the value fieldtouttextcolor

alignment of the value fieldtoutalign

vertical alignment of the value fieldtoutvaligh

style of the value fieldtoutstyle

• WorkItem Name
Text out control to display the name of the given work item. You can set the following properties:

DescriptionProperty name

width of the name (default: 200)width

button heightheight

size of the texttextsize

color of the texttextcolor

button alignment in the parent control (default: left)align

vertical button alignment in the parent control (default: center)valign

output style for the textstyle

• WorkItem ID
Text out control to display the ID of the given work item. You can set the same properties as for
WorkItem Name.

• WorkItem State
Text out control to display the state of the given work item. You can set the same properties as
for WorkItem Name.

• WorkItem Creation Time
Text out control to display the time the given work item was created. You can set the same
properties as for WorkItem Name.

• WorkItem DueDate
Text out control to display the date the given work item is due. You can set the same properties
as for WorkItem Name.

• WorkItem Assignee
Text out control to display the user or group to which the work item is assigned. You can set the
same properties as for WorkItem Name.

• WorkItem Responsible
Text out control to display the user or group who is responsible for the work item. You can set
the same properties as for WorkItem Name.
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• Process Instance Name
Text out control to display the name of the process instance. You can set the same properties
as for WorkItem Name.

• Process Instance ID
Text out control to display the ID of the process instance. You can set the same properties as for
WorkItem Name.

• Process Instance Description
Text out control to display the description of the process instance. You can set the same properties
as for WorkItem Name.

• Process Definition ID
Text out control to display the ID of the process definition. You can set the same properties as
for WorkItem Name.

• Process Definition Name
Text out control to display the name of the process definition. You can set the same properties
as for WorkItem Name.

• WorkItem Operations
Provides four buttons in a row to save, accept, decline and reassign a given work item. You can
set the following properties:

Figure 120: WorkItem Operations

DescriptionProperty name

name of the row area (default: Workitem Operations)name

text id for the nametextid

caption for the Save button (default: Save)savebuttonname

text id for the Save buttonsavebuttontextid

caption for the Accept button (default: Accept)acceptbuttonname

text id for the Accept buttonacceptbuttontextid

caption for the Decline button (default: Decline)declinebuttonname

text id for the Decline buttondeclinebuttontextid

caption for the Reassign button (default: Reassign)reassignbuttonname

text id for the Reassign buttonreassignbuttontextid

button width applying to all buttons (default: 100)btnwidth

button heightbtnheight

button alignment (default: left)btnalign

Interstage Business Process Manager Studio User's Guide 185

8: Using Forms



DescriptionProperty name

button vertical alignment (default: bottom)btnvalign

button stylebuttonstyle

button text stylebtntextstyle

• Accept WorkItem
Control for accepting the given work time. You can set the following properties:

Figure 121: Accept WorkItem

DescriptionProperty name

caption of the button (default: Accept)name

text id for the nametextid

button width (default: 200)width

button heightheight

image that will be displayed in the button when the button is enabledimage

image that will be displayed in the button when the button is disabledimagedisabled

width of the imageimagewidth

height of the imageimageheight

button alignment in the parent control (default: left)align

vertical button alignment in the parent control (default: bottom)valign

button stylestyle

button text styletextstyle

• Decline WorkItem
Control for declining the given work time. You can set the following properties:

Figure 122: Decline WorkItem

DescriptionProperty name

caption of the button (default: Decline)name

text id for the nametextid
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In addition, you can set the same properties as for Accept WorkItem.

• Reassign WorkItem
Control for reassigning the given work time. You can set the following properties:

Figure 123: Reassign WorkItem

DescriptionProperty name

caption of the button (default: Reassign)name

text id for the nametextid

In addition, you can set the same properties as for Accept WorkItem.

• Save WorkItem
Control for saving the UDA values on the given work item. You can set the following properties:

Figure 124: Save WorkItem

DescriptionProperty name

caption of the button (default: Save)name

text id for the nametextid

In addition, you can set the same properties as for Accept WorkItem.

• Start New Process
Control for starting a new process instance for the given process definition. You can set the
following properties:

Figure 125: Start New Process

DescriptionProperty name

caption of the button (default: Start Process)name

text id for the nametextid

In addition, you can set the same properties as for Accept WorkItem.

• Attachments
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Used for adding and deleting attachments for a given work item. You can set the following
properties:

Figure 126: WorkItem Operations

DescriptionProperty name

name of the row area (default: Attachments)name

text id for the nametextid

caption for the operations (default: Operations)column1

text id for column 1column1textid

caption for the name (default: Name)column2

text id for column 2column2textid

caption for the path (default: Path)column3

text id for column 3column3textid

caption for the select (default: Select)column4

text id for column 4column4textid

caption for the Add button (default: Add)addbuttonname

text id for the Add buttonaddbuttontextid

caption for the Delete button (default: Delete)delbuttonname

text id for the Delete buttondelbuttontextid

height of the value field (text out box that displays the value)toutheight

text size in the value fieldtouttextsize

text color in the value fieldtouttextcolor

alignment of the value fieldtoutalign

vertical alignment of the value fieldtoutvaligh

style of the value fieldtoutstyle

width of the button applying to all buttons (default: 10%)btnwidth

height of the buttonbtnheight
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DescriptionProperty name

button alignmentbtnalign

button vertical alignmentbtnvalign

button stylebuttonstyle

button text stylebtntextstyle

If you are using the Interstage BPM Console to start process instances and respond to work
items, you must use the above mentioned controls for work item operations. Otherwise,
users will not be given any choices on the form and users will not be able to complete work
items.

Note:

Next, decide which UDAs you want to appear on the form.

8.2.3 Integrating UDAs in Interstage BPM Forms
When creating Interstage BPM Forms, you define which form controls display the User Defined
Attributes (UDAs) on the form. You can select among several form control types like text files, text
areas, lists, and so on. Your actual choices depend on the UDA's data type. For example, you can
use a Label control only with UDAs of type STRING.

For UDAs of type XML you must use a Dynamic Control Grid control.Note:

To integrate UDAs in an Interstage BPM Form:
1. If not already open, open the Form editor.
2. Add a control of type Label to the page body of your form:

In the Controls palette, choose the Controls button. Drag the Label control and drop it in the
HTML Preview Area.

Interstage Business Process Manager Studio User's Guide 189

8: Using Forms



3. Add a control of type Field on the same level as the Label control: Drag the Field control and
drop it aside the Label control. Select Add as Last Subnode from the popup menu.

Figure 127: Integrating a UDA in an Interstage BPM Form

4. Enter a description of the UDA in the respective property field. For example:
Click label in the Layout area and enter UDA Variable 1 in the name field of the Properties area.

5. Add the reference to the UDA you want to insert in the Interstage BPM Form as follows:
a. Click field in the Layout area.
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b. In the valueprop field of the Properties area, enter the reference to the UDA in the following
format: uda_ plus <identifier of the UDA>, for example: uda_variable1:

Figure 128: Integrating a UDA in an Interstage BPM Form (2)

6. Proceed in the same way for all other UDAs that you want to integrate in your Interstage BPM
Form.

8.2.4 Using Adapter Classes for Interstage BPM Forms
The Form editor integrated in the Studio comes with a tool called "Code Assistant". You can use it
to speed up the development of your own Java adapter classes: you can generate code for the
properties and methods that are referenced within the XML layout of your Interstage BPM Form.
The compilation of the adapter class is later done within your Java development environment.
The Interstage BPM Studio comes with a predefined adapter class that is associated with the
Interstage BPM Form Template:
com.fujitsu.ibpmportal.forms.smartforms.IBPMGenericAdapter. You can use this adapter
class for other form templates as well by associating it in the model field of the Properties area.
Custom adapter classes are stored in the WEB-INF/classes directory of your application. Note that
this class needs to be manually copied from the Studio to the Interstage BPM Server. It is not part
of the Workflow Application project package file.
Refer to the Interstage Business Process Manager Form Editor User's Guide for details on how to
use the Code Assistant.

8.2.5 Integrating your own Style Sheets in Interstage BPM Forms
When creating an Interstage BPM Form, you specify a cascading style sheet (CSS) that will be used
with your form. The style sheet defines the form's look and feel.
Interstage BPM provides a set of predefined style sheets. You can configure Interstage BPM Studio
to use your own style sheets. This style sheet can be any standard-format HTML style sheet. The
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Style Sheet Editor integrated in the Studio simplifies the creation of your own style sheets: on the
one hand, you can define the very basic style elements (main colors to be used), and on the other
hand, you can change a controls' style definition on the lowest level.
Refer to the Interstage Business Process Manager Form Editor User's Guide for details on how to
use the Style Sheet Editor.

8.3 Managing Interstage BPM Forms

8.3.1 Updating Interstage BPM Forms
You can make changes to an existing Interstage BPM Form. For example, you can add additional
User Defined Attributes (UDAs) to the form, change control types, and so on.

The location of the form and its title cannot be changed.Note:

To update an Interstage BPM Form:
1. To open an existing Interstage BPM Form in the Form editor, there are two ways:

a) In the Navigator view, double click the relevant Interstage BPM form, or right click the form
and select Open > Interstage BPM Form Editor from the popup menu. To open the form in
read-only mode, select Open > Interstage BPM Form Previewer from the popup menu.

b) In the Process Definition editor, right click the node with which the Interstage BPM Form has
been associated and select Interstage BPM Form > Edit from the popup menu. Again you
can open the form in read-only mode by selecting Interstage BPM Form > Preview from the
popup menu.

2. In the Form editor, make the required changes.
For more information, refer to section Using the Form Editor on page 176.

3. Click the Save button of the Workbench window to save your changes.

8.3.2 Associating Interstage BPM Forms with Nodes
When you started creating an Interstage BPM Form from within the Process Definition editor for a
particular node, it is automatically associated with the node for which you created it. You can reuse
existing Interstage BPM Forms and associate them with additional nodes.
To associate an existing Interstage BPM Form with a node:
1. Open the relevant process definition of your Workflow Application project.

2. In the Navigator view, click the Interstage BPM Form that you want to associate with a Start Node,
Activity Node, Voting Activity Node, or Compound Activity Node of the process definition.

3. Drag the form to the respective node.
In the Forms tab of the Properties view for the node, you will see the Form Title and the Form
Path of the form associated with the node.

To reuse an existing Interstage BPM Form:
1. Open the relevant process definition of your Workflow Application project.
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2. Right click the node to which you want to associate an Interstage BPM Form and select Interstage
BPM Form > Add reference from the popup menu. The following dialog is opened:

Figure 129: Creating an Interstage BPM Form

3. From the list of available Interstage BPM Forms, select the one that you want to associate with
the given node, and click OK.

8.3.3 Dissociating Interstage BPM Forms from Nodes
You can dissociate an Interstage BPM Form from a node. This removes the association, but does
not remove the form itself.
1. To dissociate an Interstage BPM Form from a node using the node Properties view:

a) Select the node to display the Properties view for it.
b) Select the Forms tab.
c) Select the form to be dissociated and click Remove.

2. To dissociate an Interstage BPM Form from a node using the node popup menu:
a) Right click the respective node in the Process Definition editor.
b) Select Interstage BPM Form > Delete Reference from the popup menu.

Interstage Business Process Manager Studio User's Guide 193

8: Using Forms



8.3.4 Renaming Interstage BPM Forms
You can rename an Interstage BPM Form and take care that all references to this form are also
taken into account.
To rename an Interstage BPM Form:
1. In the Navigator view, right click the respective Interstage BPM Form and select Rename from

the popup menu.
2. Enter a new name for the form in the New name field.
3. Decide whether all references to this Interstage BPM Form should also be updated so that they

use the new name.
4. Click OK.

8.3.5 Deleting Interstage BPM Forms
You can delete an Interstage BPM Form and take care that all references to this form are also taken
into account.
To delete an Interstage BPM Form:
1. In the Navigator view, right click the respective Interstage BPM Form and select Delete from the

popup menu.
2. Decide whether all references to this Interstage BPM Form should also be deleted.
3. Confirm the deletion of the form by clicking Yes.

8.3.6 Importing Interstage BPM Forms
Prerequisite: You have created a Workflow Application project where the Interstage BPM Forms
can be imported.

You can import Interstage BPM Forms in XML format into Interstage BPM Studio.
To import an Interstage BPM Form:
1. In the Navigator view, right click the project where you want to import the form. Select Import

from the pop-up menu.
2. Navigate to the location where the XML file representing the Interstage BPM Form is stored.
3. Select the form and click Open.
4. If an Interstage BPM Form with the same file name already exists in the project, a dialog is

displayed asking you for a file name. Type a new file name and click OK.

8.3.7 Exporting Interstage BPM Forms
You can export Interstage BPM Forms from Interstage BPM Studio to the file system. You can use
the exported files, for example, to import them into other systems. The export format is always XML.

You can export entire Workflow Application projects including all process definitions, forms,
attachments, etc. in one step, and later deploy the application on an Interstage BPM server.
Refer to section Exporting Workflow Application Projects on page 94 for details.

Note:

To export an Interstage BPM Form:
1. In the Navigator view, right click the Interstage BPM Form. Select Export.
2. Navigate to the location where the exported form is to be stored.
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3. Click Save.

8.4 Creating QuickForms
Prerequisite: You have specified User Defined Attributes (UDAs) that are to appear on the
QuickForms. Otherwise, Interstage BPM Studio will not allow you to create a QuickForm.

You need to differentiate whether you create a QuickForm in a Workflow Application project or
whether you create one in a project that has been created with a previous version of Interstage BPM
Studio (local or server projects):
The subsequent sections describe this two cases.

8.4.1 Creating QuickForms in Workflow Application Projects
To create a QuickForm in a Workflow Application project:
1. Select the Start Node, Activity Node, Voting Activity Node, or Compound Activity Node for which

you want to create a form, to display the Properties view for those nodes.
2. Select the Forms tab.
3. Click Create New to open the Form Properties dialog.
4. In the Destination Path field, replace the default file name of the form with a file name that

describes the form and is easily recognized.
If you change the file name, make sure to specify .qf as the extension.
As a default, QuickForms are stored in the web folder of your Workflow Application project. If you
want to organize your forms in different folders, you can create subfolders under the web folder.
You can select these subfolders using the Browse button.

5. In the Form Title field, provide a descriptive title that is to appear on the form.
The title cannot be longer than 64 characters.

6. To define the look and feel of your form, do the following:
a) If you already created a form template that you want to use, click Browse next to the Use

Template field and select the form template.
For more information on form templates, refer to section Creating Templates for QuickForms
on page 202.

b) Select the cascading style sheet that you want to use.
You can select from a set of predefined style sheets that come with Interstage BPM. If you
want to use your own style sheets, refer to section Integrating your own Cascading Style
Sheets in QuickForms on page 202.

7. Specify which of the following components are to be included in your form: the work item header,
process panel, and attachment panel.
Use the Work Item Header if you want the form to look the same as the other Interstage BPM
Console pages, including the navigation tabs and other buttons that appear. Without this, you
can make the form look any way you want to.
The Process Panel displays details about the current state of the work item including who it is
assigned to, who started the process instance, when it was assigned, when it is due to be
completed, what the choices are, and buttons to accept, decline, or reassign the work item.
The Attachment Panel lists the documents currently attached to the process instance, and
provides buttons for adding, removing or editing attachments. The attachment panel depends on
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the process panel. Therefore, when using the attachment panel you must also use the process
panel.

If you are using the Interstage BPM Console to start process instances and respond to work
items, you must use the process panel. Otherwise, users will not be given any choices on
the form and users will not be able to complete work items. Only deselect the process panel
if you provide a custom Interstage BPM client.

Note:

8. For each UDA that you want to appear on the form, do the following:
a) Make sure that it is selected in the User Defined Attributes area.
b) In the Form Control column, select a control type for the UDA.
c) Check the properties of the control and change them if required. For more information, refer

to section Form Controls for QuickForms on page 199.
d) In the Form Control Properties area, click Save to save your changes.

You must click Save after making changes to the form control’s properties, or they will not
take effect.

Note:

e) For text fields, text areas, and read only fields: If you want to use your current settings as the
default for that form control type, click Set Default.
The settings are applied to all new fields of that form control type.

f) For text fields, text areas, and read only fields: If you want to use the default settings that
Interstage BPM Studio has defined for that form control type, click Use Default.
The default settings are applied to the field that you are currently editing.

Figure 130: Generating a QuickForm

9. Click Generate Form.
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The form is generated and stored in the folder that you specified. The Forms tab displays the
form title and its location.

10. To check the appearance, open the form in your Web Browser. You can customize the layout
using any HTML Editor or by modifying the HTML code directly.

When customizing QuickForms, you must ensure that the field names remain the same.
For more information on customizing QuickForms, refer to the Interstage Business Process
Manager Developer's Guide.

Note:

8.4.2 Creating QuickForms in Local Projects
To create a QuickForm in an existing local project:
1. Select the Start Node, Activity Node, Voting Activity Node, or Compound Activity Node for which

you want to create a form, to display the Properties view for those nodes.
2. Select the Forms tab.
3. Click Create New to open the Form Properties dialog.
4. In the Destination Path field, replace the default file name of the form with a file name that

describes the form and is easily recognized.
If you change the file name, make sure to specify .html as the extension.
As a default, QuickForms are stored in the <Interstage BPM Studio Installation
Directory>\ibpm\ApplicationCore\ledev\QuickForms folder. If you want to organize your
forms in different folders, you can create subfolders under the QuickForms folder. You can select
these subfolders using the Browse button. However, you must use the QuickForms folder or one
of its subfolders for form generation.

5. In the Form Title field, provide a descriptive title that is to appear on the form.
The title cannot be longer than 64 characters.

6. To define the look and feel of your form, do the following:
a) If you already created a form template that you want to use, click Browse next to the Use

Template field and select the form template.
For more information on form templates, refer to section Creating Templates for QuickForms
on page 202.

b) Select the cascading style sheet that you want to use.
You can select from a set of predefined style sheets that come with Interstage BPM. If you
want to use your own style sheets, refer to section Integrating your own Cascading Style
Sheets in QuickForms on page 202.

7. Specify which of the following components are to be included in your form: the work item header,
process panel, and attachment panel.
Use the Work Item Header if you want the form to look the same as the other Interstage BPM
Console pages, including the navigation tabs and other buttons that appear. Without this, you
can make the form look any way you want to.
The Process Panel displays details about the current state of the work item including who it is
assigned to, who started the process instance, when it was assigned, when it is due to be
completed, what the choices are, and buttons to accept, decline, or reassign the work item.
The Attachment Panel lists the documents currently attached to the process instance, and
provides buttons for adding, removing or editing attachments. The attachment panel depends on
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the process panel. Therefore, when using the attachment panel you must also use the process
panel.

If you are using the Interstage BPM Console to start process instances and respond to work
items, you must use the process panel. Otherwise, users will not be given any choices on
the form and users will not be able to complete work items. Only deselect the process panel
if you provide a custom Interstage BPM client.

Note:

8. For each UDA that you want to appear on the form, do the following:
a) Make sure that it is selected in the User Defined Attributes area.
b) In the Form Control column, select a control type for the UDA.
c) Check the properties of the control and change them if required. For more information, refer

to section Form Controls for QuickForms on page 199.
d) In the Form Control Properties area, click Save to save your changes.

You must click Save after making changes to the form control’s properties, or they will not
take effect.

Note:

e) For text fields, text areas, and read only fields: If you want to use your current settings as the
default for that form control type, click Set Default.
The settings are applied to all new fields of that form control type.

f) For text fields, text areas, and read only fields: If you want to use the default settings that
Interstage BPM Studio has defined for that form control type, click Use Default.
The default settings are applied to the field that you are currently editing.

Figure 131: Generating a QuickForm

9. Click Generate Form.
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The form is generated and stored in the folder that you specified. The Forms tab displays the
form title and its location.

10. To check the appearance, open the form in your Web Browser. You can customize the layout
using any HTML Editor or by modifying the HTML code directly.

When customizing QuickForms, you must ensure that the field names remain the same.
For more information on customizing QuickForms, refer to the Interstage Business Process
Manager Developer's Guide.

Note:

When sending the process definition to a machine on which the Interstage BPM Console
is installed, make the following adjustments:

Note:

1. If you send a QuickForm to the Interstage BPM Console for the first time, you need to
configure the Interstage BPM Server as follows:
a. Shutdown the Interstage BPM Server.
b. Create the following directory:

<Interstage BPM Server Installation
Directory>/server/instance/default/QuickForms

c. Open the following file and insert the part indicated in bold below:
<Interstage BPM Server Installation
Directory>/server/instance/default/resources/dmscollections/DmsCollections.xml

<DmsCollections>
<Dms>

<Path>...</Path>
<ImplementationClass>...</ImplementationClass>
<Name>Attachments</Name>

</Dms>
<Dms>

<Path>
<Server Installation

Directory>/server/instance/default/QuickForms
</Path>
<ImplementationClass>

com.fujitsu.iflow.dmsadapter.impl.FileSystemDmsSessionImpl
</ImplementationClass>
<Name>QuickForms</Name>

</Dms>

</DmsCollections>

d. Restart the Interstage BPM Server.

2. Copy the QuickForm to <Interstage BPM Server Installation
Directory>/server/instance/default/QuickForms

8.4.3 Form Controls for QuickForms
When creating QuickForms, you define which form controls display the User Defined Attributes
(UDAs) on the form. You can select among several form control types like text fields, text areas,
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lists, and so on. Your actual choices depend on the UDA's data type. For example, you can use a
Calendar control only with UDAs of type DATE.
These are the form control types and their properties.

Text Field
Displays a single-line text entry field.
Use the Character Width property to specify the width of the field and the Max Characters property
to specify the maximum number of characters that can be entered in the field.

Password Field
Displays a single-line text entry field with "*" replacing the actual data entered by the user.
Use the Character Width property to specify the width of the field and the Max Characters property
to specify the maximum number of characters that can be entered in the field.

Read Only Field
This value is displayed but cannot be changed on the form.
Use the Character Width property to specify the width of the field.

Text Area
Displays a multiple-line text entry field.
Use the Columns property to specify the width of the text area, that is the number of characters per
line. Use the Rows property to specify its length, that is the number of lines.

Combo Box
Displays a drop-down list (single-line display that expands to show more entries). Users are allowed
to select only one entry.
Use List Values to specify the entries that users can select from. For each entry, you define the
name that is displayed to the user and the value that is assigned to the UDA. When defining the
value that is assigned to the UDA, make sure that the value matches the UDA's data type.
A sample entry is provided and its value is set to the initial value of the UDA. You can change the
sample entry according to your needs.
Say you want to create a combo box that allows users to select a customer level. You want to display
descriptive names like Silver or Gold on the form. However, a numerical value representing the
customer level is to be assigned to the UDA. In this case, you could specify the following entries:

ValueName

150Silver

160Gold

170Platinum

Radio Button
Displays a limited number of options. Users are allowed to select only one.
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Use List Values to specify the options that users can select from. For each option, you define the
name that is displayed to the user and the value that is assigned to the UDA. When defining the
value that is assigned to the UDA, make sure that the value matches the UDA's data type.
A sample option is provided and its value is set to the initial value of the UDA. You can change the
sample option according to your needs.

Check Box
Displays a limited number of options. Users are allowed to select one or more options.
Use List Values to specify the options that users can select from. For each option, you define the
name that is displayed to the user and the value that is assigned to the UDA. When defining the
value that is assigned to the UDA, make sure that the value matches the UDA's data type.
A sample option is provided and its value is set to the initial value of the UDA. You can change the
sample option according to your needs.

List
Displays a multiple-line display with a vertical scroll bar if required.
Use the Row property to specify the length of the list, that is the number of lines. Use the Multiple
Selection property to determine whether users are allowed to select multiple entries from the list.
Use List Values to specify the entries that users can select from. For each entry, you define the
name that is displayed to the user and the value that is assigned to the UDA. When defining the
value that is assigned to the UDA, make sure that the value matches the UDA's data type.
A sample entry is provided and its value is set to the initial value of the UDA. You can change the
sample entry according to your needs.

Calendar
Displays a text field with a calendar icon. Clicking the icon displays a pop-up calendar from which
users can pick a date that will display in the text field.

Hidden Field
This value is not displayed on the form.
A hidden field is useful when the data that is stored in the UDA is not directly in the form that is
convenient for display. A JavaScript could read the UDA's value, convert it to a displayable form,
and place that form in a visible form control.

Default
Uses the default form control defined for the UDA's data type. These are the default form controls:

Default Form ControlData Type of UDA

Text fieldBIGDECIMAL

Radio buttons with the options true and falseBOOLEAN

CalendarDATE

Text fieldFLOAT

Text fieldINTEGER
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Default Form ControlData Type of UDA

Text fieldLONG

Text areaSTRING

8.4.4 Creating Templates for QuickForms
A form template is an HTML file that contains placeholders for Interstage BPM-specific content. Any
standard HTML component can be included in the form template.
Once you have provided a form template, you can create new QuickForms based on that template.
This simplifies form creation because you need to implement your particular needs only once in the
template and not in every form that you create. Also, using templates helps you to have a consistent
look and feel across your QuickForms.
To create a form template for QuickForms:
1. Create a new HTML file that implements the look and feel that you want in your QuickForms.
2. Add the following HTML tags inside the <body> tags of your HTML file:

{{QuickTemplateStart}}{{QuickTemplateEnd}}

You have now created an HTML file that can be used as a form template.

3. When creating a template in a project other than a Workflow Application project: Copy the HTML
file that you have just created to the attachments folder used by Interstage BPM Studio:
<Interstage BPM Studio Installation Directory>\ibpm\Data\attachments

When you create a template for a form stored in a Workflow Application project, the template file
is, in analogy to the QuickForm files, stored in the web folder of your Workflow Application project.

When creating QuickForms, you can now select your form template. When updating QuickForms,
you can use your newly created form template if the form has not been generated using another
form template.

Note: • You can change your form templates at any time. However, these changes do not affect
existing QuickForms using that form template.

• A QuickForm can be associated with one form template only. Once you have generated
a QuickForm using a form template, you cannot associate another form template with
that form nor dissociate the form template from that form.

8.4.5 Integrating your own Cascading Style Sheets in QuickForms
When creating a QuickForm, you specify a cascading style sheet (CSS) that will be used with your
form. The style sheet defines the QuickForm's look and feel.
Interstage BPM provides a set of predefined style sheets. You can configure Interstage BPM Studio
to use your own style sheets. This style sheet can be any standard-format HTML style sheet.
To configure Interstage BPM Studio to use your own style sheet for QuickForms:
1. Open the QuickForms configuration file that is used by Interstage BPM Studio:

<Interstage BPM Studio Installation
Directory>\ibpm\ApplicationCore\ledev\Config\QuickFormCSSDef.xml

2. Add a new <style> section and specify the name of your style sheet.
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The name will be displayed in the Form Properties dialog of Interstage BPM Studio. The following
example shows the addition of a style sheet called ExampleStyle.

<Styles>
<style>
<name>default</name>
<path>styles/iflow.css</path>
</style>
<style>
<name>ExampleStyle</name>
<path></path>
</style>
…
</Styles>

Interstage BPM Studio does not access the CSS file itself. Therefore, the style sheet's path
is not relevant with Interstage BPM Studio.

Note:

When creating or updating QuickForms, you can now select your style sheet.

When sending process definitions that reference the style sheet to an Interstage BPM
Server, make the following adjustments:

Note:

1. Copy the style sheet to the following folder:
<Interstage BPM Console Installation Directory>/apps/System/web/styles

The style sheet must have a css file extension.

2. Add the style sheet that you copied in the previous step to the QuickForms configuration
file that is used by the Interstage BPM Server. To do so, add a <style> section to the
following file:
<Interstage BPM Console Installation
Directory>/apps/System/web/Config/QuickFormCSSDef.xml

The following example shows the addition of a style sheet called ExampleStyle. The
underlying CSS file is called example.css. Its path has to be specified relative to the
<Interstage BPM Console Installation Directory>/apps/System/web.

<Styles>
<style>
<name>default</name>
<path>styles/iflow.css</path>
</style>
<style>
<name>ExampleStyle</name>
<path>styles/example.css</path>
</style>
…
</Styles>

Make sure that you specify the same name as in the QuickForms configuration file of
Interstage BPM Studio.
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8.5 Managing QuickForms

8.5.1 Updating QuickForms
You can make changes to an existing QuickForm. For example, you can add additional User Defined
Attributes (UDAs), change control types, assign a different cascading style sheet, and so on. The
location of the QuickForm and its title cannot be changed.

When updating a QuickForm, Interstage BPM replaces the existing form with a newly
generated form. If you have customized the layout of the existing form, all customizations
will be lost.

Note:

To update a QuickForm:
1. Select the node with which the QuickForm has been associated, to display the Properties view

for it.
2. Select the Forms tab.
3. Select the form and click Update.
4. In the Form Properties dialog, make the required changes.

For more information, refer to section Creating QuickForms on page 195 and to section Form
Controls for QuickForms on page 199.

5. Click Update Form.
6. Confirm that you want to overwrite the existing form.

If you already copied the QuickForm to an Interstage BPM Server, make sure to copy the
updated form to the server as well.

Note:

8.5.2 Associating QuickForms with Nodes
When you create a QuickForm, it is automatically associated with the node for which you created it.
You can reuse existing QuickForms and associate them with additional nodes.
To associate an existing QuickForm with a node:
1. Select the Start Node, Activity Node, Voting Activity Node, or Compound Activity Node with which

you want to associate the form, to display the Properties view.
2. Select the Forms tab.
3. Click Browse and select a QuickForm that you previously created.
4. Click OK to associate the form.

You return to the Forms tab. The title of the form and its location is displayed.

8.5.3 Dissociating QuickForms from Nodes
You can dissociate a QuickForm from a node. This removes the association, but does not remove
the QuickForm itself.
To dissociate a QuickForm from a node:
1. Select the node to display the Properties view for it.
2. Select the Forms tab.
3. Select the form to be dissociated and click Remove.

Interstage Business Process Manager Studio User's Guide 204

8: Using Forms



9 Modeling Subprocesses, Remote Subprocesses and
Chained-Processes
Interstage BPM enables you to break complex tasks into easier-to-handle units.
Using subprocesses, you can seamlessly link the work of different departments with different
processes for the purpose of trading information and coordinating collaborative tasks. A subprocess
can run on the same workflow server as the parent process or on a remote workflow server.
A chained-process is a process that operates independently once it has been activated by its parent
process. The parent process continues with its own flow logic without waiting for the chained-process
to complete.
This chapter explains how to model subprocesses, remote subprocesses and chained-processes.

9.1 Modeling Subprocesses
Subprocesses are used to break complex tasks into a hierarchy of easier-to-handle units. They are
most appropriate for seamlessly linking the work of different departments with different processes
for the purpose of trading information and coordinating collaborative tasks.
A subprocess is represented by a Subprocess Node in the parent process definition. When a
Subprocess Node is reached, control is passed to the subprocess. The parent process waits for the
subprocess to complete and the results to come back.
To model a subprocess:
1. Create the parent process definition and model the process flow.
2. Create the subprocess definition and model the process flow.
3. Add a Subprocess Node to the parent process definition.
4. Connect the parent to the subprocess definition.

For instructions, refer to section Connecting Parent and Subprocess Definitions on page 205.
When the process definitions are connected, you can easily navigate from the parent to the
subprocess definition. For instructions, refer to section Navigating to Subprocess Definitions on
page 206.

5. In both parent and subprocess definitions, specify the User Defined Attributes (UDAs) that will
be passed back and forth.

You can use different names for the same UDA in the process definitions involved. However,
the data type must be identical. Otherwise, you cannot map the UDAs.

Note:

6. Define data mappings for the UDAs that need to be passed back and forth.
For instructions, refer to section Defining Data Mappings for Subprocesses on page 207.

Be careful when designing process definitions that have recursive subprocesses. Check all
process definitions involved and make sure that there are no infinite recursions.

Note:

9.1.1 Connecting Parent and Subprocess Definitions
Once you have created the parent and subprocess definition, you can connect them.
To connect process definitions using drag and drop:
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To connect the parent process definition and the subprocess, drag the subprocess definition and
drop it on the Subprocess Node of the parent process definition.
To connect process definitions using Browse:
1. Make sure that you have added a Subprocess Node to the parent process definition.
2. Select the Subprocess Node to display the Properties view for the node.
3. Select the Data Mapping tab.
4. Click Browse.
5. In the Select Subprocess Definition dialog, click Get List.
6. Select the subprocess definition and click OK.

9.1.2 Navigating to Subprocess Definitions
Prerequisites:
• You have created a subprocess definition.
• In the parent process definition, you have added a Subprocess Node.
• You have connected the Subprocess Node to the subprocess definition.

You can navigate from a parent process definition to a subprocess definition.
To navigate to a subprocess definition:
1. In the parent process definition, select the Subprocess Node.
2. Right click and select Go to Subprocess from the pop-up menu.

A new Process Definition editor is opened displaying the subprocess definition.
If you do not want to edit the subprocess definition, but simply want to view it, you can display it in
a separate window: In the parent process definition, click the plus sign (+) of the Subprocess Node.
The subprocess definition will be openend in a separate window, for example:

Figure 132: Subprocess Definition
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9.1.3 Defining Data Mappings for Subprocesses
Prerequisites:
• You have specified User Defined Attributes (UDAs) that will be passed back and forth in the

parent process definition and in the subprocess definition.
• The UDAs you want to pass have the same data type in the parent process definition and

subprocess definition.
• You have connected the parent process definition and the subprocess definition.

When data is to flow between parent and subprocess, you map the UDA of the parent process
definition to the corresponding UDA of the subprocess definition. Also, you specify in which directions
values are to be passed between parent and subprocess definition.
Auto data mapping for parent process definition and subprocess definition
When the pre-requisites mentioned above are fulfilled and you connect the parent process definition
and the subprocess definition, data mapping between them is automatically completed. The UDAs
of the parent process definition are mapped to the UDAs of the subprocess that have the same data
types as that of the parent process definition. To view the automatically mapped UDAs, click the
subprocess node of the parent process definition and select the Data Mapping tab. The mapped
UDAs are displayed in All Data Mappings area along with their data flow directions.
Editing data mapping
To delete unwanted mappings, select them in All Data Mappings area and click the Delete button.
You need to manually edit the UDA mappings in the following scenarios:
• If the mappings that were automatically created after connecting the parent and subprocess

definition were incorrect and need to be changed
• If you add or edit UDAs in the parent process definition and the subprocess definition after

connecting them
To manually edit UDA mappings
1. Select the Data Mapping tab of the subprocess node in the parent process definition.
2. To map a UDA:

a) From the Mapping Type drop-down list, select the data type of the UDA you want to map.
This drop-down list displays all data types that occur in the parent process definition. TheUDA
in the parent process definition and UDA in the subprocess definition drop-down lists
are populated with the UDAs of the same mapping type as selected in the Mapping Type
drop-down list.

b) Select the UDA in the parent process definition and the corresponding UDA of the same type
as that of the parent process definition UDA in the subprocess definition.

c) Click Add.
In the All Data Mappings area, the mapped UDAs are displayed.

3. If the UDA type is XML then click in the corresponding XPath column field. A drop-down list is
displayed. Select from the drop-down list, the XPath expression that specifies where the data
can be found in the XML string of the Source UDA. This field is active only if you have selected
a UDA of type XML. The XPath expressions related to the selected UDA are displayed in the
XPath drop-down list.

4. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the ellipsis (...) button that is displayed next to the XPath drop-down list. XPath Editor dialog
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is displayed with the selected XPath expression in its editor area. You can edit this XPath
expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

5. In the All Data Mappings area, specify the data flow between process definitions:
a) When the data value passes from the parent to the subprocess, click Input.
b) When the data value passes from the subprocess to the parent process, click Output.

Figure 133: Defining Data Mappings

9.2 Modeling Remote Subprocesses
Remote subprocesses are subprocesses that run on a remote workflow server. A remote workflow
server might be, for example, another Interstage BPM Server.
Interstage BPM supports two open protocols for communication between workflow servers: Simple
Workflow Access Protocol (SWAP) and Asynchronous Service Access Protocol (ASAP). These
protocols pass XML messages over HTTP between workflow servers.
You are recommended to use ASAP when the processes run on integrated Interstage BPM Servers.
Use SWAP with CollaborationRing only. For details about CollaborationRing integration, contact
your local Fujitsu Support Organization.
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A remote subprocess is represented by a Remote Subprocess Node in the parent process definition.
The interaction between parent and remote subprocess comprises the following steps:
1. When a Remote Subprocess Node is reached, the local workflow server sends a StartProcess

request to the remote workflow server, carrying with it the User Defined Attribute (UDA) values
that the remote subprocess instance will work on.

2. The remote workflow server must receive this request, and start a process instance.
3. When the remote process instance completes, its workflow server sends a ProcessCompleted

message back, carrying with it the results of the subprocess instance.
4. The local workflow server must receive this message, incorporate the results, and complete the

Remote Subprocess Node allowing the process instance to continue to the next node.
For a successful interaction, the following must be configured with the parent process definition:
• The URI of the remote process definition
• The names of the UDAs that will be passed back and forth
• Return values of the subprocess definition.
The following instructions assume that the process definitions to be connected will run on Interstage
BPM Servers. For details about CollaborationRing integration, contact your local Fujitsu Support
Organization.
To model a remote subprocess:
1. Create the parent process definition and model the process flow.
2. Create the subprocess definition and model the process flow.
3. Add a Remote Subprocess Node to the parent process definition.
4. For each result that the subprocess might return, add an outgoing arrow to the Remote Subprocess

Node.
A Remote Subprocess Node may have one or more outgoing arrows. Only one arrow is chosen
when the parent process resumes. The arrow that is chosen is the one that matches the result
of the remote subprocess.

5. Make sure that the names of the outgoing arrows match exactly the result values that are returned
by the remote subprocess.
The result values correspond to the names of the Exit Nodes in the remote subprocess definition.

The names of the Exit Nodes in the subprocess definition and the names of the outgoing
arrows must be identical, also regarding uppercase/lowercase.

Note:

6. Connect the parent to the remote subprocess definition.
For instructions, refer to section Connecting Parent and Remote Subprocess Definition on page
210.

7. In both parent and subprocess definitions, specify the UDAs that will be passed back and forth.

You can use different names for the same UDA in the process definitions involved. However,
the data type must be identical. Otherwise, you cannot map the UDAs.

Note:

8. Define data mappings for the UDAs that need to be passed back and forth.
For instructions, refer to section Defining Data Mappings for Remote Subprocesses on page 211.
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9.2.1 Connecting Parent and Remote Subprocess Definition
In order to connect parent and remote subprocess definition, you need to know the URL of the remote
subprocess definition.
The following procedure tells you how to find the URL if you are integrating remote subprocess
definitions modeled with Interstage BPM. If you are integrating remote subprocess definitions modeled
with other products, refer to the documentation of that product on how to find the URL.
To connect process definitions:
1. Make sure that you know the hostname of the Interstage BPM Server on which the remote

subprocess will run.
Access the Interstage BPM Console on the Server where the definition of the remote subprocess
is located and log in to the Console. Refer to the Interstage Business Process Manager User's
Guide for details.

2. In the Console, select the remote subprocess definition from the Process Definitions list.
a) Open the remote subprocess definition.
b) In the Process Definition Details area, click Details tab.

Figure 134: Finding out the URL - part I

c) The Details tab is opened. On this page, you see the URL of the selected process definition
in the ASAP field.

d) Copy the URL in the ASAP field in order to avoid typos.

3. Open the parent process definition in the Interstage BPM Studio.
4. Make sure that you have added a Remote Subprocess Node to the parent process definition.
5. Select the Remote Subprocess Node to display the Properties view for the node.
6. Select the Data Mapping tab.
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7. Paste the URL you copied in Step 2d) to Factory Address of Subprocees Definition field.
8. Select the communication protocol to be used by the workflow servers on which the parent process

and the subprocess will run.
You are recommended to use ASAP when the processes run on integrated Interstage BPM
Servers. Use SWAP with CollaborationRing only. For details about CollaborationRing integration,
contact your local Fujitsu Support Organization.

9.2.2 Defining Data Mappings for Remote Subprocesses
Prerequisites:
• You have specified User Defined Attributes (UDAs) that will be passed back and forth in the

parent process definition and in the remote subprocess definition.
• When running the process and subprocess on Interstage BPM Servers: The UDAs you want to

pass have the same data type in the parent process definition and remote subprocess definition.
• You know the identifiers of the UDAs that are used in the remote subprocess definition.
• You have connected the parent process definition and the remote subprocess definition.

When data is to flow between parent and remote subprocess, you map the UDA of the parent process
definition to the corresponding UDA of the remote subprocess definition. Also, you specify in which
directions values are to be passed between parent and remote subprocess definition.
To map data between parent and remote subprocess definition:
1. Open the parent process definition.
2. Select the Remote Subprocess Node to display the Properties view for the node.
3. Select the Data Mapping tab.
4. To map a UDA:

a) From the Mapping Type drop-down list, select the data type of the UDA you want to map.
b) Select the UDA in the parent process definition (UDA in the local process definition).
c) Type the identifier (ID) of the corresponding UDA in the remote subprocess definition (UDA

in the remote process definition).
d) Click Add.

5. If the UDA type is XML then click in the corresponding XPath column field. A drop-down list is
displayed. Select from the drop-down list, the XPath expression that specifies where the data
can be found in the XML string of the UDA. This field is active only if you have selected a UDA
of type XML. The XPath expressions related to the selected UDA are displayed in the XPath
drop-down list.

6. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the ellipsis (...) button that is displayed next to the XPath drop-down list. XPath Editor dialog
is displayed with the selected XPath expression in its editor area. You can edit this XPath
expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:
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XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

7. In the All Data Mappings area, specify the data flow between process definitions:
a) When the data value passes from the parent to the remote subprocess, click Input.
b) When the data value passes from the remote subprocess to the parent process, click Output.

Figure 135: Defining the Data Mapping

9.3 Modeling Chained-Processes
A chained-process operates independently once it has been activated by its parent process. The
parent process continues with its own flow logic without waiting for the chained-process to complete.
The interaction between a parent process and a chained-process goes in one direction only. Neither
process control nor values of User Defined Attributes (UDAs) are passed back to the parent process.
To model a chained-process:
1. Create the parent process definition and model the process flow.
2. Create the Chained-Process definition and model the process flow.
3. Add a Chained-Process Node to the parent process definition.
4. Connect the parent to the chained-process definition.

For instructions, refer to section Connecting Parent and Chained-Process Definitions on page
213.
When the process definitions are connected, you can easily navigate from the parent to the
chained-process definition. For instructions, refer to section Navigating to Chained-Process
Definitions on page 213.
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5. In both parent and chained-process definitions, specify the User Defined Attributes (UDAs) that
will be passed from the parent to the chained-process.

You can use different names for the same UDA in the process definitions involved. However,
the data type must be identical. Otherwise, you cannot map the UDAs.

Note:

6. Define data mappings for the UDAs that need to be passed to the chained-process.
For instructions, refer to section Defining Data Mappings for Chained-Processes on page 213.

9.3.1 Connecting Parent and Chained-Process Definitions
Once you have created the parent and chained-process definition, you can connect them.
To connect process definitions using drag and drop:
To connect the parent process definition and the chained-process, drag the chained-process definition
and drop it on the Chained-Process Node of the parent process definition.
To connect process definitions using Browse:
1. Make sure that you have added a Chained-Process Node to the parent process definition.
2. Select the Chained-Process Node to display the Properties view for the node.
3. Select the Data Mapping tab.
4. Click Browse.
5. In the Select Subprocess Definition dialog, click Get List.
6. Select the chained-process definition and click OK.

9.3.2 Navigating to Chained-Process Definitions
Prerequisites:
• You have created a chained-process definition.
• You have added a Chained-Process Node to the parent process definition.
• You have connected the Chained-Process Node to the chained-process definition.

You can navigate from a parent process definition to a chained-process definition.
To navigate to a chained-process definition:
1. In the parent process definition, select the Chained-Process Node.
2. Right click and select Go to Subprocess from the pop-up menu.

A new Process Definition editor is opened displaying the chained-process definition.
If you do not want to edit the chained-process definition, but simply want to view it, you can display
it in a separate window: In the parent process definition, click the plus sign (+) of the Chained-Process
Node. The chained-process definition will be openend in a separate window.

9.3.3 Defining Data Mappings for Chained-Processes
Prerequisites:
• You have specified User Defined Attributes (UDAs) that will be passed from the parent to the

chained-process definition in the parent and in the chained-process definition.
• The UDAs you want to pass have the same data type in the parent and the chained-process

definition.
• You have connected the parent and the chained-process definition.
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When data is to flow between parent and chained-process, you map the UDA of the parent process
definition to the corresponding UDA of the chained-process definition.
Auto data mapping for parent process definition and chained-process definition
When the pre-requisites mentioned above are fulfilled and you connect the parent process definition
and the chained-process definition, data mapping between them is automatically completed. The
UDAs of the parent process definition are mapped to the UDAs of the chained-process that have
the same data types as that of the parent process definition. To view the automatically mapped
UDAs, click the chained-process node of the parent process definition and select the Data Mapping
tab. The mapped UDAs are displayed inAll Data Mappings area along with their data flow directions.
Editing data mapping
To delete unwanted mappings, select them in All Data Mappings area and click the Delete button.
You need to manually edit the UDA mappings in the following scenarios:
• If the mappings that were automatically created after connecting the parent and chained-process

definition were incorrect and need to be changed
• If you add or edit UDAs in the parent process definition and the chained-process definition after

connecting them
To manually edit UDA mappings
1. Select the Data Mapping tab of the chained-process node in the parent process definition.
2. To map a UDA:

a) From the Mapping Type drop-down list, select the data type of the UDA you want to map.
This drop-down list displays all data types that occur in the parent process definition. TheUDA
in the parent process definition and UDA in the chained-process definition drop-down
lists are populated with the UDAs of the same mapping type as selected in the Mapping Type
drop-down list.

b) Select the UDA in the parent process definition and the corresponding UDA of the same type
as that of the parent process definition UDA in the chained-process definition.

c) Click Add.
d) If the UDA type is XML then click in the corresponding XPath column field. A drop-down list

is displayed. Select from the drop-down list, the XPath expression that specifies where the
data can be found in the XML string of the UDA. This field is active only if you have selected
a UDA of type XML. The XPath expressions related to the selected UDA are displayed in the
XPath drop-down list.

e) Optional: If you want to edit the XPath expression that you selected in the XPath drop-down
list, click the ellipsis (...) button that is displayed next to the XPath drop-down list. XPath Editor
dialog is displayed with the selected XPath expression in its editor area. You can edit this
XPath expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:
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The data mapping is added to the All Data Mappings area.

This indicates that the data value passes from the parent to the chained-process. As the
chained-process operates independently from its parent once it has become active, no data
values are passed back to the parent.

Note:

Figure 136: Defining Data Mappings
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10 Decision Tables
Decision Tables allow you to design advanced rules for decision making without programming.
Decision Tables use a simple yet powerful table based approach for managing rules dynamically.
Decision Tables avoid the need to learn, develop, and support a complex rules engine infrastructure.
Rules engines are very generic and building a usable business application with them can take a long
time. Also, applications are often limited because they must use the rules engine’s API or access
provided by the rules engines.
To add Decision Tables, see Creating a New Decision Table on page 218 .

10.1 Summary of the Decision Tables Procedure
You must perform the steps for creating and configuring a Decision Table, in a particular order, if
you want a useful Decision Table. It is assumed that you have a particular Process Definition for
which you need this advanced rules functionality. The following is a summary of the steps for creating,
configuring, and using a Decision Table:
1. Open an existing application or create a new application. Refer to Creating Workflow Application

Projects on page 80 for instructions.
2. Add Rules Sets to the Rules folder. Refer to the section Creating a New Rule Set on page 217.
3. Add Decision Table Files to the Rules Set folder. Refer to the sectionCreating a New Decision

Table on page 218.
4. Add conditions to your Decision Table. These are the inputs to your Decision Table. You will map

these conditions to User Defined Attributes (UDAs) in a later step. Refer to section Adding or
Editing Conditions on page 221 for instructions.

5. Add results to your Decision Table. These are the outputs to your Decision Table. You will map
these results to UDAs in a later step. Refer to section Adding or Editing Results on page 223 for
instructions.

6. Add decisions to your Decision Table. These are the actual rules. These rules are evaluated to
determine the results of your Decision Table. Refer to section Adding or Editing Decisions on
page 225 for instructions.

7. Save your changes by clicking Save in the tool bar.
The Save button appears as soon as you have modified any information in a Decision Table.

8. The system validates the Decision Table while saving the changes made to it. Refer to Validating
Decision Tables for Errors and Warnings on page 227 for more information about validating the
Decision Tables for errors and warnings.
After validating the Decision Table, errors and warnings in the Decision Table, if any, are displayed
in the BPM Problems View tab.

9. Test the Decision Table that you just created. Refer to sectionValidating Decision Table Rules
on page 229 for instructions.

10. Assign the Decision Table to a Java Action and map the conditions and results added in an earlier
step to the UDAs that you want to use as input to the Decision Table. Refer to section Assigning
Decision Tables to Java Action on page 230 for instructions. You will map conditions using the
Action Set tab from the Activity Node Properties dialog.
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10.2 Creating a Decision Table
In the Studio application, every Application Project has a Rules directory that contains Rules Sets.
Each Rules Set stores Decision Tables (.dt files). Rules Set is a sub-directory within the Rules
directory.

Figure 137: Decision Table Menu

Perform the following steps to create a Decision Table File
• Create a new application. Refer to Creating Workflow Application Projects on page 80
• Create a Rules Set folder. Refer to Creating a New Rule Set on page 217
• Create a Decision Table inside the Rules Set folder. Refer to Creating a New Decision Table on

page 218

10.2.1 Creating a New Rule Set
To create a new Rule Set:
1. Right click on the Rules folder. Select New > Rules > Rules Set. You can also go to File and

select New > Rules > Rules Set, from the Windows menu.
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The New Rules Set wizard is displayed.

Figure 138: New Rules Set Wizard

2. Enter the Rule Set name in the Rule Set name field and click Finish.
A new Rules Set folder is created under the Rules folder.

You cannot create a Rules Set folder directly in an application or in another Rules Set
folder. Rules Set folders can only be created in the Rules folder.

Note:

To add a Decision Table to the Rules Set folder, see Creating a New Decision Table on page 218.

10.2.2 Creating a New Decision Table
Pre-requisites: To create a Decision Table File, you should have already created a Rules Set folder
in the Rules folder of the application.

To Create a Decision Table:
1. Right click on the Rules Set folder. Select New > Rules > Decision Table. You can also go to

File and select New > Rules > Decision Table , from the Windows menu.
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The New Decision Table Wizard is displayed.

Figure 139: New Decision Wizard

2. Enter the Decision Table name in the Name field and click Finish.
A new rules file is created in Rules Set folder and the Decision Table Editor is displayed.

3. Enter a name for your Decision Table, if you have not already entered in the previous step, in the
Name field and a description in theDescription field (a description is optional but recommended).

The decision table should be created with .dt extension.Note:

A Rules Set folder is associated to the application that it is part of, and a .dt file is associated
to the Rules Set folder it belongs to. Thus, the Rules Set names should be unique in an
Application and the .dt file names should be unique in a Rules Set folder.

Note:
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The example in the following figure creates a Decision Table called DiscountDecision.dt.

Figure 140: Creating a Decision Table

4. Click Save in the toolbar.
Your new Decision Table is saved. To know more about adding and editing Decision Tables,
refer to Editing a Decision Table on page 221.

5. To remove a Decision Table file, right click on the file in the Navigator view of Studio, and select
Delete.
You can also import and export Decision Table files and BAR files. See Exporting Decision Table
Files on page 220 and ImportingDecision Table Files on page 220 andCreatingWorkflowApplication
Projects on page 80 sections for more information.

Exporting Decision Table Files
You can export saved Decision Tables to an external file to back them up or archive them. Right
click on the Decision Table file in the Navigator view of Studio, and select Export. You can also go
to File and select Export. Save the file to the local file system.

Importing Decision Table Files
Before you can use these instructions effectively, you must have a Decision Tables file (*.dt) from
an Interstage BPM installation containing Decision Tables that you want to import. You will also need
to know the location of this file.
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To import Decision Tables from another Interstage BPM installation:
1. Right click the Decision Table file or the Rule Set folder, in the Navigator view, and select Import.

You can also go to File and select Import.
The Import Decision Tables dialog is displayed.

2. Navigate to the Decision Table file (*.dt) that you want to import. Select the file and click Open.
3. The Decision Table file that you imported is displayed in the corresponding Rules Set folder, in

the Navigation view.

10.3 Editing a Decision Table
To add a decision to the Decision Table, add condition and result variables and map them. These
actions have been explained in the subsequent sections.
• Adding or Editing Conditions on page 221
• Adding or Editing Results on page 223
• Adding or Editing Decisions on page 225

10.3.1 Adding or Editing Conditions
Pre-requisites: To use the instructions in this section you must have already created a Decision
Table. See Creating a New Decision Table on page 218 for information on creating a Decision Table
file.

A condition is an individual data variable defined in the Conditions list.
To add a condition to the Conditions list:
1. Double-click the Decision Table file from Rules folder of the application. The Decision Table is

located in the corresponding Rule Set folder.
The Decision Table Editor is displayed.

2. To add a new condition to the Decision Table, in the Condition section of the Decision Table
Editor, click Add.
A new condition with the default name, Condition0 is added to the Condition table.

3. Click on the default name of the condition to change it.
4. Enter a description (optional) for the condition in the corresponding Description column.

5. Enter information about substitute mapping in the Data Dictionary column. See Data Dictionary
on page 222 for information on how to add substitute values for user inputs.

6. Select a data type for the condition from the Type column. Click the down arrow in the
corresponding row, to display type field options.

7. Click Save from the tool bar to save the condition.
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The figure below demonstrates the addition of conditions called CustomerType, Region, DayofWeek
of data type STRING.

Figure 141: Adding a Condition

8. To remove a condition, select it in the Conditions list and click Remove .
The condition is removed from the Decision Table Conditions List.

9. To copy the condition, select it in the Conditions list and click Copy.
The condition is copied.

10. To paste the condition, copy the condition as described in the above step. Select the row above
which you want to paste the condition and click Paste. If you do not specify a row, the copied
condition is pasted below the last condition.

11. You can also move the conditions up and down using the Up and Down buttons. To do this,
select the condition that you want to move and click Up or Down according to your requirement.

You can copy, move up, move down, and remove multiple conditions by holding down the
Shift or Cntrl keys and selecting multiple rows.

Note:

You can now add results to your Decision Table. See Adding or Editing Results on page 223 section
for more information.

Data Dictionary
Decision Tables also support the use of a custom dictionary for value mapping. You can define
synonyms of values, and the system will automatically use the appropriate values. This makes the
system more flexible.
To use value mapping:
1. In the Conditions section of the Decision Table Editor, for a given condition, click the

corresponding Data Dictionary cell.
The Data Dictionary dialog is displayed. The condition information is displayed in the Condition
Details section of the dialog.
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2. Enter the UDA value in the Input Value field.
3. Enter the value that you want to substitute for your UDA Value in the Substitute value field.
4. Click Add Mapping.

The mapping appears in the Value Mapping list.

The substitute value that you entered is used in your condition in place of the Input Value that you
enter.

Example: Substituting California for CA
If you entered CA as your input value and California as your substitute value, then clicked Add
Mapping (see figure below), California will be the value of the condition when CA is the value of the
UDA.

Figure 142: Substitute Mapping CA to California

10.3.2 Adding or Editing Results
Pre-requisites: To use the instructions in this section you must have created a Decision Table. See
Creating a New Decision Table on page 218 for information on creating a Decision Table file and
added conditions to your Decision Table.

A result is generated by a Decision Table if the criterion specified in one of its decisions is satisfied
with respect to its conditions.
A result is a pre-defined action. Use the Result section to add and store results. After a result is
mapped to a condition parameter in the Decision section, if the condition specified in the Decision
expression is met, then the result action is executed.
To add a result to the Results List:
1. Double click the Decision Table file from Rules folder of the application. The Decision Table file

is located in the corresponding Rules Set folder.
The Decision Table Editor is displayed.
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2. To add a new result to the Decision Table, in the Results section of the Decision Table Editor,
click Add.
A new result with the default name, Result0 is added to the Result table.

3. Click on the default name of the result to change it.
4. Enter a description (optional) for the result in the corresponding Description column.

5. Select a data type for the result from the Type column. Click the down arrow in the corresponding
row, to display type field options.
The figure below demonstrates the addition of a result called Discount.

Figure 143: Adding a Result

6. To remove a result, select it in the Results list and click Remove .
The result is removed from the Results list.

7. To copy the result, select it in the Results list and click Copy.
The result gets copied.

8. To paste the result, copy the result as described in the above step. Select the row above which
you want to paste the result and click Paste. If you do not specify a row, the copied result is
pasted below the last result.

9. You can also move the results up and down using the Up and Down buttons. To do this, select
the result that you want to move and click Up or Down according to your requirement.

You can copy, move up, move down, and remove multiple results by holding down the
Shift or Cntrl keys and selecting multiple rows.

Note:
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You can now add decisions to your Decision Table. See Adding or Editing Decisions on page 225 for
more information.

10.3.3 Adding or Editing Decisions
Pre-requisites: Before using the instructions in this section, you must have added conditions and
results to your decision table. See Adding or Editing Conditions on page 221 and Adding or Editing
Results on page 223.

To add or edit a decision in a Decision Table:
1. Double click the Decision Table file from Rules folder of the application. The Decision Table file

is located in the corresponding Rules Set folder.
The Decision Table Editor is displayed.

2. To add a new decision to the Decision Table, in the Decision section of the Decision Table
Editor, click Add.
A new row will be added with incremental serial number in the No. column of the Decisions table.
If this is the first decision you are adding to the Decision Table the numeral 1, is displayed in the
No. column.

3. The conditions and results that you added previously, are displayed as separate columns in the
Decisions section.

4. Click the cell corresponding to a condition. A text area followed by the Expression Builder button
is displayed. Click the button.
The Expression Builder dialog is displayed.

The various comparison operators that are supported are listed below.Note:

5. Select the operation that you want to apply for the conditon from the Operator drop-down.

Figure 144: Expression Builder

The Expression Buider can be used to generate an expression for the condition, using the following
comparison operators.
• <= (less than or equal to)
• < (less than)
• = (equal)
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• != (not equal)
• > (greater)
• >= (greater than or equal to)
• in

• between

• like

• notlike

You can also modify the condition and result values directly in the Decision table. To do
this, click on the cell in the condition or results column and enter the expression in the text
area. An error is displayed in case the expression is entered in a wrong format.

Note:

For the operators =,!=,<,>,<=,>= , the format is operator followed by the value. For
example, =xyz. For operators in,like,not like, between the format is
operator(value1,value2...). For example, in(a,b,c).

Note:

The following table lists different operators supported for specific data types.

StringDateBigDecimalLongFloatIntegerBooleanOperator

NoYesYesYesYesYesNo<

NoYesYesYesYesYesNo>=

NoYesYesYesYesYesNo<=

NoYesYesYesYesYesNo>=

YesYesYesYesYesYesYes!=

YesYesYesYesYesYesYes=

YesYesYesYesYesYesNoin

NoYesYesYesYesYesNobetween

YesNoNoNoNoNoNolike

YesNoNoNoNoNoNonotlike

6. Click OK.
The expression is displayed in the Decision Table Editor, corresponding to the condition.

7. In the Discount column, enter the value for the decision, if a given condition is true.
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For example, the decision in the below screen shows if CustomerType = Gold, Region = CA, then
Discount = 10.

Figure 145: Adding a Decision

When specifying multiple conditions, you can leave the value of one of the conditions blank. A
blank value is a wildcard that matches any value. The decision displayed in the figure above
executes with any DayofWeek

Blank values can be provided as input values for any condition, even for conditions of type
BOOLEAN. Blank input values are treated as wildcards.

Note:

At run time, Interstage BPM evaluates all of the defined decisions in the order shown on the Decision
Table Details page. When defining decisions, make sure that the order makes sense. If multiple
decisions apply, the result of the decision that is evaluated first is finally used. As an example, say
you define the following discount rules:
• Decision 1: For a sales amount > $50000, a discount rate of 20% applies.
• Decision 2: For a sales amount > $20000, a discount rate of 10% applies.
If a process instance has a sales amount of $70000, both decisions match. But as soon as the first
discount rule is evaluated, the discount rate is set to 20%. The second Decision is ignored. If you
want to add a decision with values of all conditions as blank, and if it is the first decision to be
evaluated then that decision will be used. The other decisions will be ignored.
To validate decision rules, see Validating Decision Table Rules on page 229.
To know about mapping UDAs, conditions and results to a Process Definition using JavaAction, see
Assigning Decision Tables to Java Action on page 230.

10.4 Validating Decision Tables for Errors and Warnings
Decision Tables need to be validated for any errors or warnings. Decision Tables do not test
successfully if errors exist in them. Decision Table files can be validated by using any of the following
methods:
• Using the Validate icon: Click the Validate icon to validate the Decision table. This icon is located

near the New icon below the File menu. The errors and warnings in the Decision Table are
displayed in BPM Problems View tab below the Decision Table editor.

• Using the Validate Rules link: Click this link to validate the Decision Table. Refer to Validating
Decision Table Rules on page 229 for more information about Validate Rules link. The Test
Decision Tables dialog is displayed in which the Decision Table can be validated.

• Saving the Decision Table: Click Save or Save As from File menu. In this scenario, validation
of the Decision Table is done before saving it. If the Decision Table file is valid; it is saved. If it is
not valid then an error message "Decision Table file is not valid. Would you like to save it anyway?"
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is displayed. If you click Yes on the error message dialog, the Decision Table is saved with errors
and warnings and they are displayed in BPM Problems View tab. If you click No, the BPM
Problems View tab is restored to its earlier state, that is, the state before saving the Decision
Table and the file is not saved. If you click Details, the errors and warnings in the Decision Table
are displayed below the error message.

• Closing the Decision Table: Click Close to close the Decision Table. If you modify the Decision
Table and do not save the changes before closing it, the Save Resource dialog is displayed with
a message "<Decision Table Name> has been modified. Save changes?". If you click Yes on
the dialog, an error message "Decision Table file is not valid. Would you like to save it anyway?"
is displayed if the Decision Table is not valid. All the three options on this dialog have been
explained in Saving the Decision Table above. If you click No on the Save Resource dialog,
the file is not saved and closed immediately. If you click Cancel on it, the Decision Table is neither
saved nor closed.

The errors and warnings are displayed in BPM Problems View tab. Double clicking on the error row
selects the area in the Decision Table editor where the error has occurred. The error can be corrected
in this view. Refer to BPM Problems View on page 60 for more information about BPM Problems
View. The figure below displays theBPMProblems View and the errors and warnings in the Decision
Table.

Figure 146: Validating Decision Table File
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10.5 Validating Decision Table Rules
Pre-requisites: You must have a complete Decision Table to test before using these instructions.
At a minimum, you must map conditions for your Decision Table before testing it.

Interstage BPM provides a means by which you can validate Decision Tables that you have created.
Upon clicking the Validate Rules link, the Decision Table is validated for errors and warnings, if any,
in the Decision Table. If errors exist in the Decision Table then the Test Decision Tables dialog
does not open. If only warnings exist in the Decision Table then the Test Decision Tables dialog
opens. After validating the Decision Table, the errors and warnings in the Decision Table are displayed
in BPM Problems View tab. Refer to Validating Decision Tables for Errors and Warnings on page
227 for validation methods of the Decision Tables and BPM Problems View on page 60 for BPM
Problems View.
Using the Test Decision Tables dialog, you can test a Decision Table and validate the result.
To test a Decision Table:
1. Make sure that theDecision Table Editor of the Decision Table that you want to test is displayed.
2. Click Validate Rules.

The Test Decision Tables dialog opens if no errors exist in the Decision Table. It opens if warnings
exist or do not exist in the Decision Table.

3. Click Add and enter values in each of the input fields that correspond to the values that you
expect from the UDAs, that are mapped through conditions.

4. Click Test.
Test results are generated on the Decision Table Test page. Complete audit information is
provided. With this information, you can easily see which decision is matched along with its result.
The Decision Table is also provided on this page for quick reference. The test data will be saved
after each test.
The figure below displays the results of a test on the DiscountDecision Decision Table.

Figure 147: Results of Test on DiscountDecisionDecision Table
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10.6 Using the Decision Table Action
When you install Interstage BPM, a pre-built Java Action is included to facilitate the use of Decision
Tables. This section includes instructions for selecting process definitions that will work with a Decision
Table, creating a Decision Table Action to contain your Decision Table, adding the Decision Table
Action, and using the process that contains the Decision Table Action.

10.6.1 Selecting a Process Definition to Contain Your Decision Table
A Decision Table is useful only if it is run as a component of an Interstage BPM process instance.
The definition for that process instance must contain the following components along with the Decision
Table inside a Decision Table Action for a Decision Table to work correctly:
• Input User Defined Attributes (UDAs) corresponding to those defined as conditions in the Decision

Table
• Output UDAs corresponding to those defined as results in the Decision Table
SeeAssigning Decision Tables to Java Action on page 230 for information on assigning Decision
Table to a Java Action.

If the necessary UDAs are not defined in your process definition, the Decision Table Action
may work unpredictably. For example, the method that you want to use may be unavailable.
A method will be available only if all the UDAs that it uses are defined. If the process definition
UDAs are mismatched with the Decision Table conditions or results, error messages will
appear.

Note:

10.6.2 Assigning Decision Tables to Java Action
Prerequisites:
• You have defined your conditions, results, and decisions in a Decision Table. See Decision Tables

on page 216 section for more information on creating Decision Tables.
• The process definition contains User Defined Attributes (UDAs).

You can integrate Decision Tables into your process definition using the Decision Tables Java Action.
To integrate a Decision Table:
1. Open the process definition that will contain your Decision Table by double clicking the .XPDL

from the Process Definitions folder.
The Process Definition Editor is displayed.

2. To associate your Action with an activity, select the Action Set option from Properties view.
3. Click Add in the corresponding Role Actions, Epilogue Actions, or Prologue Actions tabs, where

you want to add the Java Action. The Action Type List dialog is displayed.
4. Expand Rules Actions and double click Decision Tables.

The Action Editor - Set Rules dialog is displayed.

5. Type a descriptive name and notes for the Java Action in Action Name and Notes fields
respectively.

6. Select the Rules Set to which your Decision Table belongs.
The Rules Set drop-down list displays all the available Rules Sets for the application.

7. Select the Decision Table that you want to use.
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The Decision Table drop-down list displays all the Decision Tables in the selected Rules Set.

Figure 148: Integrating Decision Tables

8. In the Data Mapping table, click in the UDA column and select UDAs that you want to assign to
the conditions and results, from the drop-down list.

By default, no mapping is displayed in the UDA column. When you click in it, drop-down
list of the UDAs is displayed. XML UDAs are displayed in the drop-down list in UDA column
irrespective of the type of the Condition or Result provided the process definition has XML
UDAs. For example, if a Condition is of String type then the UDA drop-down list for that
Condition will also display the XML UDAs even if the type of the Condition is String.

Note:

When you select a UDA in the UDA column of the Data Mapping table, you need to click
inside any other field of the same table in order to confirm the selection of the UDA for
assigning it to the respective condition and result.

Note:

Mapping UDAs to Conditions is mandatory but mapping UDAs to Results is optional. If you
do not map UDAs to Conditions and click OK, an error message is displayed. If you do not
map UDAs to Results and click OK, a warning message is displayed. You can click OK on
the warning message and still assign Decision Tables to the Java Action.

Note:

9. If the UDA is of type XML then, click in the field in the XPath column and select the XPath
expression for the UDA from the drop-down list.

An error message is displayed if XPath is not provided for UDA of type XML.Note:
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The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

10. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the ellipsis (...) button that is displayed next to the drop-down list. XPath Editor dialog is
displayed with the selected XPath expression in its editor area. You can edit this XPath expression
and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

11. Click OK to close the Action Editor dialog.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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11 Advanced Process Modeling
This chapter explains how to use Java Actions and triggers. It also provides information about how
to define JavaScript expressions.

11.1 Using Java Actions
Using Java Actions, you can customize process execution and integrate with external systems.
Interstage BPM Studio provides several types of built-in Java Actions: Notification Actions, Server
Actions, Database Actions, Rules Actions, XML Actions, and Integration Actions. It also provides a
mechanism to integrate methods of your own Java classes as Generic Actions. In addition, Interstage
BPM Studio provides a No-Operation Action that is typically used for specific error situations.
You can assign Java Actions to the process definition itself, to nodes, timers, and due dates. Start
Nodes and Exit Nodes cannot have Java Actions assigned.
When assigning a Java Action, you always assign it to a so-called Action Set. Each Action Set is
executed at a particular point of time during process execution or upon execution of specific
commands.

11.1.1 Types of Java Actions
The following Java Action Sets can be distinguished:
• Init Actions and Process Owner Actions are executed upon process initialization. These Java

Actions initialize User Defined Attribute data before the first activity is performed.
• Commit Actions are executed upon process completion. They can be used to clean up or analyze

the data of an entire process instance.
• Prologue Actions. A Prologue Action is evaluated before an activity starts. This Java Action can

therefore be used to set up or initialize values associated with a specific node before it does its
work.

• Epilogue Actions. An Epilogue Action is executed after a node finishes its task and before the
process instance moves on to another node. This Java Action can therefore be used to clean up
or analyze values associated with the node after the intended work is finished.

• Role Actions. A Role Action is evaluated after resolving a role and before assigning a task. This
Java Action is therefore used to dynamically compute a list of assignees for a task in conjunction
with a Role.

• Timer Actions are executed when a timer expires or a due date is reached.
• Error Actions. An Error Action can be used for handling specific error situations in the execution

of a process. Error Actions can be defined for entire process definitions, for individual nodes and
for other Java Actions, i.e. when you want to react on errors occurring during the execution of
another Java Action.

• Compensation Actions. A Compensation Action can be defined for another Java Action that
accesses a system outside of Interstage BPM, e.g. an external database. Compensation Actions
are useful to ensure a consistent state of all systems involved in a transaction for cleaning up
and rolling back transactions, e.g. to delete a newly added row in an external database.

• A special type of action can be activated as soon as an Administrator issues the command to
abort, suspend or resume the processing of a process instance. Such actions are stored in either
of the following Action Sets:
• onAbort Action
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• onResume Action
• onSuspend Action
on* Java Actions are to be performed before the state of a process instance is changed. They
can be defined for individual activities, i.e. for individual nodes in a process definition, or for an
entire process definition.

11.1.2 Assigning Java Actions
Java Actions can be defined and assigned on three different levels:
• Process definition level: Init Actions, Owner Actions, Commit Actions, Timer Actions, OnSuspend,

OnResume, and OnAbort Actions, Error Actions.
• Node level: Role Actions, Prologue and Epilogue Actions, OnSuspend, OnResume, and OnAbort

Actions, Error Actions, and Timer Actions. The node type determines which type of Java Action
you can assign and at which point in time a Java Action is to be executed. For example, a Web
Service Node can only have Web Service Actions assigned to it and they can be assigned as
Epilogue Actions only.

• Java Action level: Compensation and Error Actions.
When you define Java Actions both on Node level and on process definition level, first the Node
level actions, second the process definition level actions will be executed.
You can create a Java Action once and then use it in different contexts. For example, you can use
the same Java Action as Prologue Action, Error Action, and Compensation Action.

To handle specific error situations, Interstage BPM Studio provides Error Actions and
Compensation Actions. You can assign these actions to any other Java Action. For more
information on Error and Compensation Actions, refer to section Dealing With Errors in Java
Actions on page 240.

Note:

This section gives you an overview of the general steps required for assigning Java Actions.
To assign a Java Action to a process definition or a node:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab.
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The contents of the Action Set tab depends on the item for which you open it. The following
figure shows the Action Set tab for an Activity Node.

Figure 149: Action Set Tab for Activity Nodes

The following figure shows the Action Set tab for a process definition.

Figure 150: Action Set Tab for Process Definitions

Interstage Business Process Manager Studio User's Guide 235

11: Advanced Process Modeling



You can also assign Java Actions to timers and due dates, using the Timers andDue Dates
tabs. For more information, refer to sections Defining Due Dates on page 152 and Defining
Timers on page 154.

Note:

3. Specify which type of Java Action you want to add by selecting the corresponding tab, and click
Add.
The Action Type List dialog is displayed.

Figure 151: Action Type List

4. In the Action Type List dialog, expand the folder where the Java Action to be added is located.
Select the Java Action, and click Create.
A dialog is displayed where you fill in the details for the selected Java Action. You find detailed
explanations of the particular Java Actions in the subsequent sections of this chapter, where all
available Java Actions are described.

5. Click OK.
6. You can rearrange the order in which Java Actions are executed by highlighting the Java Action

and clicking the Up or Down button.
You cannot use the Up and Down buttons to move a Java Action to a different Action Set. To do
this, use cut, copy, and paste (for more information, refer to section Cutting, Copying and Pasting
Java Actions on page 237).

11.1.3 Editing Java Actions
You can edit Java Actions that you have assigned to the process definition or to individual nodes.
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To edit a Java Action:
1. Click the empty space in the Process Definition editor or select the node that has the Java Action

assigned, to display the Properties view for the process definition or the node respectively.
2. Select the Action Set tab.

The Properties view shows all Java Actions that have been assigned to the Action Set. The
following example shows a number of Java Actions assigned to the Owner Action Set.

Figure 152: Displaying the Owner Action Set

3. Select the Java Action that you want to change. Click Edit next to it.
A dialog is displayed where you can make your changes. You find detailed explanations of the
particular Java Actions in the subsequent sections of this chapter.

4. Click OK to close the dialogs.

11.1.4 Cutting, Copying and Pasting Java Actions
You can move or copy Java Actions to another position using cut, copy, and paste.
To use cut, copy and paste a Java Action:
1. Click the empty space in the Process Definition editor or select the node that has the Java Action

assigned, to display the Properties view for the process definition or the node respectively.
2. Select the Action Set tab.
3. To cut a Java Action:

• Select the Java Action and click Cut, OR:
• Right click the Java Action and select Cut from the pop-up menu.
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4. To copy a Java Action:
• Select the Java Action and click Copy, OR:
• Right click the Java Action and select Copy from the pop-up menu.

5. To paste the Java Action, right click the desired Action frame and select Paste from the pop-up
menu.
If you select a folder, the Paste function will paste inside this folder. If you select a Java Action,
the Paste function will paste after the selected Java Action.

Pasting Regular, Error and Compensation Actions
You can copy Java Actions from one Action frame and paste them into another frame. However, it
is not always useful to paste a certain action into another action (for example, pasting an Error Action
into a Compensation Action). As an example, exception qualifiers would be meaningless on a
Compensation Action. Consequently, the Paste function automatically looks to see if there are any
exception settings when pasting to a location that does not use them; any information which will be
useless at the pasted location will be lost.
The following table shows what happens if you paste regular Java Actions, Error Actions, and
Compensation Actions.

Compensation ActionError ActionRegular Java ActionPosition to paste Java
Action ->
Java Action to be
copied

The Error Action is
pasted. The default
Error Action settings
(rollback of transaction,
error state) are applied.
All Error or
Compensation Action
settings in the copied
regular Java Action are
lost.

An Error Action is
pasted. The default
Error Action settings
(rollback of transaction,
error state) are used. All
Error or Compensation
Action settings in the
copied regular Java
Action are lost.

A regular Java Action is
pasted together with the
Error and
Compensation Actions
assigned to it.

Regular Java Action
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Compensation ActionError ActionRegular Java ActionPosition to paste Java
Action ->
Java Action to be
copied

A Compensation Action
is pasted.
All error handling
settings defined in the
Error Handling tab will
be lost (refer to section
Dealing With Errors in
Java Actions on page
240).
All other settings of the
copied Error Action (e.g.
name, description,
WSDL of a web service,
etc.) are successfully
pasted.

An Error Action is
pasted.

A regular Java Action
without Error and
Compensation Actions
is pasted.
All error handling
settings defined in the
Error Handling tab will
be lost (refer to section
Dealing With Errors in
Java Actions on page
240).
All other settings of the
copied Error Action
(e.g. name, description,
WSDL of a web service,
etc.) are successfully
pasted.

Error Action

A Compensation Action
is pasted.

An Error Action is
pasted. The default
Error Action settings
(rollback of transaction,
error state) are used.

A regular Java Action
without Error and
Compensation Actions
is pasted.

Compensation Action

11.1.5 Removing Java Actions
If you no longer want to use a Java Action, you can remove it from the process definition or from a
node.
To remove a Java Action:
1. Click the empty space in the Process Definition editor or select the node that has the Java Action

assigned, to display the Properties view for the process definition or the node respectively.
2. Select the Action Set tab.
3. Select the Java Action that you want to remove. Click Remove next to it.
4. Click OK.

11.1.6 Specifying Transaction Settings
Java Actions are assigned to so-called Action Sets. Action Sets are associated with particular points
of time within process execution:
• Init Actions: When the process instance starts
• Process Instance Owner Actions: When a process instance starts
• Role Actions: When Interstage BPM determines who to assign the activity to
• Prologue Actions: Before an activity is activated
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• Timer Actions: When a timer expires or a due date is reached
• Epilogue Actions: When an activity is completed
• Commit Actions: When the process instance ends
• OnSuspend Actions: When a process instance is suspended
• OnResume Actions: When a process instance is resumed
• OnAbort Actions: When a process instance is aborted
• Error Actions: When a Java Action throws an exception.
• Compensation Ations: When an error occurs in a Java Action that accesses an external system.
As a default, each Action Set runs as a single transaction. If any action in the set fails, the database
transaction for the entire set is rolled back. However, if Java Actions access resources that are not
guarded by the transaction, such as an email server, then those effects cannot be rolled back.
To change transaction settings:
1. Select the node to display the Properties view for the node. TheGeneral tab contains theCommit

Transaction after completion check box.
2. If the Action Sets of the node are not to run as a single transaction, clear theCommit Transaction

after completion check box.

If you wish to make Java Actions run in separate transactions, simply move them to different
sets in different nodes. Make sure that the Commit Transaction after completion check
box is selected for that node.

Note:

11.1.7 Dealing With Errors in Java Actions
When an error occurs during the execution of a Java Action, an exception is thrown. Interstage BPM
allows you to define your own error handling for erroneous Java Actions. In this way, you can prevent
that a process instance goes into error state when an exception is thrown.
In addition, you can define actions for Java Actions which perform a "cleanup" before a transaction
is rolled back and a process instance is set to the error state. This includes a rollback of all Java
Actions in a Java Action Set, and allows you to perform general actions (e.g. sending notification
emails in any error case), or executing some specific actions before setting the process instance to
error state.
Interstage BPM provides the following options to handle errors in Java Actions:
• Compensation Actions: Compensation Actions are used to clean up the system and to ensure

a consistent state of all systems involved in a transaction, e.g. external databases or mail servers.
Compensation Actions are particularly useful whenever external systems are involved.
If you do not define any error handling for a Java Action, the following happens: When an exception
is thrown in this Java Action, the transaction will be rolled back. A rollback, however, is only
possible for changes in the Interstage BPM Application Server context. Any transactions in external
systems cannot be rolled back, for example, if a row has been added to an external database.
Therefore, it is sometimes necessary to manually clean up external systems to ensure a consistent
state of all systems used in the transaction. Optionally, you can use Compensation Action Sets.
You can specify a Compensation Action for every Java Action in an Action Set. You can use a
Compensation Action e.g. for removing a newly added row in a database or for sending out an
additional email. If an exception occurs in a regular Java Action Set, all Compensation Actions
defined for all Java Actions that have been successfully executed before the exception was
thrown, are invoked in reverse order.
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You cannot embed a Compensation Action in another Compensation Action. If a
Compensation Action throws an exception, the process instance will immediately go to error
state, and the execution of remaining Compensation Actions will be aborted.

Note:

Refer to the sample below for more information.

• Error Actions: On Java Action level, Error Action sets will become active when an exception is
thrown in the related regular Java Action. Error Actions are bound together in Action Sets, similar
to all other Action Sets. Error Actions can be specified for any action inside an Action Set. Note
that you cannot define an Error Action that handles exceptions occurring in an Error Action.
For every Error Action, you can specify additional error handling settings on an Error Handling
tab. Note that this tab is only available when defining Error Actions for a Remote Subprocess
Node or a Java Action. On process definition level and when defining Compensation Actions,
defining error handling settings is not required.
• Behavior after Error: Specifies the behavior of the process instance after executing the Error

Action. You can specify that a process instance goes to error state or continues executing in
case of an error.

• Exceptions to React to: You can choose which kind of exceptions trigger the execution of
the Error Action.

In case an Error Action throws an exception, the transaction will be rolled back instantly
and the process instance will go into error state. No Error Action can be defined for such a
case.

Note:

To define Error and Compensation Actions for regular Java Actions:
1. Click the empty space in the Process Definition editor or select the node to display the Properties

view for the process definition or the node respectively.
2. Select the Action Set tab.

The Properties view displays all Java Actions that are available for the selected process definition
or node. If you have not yet defined any Error or Compensation Java Actions for a regular Java
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Action, empty folders for Error and Compensation Java Actions are shown. The following figure
shows a Prologue Actions folder for an Activity Node, consisting of two Java Actions:

Figure 153: Properties view with Prologue Actions

3. Select the regular Java Action for which you want to define an Error and/or Compensation Action.
4. Select the Error Actions or Compensation Actions folder or any Error or Compensation Action

inside the folder, and click Add.
The Action Type List dialog is opened where you can select a Java Action and add this action
as a new Error or Compensation Action.

5. In the Action Type List dialog, expand the folder where the Java Action to be added is located.
Select the Java Action, and click Create.
A dialog is displayed where you fill in the details for the selected Java Action. You find detailed
explanations of the particular Java Actions in the subsequent sections of this chapter, where all
available Java Actions are described.

6. When defining an Error Action for a Remote Subprocess Node or for a Java Action: In the Action
Editor for the selected Java Action, click the Error Handling tab. Here you can specify the following
error handling settings:
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This tab is only available when defining Error Actions on process definition level or for a
Remote Subprocess Node or a regular Java Action. On process definition level and when
defining Compensation Actions, this tab is not available.

Note:

Figure 154: Displaying the Error Handling Tab

• Behavior after Error: Specifies the behavior of the process instance after executing the Error
Action. Select the Goto Error State radio button if you want your process instance to go to
error state. In case of an error, the Compensation Actions specified for the Java Actions and
the Error Actions on process level are executed, the process instance is rolled back, and the
instance is put to error state.
Select the Continue after Error radio button to continue executing your process instance. In
case of an error, the exception gets caught, the Error Actions specified for the failed Java
Action are executed, and the process instance continues. The default setting is Goto Error
State.

If you have defined several Error Actions with different settings, theGoto Error State setting
overrides the Continue after Error setting.

Note:
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• Exceptions to React to: You can choose which kind of exceptions trigger the execution of
the Error Action. If you want the Error Action to react on any kind of exception, select the
Catch All Exceptions radio button. In that case, the Add and Remove buttons are disabled.
Select the Catch Specific Exceptions radio button if you want the Error Action to react on
specific exceptions. In that case, you have to specify the exception class names (for example,
java.lang.NullPointerException), using the Add and Remove buttons.
Note that if you specify java.lang.Exception as exception class, the behavior will be the
same as when specifying Catch All Exceptions, because all exceptions belong to this class
unless you are more specific.

You can combine all error handling settings. Each combination results in a different error handling
procedure. The following table shows all possible combinations and their impact on executing
the defined Java Actions:

Continue after ErrorGoto Error StateError Handling Settings

If a Java Action throws any kind
of exception, the specified Error
Action catches this exception,
and the process instance
continues.

If a Java Action throws any kind
of exception, the specified Error
Action is executed. The
transaction is rolled back, and
the process instance goes to
error state.

Catch All Exceptions

If a Java Action throws the
specified exception, the Error
Action catches this exception,
and the process instance
continues.
If a Java Action throws an
exception that is not specified,
the Error Action is not
executed, the transaction is
rolled back, and the process
instance goes to error state
(default error handling
behavior).

If a Java Action throws the
specified exception, the Error
Action is executed. The
transaction is rolled back, and
the process instance goes to
error state.
If a Java Action throws an
exception that is not specified,
the Error Action is not
executed, the transaction is
rolled back, and the process
instance goes to error state
(default error handling
behavior).

Catch Specific Exceptions

7. Fill in details for the selected Java Action, specify the Error Action behavior, and click OK.
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The new Java Action is displayed in the Properties view. In the example, one Error Action and
one Compensation Action have been added to the Add XML Substructure Prologue Action:

Figure 155: Adding Error and Compensation Actions

11.1.8 Error Handling Sample
The following examples demonstrate the execution of regular Java Actions in conjunction with Error
Actions and Compensation Actions.

Using Error Actions
This example shows how to use regular Java Actions with Error Actions.
You are planning to execute the following Prologue Actions:
1. Sending an email message
2. Transferring a file to a remote location using FTP
3. Inserting a row to an external database
For these Prologue Actions, you create the following Error Actions for an Activity Node:

Error Actions (EA) and SettingsPrologue Actions (PA)

No-Operation Java Action (EA1):
Behavior after Error setting: Continue after
Error
Exceptions to React to setting: Catch Specific
Exceptions

Send email (PA1)

Notification Actions -> SendEmail (EA2):
Behavior after Error setting: Goto Error State
Exceptions to React to setting: Catch Specific
Exceptions

Transfer file to remote location using FTP (PA2)
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Error Actions (EA) and SettingsPrologue Actions (PA)

Error Action for connection errors, for example
writing a log file (EA3.1):
Behavior after Error setting: Goto Error State
Exceptions to React to setting: Catch Specific
Exceptions
Error Action for duplication errors (database entry
is already available), for example sending a
notification email (EA3.2)
Behavior after Error setting: Continue after
Error
Exceptions to React to setting: Catch Specific
Exceptions

Insert row in external database (PA3)

During execution, Java Actions may or may not throw an exception. If they throw an exception, the
following actions can be executed:
• Send email (PA1) fails to execute: A No-Operation Action has been defined for this error case.

If PA1 throws one of the specified exceptions, the No-Operation Java Action is executed. Nothing
happens because this action specifies no operation. After that, the process instance continues
to be executed.

• Transfer file to remote location (PA2) fails to execute: A Notification Action has been defined
for this error case. If PA2 throws one of the specified exceptions, the Notification Action is executed,
for example a notification email is sent. After that, all internal processes are rolled back, and the
process instance goes to error state.

• Insert row in external database (PA3) fails to execute: Two Java Actions have been defined
for this error case. If PA3 throws a connection error exception, Error Action EA3.1 will be executed.
EA3.1 reports the error, all internal processes are rolled back, and the process instance goes to
error state. If PA3 throws an exception because the same database entry is already available,
EA3.2 catches the exception and sends a notification email, and the process instance continues
to be executed.

If PA1 or PA2 or PA3 throws an exception which is not defined in the Exceptions to React
to setting of corresponding Error Actions, no Error Actions are executed, all internal
processes are rolled back, and the process instance goes to error state.

Note:
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The following figure shows the execution of regular Java Actions and Error Actions:

Figure 156: Executing Java Actions and Error Actions

Using Compensation Actions
This example shows how Compensation Actions function with regular Java Actions.
Compensation Actions are not executed in the normal path of execution. They are executed only
when the actions before them were successful, but the transaction was rolled back. Then, in a
separate transaction, Compensation Actions are executed in reverse order.
You can define multiple Compensation Actions for each Java Action in an Action Set.

You cannot define a Compensation Action for another Compensation Action. If a
Compensation Action throws an exception, the process instance will immediately go to error
state, and the execution of remaining Compensation Actions will be aborted.

Note:

In the following example, you are planning to execute the same Prologue Actions as described in
the example above with an addition two Java Actions:
1. Sending an email message
2. Some other action
3. Transferring a file to a remote location using FTP
4. Some other action
5. Insert a row to an external database
You have created Compensation Actions for some of the Prologue Actions. You can indicate when
exactly the Compensation Action is supposed to run by placing it in the list of actions. The following
table shows which Compensation Actions have been specified for the Prologue Actions:
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Compensation Actions (CA)Prologue Actions (PA)

Sending another email message, for example, to
apologize for any changes in the original email
(CA1)

Sending an email message (PA1)

No Compensation Action defined (CA2)Some other action (PA2)

Removing the file from the FTP server (CA3)Transferring a file to a remote location using FTP
(PA3)

No Compensation Action defined (CA4)Some other action (PA4)

Delete the row from the external database (CA5)Insert a row to an external database (PA5)

During execution, Java Actions may or may not throw an exception. At runtime, the following actions
can be executed:
• Normal execution: In normal execution, the Java Actions specified in Step 1 would be run. The

Compensation Actions specified in Step 2 are skipped and ignored.
• Execution with errors: As an example, PA4 throws an exception. First, a new transaction is

used to execute the defined Compensation Actions. All Compensation Actions defined for the
Java Actions that have been successfully executed before the exception was thrown, are invoked
in reverse order. In the example, the Compensation Action for FTP transfer (CA3) is executed,
and then the Compensation Action for sending an email (CA1) is executed in that order. CA2
cannot be executed because no Compensating Action has been defined for the second Prologue
Action (PA2). Finally, the entire transaction is rolled back. This only affects, however, changes
in the Interstage BPM Application Server context.

Only successful actions can be compensated. If, for example, PA5 fails, then again only
CA3 and CA1 are executed.

Note:
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The following figure summarizes the execution of regular Java Actions, taking Compensation Actions
into account:

Figure 157: Executing regular Java Actions and Compensation Actions

Using Error and Compensation Actions
This example shows how Error and Compensation Actions are executed if a Java Action throws an
exception.
In the following example, you have created one Java Action Set (for example a Prologue Action Set)
that consists of two Java Actions:
• Java Action 1: Java Action 1 (JA1) is used to update an external database. One Error Action

Set and one Compensation Action Set are assigned to this Java Action. The Error Action Set
contains one Error Action and the Compensation Action Set two Compensation Actions.
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• Java Action 2: Java Action 2 (JA2) is used to call a Web service. This Java Action contains an
Error Action Set with three Error Actions. For this Java Action, no Compensation Actions are
available.

Figure 158: Executing Java Actions in Error Cases

At runtime, the following actions can be executed:
• Action 1: In normal execution, the two Java Actions (JA1 and JA2) are executed one after another.

No errors occur during execution.
• Action 2: JA1 (Updating external database) throws an exception, for example a

FileNotFoundException. Since no Error Action has been defined for this exception, the process
instance goes to error state.

• Action 3: JA1 (Updating external database) throws an exception. In the example, a
NullPointerException occurs. An Error Action has been defined for this exception, so the No-op
Error Action included with the Error Action Set will be executed. The exception gets caught, and
the process instance continues.

• Action 4: JA1 (Updating external database) is successfully executed, and JA2 (Calling a Web
service) throws an IOException. The Error Actions included with the Calling alternative
Web service and Sending email Error Actions will be executed because the exception thrown
is a subclass of Exception. As in the previous action, the exception gets caught, and the process
instance continues.

• Action 5: JA1 (Updating external database) is successfully executed, and JA2 (Calling a Web
service) throws a NullPointerException. This exception is a subclass of Exception, and the
Logging an error and Sending an email message Error Actions will be executed. However,
the exception does not get caught because the Goto Error State setting overrides the Continue
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after Error setting. Therefore, the two Error Actions are executed first. After that, the two
Compensation Actions of JA1 are executed. Finally, the process instance goes to error state.

11.2 Using Server Actions
Server Actions enable you to interact with the Interstage BPM Server. Using Server Actions, you
can
• Assign an activity to a user or escalate an activity
• Make an automatic choice
• Retrieve the process initiator or performer of an activity
• Set standard attributes like process instance name, description, or priority
• Set the value of User Defined Attributes (UDAs)
• Evaluate a JavaScript

11.2.1 Assigning an Activity to a User
When modeling an activity, you assign it to a Role according to who is responsible for completing
the activity. In some situations, however, you may want to assign an activity to a particular user, and
not just to any user who is a member of a certain Role. This can be achieved using the Assign Task
to User Java Action. You can use this Java Action as a Role Action with Activity Nodes, Voting
Activity Nodes, and Compound Activity Nodes.

You can assign the activity only to users within the Role to which the activity is currently
assigned. If you want to reassign the activity to users from another Role, you must change
the activity’s Role assignment.

Note:

To assign an activity to a user:
1. Select the Activity Node, Voting Activity Node or Compound Activity Node to display the Properties

view for the nodes.
2. Select the Action Set tab. Click Add on the Role Actions tab. The Action Type List dialog is

displayed.
3. Expand Server Actions and double click Assign Task To User.
4. Specify a JavaScript expression for the users to be assigned.

You can type a constant (that is, the name of a user), select a User Defined Attribute (UDA) that
has the name as its value, or build a complex JavaScript expression that evaluates to a name.
For details, refer to section Defining JavaScript Expressions on page 339.

If you select a UDA, the UDA must be of type STRING. Otherwise an error will occur when
the Java Action is executed.

Note:
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If you want to specify multiple users, use commas to separate the names. The following figure
shows an example.

Figure 159: Assigning an Activity to Users

The JavaScript expression whether it is a simple UDA or a complex JavaScript expression
must be resolved into one or multiple users within the Role to which the activity is currently
assigned.

Note:

5. On the Details tab, type a descriptive name and your notes for the Java Action.
6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

By defining the Role Java Action, the activity is assigned to a particular user. In this case,
defining the Role of the user to whom you want to assign the activity is not required. You
can assign a Voting Activity and a Compound Activity in the same manner.

Note:

11.2.2 Assigning Task to Performer of Completed Activity
While designing a Process Definition, we can assign activities to a group in the General tab of
Properties view of the Process Definition (refer Configuring Work Item Generation on page 143 for
more information about assigning activities to a group) or by using Java Actions. If you want to assign
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activities to users after the Process Definition has been designed, you can do it by setting a Java
Action.
Depending on the business requirements, an assignee of a completed activity might need to also
complete another activity. For example, User 1 has completed Activity 1. The same user also needs
to complete Activity 2. In this scenario, you can assign the Activity 2 to the User 1.

You can assign a user of a completed activity to another activity only by using Role Java
Actions.

Note:

You can assign an activity only to the users within the Role to which the activity is currently
assigned. If you want to reassign the activity to users from another Role, you must add this
user to the current Role.

Note:

To assign a task to the performer of a completed activity:
1. Select an activity in the Process Definition which needs to be assigned to a user.

You can either select an Activity Node or a Voting Activity Node or a Compound Activity
Node to set the Java Action on it in order to assign it to the performer of a completed activity.

Note:

2. Click Action Set tab of the Properties view.
Java Action Sets area is displayed in Action Set tab. By default, Role Actions tab is selected
in Java Action Sets.

3. Select Role Actions in the work area and click Add.
Action Type List dialog is displayed.

4. Double-click on the Server Actions action type.
5. Select Assign Task To Performer Of Completed Activity in the Action Type List dialog and

click Create.
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Action editor - Assign Task To Performer Of Completed Activity dialog is displayed as shown
in the figure below.

Figure 160: Assigning task to performer of completed activity

6. Optional: Enter a name for the action in Action Name field and edit notes about the action in
Notes field. By default, a note will be displayed in the Notes field.

7. From the Activity Name drop-down list, select the activity that has been completed by a user to
whom you intend to assign the selected activity.

Only Activity Nodes are displayed in the Activity Name drop-down list.Note:

8. Click OK.
The activity for which the Java Action has been defined is assigned to the user who has completed
the activity selected in the Activity Name drop-down list.

By defining the Role Java Action, the activity is assigned to a particular user. In this case,
defining the Role of the user to whom you want to assign the activity is not required. You
can assign a Voting Activity and a Compound Activity in the same manner.

Note:

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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11.2.3 Setting Assignee from Relationship
While designing a Process Definition, we can assign activities to a group in the General tab of
Properties view of the Process Definition (refer Configuring Work Item Generation on page 143 for
more information about assigning activities to a group) or by setting Java Actions. If you want to
assign activities to users after the Process Definition has been designed, you can do it by setting a
Java Action.
Depending on the business requirements, an activity might need to be assigned to a user who is
related to the performer of a completed activity. This relationship could be manager, colleague, team
leader etc. For example, Activity 1 has been completed by User 1. Activity 2 needs to be completed
by the user (User 2) who is the manager of User 1. In this scenario, you can specify the relationship
of User 2 with User 1 and assign Activity 2 to User 2.
Similarly, you can assign an activity to a user depending on the user names associated with the
UDAs and relationships between the users. For example, Variable 1 is a String type UDA, which is
associated with User 1. In this scenario, Activity 2 needs to be assigned to User 2 who is the manager
of User 1. You can assign Activity 2 to User 2 by specifying this relationship in the Java Action.

Only UDAs of type STRING are considered for setting assignees to activities from
relationships using UDAs.

Note:

To set assignee from relationship:
1. Select an activity in the Process Definition which needs to be assigned to a user.

You can select an Activity Node or a Voting Activity Node or a Compound Activity Node to
set the Java Action on it in order to assign it to the performer of a completed activity.

Note:

2. Click Action Set tab of the Properties view.
The Java Action Sets area is displayed in Action Set tab. By default, Role Actions tab is
selected in Java Action Sets.

3. Select Role Actions in the work area and click Add.
Action Type List dialog is displayed.

4. Double-click on the Server Actions action type.
5. Select Set Assignee From Relationship and click Create.
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Action editor - Set Assignee From Relationship dialog is displayed as shown in the figure
below.

Figure 161: Setting assignee from relationship

The following sections describe the procedures to set assignee to an activity depending on his/her
relationship with the user of a completed activity and to set assignee to a task depending on his/her
relationship with the user names associated with the UDAs.

Relationship Name is a mandatory field.Note:

To assign an activity to user who has a relationship with the performer of a completed activity
1. Optional: Enter the name of the action in Action Name field.
2. Optional: Edit notes in Notes field. By default, a note will be displayed in the Notes field.
3. Select the Completed Activity radio button (selected by default) in Source Value Specified

From. Upon selecting this radio button, all the completed activities are displayed in the drop-down
list except the one which needs to be assigned to a user. The UDA Value radio button and the
drop-down list are disabled.

4. Select the completed activity from the drop-down list.
5. Enter the relationship name in the Relationship Name field. For example, User 1 has completed

Activity 1. User 2 is the manager of User 1. If you want to assign User 2 to Activity 2, select Activity
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1 in the Completed Activity drop-down list and specify Manager in the Relationship Name
field.

6. Click OK. In case of the above example, Activity 2 will be assigned to the manager of User 1.
To assign an activity to user who has a relationship with the user associated with a UDA
1. Optional: Enter the name of the action and edit notes in Action Name and Notes fields

respectively. By default, a note will be displayed in the Notes field.
2. Select the UDA Value radio button in Source Value Specified From. Upon selecting this radio

button, all the STRING type UDAs of the Process Definition are displayed in the drop-down list.
Each UDA is associated with a user name.

3. Select the UDA from the UDA Value drop-down list. For example, if you want to assign User 2
to Activity 2, select UDA Variable 1 in UDA Value. User 1 is associated with Variable 1 and User
2 is the manager of User 1.

4. Enter the relationship name in theRelationship Name field. SpecifyManager in theRelationship
Name field.

5. Click OK. In case of the above example, Activity 2 will be assigned to the manager of User 1 that
is User 2.

You can assign an activity only to the users within the Role to which the activity is currently
assigned. If you want to reassign the activity to users from another Role, you must add this
user to the current Role.

Note:

By defining the Role Java Action, the activity is assigned to a particular user. In this case,
defining the Role of the user to whom you want to assign the activity is not required. You
can assign a Voting Activity and a Compound Activity in the same manner.

Note:

Refer the Interstage Business Process Manager Developer's Guide for Relationship Name.Note:

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.4 Setting Priority for an Activity
You can set activity level priority for Activity Nodes, Voting Activity Nodes and Compound Activity
Nodes to an integer greater than or equal to 0. You can use the Set Activity Priority Java
Action to set the priority for the activity.
Priority at the activity level can be set either by using a Java Action or through the General tab in
the Properties view. For more information on setting activity level priority through the General tab,
refer to section Setting Activity Level Priority on page 129.
To set the activity priority using Java Action:
1. Select the Activity Node or Voting Activity Node or a Compound Activity Node to display the

Properties view for the nodes.
2. Select the Action Set tab.
3. Select the Prologue Actions tab from the Java Action types and click Add. The Action Type

List dialog is displayed.
4. Expand Server Actions and double click Set Activity Priority. The Action Editor - Set Activity

Priority is displayed.
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5. Type a descriptive name and your notes for the Java Action.
6. Enter a JavaScript expression in the Activity Priority field that evaluates to an Integer value.

There are different ways to set the priority. You can type a constant (that is, a number), select a
User Defined Attribute (UDA) that has the priority as its value, or build a complex JavaScript
expression. For details, refer to Defining JavaScript Expressions on page 339.

If you select a UDA, the UDA must be of type INTEGER or LONG. Otherwise an error will
occur when the Java Action is executed.

Note:

In the following example, the activity priority is set to the value of the UDA Priority.

Figure 162: Setting Activity Priority

7. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.5 Escalating an Activity
When defining a due date for an activity, you also define what happens when the due date is reached
and the activity has not been completed. One option is to escalate the activity to additional users
using the Escalate Task Java Action.
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The same applies when you define a timer for an activity: You can escalate the activity when the
timer expires.
To escalate an activity:
1. Define a due date or timer for an Activity Node or Voting Activity Node or Compound Activity

Node.
Refer to sections Defining Due Dates on page 152 or Defining Timers on page 154 for instructions.

2. On the Due Date or Timers tab, click Add. The Action Type List dialog is displayed.
3. Expand Server Actions and double click Escalate Task.
4. Specify a JavaScript expression for the users to whom you want to escalate.

You can type a constant (that is, the name of a user), select a User Defined Attribute (UDA) that
has the name as its value, or build a complex JavaScript expression that evaluates to a name.
For details, refer to section Defining JavaScript Expressions on page 339.

If you select a UDA, the UDA must be of type STRING. Otherwise an error will occur when
the Java Action is executed.

Note:

If you want to specify multiple users, use commas to separate the names. The following figure
shows an example.

Figure 163: Escalating an Activity

5. On the Details tab, type a descriptive name and your notes for the Java Action.
6. Click OK.
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It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.6 Evaluating a JavaScript
You can use JavaScript functionality within a Java Action. The Evaluate Script Java Action allows
you to combine other Java Actions with JavaScript in an Action Set and control the order of JavaScript
execution in relation to the other JavaScripts. Also, multiple JavaScripts can be evaluated in any
order using a series of these actions in Action Sets.
This section only provides instructions on assigning the Java Action. It provides no information on
writing the JavaScript for it. For more information on JavaScript, refer to appendix Supported
JavaScript Functions on page 372.
To evaluate a JavaScript:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click Evaluate Script.
4. Type your JavaScript in the text area.

Figure 164: Evaluating a JavaScript
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5. On the Details tab, type a descriptive name and your notes for the Java Action.
6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.7 Getting the Performer of an Activity
Prerequisite: The process definition has a User Defined Attribute (UDA) to which the performer can
be assigned.

You can assign the name of the user completing an activity to a UDA using the Get Performer Java
Action. You can use this Java Action as an Epilogue Action of an Activity Node or Voting Activity
Node or Compound Activity Node.
To assign the performer to a UDA:
1. Select the Activity Node or Voting Activity Node or Compound Activity Node to which you want

to assign the Java Action, to display the Properties view.
2. Select the Action Set tab and then the Epilogue Actions tab and click Add. The Action Type

List dialog is displayed.
3. Expand Server Actions and double click Get Performer.
4. In the Get Performer dialog, type a descriptive name and your notes for the Java Action.
5. In the Target UDA field, select the UDA to which the performer's name is to be assigned.

Figure 165: Assigning the Performer's Name to a UDA

6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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11.2.8 Getting the Process Initiator
Prerequisite: The process definition has a User Defined Attribute (UDA) to which the process initiator
can be assigned.

Using the Get Process Initiator Java Action, you can assign the name of the user who starts
the process instance to a UDA.
To assign the process initiator to a UDA:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click Get Process Initiator.
4. In the Get Process Initiator dialog, type a descriptive name and your notes for the Java Action.
5. In the Target UDA field, select the UDA to which the initiator's name is to be assigned.

Figure 166: Assigning the Initiator 's Name to a UDA

6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.9 Making an Automatic Choice
Using the Make Choice Java Action, a choice on a work item can be made automatically. You can
use Make Choice as a Timer Action with Activity Nodes, Voting Activity Nodes, and Compound
Activity Nodes.
To make an automatic choice:
1. Define a timer for the Activity Node or Voting Activity Node or Compound Activity Node.

Refer to section Defining Timers on page 154 for instructions.
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2. On the Timers tab, in the Specify Java Actions area click Add. The Action Type List dialog is
displayed.

3. Expand Server Actions and double click Make Choice.
4. Type a descriptive name and your notes for the Java Action.
5. Specify a JavaScript expression for the arrow that is to be chosen in the Choice field.

You can type a constant (the arrow name), select a User Defined Attribute (UDA) that has the
arrow name as its value, or build a complex JavaScript expression that evaluates to an arrow
name. For details, refer to section Defining JavaScript Expressions on page 339.

Figure 167: Making an Automatic Choice

6. Click OK.

11.2.10 Setting the Process Instance Name
By default, a process instance has the same name as the process definition from which it is created.
However, its name can be changed while the process instance is running using the Set Process
Instance Name Java Action.
To set the process instance name:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click Set Process Instance Name.
4. Type a descriptive name and your notes for the Java Action.
5. Specify a JavaScript expression for the process instance name in the Process Name field.

You can type a constant (that is, a name), select a User Defined Attribute (UDA) that has the
process instance name as its value, or build a complex JavaScript expression that evaluates to
the name. For details, refer to section Defining JavaScript Expressions on page 339.
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The following figure shows an example of how this Java Action can be used. At process
initialization, the Java Action appends the purchase order number to the process instance name.
The purchase order number is stored in the PONumber UDA.

Figure 168: Setting the Process Instance Name

6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.11 Setting the Process Instance Priority
By default, a process instance is given a medium priority (8). However, its priority can be changed
while the process instance is running using the Set Process Instance Priority Java Action.
To set the process instance priority:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click Set Process Instance Priority.
4. Type a descriptive name and your notes for the Java Action.
5. Enter a JavaScript expression in the Process Priority field that evaluates to an Integer value.

There are different ways to set the priority. You can type a constant (that is, a number), select a
User Defined Attribute (UDA) that has the priority as its value, or build a complex JavaScript
expression. For details, refer to Defining JavaScript Expressions on page 339.

If you select a UDA, the UDA must be of type INTEGER or LONG. Otherwise an error will
occur when the Java Action is executed.

Note:
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In the following example, the process instance priority is set to the value of the UDA Priority.

Figure 169: Setting Process Instance Priority

6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.12 Setting the Process Instance Description
By default, a process instance is given the same description as the process definition from which it
is created. However, its description can be changed while the process instance is running using the
Set Process Instance Description Java Action.
To set the process instance description:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click Set Process Instance Description.
4. Type a descriptive name and your notes for the Java Action.
5. Enter a JavaScript expression in the Process Description field that evaluates to a String value.

There are different ways to set the description. You can type a constant (that is, a description),
select a User Defined Attribute (UDA) that has the description as its value, or build a complex
JavaScript expression that evaluates to a description. For details, refer to section Defining
JavaScript Expressions on page 339.
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In the following example, the process instance description is composed of the string Process
started and the value of the UDA Description.

Figure 170: Setting the Process Instance Description

6. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.2.13 Assigning Values to User Defined Attributes
Prerequisite: You have added User Defined Attributes (UDAs) to the process definition.

You can set the value of a UDA using the UDA Assignment Java Action. You can set it, for example,
to the value of another UDA.
To set the value of a UDA:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Server Actions and double click UDA Assignment.
4. In the Action Editor - UDA Assignment dialog, type a descriptive name and your notes for the

Java Action.
5. From the Target UDA list, select the UDA whose value you want to set.
6. Specify a JavaScript expression for the value in the Value field.

There are different ways to set the value. You can type a constant (that is, the value itself), set it
to the value of another UDA, or build a complex JavaScript expression. For details, refer to section
Defining JavaScript Expressions on page 339.
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In the following example, the value of the UDA Input is assigned to the UDA Output.

Figure 171: Setting a UDA

7. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.3 Using XML Actions
You can use XML Actions to add XML substructures, text elements, or attribute values to User
Defined Attributes (UDAs) of type XML. In addition, you can delete XML substructures, text elements
or attribute values from a UDA of type XML, assign an XML string to a UDA of type XML and extract
values from XML data.

11.3.1 Adding a Substructure in XML
Prerequisites:
The process definition has a UDA of type XML to which a new substructure can be added.

When specifying a UDA of type XML, you might want to add an XML substructure to it. This can be
achieved using the Add Substructure in XML Java Action.

You can assign this Java Action to process definitions and all nodes.Note:

To add a substructure to a UDA of type XML:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double-click Add Substructure in XML.

Interstage Business Process Manager Studio User's Guide 267

11: Advanced Process Modeling



The Action Editor - Add Substructure In XML UDA dialog is displayed. It automatically shows
the name of the first UDA of type XML you have defined for the process definition or node
(CustomerName UDA, in the example), and provides a default description:

Figure 172: Displaying the Action Editor dialog

4. Type a descriptive name and your notes for the Java Action.
5. From the Target UDA drop-down list, select the UDA to which the new XML substructure is to

be added.
The Target UDA drop-down list displays only UDAs of type XML.
All the XPaths related to the target UDA (type XML) selected in the Target UDA drop-down list,
are displayed in the XPath drop-down list.

6. Select the XPath expression of the Target UDA from the XPath drop-down list.
7. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,

click the Edit button located next to the XPath drop-down list.
XPath Editor dialog is displayed with the selected XPath expression in its editor area. You can
edit this XPath expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:
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The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

8. In the Value field, specify the value of the XML substructure.
When entering a UDA value, use the same tags as for specifying a Web Service call or assigning
an XML string to a UDA. For more information, refer to sections Assigning an XML String to a
User Defined Attribute on page 273 andWeb Services: Special Tags for SOAPRequest Messages
on page 310. The following example shows the Action Editor dialog how the customer substructure
is added to the CustomerName UDA:

Figure 173: Adding a Substructure in XML UDA

9. Click OK.
When closing the dialog, Interstage BPM Studio automatically checks whether the entered value
is well-formed XML. If it is not, a warning message will be displayed.
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It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.3.2 Extracting User Defined Attribute Values from XML Data
Prerequisites:
• The process definition has a User Defined Attribute (UDA) that contains an XML string that is to

be parsed.
• The process definition has UDAs to which the extracted XML data can be assigned.
• You are familiar with XPath expressions and know how to write them.

You can extract data from an XML string coming in to Interstage BPM and assign the data to UDAs
using the Assign UDA from XPath Expression Java Action. You specify where the data can be
found in the XML string using an XPath expression.
This Java Action is usually used in conjunction with the Assign XML to UDA Java Action and an
HTTP Agent. This three-component system forms a data-transfer interface to a system external to
Interstage BPM.
To extract UDA values from incoming XML data:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double click Assign UDA from XPath.
4. In the Assign UDA from XPath expression dialog, type a descriptive name for the Java Action

in the Action Name field.
5. From the Source UDA field, select the UDA that contains the XML string from which the value(s)

will be extracted.
The drop-down list displays all available UDAs. For more details on the supported data types,
refer to section Specifying User Defined Attributes on page 143.

6. Map the data that you want to extract from the XML string to UDAs. To define a mapping:
a) Click in the field in the Target UDA column. A drop-down list is displayed. From the drop-down

list, select the UDA to which you want to assign the data.
b) Click in the field in the XPath of target UDA column. A drop-down list is displayed. Select

from the drop-down list, the XPath expression that specifies where the data will be stored in
the XML string of the target UDA.
This field is active only if you have selected a UDA of type XML.
The XPath expressions related to the selected Target UDA are displayed in the XPath of
target UDA drop-down list.

c) Optional: If you want to edit the XPath expression that you selected in the XPath of target
UDA drop-down list, click the ellipsis (...) button that is displayed next to the XPath of target
UDA drop-down list. XPath Editor dialog is displayed with the selected XPath expression in
its editor area. You can edit this XPath expression and click OK to use the edited XPath
expression.
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d) Click in the field in the XPath of source UDA column. A drop-down list is displayed. Select
from the drop-down list, the XPath expression that specifies where the data can be found in
the XML string of the Source UDA.
This field is active only if you have selected a UDA of type XML.
The XPath expressions related to the selected Source UDA are displayed in the XPath of
source UDA drop-down list.

e) Optional: If you want to edit the XPath expression that you selected in the XPath of source
UDA drop-down list, click the ellipsis (...) button that is displayed next to the XPath of source
UDA drop-down list. XPath Editor dialog is displayed with the selected XPath expression in
its editor area. You can edit this XPath expression and click OK to use the edited XPath
expression.

f) If you want to define another mapping, click Add and repeat the previous substeps.
g) If you want to remove a mapping, select it and click Remove.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

Interstage Business Process Manager Studio User's Guide 271

11: Advanced Process Modeling



The following figure shows an example where customer data are sent to Interstage BPM as an
XML string. They are stored in the Customer UDA. The customer's name is extracted from the
XML string and mapped to the VIPCustomer UDA.

Figure 174: Extracting Data from an XML String - XPath of target UDA

Figure 175: Extracting Data from an XML String - XPath of source UDA

7. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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11.3.3 Assigning an XML String to a User Defined Attribute
Prerequisite: The process definition has a User Defined Attribute to which the XML string can be
assigned.

You can generate an XML string and assign it as the value of a UDA using the Assign XML to UDA
Java Action. This Java Action is usually used in conjunction with the Assign UDA from XPath Java
Action and an HTTP Agent. This three-component system forms a data-transfer interface to a system
external to Interstage Business Process Manager.
To assign an XML string as the value of a UDA:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double click Assign XML to UDA.
4. In the Action Editor - Assign XML To UDA dialog, type a descriptive name and your notes for

the Java Action.
5. From the Target UDA field, select the UDA to which the generated XML string is to be assigned.

The drop-down list displays only UDAs of type STRING or XML.

6. In the Value field, type the XML string to be assigned.

Figure 176: Assigning an XML String to a UDA

In the example, Customer Info is executed at process initialization. The Java Action generates
the XML string displayed in the above figure and stores it in the CustomerDetails UDA.
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Within the XML string, you can use the following tags to specify UDAs or JavaScript code:
• {{Field <UDAName>}}

• {{Xml <UDAName>}}

• {{Js <JavaScriptExpression>}}

• {{JsXml <JavaScriptExpression>}}

These are the same tags that can be used when specifying the input parameters for a Web Service
call. For more information and for examples, refer to section Web Services: Special Tags for
SOAP Request Messages on page 310.

7. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.3.4 Deleting Substructures, Text and Attribute Values from a UDA
Prerequisite: The process definition has a User Defined Attribute of type XML from which a
substructure, text element or attribute value can be removed.

You might want to remove substructures, text or attribute values from a UDA of type XML. This can
be achieved using the Delete from XML Java Action.
To delete substructures, text and attribute values:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double-click Delete from XML.
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The Action Editor - Delete From XML UDA dialog is displayed. It automatically shows the first
UDA of type XML you have defined for the process definition or node (CustomerName UDA, in
the example), and provides a default description:

Figure 177: Displaying the Action Editor

4. Type a descriptive name and your notes for the Java Action in Action Name and Notes fields
respectively.

5. From the Target UDA drop-down list, select the UDA from which the substructure, text or attribute
value is to be removed.
The Target UDA drop-down list displays only UDAs of type XML.

6. From the XPath drop-down, select an XPath expression of the Target UDA.
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The XPath expression refers to that part of the UDA where the substructure, text or attribute value
will be removed from. In the example, the first name is removed from the UDA. Only the surname
remains (refer to sectionAdding a Substructure in XML on page 267, for the complete substructure):

Figure 178: Deleting a substructure

7. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the Edit button located next to the XPath drop-down list.
XPath Editor dialog is displayed with the selected XPath expression in its editor area. You can
edit this XPath expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

8. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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11.3.5 Setting a Substructure in XML
Prerequisites:
The process definition has a UDA of type XML whose structure you want to change by replacing an
existing substructure.

You might want to set a new XML substructure to a UDA of type XML. This can be achieved using
the Set Substructure in XML Java Action. You can assign this Java Action to process definitions
and all nodes.

As opposed to the Add Substructure in XML Java Action, the Set Substructure in
XML Java Action replaces an existing structure and overwrites it.

Note:

To set a substructure in a UDA of type XML:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double-click Set Substructure in XML.
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The Action Editor - Set Substructure In XML UDA dialog is displayed. It automatically shows
the name of first UDA of type XML you have defined for the process definition or node
(CustomerName UDA, in the example), and provides a default description:

Figure 179: Displaying the Action Editor dialog

4. Type a descriptive name and your notes for the Java Action in Action Name and Notes fields
respectively.

5. From the Target UDA drop-down list, select the UDA in which you want to set a new XML
substructure.
The Target UDA drop-down list displays only UDAs of type XML.
All the XPaths related to the target UDA (XML type) selected in the Target UDA drop-down list,
are displayed in the XPath drop-down list.

6. Select the XPath expression of the Target UDA from the XPath drop-down list.
The XPath expression refers to that part of the UDA where the new text or attribute is to be stored.

7. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the Edit button located next to the XPath drop-down list.
XPath Editor dialog is displayed with the selected XPath expression in its editor area. You can
edit this XPath expression and click OK to use the edited XPath expression.
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The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

8. In the Value field, specify the value of the text or attribute.
When entering a UDA value, use the same tags as for specifying a Web Service call or assigning
an XML string to a UDA. For more information, refer to sections Assigning an XML String to a
User Defined Attribute on page 273 andWeb Services: Special Tags for SOAPRequest Messages
on page 310. The following example shows the Action Editor dialog used for replacing the customer
substructure you have added before (refer to section Adding a Substructure in XML on page 267
for more details):

Figure 180: Setting a Substructure in XML
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9. Click OK to close the Action Editor dialog.
When closing the dialog, Interstage BPM Studio automatically checks whether the entered value
is well-formed XML. If it is not, a warning message will be displayed.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.3.6 Setting Text or Attribute Values in XML
Prerequisites:
The process definition has a UDA of type XML for which you want to set a new text or attribute value.

When specifying a UDA of type XML, you might want to set a new text or attribute value to the UDA.
This can be achieved using the Set Text or Attribute Value in XML Java Action.

You can assign this Java Action to process definitions and all nodes.Note:

To set a new text or attribute value:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand XML Actions and double-click Set Text or Attribute Value in XML.
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TheAction Editor - Set Text Or Attribute Value In XML UDA dialog is displayed. It automatically
shows the first UDA you have defined for the process definition or node (CustomerName UDA, in
the example), and provides a default description:

Figure 181: Displaying the Action Editor dialog

4. Type a descriptive name and your notes for the Java Action in Action Name and Notes fields
respectively.

5. From the Target UDA drop-down list, select the UDA in which you want to set a text or attribute
value.
The Target UDA drop-down list displays only UDAs of type XML.
All the XPaths related to the target UDA (XML type) selected in the Target UDA drop-down list,
are displayed in the XPath drop-down list.

6. Select the XPath expression of the Target UDA from the XPath drop-down list.
The XPath expression refers to that part of the UDA where the new XML text or attribute is to be
stored.

7. Optional: If you want to edit the XPath expression that you selected in the XPath drop-down list,
click the Edit button located next to the XPath drop-down list.
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XPath Editor dialog is displayed with the selected XPath expression in its editor area. You can
edit this XPath expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

8. In the Value field, specify the value of the XML text or attribute.
When entering a UDA value, use the same tags as for specifying a Web Service call or assigning
an XML string to a UDA. For more information, refer to sections Assigning an XML String to a
User Defined Attribute on page 273 andWeb Services: Special Tags for SOAPRequest Messages
on page 310. The following example shows the Action Editor dialog for changing the last name of
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the customer from "Doe" (refer to section Adding a Substructure in XML on page 267 for the
complete substructure) to "Miller". Therefore, use the following XML value and XPath expression:

Figure 182: Setting Text or Attribute Values in XML

9. Click OK to close the Action Editor dialog.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.4 Using Rules Actions
A Rules Action is a special type of Java Action that acts as an interface to a rules engine. This
interface allows you to use advanced process logic in your process definitions at every point in the
process definition where you could attach an Action Set.
Interstage BPM supports the following rules engines:
• ILOG JRules
• Blaze Advisor
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Before you can create a Rules Action, you must have a rules file that has been created with one of
these rules engines. Typically, these rules files will need to integrate Interstage BPM functionality
like retrieving or setting process instance owners, User Defined Attribute values, and so on. For more
information on creating rules files that use Interstage BPM functionality, refer to the Interstage
Business Process Manager Developer's Guide.
Rules Actions also allow you to integrate Decision Tables into your process definitions. A Decision
Table is a compact way of representing process logic. It consists of a number of business rules where
each rule specifies conditions and consequences. For more information, refer to the Decision Tables
on page 216

11.4.1 Integrating Blaze Rules
Prerequisite: You have a server configuration file that has been created with the Blaze Advisor rules
engine.

To integrate Blaze rules:
1. Import the server configuration file (*.server) that you want to use in your Java Action to the

following folder:
<Application Project>/dms/Attachments

2. Click the empty space in the Process Definition editor or select the node to which you want to
assign the Java Action, to display the Properties view for the process definition or the node
respectively.

3. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

4. Expand Rules Actions and double click Fair Isaac Blaze Advisor.
5. In the Action Editor - Set Rules dialog, type a descriptive name and your notes for the Java

Action.
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6. Click the browse button and select the server configuration file that you placed in the attachments
subfolder of Interstage BPM Studio.

Figure 183: Integrating Blaze Rules

Once the server configuration file has been set in the Server Config File field, the services and
entry points defined in it become available for selection.

7. Select the service and the entry point that you want to use.
The service is the name of the Blaze Advisor Server that is running and has the rules defined in
it. An entry point is an object in that server that will be invoked for rule evaluation.

8. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:
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When sending the process definition to an Interstage BPM Server, make the following
adjustments. Be aware that these steps are also required when you deploy a Workflow
Application project on the Interstage BPM Server:

Note:

1. If it is the first time that you use Blaze Advisor with Interstage BPM, copy the following
JAR files with the license directory from the Blaze Advisor lib directory into the
<Interstage BPM Domain>/lib directory, e.g.
C:/bea/user_projects/domains/base_domain/lib:
• AdvCommon.jar, Advisor.jar, AdvisorSvr.jar
• collections.jar

• InnovatorRT.jar

• jaxen.jar

• Ndkjc-2.1A-bin.jar

• OROMatcher.zip

• saxpath.jar

• iFlow.jar. This file is located in the client/lib folder of your Interstage BPM installation,
e.g. C:/Fujitsu/InterstageBPM/client/lib.

2. On the Interstage BPM Server, copy the Blaze server configuration file to the directory
as specified in the Java Action.

3. Include the Blaze license file in your CLASSPATH.
If you are using Interstage BPM for WebLogic, update the script setDomainEnv.cmd or
setDomainEnv.sh located in the <Interstage BPM Domain>/bin directory, e.g.
C:/bea/user_projects/domains/base_domain/bin:
On Windows, delete the line:
set CLASSPATH=%PRE_CLASSPATH%;%WEBLOGIC_CLASSPATH%;
%POST_CLASSPATH%;%WLP_POST_CLASSPATH%

Add the following lines:
set BLAZE_LICENSEPATH=<path to your license file>

set CLASSPATH=%PRE_CLASSPATH%;%WEBLOGIC_CLASSPATH%;
%POST_CLASSPATH%;%WLP_POST_CLASSPATH%;%BLAZE_LICENSEPATH%

On UNIX or Linux, delete the line:
CLASSPATH="{PRE_CLASSPATH}${CLASSPATHSEP}
${WEBLOGIC_CLASSPATH}${CLASSPATHSEP} ${POST_CLASSPATH}${CLASSPATHSEP}
${WLP_POST_CLASSPATH}"

Add the following lines:
BLAZE_LICENSEPATH=<path to your license file>

export $BLAZE_LICENSEPATH CLASSPATH="{PRE_CLASSPATH}${CLASSPATHSEP}
${WEBLOGIC_CLASSPATH}${CLASSPATHSEP} ${POST_CLASSPATH}${CLASSPATHSEP}
${WLP_POST_CLASSPATH}${CLASSPATHSEP} ${BLAZE_LICENSEPATH}"

4. Stop and start the Interstage BPM Server. For instructions, refer to the Interstage Business
Process Manager Server Administration Guide.
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11.4.2 Integrating ILOG JRules
Prerequisite: You have a rules file that has been created with the ILOG JRules rules engine.

To integrate ILOG JRules:
1. Import the rules file (*.ilr) that you want to use in your Java Action to the following folder:

<Application Project>/dms/Attachments

2. Click the empty space in the Process Definition editor or select the node to which you want to
assign the Java Action, to display the Properties view for the process definition or the node
respectively.

3. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

4. Expand Rules Actions and double click ILOG JRules.
5. In the Action Editor - Set Rules dialog, type a descriptive name and your notes for the Java

Action.
6. Click the browse button and navigate to the rules file that you placed in the attachments subfolder

of Interstage BPM Studio.

Figure 184: Integrating ILOG JRules

7. Type the name of one or more packets that identify the rule sets that need to be executed.
8. Click OK.

It is not necessary to compensate this action using a compensation action, because changes
made by this action are in Interstage BPM only and they will be rolled back after the process
instance goes into error state. For details on compensation actions, refer to section Dealing
With Errors in Java Actions on page 240.

Note:

11.5 Using Notification Actions
Notification Actions notify users on events related to process execution. Users can be notified, for
example, that a process or a single activity has been started. Currently, emails can be sent for
notification.
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11.5.1 Sending Emails
Email messages can be sent using the SendEmail Java Action. You can use this Java Action, for
example, to notify anyone that a process or an activity has been started.
You can also attach logs or reports of processes, along with the email.
You can assign SendEmail to any node and to the process definition itself. When using Email Nodes,
this is the only Java Action that can be assigned.

The following are disabled if the Send Email Java Action is created with the Studio version
10.1 or prior versions.

Note:

• From field
• Attachment field
• Attach Process Instance Attachments checkbox

To send emails:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. If the Action Type List dialog is displayed, expand Notification Actions and double click
SendEmail.

4. On the Addresses tab, in the Action Editor - Send Email dialog, specify the users to which
emails are to be sent.
a) Specify a JavaScript expression for the address.

You can type a constant (that is, an email address), select a User Defined Attribute (UDA)
that has an address as its value, or build a complex JavaScript expression that evaluates to
an address. For details, refer to section Defining JavaScript Expressions on page 339.

If you select a UDA, the UDA must be of type STRING. Otherwise an error will occur when
the Java Action is executed.

Note:

b) Click To, Cc, or Bcc depending on how you want the message to be addressed.
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c) If you want to remove an address, select it and click Delete Selected.

Figure 185: Using Addresses
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5. On the Content tab, specify JavaScript expressions for the Subject and From fields and the
message body. Select the format in which you want the email to be sent.

Figure 186: Specifying Email Content

6. Optional: To send an attachment with the email:
a) Click the Add button located near the Attachment field. Attachment dialog is displayed.

You can select an attachment in theAttachment field and click Edit to edit it or clickRemove
to remove the selected attachment. When you select an attachment and click Edit,
Attachment dialog is displayed.

Note:

b) Attach a file using either the Browse button or the expression mode button. To attach a file
by browsing, click the Browse button. Select or enter file location and name of source file
dialog is displayed. This dialog displays the tree view of the files in dms folder of the application.
You can browse the file that you want to attach with the email using this dialog. You can also
enter the path to the file in the Path field and select the required file in the dialog.
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Refer Defining JavaScript Expressions on page 339 for more information about expression
mode button.

Note:

Figure 187: Attaching File

Figure 188: Browsing for Attachment

The value of attachment is specified by the relative path from the route of the application
project. The wild-card cannot be used. For example, dms/Attachments/abc.doc or
uda.get("DMSattachment") + ".txt".

Note:
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c) Click OK on Attachment dialog.

7. Optional: On the Action Editor - Send Email dialog, select the Attach Process Instance
Attachments checkbox to attach the process instances with the email.

8. On the Details tab, type a descriptive name and your notes for the Java Action in Action Name
and Notes fields respectively.

9. Click OK.

11.6 Using Database Actions
Database Actions allow you to interact with external databases that are independent of Interstage
BPM. You can retrieve data from a database and assign it to User Defined Attributes (UDAs). You
can also send data back to the database, and you can delete data from the database.
Standard SQL queries are used to access the database.
The following sections explain how to configure Interstage BPM for Database Actions and how to
use them.

11.6.1 Configuring Interstage BPM for Database Actions
Before you can use either of the Database Actions, you must set up a connection to the external
database that you want to access. You can access any JDBC-compliant database.
To configure Interstage BPM for Database Actions:
1. In the Navigator view, right-click the Resources folder and select Java Actions >Data Source

from the pop-up menu.
A new DataSourceDefinition.xml file is created and stored in the Resources folder. The default
file is automatically displayed in the Resources editor. The following example shows the default
DataSourceDefinition.xml file:

[DataSourceDefinition.xml]

<DataSources>
<!-- DataSource name="purchaseDB">
</DataSource -->

</DataSources>

You can create each resource file only once. After you have created a new
DataSourceDefinition.xml file, the respective menu option will be disabled.

Note:

2. In the DataSourceDefinition.xml file, add a new <DataSource> section, specify the name of
the data source that you want to access, and type in the properties required for the new data
source.
The name will be displayed in the dialogs of Interstage BPM Studio that you will use to define
your Database Actions. The following example shows how to add a data source called EmployeeDB.
The DataSourceDefinition.xml file then looks as follows (the new data source parameters are
in bold below):

[DataSourceDefinition.xml]

<DataSources>
<!-- DataSource name="purchaseDB">
</DataSource -->

<DataSource name="EmployeeDB>
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<property name="UserName"
type="String">EmployeeUserName</property>

<property name="Password"
type="String">EmployeePassword</property>

<property name="URL"

type="String">jdbc:sqlserver://employeehostname:1433;databaseName=employeedb</property>

<property name="DriverClassName">
type="String">com.microsoft.sqlserver.jdbc.SQLServerDriver</property>

</DataSource>
</DataSources>

Each new data source requires the following database connection properties:
• Data Source Name: Specifies the database to use for the new connection. When you specify

a database name, the name must exist in the relational database directory on the server.

If the specifies database does not exist, the connection fails.Note:

• User Name: Name of database users required to log on a database instance and work with
database objects.

• Password: Password required to log on a database instance and work with database objects.
• URL: Universal Resource Locator (URL) that specifies a particular type of database server

(compatible with the local JDBC driver) and a particular host.
• Driver Class Name: The full Java class name of the JDBC driver to be used to connect to

the database. The class must be present on the Classpath at the time you invoke this
application.

You can add multiple data sources to a Workflow Application project.Note:
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When sending the process definition to an Interstage BPM Server, make the following
adjustments. Be aware that these steps are also required when you deploy a Workflow
Application project on the Interstage BPM Server:

Note:

1. Obtain the following information on the database to which you want to connect:
• User name and password for a normal database user account
• Database connection URL

The following is a Microsoft SQL Server 2005 example:
jdbc:sqlserver://<COMPUTER_NAME>:1433;databaseName=<yourdb>

• Driver class
The following is a Microsoft SQL Server 2005 example:
com.microsoft.sqlserver.jdbc.SQLServerDriver

2. Add the data source to the data source definition file used by the Interstage BPM Server.
<Interstage BPM Server Installation
Directory>/server/instance/default/resources/DataSourceDefinition.xml

Use the example currently in DataSourceDefinition.xml and the information that you
gathered about your database.

3. If you are using the Interstage BPM Enterprise Edition for WebLogic:
a. Check whether the jar files of the JDBC driver are already included in your WebLogic

installation. If they are included, no further action is required.
b. If the JDBC driver is not included in your WebLogic installation, copy it to the following

folder: <Interstage BPM Server Domain>/lib. Then, restart the Application Server.

4. If you are using the Interstage BPM Enterprise Edition for WebSphere, copy the jar
files of the JDBC driver to the following folder: <Interstage BPM Server Installation
Directory>/server/instance/default/lib. Then, restart the Application Server.

5. If you are using the Interstage BPM Enterprise Edition for JBoss, copy the jar files
of the JDBC driver to the following folder: <JBoss Installation
Directory>/server/ibpm/lib. Then, restart the Application Server.

6. If you are using the Interstage BPM Enterprise Edition for Interstage, copy the jar
files of the JDBC driver to the following folder: <Interstage BPM Server Installation
Directory>/server/instance/default/lib/ext. Then, restart the Application Server.

11.6.2 Retrieving Data from External Databases
Prerequisites:
• You have registered the external database as a data source. For details, refer to Configuring

Interstage BPM for Database Actions on page 292.
• You know the data model of the external database, and you know how to write SQL statements.
• The process definition has one or more User Defined Attributes (UDAs) to which the query results

can be assigned.

You can query an external database and assign the results of the query as the value of UDAs.
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To retrieve data from an external database:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. If the Action Type List dialog is displayed, expand Database Actions.
4. Double click Select SQL Java Action.
5. Choose the data source that you defined in DataSourceDefinition.xml from the Choose Data

Source drop-down list.

If the data source you defined does not appear on this list, check your configuration in
DataSourceDefinition.xml.

Note:

6. Type the SQL select statement.
In the SQL statement, you can use input variables denoted with a question mark. In a later step,
each of the input variables will be related to one of your UDAs.
The following example might be used to find an employee’s name from an employee number.
emp is the database table being queried:
select empname from emp where empnum=?

Figure 189: Specifying the Data Source and the SQL Select Statement

7. Select the Data Mappings tab.
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Note that when you are changing an SQL query, the information on the Data Mappings tab is
cleared.

8. If your SQL query contains input variables, map them to the corresponding UDAs in the Map
input from UDA area.

9. In the Map output to UDA area, select the UDAs that you want to use for the results of your SQL
query.
In the example below, a UDA called EmployeeNumber is used in the SQL query, and a UDA called
EmployeeName contains the result.

Figure 190: Specifying UDAs for the Query and Mapping Query Results to UDAs

If your SQL query returns multiple results, only one of them will be assigned to the UDA.Note:

10. On the Details tab, type a descriptive name and your notes for the Java Action.
11. Click OK.

11.6.3 Updating, Inserting, or Deleting Data in External Databases
Prerequisites:
• You have registered the external database as a data source. For details, refer to Configuring

Interstage BPM for Database Actions on page 292.
• You know the data model of the external database, and you know how to write SQL statements.

You can update the data in external databases with information stored in User Defined Attributes
(UDAs). You can also insert or delete data in the database.
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To update, insert, or delete data in an external database:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. If the Action Type List dialog is displayed, expand Database Actions.
4. Double click the database action that you want to be performed, for example Update SQL Java

Action. The Update SQL from UDA dialog is displayed.
5. Choose the data source that you defined in DataSourceDefinition.xml from the Choose Data

Source drop-down list, in the Enter Update Statement tab.

If the data source you defined does not appear on this list, check your configuration in
DataSourceDefinition.xml.

Note:

6. Type the SQL statement.
In the SQL statement, you can use input variables denoted with a question mark. In a later step,
each of the input variables will be related to one of your UDAs.
The following sample shows an SQL update statement that might be used to update the salary
of an employee in an external database. emp is the database table that stores the salary
information.
update emp set salary=? where empid=?

Figure 191: Specifying the Data Source and an SQL Statement
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7. Select the Data Mappings tab.
Note that when you are changing an SQL statement, the information on the Data Mappings tab
is cleared.

8. Select the UDAs that supply the values to be used in your SQL statement.
In the example below, a UDA called EmployeeSalary stores the salary that is to be updated in
the external database. The EmployeeName UDA is used to determine the employee whose data
are to be updated.

Figure 192: Specifying UDAs that Supply Values

9. On the Details tab, type a descriptive name and your notes for the Java Action.
10. Click OK.

11.7 Using Integration Actions
Integration Actions allow you to access external functions from within your process definition.
You can integrate any system that exposes its functions as a Web Service, and you can execute
remote commands.

11.7.1 Executing Remote Commands
Using the Remote Command Invoker Java Action, you can execute a command on any computer
that can be accessed by the Interstage BPM Server. You can run any command that can be executed
from a command prompt.
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A Remote Command Server is required to run on the computer upon which you want to execute the
command. Your Interstage BPM installation includes a Remote Command Server. However, it is not
enabled as a default.
To execute a remote command:
1. If you want to execute a command on the computer where the Interstage BPM Server is installed,

make sure that the Remote Command Server runs on that computer.
• OnWindows, you can use the StartJACommandServer.bat file to start the Remote Command

Server. This file can be found in the <Interstage BPM Server Installation
Directory>/server/instance/default/bin folder.
Usage: StartJACommandServer.bat <port> <hostname>

• On UNIX or Linux, run the following Java program:
java com.fujitsu.iflow.utilities.JACommandServer <port>, <hostname>

<port> defines the port that the Remote Command Server will listen to.
<hostname> is the name of the computer that is allowed to connect to the Remote Command
Server.
When running the following sample on Windows, a Remote Command Server will be started on
the local host (that is, on the Interstage BPM Server) and listen to port 5037:

cd <Interstage BPM Server Installation
Directory>/server/instance/default/bin
StartJACommandServer.bat 5037 localhost

2. Windows only: If you want to execute a command on a remote computer (that is a computer
where the Interstage BPM Server is not installed):
a) Copy the following files from your Interstage BPM installation to the remote computer:

<Interstage BPM Server Installation
Directory>/server/instance/default/bin/StartJACommandServer.bat

<Interstage BPM Server Installation Directory>/client/lib/iFlow.jar

b) Edit StartJACommandServer.bat on the remote computer. Make sure that the IFLOW_DIR
variable points to the folder on the remote computer to which you copied the
/client/lib/iFlow.jar file.
For example, if you copied the file to a folder called C:\RemoteCommandServer, you would
specify the following:
SET IFLOW_DIR=C:\RemoteCommandServer

c) Start the Remote Command Server by running the following batch file:
StartJACommandServer.bat <port> <hostname>

<port> defines the port that the Remote Command Server will listen to.
<hostname> is the name of the Interstage BPM Server that is allowed to connect to the Remote
Command Server. Alternatively, you can specify the IP address of the Interstage BPM Server.
When running the following sample, a Remote Command Server will be started and listen to
port 5037. An Interstage BPM Server called ibpmhost will be allowed to connect to the Remote
Command Server.

StartJACommandServer.bat 5037 ibpmhost
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3. Add a User Defined Attribute (UDA) to your process definition and specify the command to be
executed as its value.
For example, you might want to open the Notepad editor as a remote command. You would add
a UDA called RemoteCommand and set its value to the following command line:
cmd /c "C:\\WINDOWS\\System32\\notepad.exe"

When specifying the command's path, make sure that the path is valid on the computer
where the command will be executed.

Note:

4. Click the empty space in the Process Definition editor or select the node to which you want to
assign the Java Action, to display the Properties view for the process definition or the node
respectively.

5. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

6. Expand Integration Actions and double click Remote Command Invoker.
7. In the Action Editor - Remote Command dialog, type a descriptive name and your notes for

the Java Action.
8. From the Command UDA drop-down list, select the UDA that contains the remote command.
9. If additional input is needed after the execution of the remote command, type the input in the

Additional Input field.
Example:
You can open Notepad by opening a command prompt, then starting Notepad from the command
prompt. You would put cmd in your command UDA and the following in the Additional Input field:
C:\\WINDOWS\\System32\\notepad.exe

The complete path must be included in this case.Note:

When your Java Action runs, first cmd executes, then Notepad is started after cmd has executed.

10. Type the hostname and port of the Remote Command Server that is running on the computer
upon which the command will be executed.

11. From the Response UDA drop-down list, select the UDA to collect the response if there is any.
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If the Java Action shall not wait for a return value, make sure that DO NOT WAIT FOR RETURN is
selected.

Figure 193: Executing a Remote Command

12. Click OK.

11.7.2 Calling a Web Service
Prerequisites:
• You are familiar with the key concepts of Web Services.
• You have the following information about the Web Service:

• Purpose of the Web Service
• The URL of the WSDL document that describes the operations supported by the Web Service
• Optional: The Inquiry URL of a UDDI Registry that you can query for the location of the WSDL

document
• Meaning and data type of the operation's input parameters
• Meaning and data type of the operation's return value
Contact the Web Service provider to obtain this information.
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• You have specified User Defined Attributes (UDAs) for the parameters that you want to pass to
the operation.

• You have specified UDAs that are to store the operation's return value.
• You are familiar with XPath expressions and know how to write them.

You can call a Web Service from Interstage BPM using the Web Service Call Java Action. You
can assign Web Service Call to any node and to the process definition itself. When using Web
Service Nodes, this is the only type of Java Action that can be assigned to them.
To call a Web Service:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Expand Integration Actions and double click Web Service Call.
4. Type a descriptive name and your notes for the Java Action, in theAction Editor - Web Services

dialog.
5. Do one of the following:

• If you know the URL of the WSDL document, type it in the WSDL Location field.
• If you don't know the URL, click Browse to query a UDDI Registry for the WSDL document.
• If you know the URL of the WSDL document and you would like to change it dynamically, you

can define it by the UDA or the Application Variable.
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In this case, you set URL of WSDL to the value of UDA or Application Variable, and select it
with WSDL Location.

Figure 194: Searching for a WSDL Document

You can configure default UDDI query servers to be displayed in the UDDI Browser dialog.
To do so:

Note:

1. Exit Interstage BPM Studio.
2. Open the twf.ini configuration file located in the <Interstage BPM Studio

Installation Directory>\ibpm\Data\bin folder.
3. Add the following entry:

UDDIInquiryURL=<URL of a UDDI query server>[,<URL of a UDDI query server>
...]

4. Save the configuration file.
5. Start Interstage BPM Studio.

Note the following when querying a UDDI Registry:
• Type the Inquiry URL in the UDDI Query Server field.
• You can specify the Web Service name, Web Service provider, or tModel as search criteria.
• You may use the percent symbol (%) as a wildcard for any character or set of characters in

the search criteria.
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• Once you have found the Web Service that you want to use, make sure that the URL of the
WSDL document is displayed in the WSDL URL field. Then, click OK.

Figure 195: Specifying the Location of the WSDL Document

6. Specify the operation that you want to use:
a) Select the Operations tab.
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b) Select one of the operations that are available on the given Web Service and port.

Figure 196: Selecting an Operation

7. Specify the input parameters for the operation:
a) Select the Input tab.

This tab shows the SOAP request message that will be sent to the Web Service. This message
contains the input parameters that the operation needs. The XPath column shows the
parameters as XPath expressions.
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b) In the Value column, specify the UDAs that contain the values to be passed to the operation.

Figure 197: Specifying the Operation's Input Parameters

For an explanation of advanced options, refer to section Web Services: Special Tags for SOAP
Request Messages on page 310.

8. If the SOAP request message is constructed by an external application, do the following:
a) Make sure that you have added a UDA that contains the SOAP request message.
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b) On the Input tab, select Pick SOAP Request from UDA. From the drop-down list, select the
UDA that contains the SOAP request message. The list only contains UDAs of type STRING
or XML.

Figure 198: SOAP Request Message Supplied by External System

In this case, the message shown in the SOAP Request Message area is not used.

9. Map the response of the Web Service to UDAs:
a) Select the Output tab.
b) Click in the UDA Name field and select the UDA that is to store the return value.

The Web Service sends the operation's return value as a SOAP response message.

c) Click in the XPath of UDA field and select an XPath expression of the UDA that stores the
return value, from the drop-down list.
The XPath field is activated only if you have selected a UDA of type XML.

d) Optional: If you want to edit the XPath expression that you selected in the drop-down list in
XPath of UDA, click the ... button located next to the drop-down list. XPath Editor dialog is
displayed with the selected XPath expression in its editor area. You can edit this XPath
expression and click OK to use the edited XPath expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:
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XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

e) In the XPath of SOAP Response Message field, specify where the return value can be found
in the SOAP response message.

f) If you need to add additional rows, click Add.
If the return value is complex, you may need to map it to multiple UDAs. For example, if you
call a Web Service that returns flight data, you need multiple UDAs to store the flight number,
carrier, flight date, and so on.

g) If you want to remove a mapping, select it and click Remove.

Figure 199: Mapping Return Values to UDAs

If you have no information about the structure of the SOAP response message, test the
Web Service call to obtain a sample message. Use this message to determine the XPath
expression that you need.

Note:

10. If the Web Service can be accessed with a user account only:
a) Select the Security tab.
b) Type the user name and the password.

11. If you want to test the Web Service call with sample values, do the following:
a) Select the Input tab.
b) Click XML to switch to the XML view.
c) Replace the {{Field <UDA>}} tags by sample values.
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The figure below shows a SOAP request message before the replacement.

Figure 200: SOAP Request Message with UDAs
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This figure shows the SOAP request message after the replacement.

Figure 201: SOAP Request Message with Sample Values for Testing

d) Select the Test tab and click Test.
e) Check if the SOAP response message shows the result that you expected. If an error occurs,

check your input data and repeat the test.
f) On the Input tab, restore the SOAP request message to its original state. To do so, right click

the value and select the original expression.

12. Click OK.

If you want to call a Web Service on the Internet and you access the Internet through a
Proxy Server, you must configure Interstage BPM Studio to use the Proxy Server. To do
so, set the WSHttpProxyHost and WSHttpProxyPort parameters in the twf.ini configuration
file. The configuration file is located in the <Interstage BPM Studio Installation
Directory>\ibpm\Data\bin folder. The parameters for the Interstage BPM Server are
also stored in the IBPMProperties table in the database. For more information, refer to the
Interstage Business Process Manager Server Administration Guide.

Note:

11.7.3 Web Services: Special Tags for SOAP Request Messages
When specifying the SOAP request message, you can use special tags for parameters that you want
to be passed to the Web Service.
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The Input tab has an XML view and a Table view. You can add special tags in both views. However,
adding special tags in XML view is easier because you can select them from a pop-up menu. To
display the pop-up menu, click XML and then right click the SOAP Request Message area.

Figure 202: Adding Special Tags for SOAP Request Messages

Before the SOAP request message is sent, these tags are processed and replaced by the values
that need to be passed. The following list explains available tags and how they are processed.
• {{Field <UDAName>}}

The tag is replaced by the value of the User Defined Attribute (UDA). The value is XML encoded.
XML encoding affects characters that have a special meaning in XML. These characters are: less
than (<), greater than (>), ampersand (&) and double quotes ("). XML encoding ensures that
these characters are transformed to &lt;, &gt;, &amp;, and &quot;.

• {{Xml <UDAName>}}

The tag is replaced by the value of the UDA. The value is not XML encoded.
Use this tag if the value is an XML fragment that you want to pass as such.

• {{Js <JavaScriptExpression>}}

The JavaScript expression is evaluated and the tag is replaced by the evaluation result. The
evaluation result is XML encoded.

• {{JsXml <JavaScriptExpression>}}

The JavaScript expression is evaluated and the tag is replaced by the evaluation result. The
evaluation result is not XML encoded.
Use this tag if the JavaScript expression contains XML fragments that you want to pass as such.
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Example of {{Field <UDAName>}}
The following example shows how to pass the value of UDA Company to the Web Service:
<flight:Comp>{{Field Company}}</flight:Comp>

If the company's name is Good & Fast, it is passed as Good &amp; Fast.

Example of {{Xml <UDAName>}}
Say you want to call a Web Service for flight booking and need to pass the passenger's name. It is
stored as an XML fragment in UDA CustomerName:
<LastName>Jones</LastName><FirstName>Elizabeth</FirstName>

To pass this XML fragment, you need to include the following tag:
<flight:PassengerName>{{Xml CustomerName}}</flight:PassengerName>

Before the message is passed, the tag is replaced as follows:
<flight:PassengerName>

<LastName>Jones</LastName><FirstName>Elizabeth</FirstName>

</flight:PassengerName>

Example of {{Js <JavaScriptExpression>}}
The Web Service needs the address of the passenger. The street name and street number are stored
in separate UDAs, but need to be combined before being passed. This is achieved with the following
JavaScript expression:
<flight:Street>{{Js "uda.StreetNumber " + "uda.StreetName"}}</flight:Street>

If StreetName has the value Broad & Long Street and StreetNumber is 123, the JavaScript
expression evaluates to:
<flight:Street>123 Broad &amp; Long Street</flight:Street>

Example of {{JsXml <JavaScriptExpression>}}
Say your process definition stores the parts of an address in XML format, for example
<ZIP>80000</ZIP> or <City>Munich</City>. If you need to combine those parts and pass them
in XML format, you could use the following JavaScript expression:
<flight:Location>{{JsXml "uda.ZIP" + "uda.City"}}</flight:Location>

When a value of the ZIP UDA is <ZIP>80000</ZIP> and a value of the City UDA is
<City>Munich</City>, this JavaScript expression evaluates to:
<flight:Location><ZIP>80000</ZIP><City>Munich</City></flight:Location>, where ZIP
is the postal code and Munich is the name of the city of Munich.

11.8 Using Generic Java Actions
Prerequisites:
• You have implemented a Java class whose methods can be integrated as Generic Java Actions.
• The process definition has User Defined Attributes (UDAs) for all parameters that are to be passed

to the method.
• If the method has a return value, the process definition must have a UDA to which the return

value can be assigned.
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If you do not add the correct UDAs to your process definition, the Java Action may work
unpredictably.

Note:

Generic Java Actions allow you to execute Java methods that are outside the scope of Interstage
BPM. They enable you to customize process execution using methods of Java classes that you have
implemented yourself.
To assign a Generic Java Action:
1. Copy the Java class that you want to use. You must differentiate whether you are working with

a Workflow Application project or a Server project:
• Workflow Application project:

In the Workflow Application project's folder structure, store the Java class file(s) to the
Application Classes > engine > classes folder in the Navigator view.

• Server project:
Copy the Java class to the <Interstage BPM Studio Installation
Directory>\ibpm\Data\attachments folder.

2. Click the empty space in the Process Definition editor or select the node to which you want to
assign the Java Action, to display the Properties view for the process definition or the node
respectively.

3. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

4. Double click Generic JavaAction. The Action Editor dialog is displayed.
5. Type a descriptive name for your Java Action in the Action Name field.
6. Click the Browse button [...] and select the Java class that you want to use.
7. Select the method that you want to call from the Method Name list.

A method will be available only if all parameters are available as UDAs and if their data
types match.

Note:

8. From the Return Value list, select the UDA that will receive the return value, if any, from the
method.
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9. Check the UDA Mapping. Verify that the UDAs are mapped correctly to the method parameters.
These UDAs will provide input values to the method. To change a mapping, select another UDA
from the drop-down list that appears when you click a UDA.

Figure 203: Assigning a Generic Java Action

10. Click OK.

When you send the process definition to an Interstage BPM Server, or deploy your Workflow
Application project, the generic Java Actions are automatically sent to the Interstage BPM
Server.

Note:

11.9 Defining No-Operation Java Actions
No-Operation Java Actions are built-in Java Actions that specify no operation. These Java Actions
allow you to catch a Java Action exception without executing any additional actions. Using
No-Operation Java Actions, Interstage BPM simply moves on to the next sequential instruction.

You can assign No-Operation Java Actions to process definitions and all nodes.Note:

To define a No-Operation Java Action:
1. Click the empty space in the Process Definition editor or select the node to display the Properties

view for the process definition or the node respectively.
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2. Select the Action Set tab. Click Add corresponding to the position where you want to add the
Java Action. The Action Type List dialog is displayed.

3. Double-click No-Operation Java Action.
4. In the Action Editor - No Operation dialog, type a descriptive name and your notes for the Java

Action.
Providing information about the new Java Action is optional.

Figure 204: Defining a No-Operation Java Action

5. Click OK.

No-Operation Java Action Sample
The following example shows how to use a No-Operation Action.
In the example, you have created a regular Java Action, for example a Sending an email message
Java Action. For this Java Action, you have defined a No-Operation as an Error Action. An error
might occur if the recipient´s mailbox is full so that all incoming emails will be bounced back to the
sender. If executing the process instance is more important than sending the email, you can define
a No-Operation Action as an Error Action. This assures continuing the process instance regardless
of an error.
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11.10 Defining Exception Handling
With Interstage BPM Studio, you can define exception handling behavior as follows:
• Error Actions can be used to handle specific errors and to determine the behavior of a process

instance in case an error occurs. If you do not define any error handling, a process instance will
go into error state as soon as an exception is thrown, irrespective of when the error occurs, for
example, when the starting of a Remote Subprocess fails, or the sending of an email was
unsuccessful.
Error Actions can be defined on different levels:
• On Process Definition level: These Error Actions are executed in case of any error,

independent of the activity in which an error occurs and independent of the severity of an error.
Error Action Sets defined on process definition level will be executed immediately before the
process instance will go into error state. Note that such Error Actions cannot influence the
behavior of the process instance. Error Actions on process definition level may, for example,
be used for sending a notification email or for writing additional information into a log file. Refer
to section Using Error Actions on Process Definition Level on page 316 for details.

• On Node level (for Remote Subprocess Nodes only): An Error Java Action Set on this level
becomes active if the remote subprocess fails to start. Refer to section Using Error Actions
on Node Level on page 317 for details.

• On Java Action level: An Error Action Set on this level is executed when an error occurs
during the execution of a "regular" Java Action. Error Actions can be defined for all types of
Java Actions, except for an Error or Compensation Action. Assigning Error Actions to Java
Actions is described in section Dealing With Errors in Java Actions on page 240.

• OnSuspend, OnResume, and OnAbort Actions (On*Actions) can be used to deal with the
situations when an Administrator suspends, resumes or aborts the execution of a process instance.
For example, you can use these Actions to send a notification email. Refer to section Using
OnSuspend, OnResume, and OnAbort Actions on page 320 for details.

11.10.1 Using Error Actions on Process Definition Level
Error Actions on process definition level react on any kind of exception, independent of the activity
in which an exception occurred, and independent of how severe a problem is. Error Actions on
process definition level are typically used to execute general Java Actions, for example sending an
email or writing important information into a log file.
This section explains how to define Error Actions for process definitions.
To define Error Actions on process definition level:
1. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
2. Select the Exception Handling tab.
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Here you can add new Error Actions to your process definition. If you have not yet defined any
Error Action, the dialog displays an empty Error Actions folder.

Figure 205: Displaying the Exception Handling Tab

This dialog also allows you to create OnSuspend, OnResume, and OnAbort Actions. These
actions are not used to define a specific error handling behavior. They refer to situations
when the state of a process instance is changed by an Administrator. Refer to section Using
OnSuspend, OnResume, and OnAbort Actions on page 320 for more details.

Note:

3. Click Add.
The Action Type List dialog is displayed.

4. Proceed with defining a Java Action as an Error Action. Refer to section Using Java Actions on
page 233 for details.

5. Click OK.
The new Error Action will react to any kind of exception that is thrown during process execution.
You can assign the Error Action to a regular Java Action specified for a process definition. Refer
to section Dealing With Errors in Java Actions on page 240 for more details.

11.10.2 Using Error Actions on Node Level
Prerequisite:Since this feature is available for Remote Subprocess Nodes only, you must have
added a Remote Subprocess Node to one of your process definitions.

To define Error Actions on Remote Subprocess Nodes:
1. Select the Remote Subprocess Node to display the Properties view for it.
2. Select the Exception Handling tab.
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Here you can add new Error Actions to your Remote Subprocess Node. If you have not yet defined
any Error Action, the dialog displays an empty Error Actions folder.

Figure 206: Displaying the Exception Handling Tab

This dialog also allows you to create OnSuspend, OnResume, and OnAbort Actions. These
actions are not used to define a specific error handling behavior. They refer to situations
when the state of a process instance is changed by an Administrator. Refer to section Using
OnSuspend, OnResume, and OnAbort Actions on page 320 for more details.

Note:

3. Click Add.
The Action Type List dialog is displayed.

4. Proceed with defining a Java Action as an Error Action. Refer to section Using Java Actions on
page 233 for details.

Interstage Business Process Manager Studio User's Guide 318

11: Advanced Process Modeling



5. In the Action Editor for the selected Java Action, click the Error Handling tab. Here you can
specify the following error handling settings:

Figure 207: Displaying the Error Handling Tab

• Behavior after Error: Specifies the behavior of the process instance after executing the Error
Action. Select the Goto Error State radio button if you want your process instance to go to
error state. In case of an error, the Compensation Actions specified for the Java Actions and
the Error Actions on process level are executed, the process instance is rolled back, and the
instance is put to error state.
Select the Continue after Error radio button to continue executing your process instance. In
case of an error, the exception gets caught, the Error Actions specified for the failed Java
Action are executed, and the process instance continues. The default setting is Goto Error
State.

If you have defined several Error Actions with different settings, theGoto Error State setting
overrides the Continue after Error setting.

Note:

• Exceptions to React to: You can choose which kind of exceptions trigger the execution of
the Error Action. If you want the Error Action to react on any kind of exception, select the
Catch All Exceptions radio button. In that case, the Add and Remove buttons are disabled.

Interstage Business Process Manager Studio User's Guide 319

11: Advanced Process Modeling



Select the Catch Specific Exceptions radio button if you want the Error Action to react on
specific exceptions. In that case, you have to specify the exception class names (for example,
java.lang.NullPointerException), using the Add and Remove buttons.
Note that if you specify java.lang.Exception as exception class, the behavior will be the
same as when specifying Catch All Exceptions, because all exceptions belong to this class
unless you are more specific.

You can combine all error handling settings. Each combination results in a different error handling
procedure. The following table shows all possible combinations and their impact on executing
the defined Java Actions:

Continue after ErrorGoto Error StateError Handling Settings

If a Java Action throws any kind
of exception, the specified Error
Action catches this exception,
and the process instance
continues.

If a Java Action throws any kind
of exception, the specified Error
Action is executed. The
transaction is rolled back, and
the process instance goes to
error state.

Catch All Exceptions

If a Java Action throws the
specified exception, the Error
Action catches this exception,
and the process instance
continues.
If a Java Action throws an
exception that is not specified,
the Error Action is not
executed, the transaction is
rolled back, and the process
instance goes to error state
(default error handling
behavior).

If a Java Action throws the
specified exception, the Error
Action is executed. The
transaction is rolled back, and
the process instance goes to
error state.
If a Java Action throws an
exception that is not specified,
the Error Action is not
executed, the transaction is
rolled back, and the process
instance goes to error state
(default error handling
behavior).

Catch Specific Exceptions

6. In the Action Editor dialog, click OK to confirm all Error Action parameters.
The new Error Action will be executed if the Remote Subprocess Node fails to start. You can
assign the Error Action to a regular Java Action specified for a Remote Subprocess Node. Refer
to section Dealing With Errors in Java Actions on page 240 for more details.

11.10.3 Using OnSuspend, OnResume, and OnAbort Actions
OnSuspend, OnResume, and OnAbort Actions (On*Actions) are executed just before a process
instance changes its state due to the fact that an Interstage BPM Administrator has issued the
command to suspend, resume or abort the execution of a process instance.

On*Actions are not related to exceptions or error cases. They are regular Java Actions that
are executed when the command for a state transition has been invoked. Apart from this
special use, they are treated like regular Java Actions.

Note:

On* Actions can be defined for individual activities (for example individual nodes) or for process
definitions. Assume you define, for example, an OnSuspend Java Action both for a node and for a
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process definition. If this node is active when an Administrator issues the command to suspend the
process instance, the Java Actions are executed in the following order:
1. The OnSuspend Java Action of the Node is executed.
2. The OnSuspend Java Action of the process definition is executed.
Similar to all other Java Actions, On* Action Sets can contain a number of other Java Actions.
To define On* Actions:
1. Click the empty space in the Process Definition editor or select the node to which you want to

assign the Java Action, to display the Properties view for the process definition or the node
respectively.

2. In the Properties view, select the Exception Handling tab.
The Exception Handling dialog is displayed. If you have not defined any On* Actions before, an
empty folder is displayed for each of the three actions, for example:

Figure 208: Displaying On* Actions

3. Select the tab for the On* Action you want to create, and click Add.
The Action Type List dialog is displayed.

4. Proceed with defining a Java Action as an Error Action. Refer to section Using Java Actions on
page 233 for details.

5. Click OK.

11.11 Using Triggers
In Interstage BPM, triggers move data coming from an external system into process instances.
The data comes in as an XML file. This file is also referred to as a Data Event file. The external
system stores the XML file in a particular directory configured on the Interstage BPM Server. In
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response to the incoming data, a trigger either starts a process instance or makes a choice on a
particular activity. It also maps incoming data to User Defined Attributes (UDA) and thus makes it
available for further processing.
Depending on what the trigger is supposed to do (start a process instance or make a choice), you
define it either
• on process definition level for starting a process instance
• on node level (Activity Node) for making a choice
• as a separate Trigger Node in the process definition for defining an event activity.
The following sections explain how to prepare for triggers and how to define them.

11.11.1 Preparing for Using Triggers
Prerequisite: You know how to define XML schemas or how to write XPath expressions.

When defining a trigger, you will be mapping the incoming XML data to User Defined Attributes
(UDAs). To simplify data mapping, you are recommended to provide an XML schema (*.xsd file)
that describes the format of the incoming XML data. This way, the elements of the XML file are
available as a drop-down list in Interstage BPM Studio and can be easily mapped to UDAs.
If you don't provide an XML schema, you need to specify the location of the elements to be mapped
using XPath expressions.
To prepare for using triggers:
1. Recommended: Provide an XML schema that describes the format of the incoming data:

a) Create an XML schema.
b) Store the XML schema on a Web Server to which Interstage BPM Studio has access.
c) Make sure that you know the URL of the XML schema.

For example, if you have stored the XML schema in the root directory of the Web Server, the
URL would be:
http://<computername>/<xml schema name>

2. To properly map XML data, you will need to know the element names, data types, and element
description used in the incoming XML file.
As an example, the following table lists the information you need to know if the incoming XML
files were order forms:

Element DescriptionXSD Data TypeElement Name

Name of the person taking the
order

stringorderperson

Name, address, etc. of the
person making the order

stringname, address, city, state,
zip

Item being orderedstringtitle, note

Quantity of the item being
ordered

positiveIntegerquantity

Price of the item being ordereddecimalprice
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3. Before starting process instances on the Interstage BPM Server, make sure that the File Listener
is configured to check for incoming files. Refer to the Interstage Business Process Manager
Developer's Guide for information on how to configure the File Listener.

11.11.2 Defining Start Process Triggers
Prerequisites: Refer to section Preparing for Using Triggers on page 322.

A Start Process Trigger starts a process instance in response to data that comes in from an external
system.
To define a Start Process Trigger:
1. Add the User Defined Attributes (UDAs) you will need for your trigger to the process definition.
2. Click the empty space in the Process Definition editor to display the Properties view for the process

definition.
3. Select the Triggers tab.
4. Click Add.

A new trigger with a default name is added.

5. Select the trigger to view the details for that trigger in the Trigger Details area.
6. Modify the name of your trigger as required on the General sub-tab, in the Trigger Details area.

As an alternative, you can drag and drop the Trigger Node from the Palette onto the Start
Node of your process definition. In this case, you need to enter a name for the trigger only
and can define it, as described below, at a later point in time via the process definition
properties.

Note:

7. Optional: Describe the purpose of your trigger on the General sub-tab.
8. Select the Event sub-tab.
9. If you have an XML schema that describes the format of the incoming data, type its URL in the

URL to XML Schema field. Click Retrieve to load the XML schema.
The icon next to the URL to XML Schema field tells you if the XML schema has been loaded.

10. If you want process instances to be started only under certain conditions, specify a JavaScript
expression in the Event Filter field that defines those conditions.
For information on JavaScript expressions, refer to section Defining JavaScript Expressions on
page 339.
The following is an example of a JavaScript expression that starts a process instance only if the
price of the item is greater than $20.00:
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Packages.java.lang.Float.parseFloat(eventData.getXMLData("/shiporder/item/price/text()"))
> 20

Figure 209: Specifying an Event Filter

11. Select the Data Mapping sub-tab. Map the elements of the incoming XML file to UDAs. To map
an element:
a) Click Add.
b) If you specified an XML schema, select an XML element from the Event Element list.

Otherwise, specify the location of the XML element using an XPath expression.
c) Select the UDA from the Variable list to which you want to map the XML element.

Triggers are flexible enough so that you can map external data of type String to a UDA of
type INTEGER as long as the external data consists only of numerals.

Note:

d) In the XPath of Variable field, type in an XPath expression of the selected UDA.This expression
is used to map the incoming XML file to a specific attribute of the UDA.
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The XPath field is activated only if you have selected a UDA of type XML from the Variable
list.

Figure 210: Defining Data Mappings

e) If you want to remove a mapping, select it and click Remove.

12. When you have completed the data mapping, select the General sub-tab. Select the Enable
check box to enable your trigger.

11.11.3 Defining Make Choice Triggers
Prerequisites: Refer to section Preparing for Using Triggers on page 322.

A Make Choice Trigger makes a choice on an activity in response to data that comes in from an
external system.
To define a Make Choice Trigger:
1. Add the User Defined Attributes (UDAs) you will need for your trigger to the process definition.
2. Select the Activity Node to display the Properties view for it.
3. Select the Triggers tab.
4. Click Add.

A new trigger with a default name is added.

5. Select the trigger to view the details for that trigger in the Trigger Details area.
6. Modify the name of your trigger as required on the General sub-tab, in the Trigger Details area.
7. Optional: Describe the purpose of your trigger on the General sub-tab.
8. Select the Event sub-tab.
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9. If you have an XML schema that describes the format of the incoming data, type its URL in the
URL to XML Schema field. Click Retrieve to load the XML schema.
The icon next to the URL to XML Schema field tells you if the XML schema has been loaded.

10. If you want the trigger to fire only with certain incoming data, specify a JavaScript expression in
the Event Filter field that defines those conditions.
For an example, refer to section Defining Start Process Triggers on page 323. For information on
JavaScript expressions, refer to section Defining JavaScript Expressions on page 339.

11. Select the Data Mapping sub-tab. Map the elements of the incoming XML file to UDAs. To map
an element:
a) Click Add.
b) If you specified an XML schema, select an XML element from the Event Element list.

Otherwise, specify the location of the XML element using an XPath expression.
c) Select the UDA from the Variable list to which you want to map the XML element.

Triggers are flexible enough so that you can map external data of type String to a UDA of
type INTEGER as long as the external data consists only of numerals.

Note:

d) Click in the field in the XPath of Variable column. A drop-down list is displayed. Select from
the drop-down list, the XPath expression for the UDA selected in the Variable column. This
expression is used to map the incoming XML file to a specific attribute of the UDA.
The XPath field is activated only if you have selected a UDA of type XML from the Variable
list.

Figure 211: Defining Data Mappings
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e) Optional: If you want to edit the XPath expression that you selected in the XPath of Variable
drop-down list, click the ellipsis (...) button that is displayed next to the XPath of Variable
drop-down list. XPath Editor dialog is displayed with the selected XPath expression in its
editor area. You can edit this XPath expression and click OK to use the edited XPath
expression.

The edited XPath expression is displayed as the latest XPath in the XPath drop-down list.Note:

The XPath expressions related to the selected XML UDA are displayed in the XPath
drop-down list. When XML Schema is defined in selected UDA, the XPath list that can be
used with this XML Schema is displayed. When Initial value is defined in selected UDA, the
XPath list that can be used with this Initial value is displayed. When both are defined, Xpath
list of XML Schema is displayed.

Note:

XPath Editor only validates the syntax of the XPath. It does not check if the edited XPath
expression exists or not.

Note:

f) If you want to remove a mapping, select it and click Remove.

12. If you want the trigger to fire only for certain process instances:
a) Select the Process Instance Selection sub-tab.
b) Click Add to add a new condition.
c) From the Variable list, select the UDA that you want to evaluate. Specify an XPath expression

for the element in the incoming XML file whose value you want to compare.
When the trigger is fired, only those process instances are selected in which the value of the
UDA matches the value of the corresponding element in the incoming XML file. If you specify
multiple conditions, the trigger will only fire when all conditions are satisfied.

Make sure that the UDA is marked as a Worklist UDA on the User Defined Attributes tab.
Otherwise, the trigger does not work. UDAs of type XML are not displayed in the Variable
list, as they cannot be Worklist UDAs.

Note:

d) If you want to remove a condition, select it and click Remove.
Say you want to trigger process instances for orders from partners. A UDA Partner indicates if
an incoming order is from a partner. The UDA is of type BOOLEAN and is marked as a Worklist
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UDA. In the incoming XML file, the corresponding information is stored in the fromPartners
element. The following figure shows the condition that you would specify in this case:

Figure 212: Filtering on process instances

In this example, the trigger will fire if an incoming XML file contains the following data:

<order>
...
<fromPartners>true</fromPartners>
...

</order>

The trigger will not fire if the following data come in:

<order>
...
<fromPartners>false</fromPartners>
...

</order>

13. If you want a particular choice to be made only under certain conditions:
a) Select the Choice Selection sub-tab.
b) From the Choice list, select the arrow for which you want to define a condition. Specify a

JavaScript expression that defines the condition.
c) You can rearrange the order in which the conditions are evaluated by highlighting a condition

and clicking the Up or Down button.
All conditions are checked in the sequence in which they appear in this dialog. The first matching
condition is used and the process flow proceeds along this arrow.

d) Decide what is to happen if none of the conditions apply. From the If no expression is true,
then list, you can either select an arrow or specify that the trigger is to wait for another event.

Interstage Business Process Manager Studio User's Guide 328

11: Advanced Process Modeling



If you select an arrow, the process flow proceeds along the arrow to the next node. If you specify
that the trigger is to wait for another event, the Activity Node remains active.
Say you wanted the vice president’s approval of orders over $10,000. You would build a JavaScript
expression like the following:

Figure 213: Defining Conditions for Arrows

14. Select the General sub-tab. Select the Enable check box to enable your trigger.

When a Trigger has been defined, the following symbol is added to this arrow connecting the Activity

Node with another node: (Add Trigger Intermediate Event).

11.11.4 Using Trigger Nodes
Prerequisites: Refer to section Preparing for Using Triggers on page 322.

A Trigger Node represents a step in a process which is driven by an external event. Each Trigger
Node has a trigger defined that is supposed to fire when date, typically XML files, comes in from an
external system. Once the data arrives, the trigger moves the data into User Defined Attributes
(UDAs) according to your trigger definition. The trigger then makes a choice and process execution
moves forward to the next node.
This node type does not involve any human interaction. Hence, no work items are generated when
a Trigger Node becomes active. It can only be completed by the trigger defined on the node.
A process definition can have any number of Trigger Nodes. A Trigger Node can have one or more
incoming arrows and exactly one outgoing arrow.
For every Trigger Node, you need to define one or more Make Choice triggers. Prologue Action,
Epilogue Actions and timers can be used as required.
Note that a Trigger Node cannot be assigned to users, Roles, or agents; and it does not support
Role Actions or forms.
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To define a Trigger Node:
1. Add the User Defined Attributes (UDAs) you will need for your trigger to the process definition.
2. From the Palette, drag and drop a Trigger Node in the Process Definition editor.
3. Select the Trigger Node to display the Properties view for it and select the Triggers tab.
4. Click Add.

A new trigger with a default name is added.

5. Proceed as described in section Defining Start Process Triggers on page 323.

11.12 Defining Java Agents
A Java Agent is a special Java program that gathers information or performs some well-defined tasks
in the background without your immediate presence and on some regular schedule. Java Agents
are created to run automatically and act asynchronously on your behalf. You can use Java Agents
to access external systems, such as legacy systems or Web services. Using Java Agents, you can
incorporate these external services into your Interstage BPM process instances.
Interstage BPM Studio allows you to add several Java Agents to your Workflow Application projects.
For configuring new Java Agents, Interstage BPM Studio provides an XML file called
agentsConfig.xml. Once a new Java Agent is configured, it can run as an activity in an Interstage
BPM process instance by assigning it to an Activity Node. A Java Agent is assigned to an Activity
Node in the same manner that a Role is assigned to an Activity Node. The Java Agent then takes
the place of the Interstage BPM activity.
To define a new Java Agent:
1. Right-click your project in the Navigator view and select New > Agents from the pop-up menu.

A new agentsConfig.xml file is automatically stored in the Resources folder of your Workflow
Application project. The default agentsConfig.xml file automatically opens in the Resource
editor. The file looks as follws:

<?xml version="1.0" encoding="utf-8" ?>
<!-- Action agents configuration file -->
<!-- Begin sample agent configuration

For Windows:
<ActionAgentList>

<ActionAgent>
<Name>@CRChk</Name>
<Description>Invoke the CR check inform</Description>
<RetryInterval<1>/RetryInterval>
<EscalationInterval>1</EscalationInterval>
<ClassName>com.fujitsu.iflow.tests.AgentSimulator</ClassName>
<ClassPath>C:\Fujitsu\InterstageBPM\classes</ClassPath>

<ConfigFile>C:\Fujitsu\InterstageBPM\server\instance\default\attachments\AUTOEXEC.BAT</ConfigFile>

</ActionAgent>
</ActionAgentList>

For Solaris:
<ActionAgentList>

<ActionAgent>
<Name>@CRChk</Name>
<Description>Invoke the CR check inform</Description>
<RetryInterval<1>/RetryInterval>
<EscalationInterval>1</EscalationInterval>
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<ClassName>com.fujitsu.iflow.tests.AgentSimulator</ClassName>
<ClassPath>/opt/FJSVibpm/classes</ClassPath>

<ConfigFile>/opt/FJSVibpm/server/instance/default/attachments/AUTOEXEC.BAT</ConfigFile>

</ActionAgent>
</ActionAgentList>

2. Navigate to the agentsConfig.xml file and type in the properties that are required for the new
Java Agent.
Set the following properties:
• Name: Name of the agent. Make sure that the Agent name always starts with @. This designates

it as a Java Agent.
• Description: Explains form and function of the Agent.
• RetryInterval: Specifies the amount of time, in seconds, between retry attempts when a failure

occurs.
• EscalationInterval: Specifies the number of failures after which the System Administrator is

notified via email.
• ClassName: Name of the Java class associated with the Agent.
• ClassPath: Classpath of the Java class associated with the Agent. If this entry is not specified,

Interstage BPM Studio will use the C:\Fujitsu\InterstageBPM\classes Classpath.
• ConfigFile: Fully qualified name of the configuration file used by the Java Agent.
The sample configuration file BankLoanAgentsConfig.xml is located in the <Interstage BPM
Studio installation folder>\samples\BankLoan directory. This file contains the configuration
parameters for a Java Agent and a list of possible Java Agent implementations.

3. Type in the properties for the new Java Agent, and click Save on the toolbar to save the new
agent.
You can use the new Java Agent to carry out specific tasks in the background.

11.13 Defining FTP Agents
FTP Agents automatically transfer files attached to process instances that contain the FTP Agents.
Like all Agents, FTP Agents take the place of Interstage BPM activities. Process instances started
from a process definition containing an FTP Agent automatically transfer the files that are attached
to them. They transfer the attached file(s) to the FTP Server of any machine to which the Interstage
BPM Server machine can connect.
Refer Working With Resources on page 88 for more information about the location of FTP Agents
in Interstage BPM Studio.
Refer the topic Configuring FTP Agents in Interstage Business Process Manager Developer's Guide
for more information about FTP Agents.
To define a new FTP Agent:
1. Right-click your project in the Navigator view and select New >> FTP Agent.

Interstage Business Process Manager Studio User's Guide 331

11: Advanced Process Modeling



New FTP Agent dialog is displayed. The following figure displays the New FTP Agent dialog.

Figure 214: Defining FTP Agent

2. Enter the name of the project for which you want to define a new FTP Agent in Project field.
3. Optional: Click Browse to select the project.

Folder Selection dialog is displayed. Select the project from this dialog and click OK.

4. After selecting the project, enter a name for the new FTP Agent in File Name field.

You must add .xml after the name of the file that you enter in the File Name field.Note:

5. Click OK on the New FTP Agent dialog.
The new FTP Agent file (FTPAgent.xml) is added to the Resources folder and also displayed in
the editor. The FTP configuration file is displayed as given below.

<Services>
<Service>
<ServiceType>FTP</ServiceType>
<ServiceStatusUDA>AgentServiceStatus</ServiceStatusUDA>
<ServiceResultUDA>AgentServiceResult</ServiceResultUDA>
<ServiceSpecificInfo>

<FTPHost>127.0.0.1</FTPHost>
<FTPPort></FTPPort>
<FTPUser>anonymous</FTPUser>
<FTPPassword></FTPPassword>
<FTPType>BINARY</FTPType>
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<FTPAppend>FALSE</FTPAppend>
<FTPDirectory>%%REMOTE_FTP_DIRECTORY%%</FTPDirectory>
<FTPFileNames>%%REMOTE_FTP_FILES%%</FTPFileNames>
<Documents>%%OUTGOING_FILES%%</Documents>

</ServiceSpecificInfo>
</Service>

</Services>

6. Configure the FTPAgent.xml file using its tags. The following table describe the tags used in
FTPAgent.xml file.

DescriptionTag

For the FTP Agent, the service type is always
FTP. If there is no service type specified or the
service type is invalid, the process instance
goes into error state. This tag is used by all
agents using the ServiceAgent class.

<ServiceType>

Name of the User Defined Attribute (UDA) that
stores the status of the FTP Agent activity.
Possible values are Done or Failed. Removing
this tag has no effect on the FTP Agent;
however, the user cannot see the status of the
FTP Agent activity.

<ServiceStatusUDA>

Name of the UDA that stores the error message,
if the FTP Agent throws an exception. Removing
this tag has no effect on the FTP Agent;
however, if the FTP Agent fails, the user cannot
see the error that occurred.

<ServiceResultUDA>

Host name or IP address of the machine that
receives the transferred file. The default value
is 127.0.0.1, i.e. the local host. If there is no
FTP host specified or the FTP host is invalid,
files are transferred to the local FTP server, if
available. This tag is specific to the FTP Agent.

<FTPHost>

Port used by the FTP server. If no port is
specified, the default FTP port 21 is used. This
tag is specific to the FTP Agent.

<FTPPort>

User name of the FTP user that transfers the
file. If the user name is invalid, file transfer fails
and the process instance goes into error state.
This tag is specific to the FTP Agent.

<FTPUser>

Password of the FTP user that transfers the file.
This tag is specific to the FTP Agent.

<FTPPassword>
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DescriptionTag

Type of files to be transferred. Allowed values
are ASCII or BINARY. Default value is BINARY.
Use ASCII if you are transferring text files. Use
BINARY if you are transferring binary files. If any
other value than ASCII or BINARY is specified,
the FTP Agent throws an exception. This tag is
specific to the FTP Agent.

<FTPType>

Specifies whether a file to be transferred is
appended to a remote file. Allowed values are
TRUE or FALSE. Default value is FALSE.
Use TRUE if you want to append the contents of
the local file to an already existing remote file.
Use FALSE if you want to overwrite an already
existing remote file. If any other value than TRUE
or FALSE is specified, the FTP Agent throws an
exception.
This tag is specific to the FTP Agent.

<FTPAppend>

Name of the User Defined Attribute (UDA) that
specifies the directory to which files are
transferred. A path relative to the FTP server is
specified.
For example: if /iflow is the value of the
REMOTE_FTP_DIRECTORY UDA and you are
working on a Windows system, the file is
transferred to c:\Inetpub\ftproot\iflow. If
an invalid directory is specified, the process
instance goes into error state.
This tag is specific to the FTP Agent.

<FTPDirectory>

Name of the UDA that specifies the file names
to be used for the remote files. This parameter
is used to rename files while transferring them.
For example, if LocalFile.txt is attached to
the process instance and REMOTE_FTP_FILES
has RemoteFile.txt as its value,
LocalFile.txt is transferred to the FTP
directory and renamed to RemoteFile.txt.
REMOTE_FTP_FILES can contain several file
names separated by semicolon (;). If
REMOTE_FTP_FILES contains no file names, the
original file names are used.

<FTPFileNames>
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DescriptionTag

Name of the UDA that specifies the files that
are transferred to the FTP directory.
OUTGOING_FILES can contain several file names
separated by semicolon (;). If OUTGOING_FILES
contains no file names, all files attached to the
process instance are transferred.

<Documents>

Files that have a semicolon (;) in their names cannot be transferred to an FTP directory.
Semicolons are considered as file name delimiters and are therefore not allowed within
names of files that are to be transferred.

Note:

11.14 Defining HTTP Agents
HTTP Agents are used to send data to external locations on the Internet and receive data from the
Internet. An Agent sends data to the URL specified in its configuration and receives response data
from that URL.
Refer Working With Resources on page 88 to more information about the location of HTTP Agents
in Interstage BPM Studio.
Refer the topicConfiguring HTTP Agents in Interstage Business Process Manager Developer's Guide
for more information about FTP Agents.
To define a new HTTP Agent:
1. Right-click your project in the Navigator view and select New >> HTTP Agent.
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New HTTP Agent dialog is displayed. The following figure displays the New HTTP Agent dialog.

Figure 215: Defining HTTP Agent

2. Enter the name of the project for which you want to define a new HTTP Agent in Project field.
3. Optional: Click Browse to select the project.

Folder Selection dialog is displayed. Select the project from this dialog and click OK.

4. After selecting the project, enter a name for the new HTTP Agent in File Name field.

You must add .xml after the name of the file that you enter in the File Name field.Note:

5. Click OK on the New HTTP Agent dialog.
The new HTTP Agent file is added to the Resources folder and also displayed in the editor. The
HTTP configuration file is displayed as given below.

<HTTPAgent>
<HTTPBaseURL method="POST"
followRedirects="true">{{Field HTTP_URL}}</HTTPBaseURL>

<HTTPHeaderParams name="Content-Type">text/xml;
charset=UTF-8</HTTPHeaderParams>

<HTTPHeaderParams name="User-Agent">I-BPM HTTP Agent
</HTTPHeaderParams>
<HTTPHeaderParams name="accept-charset">UTF-8
</HTTPHeaderParams>
<QueryParams name= "ParamName">Param value</QueryParams>
<HTTPRequestUDA>HTTP_REQUEST</HTTPRequestUDA>
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<HTTPResponseUDA>HTTP_RESPONSE</HTTPResponseUDA>
<HTTPAgentStatusUDA>HTTP_STATUS</HTTPAgentStatusUDA>

</HTTPAgent>

6. Configure the HTTPAgent.xml file using its tags. The following table describe the tags used in
HTTPAgent.xml file.

DescriptionTag

URL end point. The value for the
<HTTPBaseURL> tag specifies the external
service to be called by the HTTP Agent, e.g. a
Servlet. This value can also be defined to come
from a process instance UDA as QuickForm
expression, such as {{Field HTTP_URL}}.
Attributes:
method="POST" or "GET". Defines the request
method to be used for the HTTP request. If you
do not specify the method attribute, the process
instance will go into the error state. If you
specify an attribute value other than "POST" or
"GET", the HTTP agent will fail.
followRedirects="true".
Since the default value for followRedirects
is false, you must specify this attribute.

<HTTPBaseURL>

Sets the HTTP header properties like the
encoding style, the content type, etc. HTTP
headers are used to define a variety of web
object properties, for example, the properties
of request and response objects for the current
HTTP session.
Attributes:
name="Content-type" or "User-Agent".
"Content-type" defines the type of requested
content and takes the following value:
value="text/xml", charset=UTF-8.
This value can also be defined to come from
process instance UDAs as QuickForm
expression such as {{Field contentType}}.
"User-Agent" contains information about the
client (user agent) from where the request
originates.
Note that currently there is no restriction for the
value that can be specified in the name attribute
of the <HTTPHeaderParams> tag. Any valid
values for this attribute are valid HTTP headers.

<HTTPHeaderParams>
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DescriptionTag

This tag is required in case the "GET" method
is used with the HTTP Agent. The value of this
tag is passed to the external service as Query
String. Note that the value of the UDA specified
in the <HTTPRequestUDA> tag is not used when
the "GET" method is used.
Correct usage of this tag is as follows:
<QueryParams name= "ParamName">Param
value </QueryParams>

This will result in the following URL specification
during HTTP Agent execution:
URL?ParamName=Param Value

You can specify any valid string for the name
attribute of the <QueryParams> tag.

<QueryParams>

Value of the UDA specified in this tag is part of
the query string for the HTTP request.

<HTTPRequestUDA>

UDA where the HTTP service status will be
stored.

<HTTPAgentStatusUDA>

UDA where the HTTP response will be stored.<HTTPResponseUDA>

11.15 Defining File Listener
File Listeners monitor files in specified directory locations. When they detect new or newly modified
files, they notify the Interstage BPM file handlers, so they can perform automatic functions like starting
Interstage BPM process instances or making choices on activities. File listeners are typically used
for integrating Interstage BPM with other enterprise applications.
Refer Working With Resources on page 88 for more information about the location of File Listener
file in Interstage BPM Studio.
Refer the topic File Listeners in Interstage Business Process Manager Developer's Guide for more
information about File Listeners.
To define a new File Listener:
1. Right-click your project in the Navigator view and select New >> File Listener.

The fileListenerConf.xml file is created and displayed in the editor.

You can create only one File Listener file each project.Note:

In non-SaaS mode, you must not create the File Listener file. Refer to the Interstage Business
Process Manager Developer's Guide for information on how to configure the File Listener.
It is necessary to change the following files of the server to use File Listener.
<Interstage BPM Server Installation
Directory>/server/instance/default/tenants/Default/attachments/apps/System/fileListenerConf.xml

Note:
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11.16 Defining JavaScript Expressions
In Interstage BPM Studio, JavaScript expressions are used with the following elements:
• Complex Conditional Nodes
• Java Actions
• Triggers
Several software controls are provided to help you build JavaScript expressions more effectively
and easily. The following figure shows an example:

Figure 216: Defining JavaScript Expressions

Key:
• 1 Expression Mode Button
• 2 Expression Field
• 3 Expression Builder Button

Expression Mode Button
The Expression Mode Button allows you to switch between different expression modes. The character
on the button shows the mode that is currently effective. The modes are:

DescriptionButtonMode

Used for simple constant (literal) JavaScript expressions.
Examples of constants are 50 or AskVicePresident.

Constant Mode

Used for JavaScript expressions that consist of a User Defined
Attribute (UDA) or Application Variables or both.
When you switch to this mode, a list is displayed that allows
you to select the UDA or the Application Variables.

Variable Mode
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DescriptionButtonMode

Used for complex JavaScript expressions. A complex
JavaScript expression might be composed of UDAs, operators,
JavaScript functions and constants.
The following is an example:
"Process started" + uda.get("Description")

With Expression Mode, you can type the JavaScript expression
directly or build it using the Expression Builder.

Expression Mode

Expression Builder Button
The Expression Builder Button opens a dialog that helps you build complex JavaScript expression.

Expression Field
The Expression Field displays the JavaScript expression that you specify.

Expression Builder
The Expression Builder helps you create more effective and viable JavaScript expressions in less
time and with less chance for making time-consuming hard-to-find errors. You can select expression
building blocks from lists and add operators by clicking them. This is an easier and faster method of
building JavaScript expressions, especially if you are unfamiliar with JavaScript syntax. Also, the
Expression Builder has a built-in verification function that checks the validity of JavaScript expressions
you have built before they are used.
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The following figure shows the Expression Builder.

Figure 217: Expression Builder

The Expression Builder consists of the following parts:
• Expression Display

This is where your JavaScript expression displays as it is built.

• Verify Button
You can verify the validity of your JavaScript expression as you build it. Verification also occurs
when you clickOK. Invalid JavaScript expressions cause an error message that provides diagnostic
information.

• Operands area
In this area, you can select a JavaScript function or a UDA from the drop-down lists or type in a
constant. Clicking Add adds it to your JavaScript expression.

Application Variable is not displayed in Variables drop-down list. When Application Variable
is used, it defines it as follows: for example, if Variable1 is an Application Variable then its
expression will be sec.getApplicationVariable("Variable1").

Note:

• Operators area
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In this area, you can click an operator to add it to your JavaScript expression. The standard
JavaScript operators are available.

11.16.1 Example: Building a JavaScript Expression Using the Expression
Builder
This example uses the Expression Builder to build a JavaScript expression that defines a process
instance description. The process instance description formed by this example tells the purpose of
the process instance.
To build a sample JavaScript expression:
1. Create a process definition.
2. Add a User Defined Attribute (UDA) of type STRING called Description.

For details, refer to section Specifying User Defined Attributes on page 143.

3. Click the empty space in the Process Definition editor to display the Properties view for the process
definition.

4. Select the Action Set tab. Add the Java Action Set Process Instance Description as an Init
Action:
a) Click Add in the Init Action area.
b) Expand Server Actions and double click Set Process Instance Description.

5. In the Action Editor - Set Process Description dialog, click the Expression Mode Button until
an E is displayed on it. Then click A + B to open the Expression Builder.

6. Type Process started in the Literals field. Click Add to add this constant to the JavaScript
expression.

7. Click the + operator to add it to the JavaScript expression.
8. Select Description from the Variables list. Click Add.
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The JavaScript expression should now look like this:

Figure 218: Building a Sample JavaScript Expression

9. Click OK to verify the JavaScript expression.
If it is valid, the Expression Builder is closed and the JavaScript expression is displayed in the
Action Editor - Set Process Description dialog .

Figure 219: Expression Field with Sample
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12 Simulating Processes
This chapter explains how to simulate the execution of processes.

12.1 Introduction to Process Simulation
The Interstage BPM Studio allows you to simulate the execution of processes. This feature can help
you in calculating cost and time for specific activities, and thus optimize your business processes.

Simulation Limitations
• You can simulate the execution of the process definitions containing:

• Activity Nodes
• Subprocess Nodes
• Chained-Process Nodes
• Voting Activity Node
• Conditional Node
• Complex Conditional Node
• Compound Activity

• The process definition whose execution is to be simulated must not contain one or several Remote
Subprocess Nodes. If it does, an error will be thrown and process simulation will fail.

• The simulation scenario must not generate more than 15,000 processes to be simulated. If it
does, an error will be thrown and process simulation will fail.

• The simulation of the processing of Java Actions and User Defined Attributes is not supported.
• If the process definition contains two or more nodes with the same name, simulation results may

not be correct.

12.1.1 Overview of the Simulation Process
The simulation process consists of various major steps:
1. In the Navigator view, when you open a new workspace, a simulation scenario folder called

Simulation is created, and also when you create a Workflow Application project, a Simulation
folder is created in the project structure. This folder is initially empty. Here you start with the
creation of a new scenario project.

2. In the Scenario editor, you define simulation properties for a scenario by editing the scenario.
Every scenario must import a process definition from either a Workflow Application or a server
project. The process definition used by a scenario can, in turn, be exported to a local or server
project. In addition, for every activity defined in the process definition, simulation properties can
be specified.

3. The scenario is calculated for preparing the simulation result by calling the Run Simulation
command. The simulation results are automatically saved to the Scenario (.ssr) file and stored
in the Simulation folder of your Workflow Application project. In addition, the Simulation Controller
is displayed below the Scenario editor.

4. From the Simulation Controller, the execution of the process simulation is started, the imported
process definition is displayed in the Scenario editor and shows the progress of simulation, and
simulation reports can be generated for analysis purposes.
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The figure below shows this process:

Figure 220: Simulation Process Overview

12.1.2 General Procedure
This section gives an overview of the steps required to set up a simulation scenario and locally
simulate the execution of a process.
1. As a prerequisite for simulating a process, you need to define a process definition based on

which process instances will be triggered and executed. For the following types of nodes in your
process definition, you can specify "Simulation Properties" that are taken into account when the
simulation is executed:
• Activity Node
• Voting Activity Node
• Conditional Node
• Complex Conditional Node

You cannot define simulation properties for Subprocess Nodes and Chained-Process Nodes.Note:

For example, you can specify the probability with which a specific arrow is chosen in case you
have a node with several outgoing arrows, or you can specify detailed information on the resources
required to perform a specific activity. Refer to section Defining Simulation Properties for Nodes
on page 356 for details.
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The processing of all nodes except Remote Subprocess Nodes can be simulated. For example,
in case of a Delay Node its timer is simulated.

2. You create a new simulation scenario. Refer to section Creating a Simulation Scenario on page
346 for details.

3. For the simulation scenario, you need to specify, among other things, the start and end date for
the simulation, the currency in which costs are to be calculated, the process definition whose
execution is to be simulated, the interval in which new process instances are created. In addition,
for every role defined in the process definition, you can specify an individual business calendar
to be applied and costs per defined unit (e.g. cost/hour). Refer to section Defining Simulation
Properties for a Scenario on page 352 for details.

You can also simulate execution of process definitions containing Subprocess Nodes and
Chained-Process Nodes. If the process definition has Subprocess Nodes or Chained-Process
Nodes, execution of the parent process definition is simulated and then execution of the
subprocess definitions is simulated automatically.

Note:

4. Once finished with the definition of the simulation properties, you simulate the scenario and
generate a simulation result. Refer to section Preparing a Simulation Result on page 359 for details.

5. Based on the prepared simulation results, you can replay the simulation with the simulation results.
While the simulation is running, you can observe the processing of every node in your process
definition. Refer to section Using the Simulation Controller on page 360 for details.

6. The simulation results can then be evaluated using the extensive simulation report functionality.
Refer to section Generating Simulation Reports on page 362 for details.

12.2 Defining a Simulation Scenario
This section describes how to create a scenario and define simulation properties.

12.2.1 Creating a Simulation Scenario
Prerequisite: You have created process definitions for which you want to simulate the execution of
processes.
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To create a new scenario:
1. Right-click the empty Simulation folder in the Navigator view and select New > Scenario. The

New Scenario dialog box is opened:

Figure 221: Creating a Scenario

2. In the Project field, the current Workflow Application project or the Simulation Scenarios project
is displayed. You can change to another project by clicking Browse and then selecting a different
project. You can create a simulation scenario for a process definition of a Workflow Application
project or a server project.

3. Type a name for your scenario in the Name field, and a brief description of the scenario in the
Description field.

4. Click Finish.
The new scenario is automatically stored in the Simulation folder in the Navigator view. The
Scenario editor is opened and the name and description you entered are automatically added.
Apart from creating a new simulation scenario, you can also open existing scenarios. To do so,
open the Simulation folder where you have stored the new scenario, and double-click the scenario
(.ssr) file.

5. Continue with defining the simulation scenario using the Scenario editor. Refer to section Defining
Simulation Properties for a Scenario on page 352 for details.
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12.2.2 Using Simulation Values From History
Prerequisite: You have created a simulation scenario for which you want to use historical values.

To use values from history for simulating processes:
1. Open a simulation scenario in the Scenario editor.
2. In the Simulation Period And Arrival Setting area, click the Gather Default Values from

History link.
The Gather Default Simulation Values from History dialog is displayed. Here you can specify
the server from which you want to retrieve the simulation values.

3. Specify the source of the historical simulation values.
You can select an available server connection or browse for a new server connection:
• Select a server connection: From the Server Connection drop-down list, select the remote

server from which you want to fetch the historical simulation values.
• Browse for a new server:

1. Click Browse Connection to add a new server connection. Select Server Connection
dialog is displayed.

2. If you want to create a new server connection, click New on Select Server Connection
dialog. Server Connection Setting dialog is displayed.

3. Enter all the parameters in Server Connection Setting dialog to create a new server
connection and click OK. The new server connection is displayed in Select Server
Connection dialog. Refer Setting Your Preferences on page 76 to know more about various
parameters.

In SaaS mode, the <tenant> in the URL connects you to the specific tenant on the Interstage
BPM Server. Refer Interstage BPM Studio Features on page 16 to know more about SaaS
mode.

Note:

If you want to connect to Interstage BPM Server in non-SaaS mode, enter default in
<tenant> in the URL. This will, through the default tenant, directly connect you to the server
specified in <hostname> in the URL.

Note:
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4. Click OK on Select Server Connection dialog.

Figure 222: Selecting a server connection

4. In the Gather Default Simulation Values from History dialog, click Get list.
The Password Required dialog is displayed.

5. In the Password Required dialog box, type in your password to authenticate against the server.
The user name is automatically displayed. Click OK to confirm your user name and password.

Figure 223: Entering your password
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6. In the Select dialog that displays all applications stored on the selected server (remote_server,
in the example), in the Application area select an application, and click Next.

Figure 224: Displaying applications on the selected server

The next dialog shows the history events pertaining to the selected application.
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7. In the Process Definition area, select a process definition and click Next.

Figure 225: Displaying process definitions

This dialog appears only if your simulation scenario contains a single process definition. If
your scenario contains more than one process definition, this dialog is skipped; all history
events related to the selected application are retrieved.

Note:

You can update the list of process definitions using the pop-up menu or pressing the F5
key on your keyboard.

Note:

8. In the dialog that appears, specify when the simulation values are to be gathered.
You can specify the following parameters:
• Start Date: Refers to the date when the Interstage BPM Studio starts getting historical

simulation values.
• End Date: Refers to the date until which the Interstage BPM Studio fetches historical simulation

values.
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• Arrivals: Specifies that process instances will be triggered at the average interval you specified
as arrival interval.

• Arrow probabilities: Refers to the percentage of the time a particular arrow is taken.
• Node durations: Refers to the calculation of average activity duration.

Figure 226: Specifying simulation dates

If you have selected a process definition having Subprocess Nodes or Chained-Process
Nodes for simulating its execution, the Arrivals checkbox will be disabled.

Note:

If you do not select any dates, the time period for fetching historical values will be unlimited.Note:

12.2.3 Defining Simulation Properties for a Scenario
Prerequisite: You have created a scenario in the Simulation Scenarios project or a Workflow
Application project. Refer to Creating a Simulation Scenario on page 346 for details.
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The Scenario editor is either opened automatically after clicking Finish in the New Scenario dialog
or by double-clicking a scenario name in the Navigator view.

Figure 227: The Scenario Editor

To define the simulation properties for a scenario:
1. Open the Scenario editor as described above.
2. In the General area, define the following information for the scenario:

1. Name: Name of the scenario. By default, this is the name you entered when creating the
scenario.

2. Description: Additional information about the scenario. For example, enter text describing
the purpose of the simulation. By default, this is the description you entered when creating
the scenario.

3. In the Imported Process Definition area, perform the following actions:
1. Process Definition: To import the process definition that is to be used for this scenario, click

the Import button ( ). The Import Process Definition dialog is opened and lists all available
projects with their process definition(s). Select the respective one from the list and click OK.

The process definition that you select in Import Process Definition dialog is treated as the
primary process definition for the simulation.

Note:
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If there are two or more process definitions which have the same name, the process definition
selection dialog will be displayed so that you can select a process definition which will be
included in the process definition list to be simulated.

Note:

If you select a process definition having Subprocess Nodes or Chained-Process Nodes for
simulating its execution, the list of all its subprocess definitions or chained-process definitions
is automatically displayed in the Process Definition field. These subprocess or
chained-process definitions are retrieved from the application project to which the scenario
belongs. In other words, even if you import the primary process definition from another
application project, Studio tries to find subprocess or chained-process definitions from the
current application project.

Note:

A process definition with subprocess or chained-process definitions cannot be simulated in
the Simulation Scenarios project.

Note:

You can also export a process definition used by the current scenario by clicking the Export

button ( ). This will open the Export Process Definition dialog and you can select a project
in which the process definition is to be stored.

When storing a process definition in a server project, its application ID is set to 'System'.Note:

2. When the importing of the process definition is finished, it is opened in a separate page that
becomes active. You can then change or define the simulation properties for the individual
nodes contained in the process definition. Proceed as described in section Defining Simulation
Properties for Nodes on page 356.

When you import a parent process definition that contains subprocesses, the parent process
definition is displayed at the top in Process Definition field. The subprocess are
automatically displayed below the parent process definition. For each subprocess definition,
a separate Process Definition tab is opened in the Scenario Editor. You can then change
or define the simulation properties for the individual nodes contained in the subprocess
definitions. The process definition list is updated if you edit process definitions and add or
delete or change the subprocesses.

Note:

3. To return to the scenario and continue with the definition of the simulation properties for the
scenario, click the tab labeled with the name of the scenario at the bottom of the Scenario
Editor.

4. In the Simulation Period and Arrival Setting area, you can perform the following actions:
• Start Date: Date when the simulation is to start. The date format depends on the locale installed

on your machine. You may click the Select Date button to choose a date from the popup
calendar.

• End Date: Date when the simulation is to finish. The date format depends on the locale installed
on your machine. You may click the Select Date button to choose a date from the popup
calendar.

• Gather Default Values from History: Click this link to gather default values from history in
order to run a simulation using these values. For more information, see the chapter Using
Simulation Values From History on page 348.
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• Arrival Interval: Arrivals define how often a process instance will be triggered in the course
of the simulation. Define this flow of process instances by specifying the interval as a specific
period in time.

• Arrival Type: You can choose betweenRegular andRandom arrivals. Regular arrivals specify
that process instances will be triggered always at exactly the interval you specified as arrival
interval. Random arrivals specify that the process instances will be triggered some time in the
interval you specified. For example, if six process instances per hour are to be triggered, the
amount of time between each trigger is not necessarily the same.

Arrival settings are used only for the primary process definition, because subprocesses will
be started appropriately when the subprocess nodes are activated in the parent process
instances.

Note:

• Business Calendar: Business calendars are very important when simulating processes
because they allow you to consider only working days and hours in your simulation. A default
business calendar is included with your installation of the Studio. The default calendar defines
business hours as 8:30 AM to 6:00 PM. The default calendar is stored at the following location:
<Interstage BPM Studio Installation Directory>\ibpm\Data\calendar

You may create as many Business Calendars as necessary to meet the needs of your
organization and use a different Business Calendar for every process definition or process
instance. Your Business Calendars are stored in the Workflow Application project directory in
the Calendar folder.
Refer to the Interstage Business Process Manager Server Administration Guide for more
details and examples.

When simulating a process definition, Interstage BPM Studio automatically uses the Calendar
that has been specified for the Workflow Application project the process definition belongs
to.

Note:

To specify a global business calendar for your simulation scenario, select it from theBusiness
Calendar drop-down list. You can additionally specify individual business calendars for each
human resource allocated in your process definition (see below).

5. In the Resources area, define the allocation of resources at scenario level. Human and
"non-human" (additional) resources are displayed in a separate table. Human resources are
defined based on the roles defined in the imported process definition. Additional resources are
defined based on node-level simulation properties defined in the imported process definition.
The area contains the following information on human resources:
• Currency: Currency used by this scenario for calculating the cost of resources. Supported

currency units are Dollars ($), Euros (€), British Pounds (£), and Japanese Yen (¥). Select the
desired currency from the drop-down list.

• Role Name: Role assigned to a particular node in the process definition. You cannot change
the role names listed in this area. If required, you need to change the process definition.

• Unit of Measurement: Time unit for calculating the cost of a particular resource. Supported
values are "Minute", and "Hour".

• Cost Per Unit: Cost of the resource per unit of measurement.
• Count: Number of allocated resources with this role.
Except for the Role Name, you can change the displayed values by clicking the table cell and
entering a value for the corresponding resource parameter.
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The area contains the following information on additional resources:
• Resource Name: Name of the resource as defined with a node in the process definition. You

cannot change the resource names listed in this area. If required, you need to change the
process definition.

• Unit of Measurement: Time unit for calculating the cost of a particular resource.
• Cost Per Unit: Cost of the resource per unit of measurement.
Except for the Resource Name, you can change the displayed values by clicking the table cell
and entering a value for the corresponding resource parameter.

Resources tables show resources of subprocess definitions as well as the parent process
definitions.

Note:

12.2.4 Defining Simulation Properties for Nodes
Prerequisite: You have created a project with a process definition whose execution you want to
simulate. It contains nodes of one or more of the following types:
• Activity Node
• Subprocess Node
• Chained-Process Node
• Voting Activity Node
• Conditional Node
• Complex Conditional Node
• Compound Activity

To set simulation properties for a particular node:
1. Select the node for which you want to set simulation properties, to display the Properties view

for it.
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2. Select the Simulation tab to define the simulation properties for the selected node, for example:

Figure 228: Simulation Node Properties view

3. For Activity Nodes and Voting Activity Nodes: Specify in the two Working Duration selection
sets, the estimated range of time necessary for a person with the specified Role to complete the
task associated with the node. Note that if you specify Months, one month corresponds to 30
days.
For Conditional and Complex Conditional Nodes, proceed with Step 4.

4. For Activity Nodes and Voting Activity Nodes: In theAdditional Resources area, any non-human
resources required for performing the task associated with the node are listed. The Resource
Name describes the resource, the Count describes the required quantity of this resource.
To add an additional resource for this node, click the Add button. The default values of a new
resource are "Resource", and "10". You can change those values by clicking the table cell
containing the value and entering a new one.
To remove a resource, highlight the corresponding row and click Remove.

You cannot define simulation properties for Subprocess Nodes and Chained-Process Nodes.Note:

5. In the Arrow Probability Information area, all outgoing arrows of the selected node are listed.
The default choice probability is as follows: 100% in case of a single choice and for the first arrow,
0% for all additional arrows when there are several outgoing arrows. The same probability
distribution is applied when an arrow is newly added to the node.
The Probability value determines the percentage amount applied to making that particular choice.
You can change the probability by clicking inside the Probability table cell and entering the new
value. Make sure that the total always sums up to 100%.
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The following probability distribution is applied when an arrow is deleted from the node: The
probability percentage is removed and distributed to each remaining arrow. The distribution factor
is decided by the ratio of the remaining arrows. For example:

10%Arrow1

30%Arrow2

60%Arrow3

The probability distribution after removing Arrow3 will be as follows:

60% * 10% / (10% + 30%)25%Arrow1

60% * 30% / (10% + 30%)75%Arrow2

The specified probabilities are validated against a total of 100%, and you will receive an error message
in the BPM Problems view if the probabilities do not add up to 100%.
If you want to simulate a process that contains two or more nodes with the same name, then the
calculation of how long the node execution takes is aggregated across the branches. As an example,
a process branches into three possibilities. On each branch, there is an Invoice Customer node.
The three nodes are different because they belong to different threads. However, the calculation of
how long an Invoice Customer node takes will be aggregated across the three branches because
the nodes have the same name. Consequently, the same average duration is put into each of the
three nodes that have the same name.

12.2.5 Saving a Scenario
You can save scenarios that have been modified. If there are no changes, the save functions are
not active.
To save a scenario:
1. Do one of the following:

• To save the scenario that is currently displayed in the Scenario editor, select File > Save.
• To save all scenarios that have been modified, select File > Save All.

2. If a scenario is not valid, for example because the start date is after the end date, a message is
displayed telling you so. You cannot save such a scenario. Instead, you must cancel saving, fix
the errors and then try to save the scenario again.
The simulation changes are automatically saved to the Scenario file in the Simulation folder of
your project directory. If the process definition imported in a scenario is not valid, you can save
the scenario anyway.

You can edit simulation results in the Scenario editor. If you save your edits, the Scenario
file will be saved and can be reused. The original simulation results, however, will be deleted.

Note:

12.3 Executing a Simulation Scenario
This section explains how to execute a simulation scenario, and describes the simulation results.
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12.3.1 Preparing a Simulation Result
Once finished with the definition of the simulation properties, you prepare your scenario for the
simulation run.
To prepare the simulation result, do one of the following:
• Right click the scenario in the Navigator view, and select Run Simulation from the popup menu.
• Click Run Simulation in the Scenario editor in which the scenario is displayed.
Your scenario will be validated. For example, it will be checked whether you imported a valid process
definition, whether all units for measurement have been specified, et cetera. If an error occurs, you
are returned to the Scenario editor and you need to fix the error(s) before you can proceed with the
simulation process.
If no errors occur, the simulation results are automatically added to the Scenario (.ssr) file and
stored in the Simulation folder of your project. The Scenario editor displays the process definition
you have selected for simulation. The Simulation Controller is displayed below the Scenario editor:

Figure 229: Displaying the Simulation Controller

If errors occur while the process definitions in the scenario are being validated, all the errors
are displayed in the BPM Problems view. The error details such as error description,
resource where the error occured, error location and project are displayed in this view.
These details are displayed in Decsription, Resource, Location and Project columns
respectively. In the Location column, the location of the error is displayed in the form of
the process definition name and the actual location of the error in that process definition.
These two are separated by a delimiter (/).

Note:

Figure 230: Error Displayed in BPM Problems View

The Simulation Controller is used for starting, stopping, pausing a simulation run, for controlling the
speed of a simulation run, and for generating simulation reports. The Simulation Controller consists
of the following parts:
• Legend: Shows if the simulation run is still waiting to be executed, just processing, or already

completed.
• Speed Controller: Controls the speed at which activities are processed and animated during the

simulation.
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• Simulation Progress: Shows the progress of a simulation run. Below the progress bar, you find
the following buttons:

DescriptionActionButton

Starts the execution of the simulation based on the selected scenario.Play

Pauses the simulation and saves its intermediate history. You can resume
the simulation run by clicking the Play button again.

Pause

Cancels the execution of the simulation run.Stop

• Simulation Date: Displays the date and time of the simulation.
• Simulation Report: Displays the View tab. Use this tab to generate simulation reports. The

reports are displayed in a separate window.

Simulation Report is not displayed in Simulation Controller of the subprocess definition.Note:

For more information on executing a simulation scenario, refer to section Using the Simulation
Controller on page 360.

12.3.2 Using the Simulation Controller
Running a simulation actually displays an animation of the items to be processed arriving at the
individual nodes (Activity Node, Subprocess Node, Chained-Process Node, Voting Activity Node,
Conditional Node, Complex Conditional Node, Compound Activity) and being sent on to other nodes
for processing.

If you simulate a process definition containing a Subprocess Node or Chained-Process
Node, you can click the respective tabs of the subprocess definitions in the Scenario Editor
and use the Simulation Controller to run the animation of their respective simulations.

Note:

You use the Simulation Controller for starting, pausing or stopping a simulation run, and for generating
simulation reports:

Figure 231: Simulation Controller

To execute a simulation scenario:
1. Prepare a simulation, as described in section Preparing a Simulation Result on page 359.
2. In the Simulation Controller, define the speed with which the processing of the nodes will be

animated and displayed. In this way you can control the pace of the simulation: Adjust the slider
of the Speed Controller by dragging it to the desired position between Min (minimum pace, e.g.
hour by hour), Med (medium pace, for example day by day) to Max (maximum pace, for example
an entire week). You can also instantly click Min, Med, or Max.
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3. Click the Play button.
The process definition imported in the selected scenario will be opened in the Scenario editor
view. In the following example, the BankLoan.xpdl process definition has been imported into the
MyTestScenario.ssr file:

Figure 232: Simulating a process definition

In the course of the simulation run, you can observe the following:
• The Simulation Date area in the Simulation Controller shows the virtual date and time of the

running simulation. It starts on the start date defined in the simulation scenario and ends on
the end date you defined in the scenario.

• The Simulation Progress bar indicates the percentage of the simulation that has been
completed so far, and the Legend explains the meaning of the Simulation Progress bar colors
during simulation animation. The same colors are used for showing the processing status of
the individual nodes in the process definition.

• The processing of the process definition is animated, The progress of the simulation run is
shown for every node, for example whether an activity has been completed, which outgoing
arrow has been chosen, how many process instances have been triggered, et cetera.

• The arrow transition probability that you define is displayed near each arrow in the process
definition.

4. To pause the execution of the scenario, click the Pause button. To resume the processing again,
click the Play button.
To stop the execution, click the Stop button. This will cancel the entire simulation run.
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The animation of the processing of the process definition is controlled in the Simulation
Controller in each tab.

Note:

5. In the Simulation Report area of the Simulation Controller, click View to generate a simulation
report.
Refer to section Generating Simulation Reports on page 362 for details.

12.3.3 Generating Simulation Reports
Simulation reports will help you analyze operating costs. Operating costs are associated with process
bottlenecks and resource utilization. You can export the report data and charts in HTML, PDF, and
CSV format.
Simulation reports also support user personalization for corporate sharing. Reports are created to
show one process at a time. The process ID of this process instance is supplied by the simulation
process itself.
1. To generate simulation reports for a particular scenario: In the Simulation Controller, click the

View button.
The Simulation Report will open in a new window displaying the name of the scenario and the
date when the simulation was executed in the title bar, and the report start and end date. This
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date is, by default, the start and end date specified in the scenario that has been executed. For
example:

Figure 233: Simulation Reports Window

Simulation Report is displayed only in the Similation Controller of the primary process
definition. This is not displayed in the Simulation Controller of the subprocess definition.
This report shows the total of all the process definitions.

Note:

2. To review a particular report, click its tab. Refer to section Simulation Report Types on page 364
for details on the various report types.

3. By default, the report start and end date is the same as the dates supplied in the scenario you
executed. You can change the start and end date of the report as follows:
In the Simulation Report Period area, click the respective date button and select the desired
date from the popup calendar. After clicking OK, the report will change accordingly.

To view the initial start and end date again, display the tool tip provided for the simulation
result in the Compare Simulation area.

Note:
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4. Use the Compare Simulation area to select the a simulation result from the list and view
comparative reports.
Refer to section Comparing Simulations on page 367 for details.

5. You can export your simulation reports by clicking the Export button.
Refer to section Exporting Simulation Reports on page 366 for details.

12.3.4 Simulation Report Types
Whenever you have executed a simulation run, you can generate simulation reports. A simulation
report is displayed in a separate window that consists of various parts. The parts depend on the type
of report displayed. For example:

Figure 234: Simulation Report Parts

The various types of report can be displayed by clicking the respective tab:

Figure 235: Report Types

Interstage Business Process Manager Studio User's Guide 364

12: Simulating Processes



You can change the layout of a report by selecting the relevant entry from theReport Type drop-down
list. For example, a Processing Cost report can be displayed as bar report or pie report.
A detailed report for the individual activities, resources, etc. can be opened by double-clicking an
entry in the Statistics area of the Simulation Reports window.
The following types of report are available:

Processing Cost Report
The Processing Cost report shows the total amount of cost (based on the defined resources) of the
simulated process activities within the specified period. The cost of human resources is shown in
one group named as "Human Resources". The cost of all other resources are shown by a separate
bar or pie segment for each resource.
The highest or critical cost flashes and is shown in the color red. The row in the Processing Cost
Statistics containing the critical values (highest values among the values in the table) is also shown
in red. In addition, the Processing Cost Statistics show the number of process instances completed
between the report start date and the report end date.
Double-clicking any particular resource opens the detail report for this resource, and processing cost
drilled down to the selected resource only will be shown. Information on the other resources is
available by clicking the respective tab.

Activities Cost
The Activities Cost report shows the cost for every performed activity, i.e. for every node that has
been processed, calculated on the basis of every resource assigned to an activity. The costs are
divided into the total amount of human resource costs and other resource costs.
Double-clicking any particular activity opens the detail report for this activity. Information on other
activities is available by clicking the respective tab.

Activities Load
The Activities Load report shows, for each activity, how often a it has been triggered and processed.
For each activity, you see how often it has been completed and how many instances are still in a
waiting or working state.
Double-clicking any particular activity opens the detail report for this activity. Information on other
activities is available by clicking the respective tab.

Activities Performance
The Activities Performance report shows, for every activity, the total processing time. The processing
time is combined of waiting hours (hours passed during which the activity could not be processed
because another instance was still in progress) and processing hours (hours it took in order to
complete the activity instances).
Double-clicking any particular activity opens the detail report for this activity. Information on other
activities is available by clicking the respective tab.

Cycle Time
The Cycle Time report shows the number of process instances completed between the report start
and end date in three categories: minimum days, maximum days, and average days.
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If you are simulating a process definition which contains Subprocess Node or
Chained-Process Node, the Cycle Time report of the simulation displays the process
instance cycle information of only the primary (parent) process definition.

Note:

Comparative Reports
Simulation reports can be generated on two sets of simulation data for comparison purposes. Such
a comparison results in the generation of comparative reports. You can consider only one process
definition at a time and both of the simulations must have a result corresponding to the same process
definition, but the simulations may have different scenarios. The above-mentioned reports are
available as comparative reports and behave in the same way as reports for single simulations.

12.3.5 Exporting Simulation Reports
Simulation reports can be exported in the following formats: PDF, HTML, or CSV.
To export your simulation reports:
1. In the Simulation Report view, click the Export button to open the Export Report dialog box.

Figure 236: Export Report Dialog

2. Enter a title for the report.
3. Select the reports that you want to export by activating the appropriate check boxes. Refer to

section Simulation Report Types on page 364 for details on the available reports.
4. Click the button corresponding to the format that you want to export (PDF, HTML, or CSV). This

will open a Save dialog box.
5. Enter a file name and navigate to a location for your report. Then, click Save.

The report will be saved with the name and location specified.
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12.3.6 Comparing Simulations
You can compare the results of two simulation runs and view comparative reports. Both simulations
must use a scenario that imports the same process definition.

Figure 237: Comparing simulation results

To compare two simulation results:
1. In the Compare Simulation area of the Simulation Reports view, select the two simulations that

are to be compared from the drop-down lists.
By default, the drop-down list on the left displays the scenario that is currently open in the Scenario
editor. The drop-down list on the right displays all scenarios simulating the same process definition
that is being used in the current scenario. The available entries in the drop-down lists consist of
the name of the scenario and scenario file name.

2. Activate the Compare check box.
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The content of the Simulation Reports window will change and display comparative reports. Refer
to section Simulation Report Types on page 364 for details. The following example shows a
comparative report.

Figure 238: Displaying a comparative report

12.4 Managing Simulation Scenarios
This section explains the functions available for managing simulation scenarios.

12.4.1 Saving a Scenario to a Different Name or Project
To save a scenario to a different name or project:
1. Click the Scenario editor that displays the scenario to be saved.
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2. Select File > Save As.

Figure 239: Saving a Scenario to a Different Name

3. In the Save As Scenario dialog, select the project where you want to save the scenario. You
can save it to any Workflow Application project or to the "Simulation Scenarios" project. You
cannot save it to server projects. When saving it to a Workflow Application project, it will always
be stored in the Simulation folder of this project.

4. If you want to save the scenario to a different name, type the new name in the Name field.
5. Click Finish.
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6. If a scenario is not valid, for example because the start date is after the end date, a message is
displayed telling you so, and you cannot save such a scenario. Instead, you must cancel saving,
fix the errors and then try to save the scenario again.
Note that if the process definition imported in a scenario is not valid, you can save the scenario
anyway.

12.4.2 Changing the Scenario Name and Description
The name of a scenario is used to identify it, therefore you must specify a name when creating a
scenario. You can use a description to provide additional information on the process.
To change the name and description for a scenario:
1. In the Navigator view, double click the scenario to open it in the Scenario editor.
2. Change the name and description, as desired, in the Name and Description fields.
3. Save the scenario when finished by selecting File > Save.

12.4.3 Opening a Scenario
To open a scenario, do one of the following:
• In the Navigator view, double click the scenario.
• In the Navigator view, right click the scenario and select Open from the pop-up menu.

12.4.4 Closing a Scenario
To close a scenario:
1. Do one of the following:

• To close a particular scenario, click the Close button of the Scenario editor.
• To close all scenarios, select File > Close All.

2. If there are unsaved changes, a message is displayed telling you so. Do one of the following:
• To close the scenario and save your changes, click Yes.
• To close the scenario without saving your changes, click No.

12.4.5 Importing a Scenario
You can import scenarios in XML format into Interstage BPM Studio.
To import a scenario:
1. In the Navigator view, right click the Simulation Scenarios project and select Import from the

pop-up menu.
2. Navigate to the location where the scenario is stored.
3. Select the scenario and click Open.
4. If a scenario with the same file name already exists in the scenario, a dialog is displayed telling

you so. Rename the file to a unique name and restart importing.

12.4.6 Exporting a Scenario
You can export scenarios from Interstage BPM Studio to the file system. You can use the exported
files, for example, to import them into other systems. The export format is XML.
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To export a scenario:
1. In the Navigator view, right click the scenario. Select Export Scenario.
2. Navigate to the location where the exported scenario is to be stored.
3. Click Save.

12.4.7 Copying a Scenario
You can copy scenarios easily in the Navigator view.
To copy a scenario:
1. In the Navigator view, right click the scenario that you want to copy and select Copy from the

pop-up menu.
2. Right click the Simulation Scenarios folder scenario and select Paste from the pop-up menu.
3. Type a new file name and click OK.

You can copy several scenarios at once. Hold down the <Shift> key or <Ctrl> key while selecting all
scenarios to be copied, and - for each scenario - enter a new name.

12.4.8 Renaming a Scenario
You can specify a new file name for a scenario.

You can use this function only if you set your preferences for the Navigator view to File
name.

Note:

To rename a scenario:
1. Right click the scenario in the Navigator view. Select Rename from the pop-up menu.
2. Type the new name for the scenario.
3. Press the <Return> key.
4. If a scenario using the same file name already exists in the Simulation Scenarios project, a dialog

is displayed telling you so. Do one of the following:
• To overwrite the existing scenario, click Yes.
• To keep the existing scenario, click No.

In this case, the scenario is not renamed.

12.4.9 Removing a Scenario
When you remove a scenario, it is removed from the Interstage BPM Studio and from the file system
as well.
To remove a scenario:
1. Right click the scenario in the Navigator view. Select Delete from the pop-up menu.
2. Confirm the removal with Yes.
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Appendix A: Supported JavaScript Functions
Interstage BPM provides a set of JavaScript functions that you can use with Java Actions, triggers
and Complex Conditional Nodes.
This appendix explains which functions you can use with these elements. Also, it provides a description
of some of these functions.
Apart from functions listed in this appendix, you can use the JavaScript functionality that is defined
in the ECMA Standard. For information about the ECMA Standard, refer to the document
ecma-262.pdf included with the Interstage BPM installation.

The size that a method used in a JavaScript may have is limited by the Java Virtual Machine
(JVM). Currently, the method byte code size is limited to 65535 bytes (64 KBytes). If you
use a method with a larger size, the JVM will throw an error and you have to reduce the
size of the method before executing the JavaScript again.

Note:

A.1 General JavaScript Functions
You can use the JavaScript functions explained in this section with Java Actions, triggers, and
Complex Conditional Nodes.

Since numeric values are treated as values of type Number, you can use only the following
range of integers in JavaScript:

Note:

• Minimum: -9007199254740992
• Maximum : 9007199254740992
Note that the following minimum and maximum values of type Long are not supported:
• Minimum: Packages.java.lang.Long.MIN_VALUE
• Maximum: Packages.java.lang.Long.MAX_VALUE

new Packages.java.util.Date()
For a description, refer to the Javadoc that comes with the J2SE Development Kit (JDK).

Date DateAdd(Date or Number date, Number offset, String field)
Returns a JavaScript Date object containing the date and time that is the result of adding the offset
to the date. field determines the unit of time measure for the offset. Valid field values are:

DescriptionField Value

Seconds"ss"

Minutes"mi"

Hours"hh"

Days"dd"

Example:

var now = Packages.java.util.Date();
uda.Date = DateAdd (now, 1, "dd");

Interstage Business Process Manager Studio User's Guide 372

Appendix A: Supported JavaScript Functions



The example works correctly only if the User Defined Attribute (UDA) Date is of type DATE.Note:

Say now has the following value:
Tue Jul 01 2006 14:02:59 GMT-0800 (PST)

Then, tomorrow ( DateAdd ( now, 1, "dd" ) ) has the following value:
Wed Jul 02 2006 14:02:59 GMT-0800 (PST)

If date is of type Number, its value is interpreted as milliseconds since January 1, 1970.

Boolean DateCompare(Date or Number date1, String operator, Date or Number
date2)
Compares two Date values and returns true or false as the result of the comparison. Valid operators
are:

DescriptionOperator

Greater than">"

Less than"<"

Greater than or equal to">="

Less than or equal to"<="

Equal to"=="

Not equal to"!="

Example:

var now = Packages.java.util.Date();
var tomorrow = DateAdd (now, 1, "dd");
if (DateCompare (now,"<", tomorrow))

...;
//... Executes because DateCompare evaluates to true.

If date1 and date2 are of type Number, their values are interpreted as milliseconds since January
1, 1970.

Number DateDiff(Date or Number date1, Date or Number date2, String field)
Subtracts date2 from date1. Returns the difference between these date/times in days, hours, minutes
or seconds depending on the field value. Valid field values are:

DescriptionField Value

Seconds"ss"

Minutes"mi"

Hours"hh"

Days"dd"
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Example:

var now = Packages.java.util.Date();
var tomorrow = DateAdd (now, 1, "dd");
var diff = DateDiff (tomorrow, now, "dd"));
//diff has a value of 1.

If date1 and date2 are of type Number, their values are interpreted as milliseconds since January
1, 1970. Example:

var date = DateDiff (20000000,10000000,"ss");

BigDecimal DecimalAdd(BigDecimal value1, BigDecimal value2)
Returns a JavaScript BigDecimal object that is the sum of the parameters specified. The result
inherits the precision from the parameter with the most significant figures.
If you want to assign the result to a UDA, make sure that the UDA is of type BIGDECIMAL.
If you pass any other data type as a parameter, the function converts the parameter to a BigDecimal.
Example:

int x = 39;
var z = DecimalAdd ("3.1416",x);

If z is a BigDecimal, its value is 42.1416.

Boolean DecimalCompare(BigDecimal value1, String operator, BigDecimal
value2)
Compares two BigDecimal values and returns true or false as the result of the comparison.
Valid operators are:

DescriptionOperator

Greater than">"

Less than"<"

Greater than or equal to">="

Less than or equal to"<="

Equal to"=="

Not equal to"!="

If you want to assign the result to a UDA, make sure that the UDA is of type BIGDECIMAL.
If you pass any other data type as a parameter, the function converts the parameter to a BigDecimal.
Example:

var smallDecimal = "1.11";
var largeDecimal = "22.22";
if (DecimalCompare (smallDecimal,"<", largeDecimal))

...;
//Executes because DecimalCompare evaluates to true.
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BigDecimal DecimalDivide(BigDecimal value1, BigDecimal value2, Number
scale )
Divides value1 by value2 and returns the result of the division. scale determines the number of
significant digits for rounding. Any Number can be used as a scale value. Default value is 2.
The rounding mode is always to round half up; it rounds towards the "nearest neighbor" unless both
neighbors are equidistant. In that case, it rounds up.
If you want to assign the result to a UDA, make sure that the UDA is of type BIGDECIMAL.
If you pass any other data type as a parameter, the function converts the parameter to a BigDecimal.

BigDecimal DecimalMultiply(BigDecimal value1, BigDecimal value2, Number
scale)
Multiplies value1 by value2 and returns the result of the multiplication. scale determines the number
of significant digits for rounding. Any number can be used for scale. Default value is 2.
The rounding mode is always to round half up; it rounds towards the "nearest neighbor" unless both
neighbors are equidistant. In that case, it rounds up.
If you want to assign the result to a UDA, make sure that the UDA is of type BIGDECIMAL.
If you pass any other data type as a parameter, the function converts the parameter to a BigDecimal.

BigDecimal DecimalSubtract(BigDecimal value1, BigDecimal value2)
Subtracts value2 from value1. Returns the difference between these values as a BigDecimal.

boolean toBoolean(String or Number value)
Converts value to a JavaScript Boolean. The value can be either a String containing "true" or
"false", or a Number containing zero (for true) or non-zero (for false). Returns true or false
depending on the parameter passed. If value cannot be converted into a Boolean, false is returned.

BigDecimal toDecimal(BigDecimal value, Number scale)
Converts value to a BigDecimal object. Returns the result of the conversion to the number of
significant figures specified with scale. Any Number can be used for scale. Default value is 2.
If you want to assign the result to a UDA, make sure that the UDA is of type BIGDECIMAL.
If you pass any other data type as a parameter, the function converts the parameter to a BigDecimal.

Packages.java.lang.Float.parseFloat
For a description, refer to the Javadoc that comes with the J2SE Development Kit (JDK).

Packages.java.lang.Integer.parseInt
For a description, refer to the Javadoc that comes with the J2SE Development Kit (JDK).

Packages.java.lang.String.valueOf
For a description, refer to the Javadoc that comes with the J2SE Development Kit (JDK).
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A.2 JavaScript Functions Supported with Java Actions
With Java Actions, you can use the functions explained in section General JavaScript Functions on
page 372 and the functions listed below.
The functions listed below use the Server Enactment Context API
com.fujitsu.iflow.server.intf.ServerEnactmentContext to provide access to workflow
information. For a description, refer to the API Javadoc.
void sec.addAttachment(String attachmentName, String attachmentPath)

void sec.addProcessXMLAttributeSubstructure(String udaName, String xPath, String
value)

void sec.addProcessXMLAttributeSubstructureByIdentifier(String identifier, String
xPath, String value)

void sec.deleteAttachment(String attachmentName)

void sec.deleteProcessXMLAttributeSubStructure(String udaName, String xPath)

void sec.deleteProcessXMLAttributeSubStructureByIdentifier(String identifier,
String xPath)

void sec.escalateActivity(String assignees)

Array sec.getActivityAssignees()

String sec.getActivityName()

String sec.getActor()

Array sec.getAllAttachmentNames()

Array sec.getAllAttributeNames()

String sec.getAttachment(String attachmentName)

Number sec.getCurrentActivityId()

Number sec.getCurrentProcessId()

Array sec.getGroupMembers(String groupName)

String sec.getProcessAttribute(String attName)

String sec.getProcessAttributeByIdentifier(String identifier)

String sec.getProcessAttributeStringType(String udaName)

String sec.getProcessDefinitionId()

String sec.getProcessDefinitionName()

String sec.getProcessDescription()

String sec.getProcessInitiator()

String sec.getProcessName()

Array sec.getProcessOwners()

Number sec.getProcessPriority()

String sec.getProcessTitle()

String sec.getProcessXMLAttributeElementValue(String udaName, String xPath)

String sec.joinString(Array)

void sec.sendEmail(String to, String from, String cc, String bcc, String subject,
String body, String mimeType)
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void sec.setActivityAssignees(Array assignees)

void sec.setOwners(Array users)

void sec.setProcessAttribute(String name, String value)

void sec.setProcessAttributeByIdentifier(String identifier, String value)

void sec.setProcessDescription(String description)

void sec.setProcessName(String name)

void sec.setProcessOwners(Array users)

void sec.setProcessPriority(Number priority)

void sec.setProcessTitle(String title)

void sec.setProcessXMLAttributeElementValue(String udaName, String xPath, String
value)

void sec.setProcessXMLAttributeElementValueByIdentifier(String identifier, String
xPath, String value)

void sec.setProcessXMLAttributeSubstructure(String udaName, String xPath, String
value)

void sec.setProcessXMLAttributeSubstructureByIdentifier(String identifier, String
xPath, String value)

void sec.validateProcessXMLAttributeValue(String udaName)

void sec.validateProcessXMLAttributeValueByIdentifier(String identifier)

Array sec.splitString(String commaSeparatedList)

Using User Defined Attributes (UDAs)
You can use UDAs that have been added to the process definition in your JavaScripts. Use the
following syntax:
uda.<udaIdentifier>. Note that you must use the identifier and not the name of the UDA, as
multibyte characters are not allowed for variable names in JavaScript.
The following example creates a variable and initializes it to the value of a UDA:
var someVariable = uda.Price;

The following example shows how to assign the value of a variable to a UDA:
var lastName = "Jones";

uda.udaIdentifier = lastName;

The methods uda.get and uda.set allow you to access UDAs by their names:
• uda.get returns the value of the specified UDA:

var value = uda.get("<udaName>");

• uda.set sets the value of the UDA to the specified value:
uda.set("<udaName>", "<udaValue>");

When assigning a JavaScript return value to a UDA, make sure that their data type matches.
Otherwise, the assignment fails.

If the assignment of a value to a target UDA fails due to conversion or any other kind of
errors, error details are logged in IBPMServer.log. The target UDA is not updated and
holds its earlier value.

Note:
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Interstage BPM maps UDA data types to the following Java data types:
• UDAs of type BIGDECIMAL are mapped to Packages.java.math.BigDecimal objects.
• UDAs of type DATE are mapped to Packages.java.util.Date objects.
For details about the Java objects, refer to the Javadoc that comes with the J2SE Development Kit
(JDK).

A.3 JavaScript Functions Supported with Triggers
With triggers, you use JavaScript expressions to specify control conditions. Control conditions narrow
down when the trigger fires.
You can use the functions explained in section General JavaScript Functions on page 372 and the
function explained below.

String eventData.getXMLData(String xpath)
Returns the text value of the XML element specified in the xpath expression.
Example:
Consider the following XML fragment:

<Customer>
<Data>

<Name>John</Name>
</Data>

</Customer>

The following statement assigns the text value "John" of the <Name> XML element to the name
variable:
var name = eventData.getXMLData ( "/Customer/Data/Name/text()");
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Appendix B: Project Components
Interstage BPM supports a set of files that you need for running a specific process solution:
This appendix provides a complete list of files supported by Interstage BPM, and contains a brief
description of all these files:

Location in the Application
Project Directory

Description of FilesFolder Name

<Project Root>/Process
Definitions

The Process Definitions folder
contains all process definition
(.xpdl) files.

Process Definitions

<Project Root>/FormsThe Forms folder contains all
Interstage BPM Forms (.xml
files) that you create for your
project.

Forms

<Project Root>/webThe default web folder contains
files that will be exposed to the
Internet, such as various image
(.gif, .jpeg) files, calendar setup
(.js) files, and design (.css)
files.

web

<Project Root>/dms and
<Project
Root>/dms/Attachments

The dms folder contains all sorts
of attachments of Workflow
Application projects in
Attachments folder, such as
image (.gif) files, preview
(.wmf) files, and .html files.
Attachments folder also
contains Blaze and new ILOG
rules files.

dms

<Project Root>/Application
Classes/engine/classes and
<Project Root>/Application
Classes/engine/lib

The engine folder contains the
classes, lib, and js subfolders.
The classes folder contains the
class (.class) files loaded by
the application at runtime.
The lib folder contains the jar
(.jar) files used by your
application.
The js folder contains the Java
Script (.js) files used by your
application.

Application Classes/engine
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Location in the Application
Project Directory

Description of FilesFolder Name

<Project Root>/SimulationThe Simulation folder contains
the scenario files storing
simulation scenarios (.ssr files)
and, after running a simulation,
the scenario results.

Simulation

<Project Root>/CalendarCalendar (.cal) file used for
configuring new business
calendars. Calendars are similar
to property or .ini files. They
consist of name-value pairs. To
indicate a period of time,
commas are used.
One project can have several
calendar files.

Calendar

<Project Root>/ResourcesResources folder contains the
following:
• FTP Agent files
• HTTP Agent files
• Custom Config files
• Configuration file for Java

Agents used by the
application
(agentsConfig.xml)

• Configuration files for new
data sources used by
Interstage BPM Studio
(DataSourceDefinition.xml)

• File Listener file
(fileListenerConf.xml)

• Process Scheduler File
(ProcessScheduler.xml)

Resources

<Project Root>/RulesTheRules folder containsRules
Set sub-folders, which contains
the Decision Table (DTM files).

Rules

<Project Root>/DocumentsTheDocuments folder contains
report and document files.

Documents

<Project Root>/AnalyticsThe default Analytics folder is
empty. After installing the
Interstage Analytics plugin, this
folder contains the process
definitions (.xpdl files) defining
the Analytics setting.

Analytics
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Glossary
A transaction is a set of actions that obeys the four so-called ACID
properties: atomic, consistent, isolated, and durable.

ACID properties

The description of a task, logical step, or work to be performed in a
process. An activity is represented by a work item.

Activity

A graphical representation of an activity .Activity Node

The time it takes to perform a particular activity.Activity Time

Components that asynchronously access systems external to Interstage
BPM.

Agents

A node that synchronizes multiple branches in a process.AND Node

An addition to a process definition allowing for adding explanatory
comments to the process definition.

Annotation

Application Programming Interface. The interfaces and classes that
programmers may use in their own customized applications to access
the server.

API

Asynchronous Service Access Protocol. ASAP is a communication
protocol based on SOAP and is used to start, manage, and monitor long
running services.

ASAP

A connector between nodes. Arrows guide the process flow from one
node to another.

Arrow

The person(s) assigned to perform an activity.Assignee

A document file generated by any application, which has been associated
with a process.

Attachment

Business Process Reengineering. The field of study which concentrates
on how work may be redefined in terms of processes.

BPR

A calendar that specifies working days and times.Business Calendar

See Process.Business Process

A node representing a complex task that can be accomplished
independently from the tasks defined in the parent process definition.

Chained-Process Node

A Java Action that can be defined as compensation for a regular Java
Action, e.g. for cleaning up the system and ensuring a consistent state
of external systems involved in a transaction.

Compensation Action

A Conditional Node where the condition is specified as a JavaScript
expression.

Complex Conditional
Node

A node that directs the process flow along one of several branches,
depending on specified criteria.

Conditional Node

A Java Action allowing for the interaction with external databases that
are independent of Interstage BPM.

Database Action

A node that accesses an external database using JDBC.DB Node
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A node that suspends process execution for a certain amount of time.Delay Node

Repository for the entire network's authentication and configuration data.
Provides access to services, file servers, databases, and other
applications. User and application access to the repository is controlled.

Directory Service (DS)

The system integrated with Interstage BPM which is used to store
attachments, forms, etc. The DMS Adapter is the communication link
between the DMS and Interstage BPM.

DocumentManagement
System (DMS)

Specifies when an activity is due to be completed once it has become
active. A due date also specifies what will happen when it is reached
and the activity has not been completed.

Due Date

Enterprise JavaBeans.EJB

A node that sends out predefined emails.Email Node

A Java Action that is used to handle specific errors on process definition
level, on Remote Subprocess level, and on Java Action level.

Error Action

A node that identifies the end of a process branch. A process definition
has at least one Exit Node.

Exit Node

An HTML or XML file which may be associated with an activity, process
instance, or process definition. Forms can be created using Interstage

Form

BPM; their appearance can be modified using any XML or HTML editing
tool.

The Framework Adapter, also called DD Adapter, connects the Directory
Service and the Document Management System Adapters. The "DD" is

Framework Adapter

short for "document" and "directory". It handles authentication of the user
and manages a consistent user authentication to the Directory Services
and Document Management System.

Visual grouping of activities of the same category.Groups

A type of software, which facilitates collaboration.Groupware

Graphical User Interface.GUI

The person who starts a new process instance.Initiator

A Java Action allowing for accessing external functions from within a
process definition.

Integration Action

User interface which allows a user to create process instances, process
definitions and access and respond to work items. It is also used by
Interstage BPM Administrators to administrate Interstage BPM.

InterstageBPMConsole

An XML layout definition plus a Java adapter class from which an HTML
file is generated. An Interstage BPM Form is created and designed using
the Interstage BPM Form editor.

Interstage BPM Form

A custom programmed component used for performing the same function
several times.

Java Action

Lightweight Directory Access Protocol.LDAP

A service that allows clients to find objects based on names.Naming Service
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A graphical representation of a step in a process. Interstage BPM
supports different node types, e.g. Activity Nodes, AND Notes,
Subprocess Nodes, Conditional Nodes.

Node

A built-in Java Action that specifies no operation.No-Operation Action

A Java Action allowing for notifying users on events related to process
execution. Users can be notified by email, for example, that a process
or a single activity has been started.

Notification Action

A Java Action that will be executed before a process instance is aborted.OnAbort Action

A Java Action that will be executed before a process instance is resumed.OnResume Action

A Java Action that will executed before a process instance is suspended.OnSuspend Action

A node that splits process flow into multiple parallel branches.OR Node

See Process Definition Owner and Process Instance Owner.Owner

A person involved in a process.Participant

A sequence of steps that are performed to reach a business goal.
Processes are modeled in process definitions.

Process

The representation of a business process in a form that supports
automated manipulation. A process definition defines the behavior and

Process Definition

properties of the process instances created from it including the flow of
control within the process.

The person who created (or last edited) the process definition.Process Definition
Owner

See Initiator.Process Initiator

Represents a single enactment of a specific process definition. The
structure of a process instance is exactly the same as the structure of
the process definition on which it is based.

Process Instance

By default, the owner of a process instance is the owner of the process
definition from which the process instance was created.

Process Instance
Owner

See Participant.Process Participant

A container for process definitions, forms, simulation scenarios,
attachments, etc. On file system level, a project corresponds to a folder.

Project

A structured, field-based HTML file created using the Interstage BPM
Studio.

QuickForm

A node representing a subprocess that runs on a remote workflow server.Remote Subprocess
Node

The name of a person or group (for example, the Manager Role). Each
task (activity) in a process is assigned to a role for completion. Roles

Role

are equivalent to groups, as defined in Interstage BPM's local group
store or in a Directory Service.

Method used to determine choices on activities for which the rules are
defined.

Rule
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In the Interstage BPM context, the component of the workflow
management system installed on the computer where the workflow
engine provides the run-time environment for a process.

Server

A Java Action allowing for interacting with the Interstage BPM Server.Server Action

A defined setup for simulating the execution of a process definition on
your local computer.

Simulation Scenario

Simple Object Access Protocol. SOAP is a standard communication
protocol that allows one application to send an XML message to another
application. It is used, for example, to access Web Services.

SOAP

Structured Query Language.SQL

A node that identifies the beginning of a process. Every process definition
has one and only one Start Node.

Start Node

A node that represents a complex task. The details of that task are
defined in another process definition.

Subprocess Node

Simple Workflow Access Protocol. SWAP passes XML messages over
HTTP between workflow servers.

SWAP

Visual grouping of activities performed by the same Role.Swimlane

An activity in a process; it typically requires a human decision to be made.Task

Expires after a specified interval or at a specified time and date. Timers
trigger certain actions when they expire.

Timer

Data that process participants need to access, modify, or add, such as
customer data, order numbers etc. User Defined Attributes are specified
in the process definition.

User Defined Attribute
(UDA)

Sets of individuals who typically share common characteristics. User
groups are defined in Interstage BPM's local group store, in a Directory
Service or in both systems.

User Groups

User-specific configuration information. This includes information such
as whether a users wishes to receive email notifications, email address,
and default directory, etc.

User Profile

A node that allows users to work on an activity in collaboration with one
another.

Voting Activity Node

Rule defined on a Voting Activity Node to determine the outcome of the
vote.

Voting Rule

A node that retrieves data from a Web Service and makes it available
for further processing.

Web Service Node

The sequence of activities within a business process.Workflow

A process solution consisting of process definitions, forms, simulation
scenarios, attachments, etc. Interstage BPM allows for the creation of

Workflow Application

Workflow Application projects having a predefined structure. Such
applications can be deployed on an Interstage BPM server that can be
accessed by Interstage BPM clients.
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An Interstage BPM component that provides the run-time environment
for process instances.

Workflow Server

An activity in the worklist.Work Item

The list of activities.Worklist

Web Services Description Language. WSDL is an XML-based language
that describes the Web Services an organization offers. It also describes
how to access the Web Services.

WSDL

A Java Action that allows you to perform specific operations on UDAs
of type XML, for example adding XML substructures, setting text or
attribute values in XML, or extracting UDA values from XML data.

XML Action

XML Path Language. XPath is a language for finding information in an
XML document. It is used to navigate through elements and attributes.

XPath

XML Process Definition LanguageXPDL
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Index

A

About this manual, 12
Actions

property symbol, 24
Activities

assigning to Roles, 142
activity level priority, 129, 257
Activity Nodes, 20
Adding

annotations, 140
arrows, 131
groups, 137
nodes, 128
swimlanes, 134

Adjusting
group size, 139
swimlane size, 135

Advanced due dates, 160
Advanced timers, 160
Agents

defining, 330
property symbol, 24

Aligning
groups, 138
nodes, 129
swimlanes, 134

AND Nodes, 21
Annotations

adding, 140
introduction, 26

Application Variables, 108
Define, 108

Architecture
Interstage BPM, 15

Arrows, 24, 131
adding, 131
changing shape, 133
defining names, 132
property symbols, 25
reconnecting, 133
removing, 133

assign, 230
Assigning

activities to Roles, 142
activities to users, 251
an XML string to a UDA, 273

Assigning (continued)
business calendars to due dates or timers,
164
business calendars to process definitions,
163
Generic Java Actions, 313
Java Actions, 234
process instance owners, 142

Assigning Task
Completed Activity, 252

Automatic choice, 262

B

Blaze rules, 284
Business calendars

assigning to due dates or timers, 164
assigning to process definitions, 163
creating, 161

Business User Persepctive
Start, 68

Business User Perspective
Application View, 69
Process Outline Editor, 71
Use, 43

C

Cascading style sheets
integrating, 191, 202

Chained-process definitions
connecting to parent, 213
navigating to, 213

Chained-Process Nodes, 21
Chained-processes, 212

defining data mappings, 214
Changing

arrow shape, 133
swimlane color, 136
swimlane style, 136

Closing
process definitions, 124
scenarios, 370
Server projects, 113
Workflow Application projects, 91

Commit Actions, 233
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Comparing
simulations, 367

Compensation Actions, 233, 240
introducing, 316
sample, 245

Complex Conditional Nodes, 22
Complex conditions

defining, 171
Components

Workflow Application, 82
Compound Activity

Node, 151
Conditional Nodes, 22
Conditions

defining, 168
Connecting

parent and chained-process definitions, 213
parent and remote subprocess definitions,
210
parent and subprocess definitions, 205

Copying
groups, 139
Java Actions, 237
nodes, 130
process definitions, 124
scenarios, 371
swimlanes, 137
Workflow Application projects, 90

Creating
business calendars, 161
Interstage BPM Forms, 174
Process Definition Reports, 120
process definitions, 115
QuickForms, 195, 197
scenarios, 346
server projects, 110
Workflow Application projects, 80

Cutting
groups, 139
Java Actions, 237
nodes, 130
swimlanes, 137

D

Data mappings
for chained-processes, 214
for remote subprocesses, 211
for subprocesses, 207

Data source
adding new, 292

Database Actions, 292
configuring Interstage BPM, 292

Day codes for advanced due dates and timers,
160
DB Nodes, 23
Decision Table Editor, 59
Decision Tables

condtions
add, 221
edit, 221

create new, 218
create Rule Set, 217
creating, 217
data dictionary, 222
decisions

add, 225
edit, 225

exporting, 220
importing, 220
results

add, 223
edit, 223

selecting Process Definition, 230
Summary, 216
testing, 229

Defining
agents, 330
arrow names, 132
complex conditions, 171
conditions, 168
data mappings for chained-processes, 214
data mappings for remote subprocesses, 211
data mappings for subprocesses, 207
due dates, 152
group titles, 138
JavaScript expressions, 339
Make Choice Triggers, 325
No-Operation Java Action, 314
node name and description, 128
process definition name and description, 118
scenario name and description, 370
scenario properties, 352
simulation properties, 356
Start Process Triggers, 323
swimlane titles, 134
timers, 154
voting rules, 165

Delay Nodes, 22
Deleting

Interstage BPM Forms, 194
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Designing
Interstage BPM Forms, 176

Display mode, 66
Displaying

properties, 64
Downloading

Workflow Application projects, 28, 97
Due dates, 152

assigning business calendars, 164
defining, 152
time and day codes, 160

E

Edit menu, 50
Editing

arrows, 131
groups, 137
Java Actions, 236
nodes, 127
swimlanes, 134

Email Nodes, 23
Enabling

Future Work Items, 141
Enabling Recall

work item, 140
Epilogue Actions, 233
Error Actions, 233, 241

defining, 240
introducing, 316
on activity level, 317
on process level, 316
sample, 245

Error handling
settings, 244, 320

Errors
property symbol, 24

Escalating
activities, 258

Evaluating
JavaScript, 260

Exception handling
describing, 316

Executing
simulation scenarios, 358

Exit Nodes, 22
Exiting

Interstage BPM Studio, 44
Exporting

Interstage BPM Forms, 194
process definitions, 121
scenarios, 370

Exporting (continued)
simulation reports, 366
Workflow Application projects, 29, 94

F

File Listener
Define, 338

File menu, 48
Folders

in Workflow Application projects, 84
Folders and files

importing, 86
searching, 87

Form controls, 199
Form editor, 56, 176
Form templates, 202
Forms, 174

creating, 174
designing the layout, 176
introduction, 25
property symbol, 24

FTP Agents
Define, 331

G

Generating
simulation reports, 362

Generic Java Actions, 313
Getting started, 31

modeling a process, 32
starting Interstage BPM Studio, 31

Glossary, 381
Grid settings, 66
Group work items, 143
Groups, 26, 137

adding, 137
adjusting size, 139
aligning, 138
cutting, copying and pasting, 139
defining title, 138
moving, 139
removing, 139

H

Help menu, 52
HTTP Agents

Define, 335
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I

ILOG JRules, 287
Importing

folders and files, 86
Interstage BPM Forms, 194
process definitions, 121
scenarios, 370
Workflow Application projects, 29, 91

Individual work items, 143
Init Actions, 233
Integration Actions, 298
Interstage BPM

Clients, 15
documentation list, 13
Server, 15
Studio, 16

Interstage BPM Form
UDAs, 189

Interstage BPM Form Adapter Classes, 191
Interstage BPM Form Controls, 180
Interstage BPM Form Editor, 176
Interstage BPM Form menu, 52
Interstage BPM Forms, 174

associating with nodes, 192
deleting, 194
dissociating from nodes, 193
exporting, 194
importing, 194
integrating cascading style sheets, 191
renaming, 194
updating, 192

Interstage BPM Studio
exiting, 44
features, 16
starting, 31
using as application, 17
using as Eclipse plug-in, 17

Interstage Business Process Manager, 15
Iterator Node, 149

J

Java Actions
adding substructures, 267
Assign Task to User, 251
Assign UDA from XPath, 270
Assign XML to UDA, 273
assigning, 234
calling a Web Service, 301
cutting, copying and pasting, 237
Database Actions, 292

Java Actions (continued)
Decision Tables, 230
Delete SQL Java Action, 296
deleting substructures, text, attribute values,
274
editing, 236
Error Actions, 240
Escalate Task, 258
Evaluate Script, 260
Fair Isaac Blaze Advisor, 284
Generic Java Actions, 313
Get Performer, 261
Get Process Initiator, 262
ILOG JRules, 287
Insert SQL Java Action, 296
Integration Actions, 298
introduction, 233
Java Actions

Java Actions
OnAbort, 320

OnResume, 320
Make Choice, 262
No-Operation Java Actions, 314
Notification Actions, 287
OnSuspend, 320
Process Owner, 233
Remote Command Invoker, 298
Removing, 239
Rules Actions, 283
Select SQL Java Action, 294
SendEmail, 288
Server Actions, 251
Set Activity Level Priority, 257
Set Process Instance Description, 265
Set Process Instance Name, 263
Set Process Instance Priority, 264
setting a substructure, 277
setting text or attribute values, 280
specifying transaction settings, 239
supported JavaScript functions, 376
types, 233
types of, 233
UDA Assignment, 266
Update SQL Java Action, 296
XML Actions, 267

JavaScript
evaluating, 260

JavaScript expressions, 339
example, 342

JavaScript functions, 372
general, 372
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JavaScript functions (continued)
supported with Java Actions, 376
supported with triggers, 378

M

Make Choice Triggers, 325
Menu bar, 48

Edit menu, 50
File menu, 48
Help menu, 52
Interstage BPM Form menu, 52
View menu, 51
Window menu, 51

Modeling
processes, 126

Moving
arrows, 133
group, 139
nodes, 130
swimlanes, 137

N

Navigating
to chained-process definitions, 213
to subprocess definitions, 206

Navigator view, 54
No-Operation Java Action, 314
Nodes, 127

adding, 128
aligning, 129
cutting, copying and pasting, 130
defining name and description, 128
introduction, 19
moving, 130
removing, 131

Notification Actions, 287

O

Offline editing
introduction, 27

onAbort Java Actions, 233
onResume Java Actions, 234
onSuspend Java Actions, 234
Opening

process definitions, 121
scenarios, 370
Server projects, 114
Workflow Application projects, 91

OR Nodes, 22

Outline view, 63
Overview View, 62

P

Palette Settings, 67
Pasting

groups, 139
Java Actions, 237
nodes, 130
swimlanes, 137

Performer of activity, 261
Power User Perspective, 46
Preferences, 76
Printing

process definitions, 127
Problems view, 60
Process Definition Editor, 55
process definition priority, 118
Process definitions, 115

closing, 124
copying, 124
creating, 115
defining name and description, 118
exporting, 121
importing, 121
introduction, 18
opening, 121
removing, 125
renaming, 124
saving, 116
sending to server, 122
validating, 116

process fragments, 172
adding to process definitions, 173
creating, 172

Process initiators, 262
Process instance description, 265
Process instance name, 263
Process instance owners

assigning, 142
Process instance priority, 264
Process Owner Actions, 233
Processes

modeling, 126
simulating, 344

Projects, 80
Prologue Actions, 233
Properties

displaying, 64
Properties view, 59
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Property symbols
introduction, 23

Q

QuickForm controls, 199
QuickForm templates, 202
QuickForms, 174

associating with nodes, 204
creating, 195
creating in local projects, 197
creating in Workflow Application projects, 195
dissociating from nodes, 204
integrating cascading style sheets, 202
updating, 204

R

Redo, 127
Remote commands, 298
Remote subprocess definition

connecting to parent, 210
Remote Subprocess Nodes, 21, 208
Remote subprocesses, 208

defining data mappings, 211
Removing

arrows, 133
groups, 139
Java Actions, 239
nodes, 131
process definitions, 125
scenarios, 371
server projects, 114
swimlanes, 137
Workflow Application projects, 91

Renaming
Interstage BPM Forms, 194
process definitions, 124
scenarios, 371
Workflow Application projects, 90

Report types, 364
Reports

Process Definition, 119
Resources

working with, 88
Role Actions, 233
Roles, 25

displaying, 66
hiding, 66

Rulers
displaying, 66
hiding, 66

Rules Actions, 283
Running

simulation, 360

S

Saving
process definitions, 116
scenarios, 358, 368

Scenario editor, 57, 352
Scenario projects, 80
Scenarios

changing name and description, 370
closing, 370
copying, 371
creating, 346
executing, 358
exporting, 370
importing, 370
introduction, 30
opening, 370
preparing results, 359
removing, 371
renaming, 371
running simulation, 360
saving, 358, 368

Search Results View, 59
Sending emails, 288
Server Actions, 251
Server projects, 80

closing, 113
creating, 110
introduction, 29
opening, 114
removing, 114

Setting Assignee
Relationship, 255

Simulation
comparing, 367
defining scenario properties, 352
generating reports, 362
introduction, 344
node properties, 356
overview, 344
preparing results, 359
procedure, 345
report types, 364
running, 360
using values from history, 348

Simulation Controller, 58
Simulation reports

exporting, 366

Interstage Business Process Manager Studio User's Guide 391

Index



Simulation reports (continued)
generating, 362
types, 364

Simulation scenarios
introduction, 30

Start Node, 20
Start Process Triggers, 323
Starting

Interstage BPM Studio, 31
Style Sheet Editor view, 60
Subprocess definitions

connecting to parent, 205
navigating to, 206

Subprocess Nodes, 21
Remote, 208

Subprocesses, 205
defining data mappings, 207

Swimlanes, 26, 134
adding, 134
adjusting size, 135
aligning, 134
changing color, 136
changing style, 136
cutting, copying and pasting, 137
defining title, 134
moving, 137
removing, 137

T

Time codes for advanced due dates and timers,
160
Timer Actions, 233
Timers, 152

assigning business calendars, 164
defining, 154
property symbol, 24
time and day codes, 160

Toolbar, 52
Transaction settings, 239
Transfer to server

introduction, 27
Transferring

process definitions to server, 122
Trigger Node, 329
Trigger Nodes, 22
Triggers, 321

defining Make Choice Triggers, 325
defining Start Process Triggers, 323
preparing, 322
property symbol, 23
supported JavaScript functions, 378

Triggers (continued)
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